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EM Simulation Overview

EM Simulation Overview

ADS provides EM simulation tools for designing and evaluating modern 
communications systems products. It provides a unified interface for Momentum 
and FEM simulators. These are electromagnetic simulators that compute S-
parameters, surface currents, and fields for general planar circuits, including 
microstrip, stripline, coplanar waveguide, and other topologies.

The EM simulation use model provides the following advantages:

Single EM Setup window that replaces the tasks performed by multiple 
dialog boxes.

Unified use model for Momentum, Momentum RF, and FEM.

Job manager provides improved ease-of-use for monitoring multiple local, 
remote, queued, or distributed simulations.

EM models are fully compatible with the new dynamic model selection.

EM Simulation toolbar provides shortcuts to frequently used menus.

Generates reusable EM setups that offer the following benefits:

Creates easy to save and restore EM setups.

Reduces the efforts to define EM settings.

Simplifies the simulation process.

Ensures easier, faster, and accessible EM simulations.

Getting Started with an EM Simulation

The EM menu that enables you to perform various tasks such as simulating a 
circuit, configuring a simulation, and adding a box or waveguide. Using the EM 
menu, you can perform the following tasks:

Performing simulations: Choose >  to perform an EM simulation. EM Simulate
You can also press  to start the simulation process.F7

Configuring a Simulation Setup: Choose >  to open EM Simulation Setup...
the  window. You can also press  to open the  window. EM Setup F6 EM Setup
The EM Setup window enables you to define frequency and output plan, 
configure engine options, generate ports and EM model. For more 
information, see .Setting up EM Simulations

Modifying the Output Dataset name: Choose >  to EM Choose Output Dataset
change the name of the dataset that is used to store the EM S-Parameter 
results.

Stopping a simulation: To end a simulation before it is finished, choose > EM
. You can use this option to release your Stop and Release Simulator

simulation license.
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Clearing the Momentum Mesh: Choose >  to EM Clear the Momentum Mesh
remove the momentum mesh.

Viewing the recent simulations: You can view the latest EM simulations from 
the current EM Setup by selecting the >  option.EM Show Most Recent

Creating/editing Layout components: You can create, edit, or select a 
parameter by using the  dialog box. Select Layout Component Parameters EM
> >  to open this dialog box.Components Parameters

Viewing the results: You can view and analyze, S-parameters, currents, far-
fields, antenna parameters, and transmission line data by choosing > EM

> . For more information, refer to Post-Processing Visualization Visualizing 3D 
.View before EM Simulations

The SIO file format (replacement of CITI file format) is a compact 
internal representation of the S-parameters as generated by the 
EM simulators (Momentum/FEM).

Adding or deleting a box or waveguide: You can specify a box or waveguide 
around the substrate by selecting > . You can select the EM Box - Waveguide
required options for adding or deleting a box or waveguide. For more 
information, refer to .Adding Boxes, Waveguides, and Symmetry Planes

Defining radiation patterns: You can compute the electromagnetic fields by 
choosing > > . For more information, refer to EM Post-Processing Far Field

.Computing Radiation Patterns

Adding and deleting FEM symmetry planes: You can add an FEM symmetry 
plane by selecting > > .For EM FEM Symmetry Plane Add Symmetry Plane
more information, refer to Adding Boxes, Waveguides, and Symmetry Planes
.

Related Videos

You might find the following online video useful in understanding the topics 
covered on this page:

   ADS Momentum and FEM Interface

Process for Simulating a Design

Perform the following process for creating and simulating a design:

https://www.youtube.com/watch?v=4cWNaJXVWe4
https://www.youtube.com/watch?v=4cWNaJXVWe4
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Creating a physical design: You can start with the physical dimensions of a 
planar design, such as a patch antenna or the traces on a multilayer printed 
circuit board. There are three ways to enter a design into Advanced Design 
System:

Convert a schematic into a physical layout.

Draw the design using Layout.

Import a layout from another simulator or design system. ADS can 
import files in various types of formats.
For information on converting schematics or drawing in Layout, see 

 and Schematic Capture and Layout Creating a Layout for EM 
. For information on importing designs, see Simulations Importing and 

.Exporting Designs

Selecting an EM simulator: From the EM Setup dialog box, you can select 
the required simulator: Momentum Microwave, Momentum RF, and FEM. 
For more information, see .Selecting an EM Simulator

Defining the substrate: A substrate is the media where a circuit resides. 
Using the EM Setup dialog box, you can assign predefined substrates. For 
more information, see .Defining Substrates

Assigning port properties: Ports enable you to inject energy into a circuit to 
analyze the behavior of your circuit. You apply ports to a circuit when you 
create the circuit, and then assign port properties. There are several 
different types of ports that you can use in your circuit, depending on your 
application. For more information, refer to .Ports

Defining the Frequency and Output Plan: You can set up multiple frequency 
plans for a simulation. For each plan, a solution can be found for a single 
frequency point or over a frequency range. You can define the output plans. 
For more information, refer to .Defining a Frequency Plan

Setting Simulation Options: You set up a simulation by specifying the 
parameters of preprocessor, substrates, and mesh. You can specify various 
mesh parameters to customize the mesh to your design. For more 
information, refer to .Defining Simulation Options

Simulating the circuit: After completing the setup, you can run an EM 
simulation. Choose the  option to perform an EM simulation. You Simulate
can also press F7 to start the simulation process.

You need to specify only valid data in the EM Setup window. If you copy an EM 
setup file from one library to another library, all the information is not copied. 
For example, you must define a substrate in the new library. Similarly, if a 
layout does not have pins referenced in the original layout, these pins are not 
visible and all the ports are invalid.

http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Importing+and+Exporting+Designs
http://edadocs.software.keysight.com/display/ads2017/Importing+and+Exporting+Designs


13 Electromagnetic

Momentum

Momentum

Momentum is a complete 3D planar EM tool set to predict the performance of high-
frequency circuit boards, antennas, ICs, and modules. It identifies parasitic coupling 
between components and goes beyond simple analysis and verification to design 
automation of passive distributed circuits. It also visualizes current flow and 3D 
display of far-field radiation.

Momentum Simulator comes with the following list of features:

Computes S-parameters for general planar circuits, including microstrip, 
slotline, stripline, coplanar waveguide, and other topologies

Vias and airbridges connect topologies between layers, so you can simulate 
multilayer RF/microwave printed circuit boards, hybrids, multichip modules, 
and integrated circuits

Installs with ADS and runs locally on the desktop, on a remote server, or on 
a distributed compute cluster

State-of-the-art meshing and solving technologies provide breakthrough 
capacity, speed, and accuracy

Seamless EM/circuit co-simulation and co-optimization

Complete feature list for the Momentum G2 Element

Contents

Momentum Overview

Theory of Operation for Momentum

Setting up Momentum Simulations

Examples- Setting up Momentum Simulations

Designing a Coplanar Waveguide Bend

Defining Momentum Settings for LPF

Momentum Overview

Momentum Overview

Momentum is an electromagnetic simulator that computes S-parameters for 
general planar circuits, including microstrip, slotline, stripline, coplanar waveguide, 
and other topologies. Vias and airbridges connect topologies between layers that 
enable you to simulate multilayer RF/microwave printed circuit boards, hybrids, 
multichip modules, and integrated circuits. Momentum provides a complete tool 
set to predict the performance of high-frequency circuit boards, antennas, and ICs.

http://www.keysight.com/main/product.jspx?cc=US&lc=eng&ckey=1385440&nid=-34333.804583.00&id=1385440
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Momentum Visualization is an option that gives users a 3-dimensional perspective 
of simulation results, enabling you to view and animate current flow in conductors 
and slots, and view both 2D and 3D representations of far-field radiation patterns.

Momentum enables you to:

Simulate when a circuit model range is exceeded or the model does not 
exist.

Identify parasitic coupling between components.

Go beyond simple analysis and verification to design automation of circuit 
performance.

Visualize current flow and 3-dimensional displays of far-field radiation

Key features of Momentum include:

An electromagnetic simulator based on the Method of Moments.

Adaptive frequency sampling for fast, accurate, simulation results.

Optimization tools that alter geometric dimensions of a design to achieve 
performance specifications.

Comprehensive data display tools for viewing results.

Equation and expression capability for performing calculations on simulated 
data.

Full integration in the ADS circuit simulation environment allowing EM
/Circuit co-simulation and co-optimization.

Related Videos

You might find the following online video useful in understanding Momentum:

   Momentum Overview

Momentum Simulation Modes

You can use Momentum RF and Momentum Microwave simulation modes. 
Momentum RF provides accurate electromagnetic simulation performance at RF 
frequencies. At higher frequencies, as radiation effects increase, the accuracy of 
the Momentum RF models declines smoothly with increased frequency. Momentum 
RF addresses the need for faster, more stable simulations down to DC, while 
conserving computer resources. Typical RF applications include RF components 
and circuits on chips, modules, and boards, as well as digital and analog RF 
interconnects and packages.

When compared to the Momentum Microwave mode, the Momentum RF mode 
uses new technologies enabling it to simulate physical designs at RF frequencies 
with several useful benefits. The RF mode is based on quasi-static electromagnetic 
functions enabling faster simulation of designs. Momentum RF has the same use-
model as Momentum in ADS, and works with Momentum Visualization and 
Optimization.

Choose the mode that matches the application

https://www.youtube.com/watch?v=6Me_TlFpW1w
https://www.youtube.com/watch?v=6Me_TlFpW1w
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1.  

2.  

3.  

4.  

5.  

Choose the mode that matches the application

Momentum RF is usually the more efficient mode when a circuit

is electrically small

is geometrically complex

does not radiate

For descriptions about electrically small and geometrically complex circuits, see 
.Matching the Simulation Mode to Circuit Characteristics

For infinite ground planes with a loss conductivity specification, the MW mode 
of Momentum incorporates the HF losses in ground planes, however, the RF 
mode of Momentum will make an abstraction of these HF losses.

Locating Momentum Examples

You can refer the examples of designs that are simulated using Momentum RF and 
Momentum Microwave in the Examples directory.

To open a Momentum design example:

Choose  >  >  from the ADS Main window. The File Open Example Select an 
 dialog box is displayed.Archived File

Select . A list of examples is displayed, as shown in the following Momentum
figure:

Select the required example directory. For example, you can select Antenna, 
ModelComposer, or Microwave.

Click . A list of all examples present in the selected example category is Open
displayed.

Select the required example.
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6.  Click .Open

Theory of Operation for Momentum

Theory of Operation for Momentum

Momentum is based on a numerical discretization technique called the method of 
. This technique is used to solve Maxwell's electromagnetic equations for moments

planar structures embedded in a multilayered dielectric substrate. The simulation 
modes available in Momentum (microwave and RF) are both based on this 
technique, but use different variations of the same technology to achieve their 
results.

Momentum has two modes of operation, Microwave or full-wave mode and the RF 
or quasi-static mode. The main difference between these two modes lies within the 
Green functions formulations that are used. The full-wave mode uses full-wave 
Green functions, these are general frequency dependent Green functions that fully 
characterize the substrate without making any simplification to the Maxwell 
equations. This results in L and C elements that are complex and frequency 
dependent. The quasi-static mode uses frequency independent Green functions 
resulting in L and C elements that are real and frequency independent. Because of 
the approximation made in the quasi-static mode, the RF simulations run a lot 
faster since the matrix L and C elements only have to be calculated for the first 
frequency simulation point. The approximation also implies that the quasi-static 
mode typically should be used for structures that are smaller than half the 
wavelength. Both engine modes are using the so-called star-loop basis function, 
ensuring a stable solution at all frequencies. Both engines also make use of a mesh 
reduction algorithm which reduces the number of unknowns in the simulation by 
generating a polygonal mesh. This mesh reduction algorithm can be turned on or 
off, with a toggle switch.

The sources applied at the ports of the circuit yield the excitations in the equivalent 
network model. The currents in the equivalent network are the unknown amplitudes 
of the rooftop expansion functions. Solving the equivalent network for a number of 
independent excitation states yields the unknown current amplitudes. A port 
calibration process is used to calculate the S-parameter data of the circuit from the 
current solution, when calibration is requested.

The following sections contain more information about:

The method of moments technology

The Momentum solution process

Special simulation topics

Considerations and software limitations

The Method of Moments Technology

The method of moments (MoM) technique is based upon the work of R.F. 
Harrington, an electrical engineer who worked extensively on the method and 
applied it to electromagnetic field problems, in the beginning of the 1960's. It is 
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based on older theory which uses weighted residuals and variational calculus. More 
detailed information on the method of moments and Green's theorem refer to, Field 

. Reference 1)Computation by Moment Methods

In the method of moments, prior to the discretization, Maxwell's electromagnetic 
equations are transformed into integral equations. These follow from the definition 
of suitable electric and magnetic Green's functions in the multilayered substrate.

In Momentum, a mixed potential integral equation (MPIE) formulation is used. This 
formulation expresses the electric and magnetic field as a combination of a vector 
and a scalar potential. The unknowns are the electric and magnetic surface 
currents flowing in the planar circuit.

Using notations from linear algebra, we can write the mixed potential integral 
equation in very general form as a linear integral operator equation:

 (1)

Here, J(r) represents the unknown surface currents and E(r) the known excitation of 
the problem. The Green's dyadic of the layered medium acts as the integral kernel. 
The unknown surface currents are discretized by meshing the planar metalization 
patterns and applying an expansion in a finite number of sub-sectional basis 
functions B1(r), ..., BN(r):

 (2)

The standard basis functions used in planar EM simulators are the subsectional 
rooftop functions defined over the rectangular, triangular, and polygonal cells in 
the mesh. Each rooftop is associated with one edge of the mesh and represents a 
current with constant density flowing through that edge as shown in the following 
illustration. The unknown amplitudes Ij, j=1,..,N of the basis function expansion 
determine the currents flowing through all edges of the mesh.

Discretization of the surface currents using rooftop basis functions.
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The integral equation  is discretized by inserting the rooftop expansion  of the (1) (2)
currents. By applying the Galerkin testing procedure, that is, by testing the integral 
equation using test functions identical to the basis functions, the continuous 
integral equation  is transformed into a discrete matrix equation:(1)

for i=1,...,N

 (3)

with

 (4) 

 (5)

The left hand side matrix [Z] is called the interaction matrix, as each element in this 
matrix describes the electromagnetic interaction between two rooftop basis 
functions. The dimension N of [Z] is equal to the number of basis functions. The 
right-hand side vector [V] represents the discretized contribution of the excitations 
applied at the ports of the circuit.

The surface currents contribute to the electromagnetic field in the circuit by means 
of the Green's dyadic of the layer stack. In the MPIE formulation, this Green's 
dyadic is decomposed into a contribution from the vector potential A(r) and a 
contribution from the scalar potential V(r):

 (6)

The scalar potential originates from the dynamic surface charge distribution 
derived from the surface currents and is related to the vector potential through the 
Lorentz gauge.
By substituting the expression  for the Green's dyadic in the expression  for (6) (4)
the interaction matrix elements, yields the following form:

 (7)

with

 (8)

 (9)
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This allows the interaction matrix equation to be given a physical interpretation by 
constructing an equivalent network model. In this network, the nodes correspond 
to the cells in the mesh and hold the cell charges. Each cell corresponds to a 
capacitor to the ground. All nodes are connected with branches which carry the 
current flowing through the edges of the cells. Each branch has in inductor 
representing the magnetic self coupling of the associated current basis function. 
The equivalent circuit is built by replacing each cell in the mesh with a capacitor to 
the ground reference and inductors to the neighboring cells, as shown in the 
following figure:

All capacitors and inductors in the network are complex, frequency dependent and 
mutually coupled, as all basis functions interact electrically and magnetically. The 
ground in this equivalent network corresponds with the potential at the infinite 
metallization layers taken up in the layer stack. In the absence of infinite 
metallization layers, the ground corresponds with the sphere at infinity. The method 
of moments interaction matrix equation follows from applying the Kirchoff voltage 
laws in the equivalent network. The currents in the network follow from the solution 
of the matrix equation and represent the amplitudes of the basis functions. 
Equivalent network representation of the discretized MoM problem are displayed in 
the following figure:
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The Momentum Solution Process

Different steps and technologies enable the Momentum solution process:

Calculation of the substrate Green's functions

Meshing of the planar signal layer patterns

Loading and solving of the MoM interaction matrix equation

Calibration and de-embedding of the S-parameters

Reduced Order Modeling by Adaptive Frequency Sampling

Calculation of the Substrate Green's Functions

The substrate Green's functions are the spatial impulse responses of the substrate 
to Dirac type excitations. They are calculated for each pair of signal (strip, slot and
/or via) layers mapped to a substrate level. Although it is necessary to know which 
signal layers are mapped to a substrate level, since only impulse responses are 
being calculated, it is not necessary to know the patterns on these signal layers. 
This implies that the Green's functions can be pre-calculated and stored in a 
substrate database. This allows the substrate Green's functions to be reused for 
other circuits defined on the same substrate.
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The high frequency electromagnetic Green's functions depend upon the radial 
distance and the frequency. The computations are performed up to very large radial 
distances over the entire frequency band specified by the user. The frequency 
points are selected adaptively to ensure an accurate interpolation with respect to 
frequency. Computations performed over very wide frequency ranges can consume 
more CPU time and disk space to store the results. To increase speed, the RF mode 
uses quasi-static electromagnetic Green's functions based on low-frequency 
approximation and scales the quasi-static Green functions at higher frequencies.

Meshing of the Planar Signal Layer Patterns

The planar metallization (strip, via) and aperture (slot) patterns defined on the 
signal layers are meshed with rectangular and triangular cells in the microwave 
simulation mode. As translational invariance can be used to speed up the 
interaction matrix load process, the meshing algorithm will maximize the number of 
uniform rectangular cells created in the mesh. The meshing algorithm is very 
flexible as different parameters can be set by the user (number of cells/wavelength, 
number of cells/width, edge meshing, and mesh seeding), resulting in a mesh with 
different density. It is clear that the mesh density has a high impact on both the 
efficiency and accuracy of the simulation results. Default mesh parameters are 
provided which give the best accuracy/efficiency trade-off. Both the RF and 
microwave modes use mesh reduction technology to combine rectangular and 
triangular cells to produce a mesh of polygonal cells, thus reducing demand for 
computer resources. Mesh reduction eliminates small rectangles and triangles 
which from an electrical modeling point of view only complicate the simulation 
process without adding accuracy. As mentioned previously, this feature may be 
turned on or off with a toggle switch. 

Loading and Solving of the MoM Interaction Matrix Equation

The loading step of the solution process consists of the computation of all the 
electromagnetic interactions between the basis functions and the filling of the 
interaction matrix and the excitation vector. The interaction matrix as defined in the 
rooftop basis is a dense matrix, that is, each rooftop function interacts with every 
other rooftop function. This electromagnetic interaction between two basis 
functions can either be strong or weak, depending on their relative position and 
their length scale. The matrix filling process is essentially a process of order (N ), (i.2

e. the computation time goes up with the square of the number of unknowns).

In the solving step, the interaction matrix equation is solved for the unknown 
current expansion coefficients. The solution yields the amplitudes of the rooftop 
basis functions which span the surface current in the planar circuit. Once the 
currents are known, the field problem is solved because all physical quantities can 
be expressed in terms of the currents. With the release 2005A, an iterative matrix 
solve scheme was introduced in Momentum. For large problem sizes, the iterative 
matrix solve performs as an order (N2) process. Momentum still uses a direct 
matrix solve process if the structure is small or when convergence problems are 
detected in the iterative matrix solver process.
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Calibration and De-embedding of the S-parameters

Momentum performs a calibration process on the single type port, the same as any 
accurate measurement system, to eliminate the effect of the sources connected to 
the transmission line ports in the S-parameter results. Feedlines of finite length 
(typically half a wavelength at high frequencies, short lines are used at low 
frequencies) are added to the transmission line ports of the circuit. Lumped sources 
are connected to the far end of the feedlines. These sources excite the eigenmodi 
of the transmission lines without interfering with the circuit. The effect of the 
feedlines is computed by the simulation of a calibration standard and subsequently 
removed from the S-parameter data. A built-in cross section solver calculates the 
characteristic impedance and propagation constant of the transmission lines. This 
allows to shift the phase reference planes of the S-parameters, a process called de-
embedding. Results of the calibration process includes the elimination of low-order 
mode mismatches at the port boundary, elimination of high-order modes, and 
removal of all port excitation parasitics.

Besides transmission line ports, Momentum offers the user the ability to define 
direct excitation or internal ports. These ports can be specified at any location on 
the planar metallization patterns as either a point or a line feed. They allow to 
connect both passive and active lumped components to the distributed model of 
the planar circuits. The S-parameters associated with these ports are calculated 
from the excitation consisting of a lumped source connected to the equivalent 
network model at the locations of the internal ports. The parasitic effects of these 
lumped sources are not calibrated out of the S-parameters results.

Reduced Order Modeling by Adaptive Frequency Sampling

A key element to providing fast, highly accurate solutions using a minimum of 
computer resources is the Adaptive Frequency Sampling (AFS) technology. When 
simulating over a large frequency range, oversampling and straight line 
interpolation can be used to obtain smooth curves for the S-parameters. 
Oversampling however implies a huge amount of wasted resources. Momentum 
allows the user to benefit from a smart interpolation scheme based on reduced 
order modeling techniques to generate a rational pole/zero model for the S-
parameter data. The Adaptive Frequency Sampling algorithm selects the frequency 
samples automatically and interpolates the data using the adaptively constructed 
rational pole/zero model. This feature allows important details to be modeled by 
sampling the response of the structure more densely where the S-parameters are 
changing significantly. It minimizes the total number of samples needed and 
maximizes the information provided by each new sample. In fact, all kinds of 
structure can take advantage of the AFS module. The Adaptive Frequency 
Sampling technology reduces the computation time needed for simulating large 
frequency ranges with Momentum significantly.

Special Simulation Topics

Some special simulation topics are discussed in this section:

Simulating slots in ground planes
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Simulating metallization loss

Simulating internal ports and ground references

Simulating Slots in Ground Planes

Slots in ground planes are treated in a special manner by Momentum. An 
electromagnetic theorem called the equivalence principle is applied. Instead of 
attempting to simulate the flow of electric current in the wide extent of the ground 
plane, only the electric field in the slot is considered. This electric field is modeled 
as an equivalent magnetic current that flows in the slot.
Momentum does not model finite ground plane metallization thickness. Ground 
planes and their losses are part of the substrate definition.

By using slot metallization definitions, entire structures, such as slot lines and 
coplanar waveguide circuits, can be built. Slots in ground planes can also be used 
to simulate aperture coupling through ground planes for multi-level circuits. 
Structure components on opposite sides of a ground plane are isolated from each 
other, except for intermediate coupling that occurs through the slots. This 
treatment of slots allows Momentum to simulate slot-based circuits and aperture 
coupling very efficiently.

Simulating Metallization Loss

When using Momentum, losses in the metallization patterns can be included in the 
simulation. Momentum can either treat the conductors as having zero thickness or 
include the effects of finite thickness in the simulation. In the substrate definition, 
the expansion of conductors to a finite thickness can be turned on/off for every 
layer. Conductors with arbitrary height/width ratio can be accurately modeled with 
Momentum.

Momentum uses a complex surface impedance model for all metals that is a 
function of conductor thickness, conductivity, and frequency. At low frequencies, 
current flow will be approximately uniformly distributed across the thickness of the 
metal. At high frequencies, the current flow flows dominantly on the outside of the 
conductor and Momentum uses a complex surface impedance that closely models 
this skin effect.

For more information on the surface impedance model can be found .here

The mesh density can affect the simulated behavior of a structure. A denser mesh 
allows a better finer distribution of the current flow what can slightly increase the 
loss. This is because a more uniform distribution of current at a low density mesh 
corresponds to a lower resistance.

Losses can be defined for ground planes defined in the substrate definition. This 
uses the same formulation as for loss in microstrips (i.e., through a surface 
impedance approximation). It should be noted however that since the ground 
planes in the substrate description are defined as infinite in size, only HF losses are 
incorporated effectively. DC losses are zero by definition in any infinite ground 
plane. DC metallization losses in ground planes can only be taken into account by 
simulating a finite size ground plane as a strip metallization level.



Electromagnetic 24

For infinite ground planes with a loss conductivity specification, the MW mode 
of Momentum incorporates the HF losses in ground planes, however, the RF 
mode of Momentum will make an abstraction of these HF losses.

Simulating with Internal Ports and Ground References

Momentum offers the ability to use internal ports within a structure. Internal ports 
can be specified at any location on the planar metallization patterns, and they 
make possible a connection for both passive and active lumped components to the 
distributed model of the planar circuits. The following figure displays an internal 
port and equivalent network model.

The S-parameters associated with these ports are calculated from the excitation 
consisting of a lumped voltage source connected to the equivalent network model. 
The ground reference for these ports in the resulting S-parameter model is the 
ground of the equivalent network, and this ground corresponds  to the physically
infinite metallization layers taken up in the layer stack. In the absence of infinite 
metallization layers, the ground no longer has a physical meaning and corresponds 

 with the sphere at infinity.mathematically

It is important to mention that in this case, the associated S-parameters also lose 
their physical meaning, as the applied voltage source is assumed to be lumped, 
that is electrically small, since it sustains a current flow from the ground to the 
circuit without phase delay. To overcome this problem, a ground reference must be 
specified at a distant electrically small from the internal port. Failure to do so may 
yield erroneous simulation results.

The following sections illustrate the use of internal ports with ground planes and 
with ground references, and the results.

Internal Ports and Ground Planes in a PCB Structure

The following figure shows the layout for a PCB island structure with two internal 
ports.
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The infinite ground plane is taken up in the substrate layer stack and provides the 
ground reference for the internal ports. The magnitude and phase of the S21-
parameter calculated with Momentum. The simulation results are validated by 
comparing them with the measured data for the magnitude and the phase of S21. 
The following figure displays the Magnitude and phase of S21:

The thicker line is Momentum results, the thinner line is the measurement.

Finite Ground Plane, no Ground Ports

The same structure was resimulated with a finite groundplane. The substrate layer 
stack contains no infinite metallization layers. No ground reference was specified 
for the ports, so the sphere at infinity acts as the ground reference for the internal 
ports. The S-parameters obtained from a simulation for these ports no longer have 
a physical meaning. The following figure displays PCB substrate layer stack and 
metallization layers:
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Using such ports in the simulation yields incorrect simulation results as shown in 
the following figure:

The thicker line is Momentum results, the thinner line is the measurement.

Finite Ground Plane, Internal Ports in the Ground Plane

One way to define the proper grounding for the internal ports is to add two extra 
internal ports in the ground plane, as shown in the following figure:
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The resulting four-port structure is simulated with Momentum. Note that because 
no ground reference is specified for the internal ports, the resulting S-parameters 
for the four port structure have no physical meaning.

However, by properly recombining the four ports, a two-port structure is obtained 
with the correct ground references for each of the ports. Care should be taken with 
this recombination, as the ground reference for the four individual ports does not 
act as the ground reference for the two recombined ports. Therefore, the top 
recombination scheme is incorrect. The correct recombination scheme is the 
bottom one shown in the following figure:
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Finite Ground Plane, Ground References

The process of adding two extra internal ports in the ground plane and recombining 
the ports in the correct way can be automated in Momentum by defining two 
ground reference ports, as shown in the following figure:

The S-parameters obtained with Momentum are identical to the S-parameters of 
the two-port after the correct recombination in the section above, also shown in 
the following figure:

The thicker line is Momentum results, the thinner line is the measurement.

Internal Ports with a CPW Structure

The following figures show the layout for a CPW step in width structure with an 

integrated sheet resistor (45  m x 50  m, 50  ).
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The following figure display the CPW Step-in-width structure with integrated sheet 
resistor, port configurations and results:
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Six internal ports are added to the metallization layers. The six-port S-parameter 
model is recombined into a two-port model to describe the CPW-mode S-
parameters. Different recombination schemes are possible, yielding different 
simulation results. Scheme (c) is the correct one, as the ground reference for the 
internal ports is the sphere at infinity and this cannot act as the ground reference 
for the CPW ports.

The process of adding extra internal ports to the ground metallization patterns and 
recombining the ports in the correct way can be automated in Momentum by 
defining ground reference ports, as shown in the following figure:

Limitations and Considerations

This section describes some software limitations and physical considerations which 
need to be taken into account when using Momentum:

Comparing the microwave and RF simulation modes

Matching the simulation mode to circuit characteristics

Higher-order modes and high frequency limitation

Substrate waves and substrate thickness limitation

Parallel-plate modes and high frequency limitation

Slotline structures and high frequency limitation

Via structures and metallization thickness limitation

Via structures and substrate thickness limitation

CPU time and memory requirements

Comparing the Microwave and RF Simulation Modes

Momentum has two simulation modes: the Microwave and RF mode. The 
Microwave mode uses full-wave formulation, the RF mode uses a quasi-static 
formulation. In the quasi-static formulation, the Green functions are low-frequency 
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approximations to the full-wave and more general Green functions. Because of the 
approximations made in the RF mode, the simulations are more efficient. The 
approximation is valid for structures that are small compared to the wavelength 
(size of the circuit smaller than half a wavelength).

For infinite ground planes with a loss conductivity specification, the MW mode 
of Momentum incorporates the HF losses in ground planes, however, the RF 
mode of Momentum will make an abstraction of these HF losses.

Matching the Simulation Mode to Circuit Characteristics

The Momentum RF mode can be used to simulate RF and microwave circuits, 
depending on your requirements. However, Momentum RF is usually the more 
efficient mode when a circuit is electrically small, geometrically complex, and does 
not radiate. This section describes these characteristics.

Radiation

Momentum RF provides accurate electromagnetic simulation performance at RF 
frequencies. However, this upper limit depends on the size of your physical design. 
At higher frequencies, as radiation effects increase, the accuracy of the Momentum 
RF models declines smoothly with increased frequency.

Similarly, if the substrate allows the propagation of surface waves (these are guided 
waves that propagate in the substrate layers) the accuracy of the RF mode will 
gradually decline because surface waves are not included in the RF calculation.

Electrically Small Circuits

Momentum RF works best for electrically small circuits as its accuracy smoothly 
decreases with increasing electrical size relative to a given frequency. A circuit is 
considered electrically small relative to a given frequency if its physical dimension 
is smaller than half the wavelength of the frequency. Depending on which value you 
know, maximum circuit dimension or maximum simulation frequency, you can 
determine a qualitative approximation of the circuit's electrical size.

For space wave radiation, you can use one of the following two expressions strictly 
as a guideline to have an awareness about the circuit's electrical size relative to the 
maximum frequency you plan to run the simulation. When you know the value of  D
, use the first expression to approximate the maximum frequency up to which the 
circuit is electrically small. When you know the maximum simulation frequency, use 
the second expression to approximate the maximum allowable dimension:

or
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where:
 = the maximum length in  diagonally across the circuit.D mm
 = the maximum frequency in  .F GHz

The following expression provides a guideline up to which frequency the substrate 
is electrically small for surface wave radiation.

During a simulation, Momentum RF calculates the maximum frequency up to which 
the circuit is considered electrically small, and displays that value in the status 
display. This is similar to using the expressions above since the dimension and 
thickness of a layout is typically fixed, and it is the simulation frequency that is 
swept.

Geometrically Complex Circuits

The mesh generated for a simulation establishes a geometric complexity for a 
circuit. A circuit is considered geometrically complex if its shape does not fit into a 
uniform, rectangular mesh, and the mesh generation produces a lot of triangles. 
Layouts containing shapes such as circles, arcs, and non-rectangular polygons 
usually result in meshes with many triangles. A measure of increasing geometric 
complexity is when the ratio of triangular cells to rectangular cells grows larger:

The mesh-reduction technology offered by Momentum RF and Microwave 
eliminates electromagnetically redundant rectangular and triangular cells. This 
reduces the time required to complete the simulation thus increasing efficiency. 
This mesh reduction algorithm can be turned on or off, using a toggle switch.

Higher-order Modes and High Frequency Limitation

Since Momentum does not account for higher-order modes in the calibration and 
de-embedding process, the highest frequency for which the calibrated and de-
embedded S-parameters are valid is determined by the cutoff frequency of the port 
transmission line higher-order modes. As a rule of thumb for microstrip 
transmission lines, the cutoff frequency (in GHz) for the first higher-order mode is 
approximately calculated by:
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Cutoff frequency fc = 0.4 Z0 / height where Z0 is the characteristic impedance of 
the transmission line. For a 10 mil alumina substrate with 50 ohm microstrip 
transmission line, we obtain a high frequency limit of approximately fc = 80 GHz.

Parallel Plate Modes

In the region between two infinite parallel plates or ground planes, parallel plate 
modes exist. Any current flowing in the circuit will excite all of these modes. How 
strong a mode will be excited depends on how well the field generated by the 
current source matches with the field distribution of the parallel plate mode.

A distinction can be made between the fundamental mode and the higher order 
modes. The fundamental mode, which has no cut-off frequency, propagates at any 
frequency. The higher order modes do have a cut-off frequency. Below this 
frequency, they decay exponentially and only influence the local (reactive) field 
around the source. Above this frequency, they propagate as well and may take real 
energy away from the source.

Momentum takes the effect of the fundamental mode into account. The higher 
order modes are taken into account as long as they are well below cut-off. If this is 
not the case, a warning is issued saying that higher-order parallel plate modes 
were detected close to their cut-off frequency. Simulation results will start to 
degrade from then on.

The Effect of Parallel Plate Modes

The fundamental mode has its electric field predominantly aligned along the Z-axis 
from the top plate to the bottom plate. This means that this mode creates a 
difference in the potential between both plates. This mode can be excited by any 
current in your circuit: electric currents on a strip or via, magnetic currents on a 
slot. It behaves as a cylindrical wave that propagates to infinity where it feels a 
short circuit (since both plates are connected there). However, since infinity is very 
far away, no reflected wave ever comes back.

In a symmetric strip line structure, the current on the strip won't excite the 
fundamental mode due to this symmetry. However, the presence of a feature such 
as a slot in one of the plates creates an asymmetry. The slot will excite the 
fundamental mode!

The accuracy of the Momentum results for calibrated ports degrades when the 
parallel plate modes become important. For calibrated ports is assumed that they 
excite the circuit via the fundamental transmission line mode. However, this 
excitation is not pure. The source will excite the circuit via the parallel plate modes, 
too. This effect cannot be calibrated out, since those contributions are not 
orthogonal. The consequence is that the excitation doesn't correspond with a pure 
fundamental transmission line mode excitation.

Avoiding Parallel Plate Modes

You can short circuit the parallel plate modes by adding vias to your structure at 
those places where parallel plate modes will be excited. Similar problems will exist 
with the measurements. Both plates must be connected explicitly with each other! 
This won't take place at infinity but somewhere at the side of the board. If no vias 
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are used in the real structure, the fundamental mode may be excited. This mode 
will propagate to the borders and reflect. Thus, the real structure differs in that 
from the simulations where no reflection will be seen since a reflection only 
happens at infinity.

One way to counter the difference between measurements in reality and simulation 
is to take into account the package (box) around the structure. Another possibility 
is adding vias to your structure, both in real life and in the simulations. Try to make 
the physical representation of your circuit as close as possible to reality. However, 
the actual shape of the via should not be that important. Small sheets can be used 
to represent the small circular vias that are realized in the real structure.

Surface Wave Modes

If the substrate is not closed (open or half open), and not homogeneous, surface 
wave modes can exist. The parallel plate mode can be seen as a special case of a 
surface wave mode. Their behavior is identical. Both are cylindrical waves that 
propagate radially away from the source. They are  by the substrate. Both guided
fundamental and higher order surface wave modes exist. Similar conclusions can 
be drawn with respect to limitations such as the effects of the modes.

Slotline Structures and High Frequency Limitation

The surface wave accuracy deterioration of the calibration process is somewhat 
more prominent for slotline transmission lines than for microstrip transmission 
lines. Therefore, slotline structures simulated with Momentum will exhibit a 
somewhat higher noise floor (10-20 dB higher) than microstrip structures. For best 
results, the highest simulation frequency for slotline structures should satisfy:

Substrate thickness < 0.15 * effective wavelength

Simulation of narrow slot lines are accurate at frequencies somewhat higher than 
the high frequency limit determined by this inequality, but wide slotlines will show 
deteriorated accuracy at this frequency limit.

Via Structures and Substrate Thickness Limitation

The vertical electrical currents on via structures are modeled with rooftop basis 
functions. In this modeling, the vertical via structure is treated as one cell. This 
places an upper limit to the substrate layer thickness as the cell dimensions should 
not exceed 1/20 of a wavelength for accurate simulation results. Momentum 
simulations with via structures passing through electrically thick substrate layers 
will become less accurate at higher frequencies. By splitting the thick substrate 
layer into more than one layer, more via-cells are created and a more accurate 
solution is obtained.

CPU Time and Memory Requirements

Both CPU time and memory needed for a Momentum simulation increase with the 
complexity of the circuit and the density of the mesh. The size N of the interaction 
matrix equation is equal to the number of edges in the mesh. For calibrated ports, 
the number of unknowns is increased with the edges in the feedlines added to the 
transmission line ports.

CPU Time
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1.  

CPU Time

The CPU time requirements for a Momentum simulation can be expressed as:

CPU time = A + B N + C N  + D N2 3

where:

N = number of unknowns

A, B, C, D = constants independent of N

The constant term A accounts for the simulation set up time. The meshing of the 
structure is responsible for the linear term, BN. The loading of the interaction 
matrix is responsible for the quadratic term and the solving of the matrix equation 
accounts for:

part of the quadratic term (when using the iterative solver)

the cubic term (when using the direct solver)

It is difficult to predict the value of the constants A, B, C and D, because they 
depend on the problem at hand.

Memory Usage

The memory requirement for a Momentum simulation can be expressed as:

Memory = X + Y N + Z N2

where

N = number of unknowns

X, Y, Z constants independent of N

Like with the CPU time expression, the constants X, Y and Z are difficult to predict 
for any given structure.

For medium to large size problems, the quadratic term, which accounts for storing 
of the interaction matrix, always dominates the overall memory requirement. For 
small structures, memory usage can also be dependent upon the substrate. The 
substrate database must be read and interpolated, which requires a certain amount 
of memory. Algorithms to make trade-off between time and memory resources are 
implemented in the simulator. These algorithms result in additional usage above 
that required to solve the matrix. Total memory consumption is typically less than 
1.5 times what is required to store the matrix, for large matrices.

References

R. F. Harrington,  . Maxillan, New Field Computation by Moment Methods
York (1968).

Conductor Loss Models in Momentum

Conductor Loss Models in Momentum
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Surface Impedance Models

Sheet Conductor

model 0: DC resistance

model 1: single sided skin effect

model 2 (default): double sided skin effect

With

In  file: MOM3D_USE_SHEETLOSSMODEL=0,1,2momentum.cfg

Thick Conductor (2D Distributed Model)

No horizontal currents on the conductor sides are allowed. Deprecated setting.

model 0: 2-layer sheet conductor

each layer has half the conductor thickness

each layer is modeled with DC resistance sheet model
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model 1: 2-layer sheet conductor Note: this is default in ADS 2003C

each layer has half the conductor thickness

each layer is modeled with single-sided skin effect sheet model

model 2 (default): 2-layer sheet conductor

2 surface current layers at top and bottom

both modeled with coupled skin effect

medium 1 = background layer, medium 2 = conductor

In  file: momentum.cfg MOM3D_USE_THICKLOSSMODEL=0,1,2

Thick Conductor (3D Distributed Model)

Horizontal currents on the conductors sides are included.

The same models as for thick conductors without horizontal side currents apply, 
however, the thickness is replaced by the effective thickness of the solid object 
represented by the thick conductor.
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Example: Single Trace in Free Space
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Convergence Using N-layer Sheet Conductor Model
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Results Using Sheet Conductor Models



41 Electromagnetic

Results Using Thick Conductor Models

Example: Folded Trace in Free Space
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Results Using Thick Conductor Models

Using Infinite and Finite Ground Planes

Any closed boundary condition or slot conductor layer in ADS is considered to be 
an infinite Ground Plane. It is important to understand what is modeled for the 
various definitions for these infinite planes. Since return currents are modeled in 
the infinite ground plane for all three models (perfect conductor, impedance, 
conductivity), the inductance of the Ground Plane is included in the simulation 
results for any case with an infinite Ground Plane.

When using the impedance and conductivity models for infinite Ground Planes, 
Momentum and FEM models and captures an equivalent surface impedance. The 
surface impedance is described as follows:

For both the impedance and conductivity models, the High Frequency 
resistive losses are included but not the DC resistive losses.

For the impedance model, the surface impedance is constant versus 
frequency.

For the conductivity model, the surface impedance is frequency dependent. 
(Note: for infinite ground planes with a loss conductivity specification, the 
MW mode of Momentum incorporates the High Frequency (HF) losses in 
ground planes; however, the RF mode of Momentum will make an 
abstraction of these HF losses.)
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If DC resistive losses need to be modeled in a Ground Plane, then a finite Ground 
Plane must be used. The DC resistance between two points on an infinite ground 
plane is always zero (independent of the impedance value). This is a theoretical 
limit that does not exist in real life (ground planes are always finite in size). Hence, 
Momentum will always compute a zero DC resistance for an infinite Ground Plane.

Specifying a finite conductivity in the Ground Plane provides an additional way to 
model a loss mechanism that happens in a real world situation. In this case, it is the 
resistive losses of the 'return current' that flows in the Ground Plane. In most 
practical cases the Ground Plane losses are much smaller than the losses in the 
signal lines because the Ground Plane metallization is both thicker and wider than 
the signal lines (thus the return current is distributed on more metal which reduces 
the losses). As such, modeling the Ground Plane as a "Perfect Conductor" is less of 
an approximation than modeling the signal lines as "Perfect Conductors".

Another way to think about this would be to consider the difference between 
modeling a big chunk of metal (an 'area fill' as a 'finite Ground Plane') as either a 
"Perfect Conductor" or with a finite conductivity. The effect will typically be a slight 
increase in the simulated losses, but usually the difference will be pretty small.

Defining Infinite Ground Planes in ADS

This section demonstrates how to define infinite Ground Planes within ADS. When 
an infinite Ground Plane is required, the ‘Closed’ boundary condition is used. This 
can be selected at the top and/or bottom of the substrate stack-up. Note that 
intermediate layers in the substrate stack-up can also be used as infinite Ground 
Planes, but are defined by using the ‘Layout Layers’ tab of the substrate editor to 
define ‘Slot’ planes at the desired locations.

Access the substrate editor, to define the ‘Closed’ boundary condition (or ‘Slot’ 
layers) that is used for an infinite Ground Plane. The Slot layers may also be used as 
infinite Ground Planes. This can be used in many different applications. Consider 
the case of a simple transmission line over an infinite Ground Plane that has a hole 
in it. If you want to create this structure, perform the following steps in the 
subsequent Figures.

ADS Momentum Layout for a very simple case of a transmission line over an infinite 
Ground Plane that has a hole in it. (The signal trace is on the “cond’ layer and the 
hole for the Ground Plane is drawn on the “resi” layer, which is displayed in green 
and in outline mode. There is no significance to which layer upon which this is 
drawn, we just need to make note of it for the next steps.)
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After the layout is created, the next step is to properly define the substrate stack-
up. This is shown in the next two Figures. These illustrations will conclude the main 
concepts that you need to know to setup infinite Ground Planes using ‘Slot’ layers.

Defining Finite Ground Planes in ADS Momentum
This section will pictorially demonstrate how to define finite Ground Planes within 
ADS Momentum.

When a finite Ground Plane is desired, ‘Strip’ conductor layers are used with 
“Ground Reference” ports attached to them such that an explicit ground definition 
is created. In the case of a simple microstrip structure, the bottom ‘Closed’ 
boundary is replaced with an ‘Open’ boundary definition and then the Layout Layer 
with the object representing the finite Ground Plane is mapped as a ‘Strip’ layer 
into the appropriate substrate stack-up location. In the Figures on the following 
pages, the geometry (a simple rectangle in this case, but it could be any polygon) 
to be used as the finite Ground Plane was drawn on the “cond2” layout layer.

Note that the layout layer with the finite Ground Plane object (“cond2” in this case) 
is mapped as a ‘Strip’ layer at the bottom conductor location when using the open 
boundary at the very bottom of the substrate stack-up. In this case, we will 
consider a scenario with edge ports placed on the signal and finite Ground Plane 
objects.

For the case above, we observed some nuances to consider when using “Single 
Mode” ports with the finite Ground Plane configuration. Now let’s look at a similar 
case that uses “Internal” ports instead. Once again, note that the layout layer with 
the finite Ground Plane object (“cond2” in this case) is mapped as a ‘Strip’ layer at 
the bottom conductor location when using the open boundary at the very bottom 
of the substrate stack-up. In this next case, we will consider a scenario with 
“Internal” point ports placed inside the signal and finite Ground Plane objects.

Setting up Momentum Simulations

Setting up Momentum Simulations

This section provides information about how to create and simulate a design with 
Momentum.

Creating a Physical Design

You start with the physical dimensions of a planar design, such as a patch antenna 
or the traces on a multilayer printed circuit board. There are three ways to create a 
design in ADS:

Convert a schematic into a physical layout

Draw the design using Layout

Import a layout from another simulator or design system: Advanced Design 
System can import files in a variety of formats.

For information on converting schematics or drawing in Layout, see Schematic 
 and . For information on Capture and Layout Creating a Layout for EM Simulations

importing designs, see .Importing and Exporting Designs

Applying and Drawing Vias in Layout

http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Importing+and+Exporting+Designs
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Applying and Drawing Vias in Layout

Momentum creates a via by extruding the object that is mapped as a via through 
the substrate layer it is applied to. Vias can be drawn as polylines (open or closed) 
or polygons. A simple line segment via is the simplest and most practical way of 
drawing a via. Vias drawn as open polylines are often called sheet vias because, 
when the line is extruded through the substrate, it is treated as a vertical metal 
sheet. Vias drawn as closed polylines or polygons will be treated as if they are 
filled. For example, for a cylinder via you draw a circle. When the shape is mapped 
to a via metallization layer in Momentum, the vertical dimension is added to the 
object in order for the shape to cut through the substrate. Thus a line becomes a 
sheet, a circle becomes a cylinder. To model a hollow via, use boolean operations 
to subtract the inner cylinder from the outer one keeping the resulting shape. 
During simulations, it will be assumed that the inner cylinder is filled with the 
material of the substrate layer it is applied to. A via cannot be coincident with 
another via if they cut through the same substrate layer and they are on different 
layout layers. But two vias can be coincident on the same layout layer.

Selecting the Momentum Mode

After creating a physical design in the layout window, you need to specify 
simulation setup options by using the EM Setup window. Select  > EM Simulation 

 in the Layout window. Most Momentum simulation setups are specified in Setup
the EM Setup window.

Momentum can operate in two simulation modes: microwave or RF. You can select 
the mode based on your design goals. Use  (microwave) mode for Momentum
designs requiring full-wave electromagnetic simulations that include microwave 
radiation effects. Use  mode for designs that are geometrically Momentum RF
complex, electrically small, and do not radiate. You might also choose Momentum 
RF mode for quick simulations on new microwave models that can ignore radiation 
effects, and to conserve computer resources.

From the EM Setup window, you can choose the required simulation mode. In each 
case, the menu label in the EM Setup dialog box changes to the current mode. You 
can choose a simulation mode based on your application. Each mode has its 
advantages. In addition to specifically RF applications, Momentum RF can simulate 
microwave circuits. The following graph identifies which mode is best suited for 
various applications.
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2.  

Deciding which mode to use depends on your application. Each mode has its 
advantages. In addition to specifically RF applications, Momentum RF can simulate 
microwave circuits. As your requirements change, you can quickly switch modes to 
simulate the same physical design. As an example, you may want to begin 
simulating microwave applications using Momentum RF for quick, initial design, 
and optimization iterations. Later, you can switch to Momentum to include the 
radiation effects for final design and optimization. Momentum RF is an efficient 
mode for a circuit that is electrically small, geometrically complex, and does not 
radiate.

To select a Momentum mode:

Choose  >  in the Layout window. The EM Setup window EM Simulation Setup
is displayed.

Choose either  or  in the Simulator Momentum RF Momentum Microwave
panel, as shown in the following figure:

Specifying Simulation Settings

In the EM Setup window, options required for specifying simulation settings are 
listed in the left pane. You can select the required option to open the settings in the 
right pane of the EM Setup window, as shown in the following figure:
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For more information about the EM Setup window, see  EM Setup Window Overview
and .Setting up EM Simulations

You can specify settings for the following options:

Layout: You can view information about the workspace, library, cell, and 
view by selecting . For more information, refer Layout Viewing Layout 

.Information

Partitioning: The Automatic EM/Circuit Partitioning feature facilitates 
combining EM simulation of a layout with circuit simulation of instances that 

For more information, see cannot be simulated by the EM simulator. 
.Automatic EM Circuit Partitioning

Substrate: You can open a predefined substrate file from ADS by selecting 
. For more information, refer .Substrate Defining Substrates

Ports: You can refresh layout pins information, create, delete, and 
resequence ports, and search the required S-parameter ports or layout pins 
by selecting . For more information, see , , and Ports Ports Defining Ports

.Ports for Momentum Overview

Frequency Plan: You can add or remove frequency plans for your EM 
simulations by selecting . For more information, see Frequency Plan Defining 

.a Frequency Plan

Output Plan: You can specify the data display settings for your EM 
simulations by selecting . For more information, see Output Plan Defining a 

.Frequency Plan

Options: You can define the preprocessor, mesh, simulation, and expert 
settings by selecting . For more information, see Options Defining Simulation 

.Options

You can control the number of threads used by Momentum by 
setting OMP_NUM_THREADS environment variable. This variable 
takes precedence over what you set in the EM Setup window. If 
you limit the number for cores via OMP_NUM_THREADS, and try 
to specify more cores using the EM Setup window, you will not 
get extra cores.
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Resources: You can specify the local, remote, and third party settings by 
selecting . For more information, see Resources Specifying Simulation 
Resources

Model: You can generate an EM model by selecting . For more Model
information, see .Generating an EM Model

Notes: You can add comments to your EM Setup window by selecting .Notes

Defining Substrates

A substrate is the media where a circuit resides. For example, a multilayer PC board 
consists of various layers of metal, insulating or dielectric material, and ground 
planes. Other designs may include covers, or they may be open and radiate into air. 
A complete substrate definition is required in order to simulate a design. The 
substrate definition includes the number of layers in the substrate and the 
composition of each layer. This is also where you position the layers of your 
physical design within the substrate, and specify the material characteristics of 
these layers.

For specifying a substrate for your Momentum simulation, see Defining Substrates 
.in an EM Simulation

Assigning Port Properties

Ports enable you to inject energy into a circuit, which is necessary in order to 
analyze the behavior of your circuit. You apply ports to a circuit when you create 
the circuit, and then assign port properties in Momentum. There are several 
different types of ports that you can use in your circuit, depending on your 
application.

For assigning ports in a Momentum simulation, see .Ports

Defining the Frequency and Output Plan

You can set up multiple frequency plans for a Momentum simulation. You can also 
specify the data display settings for your EM simulations by using the EM Setup 
Window.

For specifying a frequency and output plan, see  and Defining a Frequency Plan
.Defining an Output Plan

Defining Simulation Options

You can specify global options, such as physical model, preprocessor, and mesh for 
Momentum simulations. You can either use a predefined set of simulation options 
or or create a new set in Simulation Options of the EM Setup window. You can 
specify the following simulation options for a Momentum simulation:

Defining Preprocessor Settings

Specifying Physical Model Settings for Momentum

Defining Solver Settings

Defining Mesh Settings for Momentum

Setting up Local, Remote, or Third Party Simulation
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Setting up Local, Remote, or Third Party Simulation

You can run a Momentum simulation on a local or remote machine, or take 
advantage of a third party load balancing and queuing system such as LSF, Sun 
Grid Engine, and PBS Professional.

For more information, see .Specifying Simulation Resources

Adding a Box or Waveguide

These elements enable you to specify boundaries on substrates along the 
horizontal plane. Without a box or waveguide, the substrate is treated as being 
infinitely long in the horizontal direction. This treatment is acceptable for many 
designs, but there may be instances where a boundaries need to be taken into 
account during the simulation process. A box specifies the boundaries as four 
perpendicular, vertical walls that make a box around the substrate. A waveguide 
specifies two vertical walls that cut two sides of the substrate. For more 
information, see .Adding Boxes, Waveguides, and Symmetry Planes

Running the Momentum Simulation

You set up a simulation by specifying the parameters of a frequency plan, such as 
the frequency range of the simulation and the sweep type. When the setup is 
complete, you run the simulation. The simulation process uses the mesh pattern, 
and the electric fields in the design are calculated. S-parameters are then 
computed based on the electric fields. If the Adaptive Frequency Sample sweep 
type is chosen, a fast, accurate simulation is generated, based on a rational fit 
model.

For more information, see .Running Momentum Simulations

Viewing Momentum Simulation Results

You can display the results of a Momentum simulation by using the Data Display 
and Visualization window. You can display the various type of results from a 
Momentum simulation such as S-parameters, radiation patterns (far-field plots) 
and derived antenna parameters.

For more information, see  and Visualizing 3D View before EM Simulation Visualizing 
.Momentum Simulations

Computing Radiation patterns

Once the electric fields on the circuit are known, you can compute electromagnetic 
fields. The electromagnetic fields can be expressed in the spherical coordinate 
system attached to your circuit. For more information on radiation patterns, see 

.Computing Radiation Patterns

Examples- Setting up Momentum Simulations

Examples- Setting up Momentum Simulations

Designing a Coplanar Waveguide Bend

Defining Momentum Settings for LPF
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Defining Momentum Settings for LPF

Defining Momentum Settings for LPF

This example describes the recommended settings for Momentum by designing a 
MMIC Low Pass Filter (LPF).

Application Workspace

This application is available in the following location:
$HPEESOF_DIR/examples/Tutorial/LPF_Design_Demo_wrk.7zap

Defining a Substrate

To open a predefined substrate:

Select  >  to open the  window.EM Simulation Setup EM Setup

Select .Substrate

Select the  substrate file from the drop-down list.LPF_Design_Demo_lib

To open the  window, click . The following figure displays the Substrate Open
LPF_Design_Demo_lib substrate window.

Defining Materials

Select a substrate layer in the Substrate window. The substrate layer 
properties are displayed.

Select  from the  drop-down list.Demo_Nit21 Material

You can also select a material by clicking  (  ). The Edit Materials
Materials Definitions window is displayed.
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6.  

1.  
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Choose the required material and click .OK

Type  in the  field and select .0.12 Thickness micron

Select  from the  list.<inherit from substrate> Bounding area layer

Defining a Conductor Layer

Select a conductor layer in the Substrate window.

Specify the settings displayed in the following figure:
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Defining Ports

Defining TML Ports

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Ports

Select  from the drop-list available in the  column.TML Calibration

Click once in the   column of a port and specify the Ref Impedance [Ohm]
required value.

Click once in the   column of a port and specify the required Ref Offset [um]
value.

Assigning Pins to an S-parameter Port

To assign a layout pin to the S-parameter port:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Ports

Select a pin row in . For example,  row is selected in the Layout Pins P2
following figure:
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Drag the pin from Layout Pins and drop it on the  or  terminal of the 
required port in . For example, P2 is dragged and dropped S-parameter Ports
on the - terminal of  in the following figure:Port1

A message box is displayed if your target pin is already used by other ports.

Click in the message box.Delete Ports and Continue

You can drag and drop multiple layout pins and connect with a S-
parameter port.

Specify a Frequency Plan

To add a frequency plan:

Choose >  to display the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Frequency Plan

To add a new frequency plan, click .Add

Select  sweep from the  column.Adaptive Type

Specify 0 GHz in the  column.Fstart

Specify 10 GHz in the  column.Fstop
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Specify 50(max) of N points in the  column.Npts

Do not specify any value in the  column.Step

Select the check box in the  column to enable the frequency plan. Enabled
The following figure displays the recommended frequency settings:

See  for more information.frequency plan

Defining an Output Plan

To create an output plan:

Choose >  to display the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Output Plan

The default dataset name is displayed. To specify a new dataset, click . Edit
For more information, see Defining an Output Plan#Selecting an Output 

.Dataset

Select  as an appending text to the dataset name.Simulation Type

Select .Open data display when simulation completes

Select  as a template to be used for Auto-select based on number of Ports
displaying the data in .Template

Select .Reuse files from previous simulation

Select .All generated frequencies
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See  for more information.Define an Output Plan

Specifying Physical Model Settings

Defining Engine-specific Modeling Options

To specify physical model definition globally:

Choose  to open the EM Setup window.EM> Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Physical Model

Ensure that the  tab is displayed.Global

Select  from the  drop-down list.3D-distributed Thick Conductor
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Select  from the  drop-down list.2D-distributed Via

Select the required lumped and wire via model options, as shown in the 
following figure:

Specifying Layer-specific Modeling Options

To specify physical model definition for a specific layer:

Select  to open EM Setup window.EM> Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Physical Model

Click the  tab.Layer Specific

Select a value from the  drop-down list in the required Model Type for Via
layer, as shown in the following figure:
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Defining Preprocessor Settings

To specify preprocessor settings:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the EM Setup window.Options

Click the  tab.Preprocessor

Select .Heal the layout

Select .Auto-determine a safe snap distance (conservative)

Select  to preserve the Merge shapes touching each other where possible
edges shared between adjacent shapes.

Select  to generate a conformal mesh containing minimum Simplify the layout
number of edges.

Type  in the  field.1 Displacement

Select  to enable the Generate and replace shapes on derived layers
processing of derived layers.
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12.  

1.  

2.  

Select  to display the location-Save Preprocessor Messages as a DRC Result
bound information and warning messages.

Type  in the  field.EmPpmsgs Job Name

Type  in the  field. The following figure displays the 255 DRC Layer
recommended preprocessor settings for Momentum.

Defining Mesh Settings

Define global and layer-specific  for Momentum.mesh settings

Defining Global Mesh Parameters

Global mesh parameters affect the entire circuit. To set up global parameters:

Select  to open the  window.EM> Simulation Setup EM Setup

Select  as the EM simulator.Momentum
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Select  in the left pane of the EM Setup window.Options

Select the  tab. By default, the Global parameters are displayed.Mesh

Select .Highest Simulation Frequency

Select Cell/Wavelength and type 20.

Enable Edge Mesh

Select .Auto-determine Edge Width

Enable  to obtain an optimal mesh with fewer small cells and Mesh reduction
an improved memory usage and simulation time.

Enable to extract objects for the following Thin layer overlap extraction
situations:

Two objects on different layers overlap.

The objects are separated with a thin substrate layer.
If this is enabled, the geometry will be altered to produce a more 
accurate model for the overlap region. The  setting is Normal
recommended for most layouts. The  setting is only Aggressive
recommended when tiny overlap differences are expected to lead to 
significant result variations as this option will considerably increase 
the problem size. For more information, refer to Defining Mesh 

.Settings for Momentum#Processing Object Overlap

This should always be enabled for modeling thin layer 
capacitors.

Specifying Layer-specific Mesh Options

You can use the Layer Specific tab to define the mesh options for a specific layer. 
Perform the following steps:

Select >  to open the  window.EM Simulation Setup EM Setup

Select  as the EM simulator.Momentum

Select  in the EM Setup window.Options

Select the  tab to display the mesh options for Momentum.Mesh

Select the  subtab to specify settings at the layer level, as Layer Specific
shown in the following figure:

Select a value from the  drop-down list in the required layer.Mesh Density

Select a value from the  drop-down list in the required Edge Mesh Width
layer.

Select a value from the  drop-down list in the Transmission Line Mesh Width
required layer.

Specifying Shape-specific Mesh Options

You can customize the selected shape by using the Shape Specific tab. Perform the 
following steps:
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Choose >  to open the  window.EM Simulation Setup EM Setup

Select  as the EM simulator.Momentum

Select  in the left pane of the EM Setup window.Options

Select the  tab to display the mesh options for Momentum.Mesh

Select the subtab to specify settings at the shape level, as Shape Specific
shown below.

To enable the shape-specific options, you need to select a shape in the 
layout before specifying the options.

Enable the section. You can select one Override Layer Specific Mesh Density
of the following options:

Select . Set the maximum value of the mesh density Maximum Cellsize
that will be simulated. For more information, refer to Defining Mesh 

.Settings for Momentum#Adjusting Mesh Density

Type the number of cells per wavelength in the  text Cells/Wavelength
box.

Enable . You can select one of the Override Layer Specific Edge Mesh
following options:

No Edge Mesh

Auto-determine Edge Width

Use Edge Width

Enable the section. You can Override Layer Specific Transmission Line Mesh 
select one of the following options:

No Transmission Line Mesh

Cells in Width

Creating an EM Model and Symbol

To create an EM model and symbol:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Model/Symbol

Accept the default  name.emModel

Select .Create EM Model when simulation is launched
If the  button is labeled , then the EM Model already Create Now Update Now
exists for this cell.

Type  in the  field.Symbol_look_alike View Name

Select .Layout Lookalike

Select  from the  drop-down list.min pin-pin distance Size
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8.  Select  to create a symbol after Create Symbol when simulation is launched
the simulation process.

Designing a Coplanar Waveguide Bend

Designing a Coplanar Waveguide Bend

There are two methods for constructing a coplanar waveguide in layout:

The objects that you draw are the slots on a groundplane. In the substrate 
definition, the layout layer that the slots are drawn on is mapped to a slot 
metallization layer.This method gives you infinite grounds on the coplanar 
plane. An example is the coplanar waveguide bend, shown below.

The objects that you draw represent metal. For example, you can draw strips 
and ground metal with gaps in between. This layer is mapped to a 
metallization layer defined as a strip. This method gives you finite grounds 
on the coplanar plane. Typically, this method is used when coupled 
microstrip lines are created initially as schematic elements.

Drawing slots on a ground plane is the preferred method because a mesh with 
fewer edges or unknowns will result, compared to meshing the strips. If a coplanar 
waveguide design is drawn with strips, it can be converted to a slot pattern with a 
boolean operation if a bounding box is provided.

Designing a Coplanar Waveguide Bend

This exercise, like the previous exercises, takes you through all of the steps that are 
necessary when designing with Momentum: creating a layout, defining a substrate, 
adding ports to the circuit, defining a mesh, simulating, and viewing results. Unlike 
the previous exercises, this one explores the following design topics:

Creating a layout that is drawn on more than one layer

Using vias as connections between layers
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Specifying new port types

Working with new mesh parameters
This circuit drawn in this exercise is a coplanar waveguide bend. A coplanar 
waveguide is, generally, slots filled with a dielectric or air, surrounded by 
metal, as shown in the figure here.

Creating the Layout

In this example, the circuit is created entirely within the Layout window, and a 
schematic representation is not used. Be sure to save your work periodically.
The layout consists of the following components:

Coplanar waveguide slots

Bridges that span the two slots

Vias that vertically connect the bridges to the slots
The slots will be drawn on one layer, the bridges will be drawn on a second 
layer, and the vias on a third layer. This will be important for when these 
layers are mapped to the substrate. An illustration of the circuit is shown on 
the left, the layout is on the right.
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Set your preferences so that a Layout window will open instead of a 
Schematic window. From the Main window, choose  and Tools > Preferences
enable . Disable Create Initial Layout Window Create Initial Schematic 

.Window

Create a new workspace named .cpw_bend

From the Layout window, choose  > . Scroll to the Options Preferences Layout 
 tab. Set the layout units to  and the resolution to 0.001. Click .Units um OK

There is a difference between the length units that you chose when you 
created the new project, and the units that you just set. The units chosen 
when you created the project set the units of the layout window in which you 
are working. The units chosen through  sets the units Options > Preferences
for objects that are drawn in the Layout window.

You will rename the layout layers that are used for drawing the slots, bridges, 
and vias of the coplanar waveguide bend. Using more descriptive names can 
help identify which layer that each part of the circuit is drawn on. Choose 

. Select the  tab. From the  list, select . Options > Layers Advanced Layers cond
In both the  and  fields, enter . Click  (located Name Layer Binding slot Apply
just below the Layers list). Select . In both the  and  cond2 Name Layer Binding
fields, enter . Click . Select . In the  field only, enter  bridge Apply hole Name via
and click . Click .Apply OK

Drawing the Waveguide Slots

The section describes how to draw the coplanar waveguide slots.

Verify that  is the current layer. The slots will be drawn on this layer. The slot
name of the current layer is displayed in the tool bar and at the top of the 
Layout window. If slot is not displayed, select it from the list.

Choose  >  , then choose  > . The Insert Rectangle Insert Coordinate Entry
toolbar arrow is activated and the  dialog box opens.Coordinate Entry

You will define four rectangles to make two waveguide bends. Establish the 
following values in the X,Y coordinate window, and click  after each Apply
entry:

X, Y coordinates Define

0, 0 First corner of first rectangle

+45, +290 Second corner of first rectangle

0, +335 First corner of second rectangle

+335, +290 Second corner of second rectangle

+110, 0 First corner of third rectangle
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X, Y coordinates Define

+155, +180 Second corner of third rectangle

+110, +180 First corner of fourth rectangle

+335, +225 Second corner of fourth rectangle

Click  when finished, to dismiss the dialog box.OK

Select  >  to see your drawing.View View All

End the command. The drawing in the layout window should resemble the 
figure here.

Drawing the Bridges

The slots that make up the coplanar waveguide have been drawn on the layer . slot
On a different layer, you will draw the bridges that span the two slots. This is 
important, because the slots and bridges will be treated differently in Momentum. 
This will become more clear when the substrate is applied to the circuit, later in this 
exercise.

From the layer list on the toolbar, select the layer  and click .bridge OK

The  layer is still visible. You will not do so here, but it can be made slot
invisible if you go to the  window and choose  >  , Layout Options Layers
select the slot layer and deselect  to turn  off. The same action Vis Visible
can be taken in  window by deselecting  in the slot layer.Layers Vis

Choose  >  , then choose  > .Insert Rectangle Insert Coordinate Entry
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Using the  dialog box you will define two rectangles that Coordinate Entry
make the bridges. Establish the following values in the X,Y coordinate 
window, and click  after each entry:Apply

X, Y coordinates Define

0, +170 First corner of first bridge

+155, +180 Second corner of first bridge

+155, +180 First corner of second bridge

+165, +335 Second corner of second bridge

Click  when finished, to dismiss the dialog box.OK

End the current command. The drawing in the Layout window should now 
look like the following figure.

Drawing a Via

The vias must be drawn on a third layer. This is necessary for when the vias are 
mapped to the substrate, later in this exercise.

The position and size of a via is very important. The various snap modes in Layout 
can aid in drawing vias, as shown in this part of the exercise. More information on 
how to draw vias and other drawing tips are in Drawing Tips.

From the layout layer list on the toolbar, select via.

Choose  > . Select the  tab. Under Active Snap Options Preferences Grid/Snap
Modes, enable  and deselect . Click .Vertex Grid OK
By using the vertex snap mode, the vias that you draw will snap to the vertex 
of a nearby object (a bridge) and not to a grid point. This ensures that the 
vias will be positioned precisely on the edges of the rectangles.
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Choose  > . Referring to the points identified on the drawing Insert Polyline
below, create the line segments shown by performing these steps:

Click once on A1 and click twice on A2.

Click once on B1 and click twice on B2.

Click once on C1, click once on C2, and click twice on C3. Then, click 
the toolbar arrow. End the command. The drawing in the Layout 
window should now appear as shown below.

Opening a Substrate

This exercise uses a substrate that is supplied with Momentum. It will not be 
necessary to make any changes to it, but it will be reviewed to clarify how layout 
layers can be mapped to a substrate.

From the Layout window, choose  > .EM Simulation Setup

Select .Substrate

Select the substrate file .cpw_bend_example

Click .Open

Map the conductor layers

Right-click a layer and select . You can see how the Map Conductor Layer
layers are mapped between the Free_Space, air, and GaAs layers:

There is a thin layer of air between the bridges and the slots.

The vias are mapped directly to the air substrate layer. The vias, 
although drawn as lines, are extruded by Momentum and effectively 
cut vertically through this layer of air, connecting the edges of the 
slots and the bridges.

A  defines the layer such that the bridges are metal and what strip
surrounds the microstrips on that layer is air. A  is the opposite of slot
a strip: the layout layer would be treated as a ground plane, and the 
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bends that you have drawn are treated as open areas in the ground 
plane.  represent vertical sections that cut through other layers Vias
vertically.

Adding Ports

This section describes how to add ports to the layout and how to apply the 
coplanar port type to them. Coplanar is one of the several port types that are 
available in Momentum. It is designed specifically for coplanar waveguide circuits, 
where an electric field is likely to build up between two ports. Each of the two ports 
is excited with the same absolute electrical field, but with opposite polarity. The 
currents are equal but in opposite in direction. For more information, see .Ports

The ports must be added to the waveguide slots and so they must be drawn 
on the same layer as the slots. From the Layout Layers list box, select .slot

The ports must also be positioned in the center of each slot edge. To help 
position the ports, set the following snap modes:

Enable  > Options Midpoint Snap

Enable Options > Edge/Centerline Snap

Disable  other snap modes except  .all Snap Enabled

Click the  icon. The Properties dialog box appears.Pin

Verify that . If it is not, select  and set it to . Click .Num=1 Num 1 OK

Note the ghost image of the port. If it appears very large, or if it cannot be 
seen, cancel the command. Depending on your system defaults, you may 
need to change the value of the Port/Ground Size (  >  > Options Preferences

 ) and the value of the Font Definition Size (  >  Placement Options Preferences
>  before your ports and labels will be an appropriate size Component Text)
for this layout.

When you are ready to add ports, apply them in the order and direction as 
shown here, then end the port command.
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From the Layout window, chose  > . Select  to EM Simulation Setup Ports
display port properties.

In the Layout window, click . In the EM Setup window, verify that the P1
calibration is set to .TML

Click . Verify that the calibration is set to .P2 TML

Select the  terminal of P2 and drop it on the  terminal of P1.

Click . Verify that the calibration is set to .P3 TML

Click . Verify that the calibration is set to .P4 TML

Select the  terminal of P3 and drop it on the  terminal of P3.

Save your changes.

Generating the Mesh

This section describes how to use additional mesh parameters. Because this circuit 
is on multiple layers, it is possible to set mesh parameters for each layer. Thus, you 
can set a relatively dense mesh on a specific layer. In this example, you will not use 
an edge mesh on the bridge layer.

From the Layout window, choose  > .EM Simulation Setup

Select .Options

Click the  tab.Mesh

Set the following Global parameters:

Mesh Frequency = 40 GHz

Number of Cells per Wavelength = 30

Enable Edge Mesh
Global parameters will be applied to all layers, unless other values are 
specified from the  tab.Layer

Click the  tab.Layer

In the Layout Layers list, select . Set the mesh density to  and select bridge 30
. These mesh parameters will be applied to the objects drawn No Edge Mesh

on the bridge layer only.

Select  from the Generate listPreprocessed geometry

Click Simulate to start the computations. The mesh will be computed and 
displayed on the layout, as shown here. Zoom in for a closer look at the 
mesh.
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Zoom in on the ports. You can see that additional arrows have been added to 
each port. The new arrow indicate the direction of the voltage over the slot.

Performing a Simulation

From the Layout window, choose  >  .EM Simulation Setup

Select  in the EM Setup window.Frequency Plan

From the  list, select  and set these parameters:Type Adaptive

Fstart = 1 GHz

Fstop = 40 GHz

Npts = 50

Click .Add

Click .Simulate

Viewing Simulation Results

The figure shows some of the automatically plotted simulation results.
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HSD Applications: Guidelines for Specifying EM Settings

HSD Applications: Guidelines for Specifying EM Settings

This section provides guidelines for setting up an EM simulation with Momentum 
for HSD users.

Select the Momentum RF Mode

Momentum can operate in two simulation modes: microwave or RF. You can select 
the mode based on your design goals. Use  (microwave) mode for Momentum
designs requiring full-wave electromagnetic simulations that include microwave 
radiation effects. Use  mode for designs that are geometrically Momentum RF
complex, electrically small, and do not radiate. You might also choose Momentum 
RF mode for quick simulations on new microwave models that can ignore radiation 
effects, and to conserve computer resources.
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To select a Momentum mode:

Choose  >  in the Layout window. The EM Setup window EM Simulation Setup
is displayed.

Select , as shown in the following figure:Momentum RF

Selecting a Set up Type

You can configure a circuit simulation to use an EM-based model for a cell instance 
by selecting EM Cosimulation. For more information, see .EM Circuit Cosimulation

Specifying Momentum Simulation Settings

To set up a Momentum simulation:

Select the Momentum RF Simulator.

Define a substrate.

Specify a Frequency Plan.

Specify Physical Model Settings.

Specify Preprocessor Settings.

Create Ports.

Create an EM Cosimulation View.
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For more information about the EM Setup window, see  EM Setup Window Overview
and .Setting up EM Simulations

Partitioning

Using partitioning, you can combine the EM simulation of a layout with circuit 
simulation of instances that cannot be simulated by the EM simulator or for which a 
model already exists. For more information, see .Automatic EM Circuit Partitioning

Define a Substrate

For HSD applications, it is recommended to specify the sheet option for conductor 
layers.

To define a substrate:

Open the Substrate Editor by double-clicking the imported substrate.

Select the conductor layer.

Select the  option for the conductor layers highlighted in the following Sheet
figure:

http://edadocs.software.keysight.com/display/adsss/Automatic+EM+Circuit+Partitioning
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Specify a Frequency Plan

For HSD applications, it is recommended to select the Adaptive type frequency.

To create a frequency plan:

Select  in the left pane of the EM Setup window.Frequency Plan

To add a new frequency plan, click Add.

Specify the , , ,  values, as shown in the following figure:Type Fstart Fstop Npts

For more information about how to specify a frequency and output plan, see 
 and .Defining a Frequency Plan Defining an Output Plan

Specify Physical Model Settings

For faster EM simulation results, it is recommended to select the Wire option for 
Via globally. You can also specify the layer-specific and net-specific model types. 
For more information, see .Specifying Physical Model Settings for Momentum

Defining Net Specific Physical Model Options

You can specify the physical model definition for a specific net by using the Net 
Specific tab in Physical Model options. To define a model type for specific nets in 
your design:
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Select  to open EM Setup window.EM> Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Physical Model

Click the  tab, as shown in the following figure:Net Specific

Select a value from the  drop-down Model Type for Currents Thick Conductor
list in the required layer.

Select a value from the  drop-down list in the required Model Type for Via
layer.

Specify Preprocessor Settings

It is recommended that the user specified snap distance is set at 20 % of max trace 
Width (Max trace width:10 mil). For more information, see Defining Preprocessor 

.Settings

To specify Preprocessor settings:

Click the  tab in the EM Setup window.Preprocessor

Specify the User-defined snap distance as 20 % of the maximum trace 
Width.

Specify the  value, such as 60 degrees.arc resolution

Create Ports

To assign pins:

Open the Port Editor window from a layout by clicking the  icon ( Port Editor

 ) present on the EM toolbar.

Move all GND pins and drop them on the respective VDD part of the 
component, which is the negative terminal, as shown below:
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Ensure that the port calibration is set to  for all ports in the Calibration None
drop-down list.

Click Refresh (  ).

Open the EM Setup window.

Select  in the left pane of the EM Setup window.Ports

Click  (  ) to update ports definition in the EM Setup window.Refresh

For more information about assigning ports, see .Ports

Create an EM Cosimulation View

After finalizing the EM setup, generate an EM cosimulation view:

Select  in the Setup Type panel.EM Cosimulation

Ensure that  is selected in the Generate drop-down list.Views

Click . An EM Cosimulation view is created, as shown in the following Go
figure:
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Running the Momentum Simulation

You set up a simulation by specifying the parameters of a frequency plan, such as 
the frequency range of the simulation and the sweep type. When the setup is 
complete, you run the simulation. The simulation process uses the mesh pattern, 
and the electric fields in the design are calculated. S-parameters are then 
computed based on the electric fields. If the Adaptive Frequency Sample sweep 
type is chosen, a fast, accurate simulation is generated, based on a rational fit 
model.

For more information, see .Running Momentum Simulations

Viewing Momentum Simulation Results

You can display the results of a Momentum simulation by using the Data Display 
and Visualization window. You can display the various type of results from a 
Momentum simulation such as S-parameters, radiation patterns (far-field plots) 
and derived antenna parameters.

For more information, see  and Visualizing 3D View before EM Simulation Visualizing 
.Momentum Simulations
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FEM

FEM

FEM is a powerful finite-element EM simulator that solves a wide array of 
applications. It enables you to model arbitrary 3D shapes such as bond wires and 
finite dielectric substrates. It is a 3D EM simulator, with a full 3D electromagnetic 
field solver, and fully automated meshing and convergence capabilities.

FEM Simulator comes with the following list of impressive features:

Conductors, resistors, isotropic dielectrics, isotropic linear magnetic material 
modeling that allows a wide range of application coverage.

An unlimited number of ports, which enables simulating multi-I/O design 
applications such as packages.

Electric and magnetic fields modeling, enabling visualization of EM fields in 
a design.

Absorbing boundary condition (free space), enabling antenna modeling.

Full-wave, EM-accuracy for first-pass design success.

Antenna parameters (gain, directivity, polarization, and so on) to enable 
better insight into antenna design.

Installs with ADS and runs locally

Contents

FEM Overview

Theory of Operation for FEM

Setting up FEM Simulations

Example- Designing a Microstrip Filter

Guidelines For Optimal Performance of FEM Simulation

FEM Overview

FEM Overview

An FEM simulator provides a complete solution for electromagnetic simulation of 
arbitrarily-shaped and passive three-dimensional structures. FEM simulators create 
3D EM simulation for designers working with RF circuits, MMICs, PC boards, 
modules, and Signal Integrity applications. It provides a 3D electromagnetic field 
solver and fully automated meshing and convergence capabilities for modeling 
arbitrary 3D shapes, such as bond wires and finite dielectric substrates. Along with 
Momentum, FEM simulators provide RF and microwave engineers access to some 
of the most comprehensive EM simulation tools in the industry.
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Developed with the designer of high-frequency/high-speed circuits in mind, FEM 
Simulator offers a powerful finite-element EM simulator that solves a wide array of 
applications with impressive accuracy and speed.

By combining fast solution times, efficient memory usage, and powerful display 
capabilities, FEM Simulator for ADS provides performance solution to complex high-
frequency problems. FEM Simulator for ADS users need very little background in 
electromagnetic field theory in order to operate and achieve accurate, and 
meaningful solutions.

Major Features and Benefits

FEM Simulator comes with a list of impressive features. These key technological 
enablers demonstrate the advantages of full 3D EM design and verification which 
include:

Conductors, resistors, isotropic dielectrics, isotropic linear magnetic material 
modeling that allow a wide range of application coverage.

An unlimited number of ports, which enables simulating multi-I/O design 
applications such as packages.

Electric and magnetic fields modeling, enabling visualization of EM fields in 
a design.

Absorbing boundary condition (free space), enabling antenna modeling.

Full-wave, EM-accuracy for first-pass design success.

Antenna parameters (gain, directivity, polarization, and so on), to enable 
better insight into antenna design.

FEM Simulator/ADS integration provides an integrated approach to EM
/Circuit design for both co-simulation and co-optimization.

Application Areas

EM modeling tools are known for their great accuracy. FEM Simulator redefines this 
term with broad application coverage, including the following:

Microstrip, stripline, CPW elements (filters, couplers, spiral inductors, via 
holes, air bridges, meander lines...)

Multilayer structures
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Ceramic filters

Adapters/transitions

Antennas

Couplers

Power splitters/combiners

Visualization and Display of Results

The visualization and animation capabilities in FEM Simulator enable you to 
evaluate simulation results thoroughly.

To aid in analyzing your designs, EM field animation and dynamic rotation of 
structures can be performed simultaneously. Choose from shaded plots, contour 
lines, or vectors. 3D far-field plots illustrate beam shapes in both azimuth and 
elevation on a single plot. To aid in analyzing your designs, EM field animation and 
dynamic rotation of structures can be performed simultaneously. Choose from 
shaded plots, contour lines, or vectors. 3D far-field plots illustrate beam shapes in 
both azimuth and elevation on a single plot.

Theory of Operation for FEM

Theory of Operation for FEM

The simulation technique used to calculate the full three-dimensional 
electromagnetic field inside a structure is based on the finite element method. 
Although its implementation is largely transparent, a general understanding of the 
method is useful in making the most effective use of FEM Simulator.

This section provides an overview of the finite element method, its implementation 
in FEM Simulator, and a description of how S-parameters are computed from the 
simulated electric and magnetic fields.

The Finite Element Method

To generate an electromagnetic field solution from which S-parameters can be 
computed, FEM Simulator employs the finite element method. In general, the finite 
element method divides the full problem space into thousands of smaller regions 
and represents the field in each sub-region (element) with a local function.

In FEM Simulator, the geometric model is automatically divided into a large number 
of tetrahedra, where a single tetrahedron is formed by four equilateral triangles.

Representation of a Field Quantity

The value of a vector field quantity (such as the H-field or the E-field) at points 
inside each tetrahedron is interpolated from the vertices of the tetrahedron. At 
each vertex, FEM Simulator stores the components of the field that are tangential 
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to the three edges of the tetrahedron. In addition, the component of the vector field 
at the midpoint of selected edges that is tangential to a face and normal to the 
edge can also be stored. The field inside each tetrahedron is interpolated from 
these nodal values.

In the following figure, the field quantities are interpolated from nodal values:

The components of a field that are tangential to the edges of an element are 
explicitly stored at the vertices.
The component of a field that is tangential to the face of an element and normal to 
an edge is explicitly stored at the midpoint of the selected edges.

The value of a vector field at an interior point is interpolated from the nodal values.
By representing field quantities in this way, Maxwell's equations can be 
transformed into matrix equations that are solved using traditional numerical 
methods.

Basis Functions

A first-order tangential element basis function interpolates field values from both 
nodal values at vertices and on edges. First-order tangential elements have 20 
unknowns per tetrahedra.

Size of Mesh Versus Accuracy

There is a trade-off between the size of the mesh, the desired level of accuracy, and 
the amount of available computing resources.

On one hand, the accuracy of the solution depends on how small each of the 
individual elements (tetrahedra) are. Solutions based on meshes that use a large 
number of elements are more accurate than solutions based on coarse meshes 
using relatively few elements. To generate a precise description of a field quantity, 
each tetrahedron must occupy a region that is small enough for the field to be 
adequately interpolated from the nodal values.

On the other hand, generating a field solution for meshes with a large number of 
elements requires a significant amount of computing power and memory. 
Therefore, it is desirable to use a mesh that is fine enough to obtain an accurate 
field solution but not so fine that it overwhelms the available computer memory and 
processing power.
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To produce the optimal mesh, FEM Simulator uses an iterative process in which the 
mesh is automatically refined in critical regions. First, it generates a solution based 
on a coarse initial mesh. Then, it refines the mesh based on suitable error criteria 
and generates a new solution. When selected S-parameters converge to within a 
desired limit, the iteration process ends.

Field Solutions

During the iterative solution process, the S-parameters typically stabilize before the 
full field solution. Therefore, when you are interested in analyzing the field solution 
associated with a structure, it may be desirable to use convergence criteria that is 
tighter than usual.

In addition, for any given number of adaptive iterations, the magnetic field (H-field) 
is less accurate than the solution for the electric field (E-field) because the H-field 
is computed from the E-field using the following relationship:

thus making the polynomial interpolation function an order lower than those used 
for the electric field.

Implementation Overview

To calculate the S-matrix associated with a structure, the following steps are 
performed:

The structure is divided into a finite element mesh.

The waves on each port of the structure that are supported by a transmission 
line having the same cross section as the port are computed.

The full electromagnetic field pattern inside the structure is computed, 
assuming that each of the ports is excited by one of the waves.

The generalized S-matrix is computed from the amount of reflection and 
transmission that occurs.

The final result is an S-matrix that allows the magnitude of transmitted and 
reflected signals to be computed directly from a given set of input signals, reducing 
the full three-dimensional electromagnetic behavior of a structure to a set of high 
frequency circuit values.

The Solution Process

There are three variations to the solution process:

Adaptive solution

Non-adaptive discrete frequency sweep

Non-adaptive fast frequency sweep
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Adaptive Solution

An adaptive solution is one in which a finite element mesh is created and 
automatically refined to increase the accuracy of succeeding adaptive solutions. 
The adaptive solution is performed at a single frequency. (Often, this is the first step 
in generating a non-adaptive frequency sweep or a fast frequency sweep.).

Non-adaptive Discrete Frequency Sweep

To perform this type of solution, an existing mesh is used to generate a solution 
over a range of frequencies. You specify the starting and ending frequency, and the 
interval at which new solutions are generated. The same mesh is used for each 
solution, regardless of the frequency.

Non-adaptive Fast Frequency Sweep

This type of solution is similar to a discrete frequency sweep, except that a single 
field solution is performed at a specified center frequency. From this initial solution, 
the system employes asymptotic waveform evaluation (AWE) to extrapolate an 
entire bandwidth of solution information. While solutions can be computed and 
viewed at any frequency, the solution at the center frequency is the most accurate.

The Mesher

A mesh is the basis from which a simulation begins. Initially, the structure's 
geometry is divided into a number of relatively coarse tetrahedra, with each 
tetrahedron having four triangular faces. The mesher uses the vertices of objects as 
the initial set of tetrahedra vertices. Other points are added to serve as the vertices 
of tetrahedra only as needed to create a robust mesh.

After the initial field solution has been created, if adaptive refinement is enabled, 
the mesh is refined further.

2D Mesh Refinement

For 2D objects or ports, the mesher treats its computation of the excitation field 
pattern as a two-dimensional finite element problem. The mesh associated with 
each port is simply the 2D mesh of triangles corresponding to the face of 
tetrahedra that lie on the port surface.

The mesher performs an iterative refinement of this 2D mesh as follows:

Using the triangular mesh formed by the tetrahedra faces of the initial mesh, 
solutions for the electric field, , are calculated.E

The 2D solution is verified for accuracy.

If the computed error falls within a pre-specified tolerance, the solution is 
accepted. Otherwise, the 2D mesh on the port face is refined and another 
iteration is performed.
Any mesh points that have been added to the face of a port are incorporated 
into the full 3D mesh.
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The 2D Solver

Before the full three-dimensional electromagnetic field inside a structure can be 
calculated, it is necessary to determine the excitation field pattern at each port. The 
2D solver calculates the natural field patterns (or modes) that can exist inside a 
transmission structure with the same cross section as the port. The resulting 2D 
field patterns serve as boundary conditions for the full three-dimensional problem.

Excitation Fields

The assumption is that each port is connected to a uniform waveguide that has the 
same cross section as the port. The port interface is assumed to lie on the z=0 
plane. Therefore, the excitation field is the field associated with traveling waves 
propagating along the waveguide to which the port is connected:

where:

Re is the real part of a complex number or function.
 is a phasor field quantity.E(x,y)

 is the imaginary unit,  j
ω is angular frequency, 2πf.
γ=α +  β is the complex propagation constant, α is the attenuation constant of the j
wave.
β is the propagation constant associated with the wave that determines, at a given 
time  , how the phase angle varies with .t z

In this context, the x and y axes are assumed to lie in the cross section of the port; 
the z axis lies along the direction of propagation.

Wave Equation

The field pattern of a traveling wave inside a waveguide can be determined by 
solving Maxwell's equations. The following equation that is solved by the 2D solver 
is derived directly from Maxwell's equation.

where:

E(x,y) is a phasor representing an oscillating electric field.

k  is the free space wave number,  ,0
ω is the angular frequency, 2πf.
µ (  ) is the complex relative permeability.r x, y

ε (  ) is the complex relative permittivity.r x, y
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To solve this equation, the 2D solver obtains an excitation field pattern in the form 
of a phasor solution,  . These phasor solutions are independent of  and  ; E(x,y) z t
only after being multiplied by e-γ  do they become traveling waves.z

Also note that the excitation field pattern computed is valid only at a single 
frequency. A different excitation field pattern is computed for each frequency point 
of interest.

Modes

For a waveguide or transmission line with a given cross section, there is a series of 
basic field patterns (modes) that satisfy Maxwell's equations at a specific frequency. 
Any linear combination of these modes can exist in the waveguide.

Modes, Reflections, and Propagation

It is also possible for a 3D field solution generated by an excitation signal of one 
specific mode to contain reflections of higher-order modes which arise due to 
discontinuities in a high frequency structure. If these higher-order modes are 
reflected back to the excitation port or transmitted onto another port, the S-
parameters associated with these modes should be calculated.

If the higher-order mode decays before reaching any port-either because of 
attenuation due to losses or because it is a non-propagating evanescent mode-
there is no need to obtain the S-parameters for that mode. Therefore, one way to 
avoid the need for computing the S-parameters for a higher-order mode is to 
include a length of waveguide in the geometric model that is long enough for the 
higher-order mode to decay.

For example, if the mode 2 wave associated with a certain port decays to near zero 
in 0.5 mm, then the "constant cross section" portion of the geometric model 
leading up to the port should be at least 0.5 mm long. Otherwise, for accurate S-
parameters, the mode 2 S-parameters must be included in the S-matrix.

The length of the constant cross section segment to be included in the model 
depends on the value of the mode's attenuation constant, α.

Modes and Frequency

The field patterns associated with each mode generally vary with frequency. 
However, the propagation constants and impedances always vary with frequency. 
Therefore, when a frequency sweep has been requested, a solution is calculated for 
each frequency point of interest.

When performing frequency sweeps, be aware that as the frequency increases, the 
likelihood of higher-order modes propagating also increases.

Modes and Multiple Ports on a Face

Visualize a port face on a microstrip that contains two conducting strips side by 
side as two separate ports. If the two ports are defined as being separate, they are 
treated as two ports are connected to uncoupled transmission structures. It is as if 
a conductive wall separates the excitation waves.
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However, in actuality, there will be electromagnetic coupling between the two 
strips. The accurate way to model this coupling is to analyze the two ports as a 
single port with multiple modes.

The 3D Solver

To calculate the full 3D field solution, the following wave equation is solved:

where:
 is a complex vector representing an oscillating electric field.E(x,y,z)

mr(  ) is the complex relative permeability.x, y

k  is the free space phase constant,  .0
ω is the angular frequency, 2πf.
ε (  ) is the complex relative permittivity.r x, y

This is the same equation that the 2D solver solves for in calculating the 2D field 
pattern at each port. The difference is that the 3D solver does not assume that the 
electric field is a traveling wave propagating in a single direction. It assumes that 
the vector E is a function of x, y, and z. The physical electric field,  , is the E(x,y,z,t)
real part of the product of the phasor,  , and ε  ω  :E(x,y,z) j t

Boundary Conditions

FEM Simulator imposes boundary conditions at all surfaces exposed to the edge of 
the meshed problem region. This includes all outer surfaces and all surfaces 
exposed to voids and surface discontinuities within the structure.
The following types of boundary conditions are recognized by the 3D solver:

Port

Perfect H

Symmetric H

Perfect E

Symmetric E

Ground plane

Conductor

Resistor

Radiation

Restore



Electromagnetic 86

Port Boundaries

The 2D field solutions generated by the 2D solver for each port serve as boundary 
conditions at those ports. The final field solution that is computed for the structure 
must match the 2D field pattern at each port.

FEM Simulator solves several problems in parallel. Consider the case of analyzing 
modes 1 and 2 in a two-port device. To compute how much of a mode 1 excitation 
at port 1 is transmitted as a mode 2 wave at port 2, the 3D mesher uses the 
following as boundary conditions:

A "mode 1" field pattern at port 1.

A "mode 2" field pattern at port 2.

To compute the full set of S-parameters, solutions involving other boundary 
conditions must also be solved. Because the S-matrix is symmetric for reciprocal 
structures (that is, S  is the same as S  ), only half of the S-parameters need to 12 21
be explicitly computed.

Perfect H Boundaries

A Perfect H boundary forces the magnetic field (H-field) to have a normal 
component only. A symmetric H boundary can be used to model a plane of 
symmetry for a mode in which the H-field is normal to the symmetry plane.

Perfect E Boundaries

By default, the electric field is assumed to be normal to all surfaces exposed to the 
background, representing the case in which the entire structure is surrounded by 
perfectly conducting walls. This is referred to as a Perfect E boundary. The final 
field solution must match the case in which the tangential component of the 
electric field goes to zero at Perfect E boundaries.

It is also possible to assign Perfect E boundaries to surfaces within a structure. 
Using Perfect E boundaries in this way enables users to model perfectly conducting 
surfaces. The surfaces of all objects that have been defined to be perfectly 
conducting materials are automatically assigned to be Perfect E boundaries.

Conductor Boundaries

Conductor boundaries can be assigned to surfaces of imperfect conductors or 
resistive loads such as thick film resistors. At such boundaries, the following 
condition holds:

where:
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is the is the unit vector that is normal to the surface.
 tan is the component of the E-field that is tangential to the surface.E
 is the H-field.H
 s is the surface impedance of the boundary. (1+  )/(δσ).Z j

δ is the skin depth,  , of the conductor being modeled.
ω is the frequency of the excitation wave.
σ is the conductivity of the conductor.

The fact that the E-field has a tangential component at the surface of imperfect 
conductors simulates the case in which the surface is lossy. The amount of loss will 
be proportional to the component of ExH that flows into the surface.

The field inside these objects is not computed; the conductor boundary 
approximates the behavior of the field at the surfaces of the objects.

Resistor Boundaries

Resistor boundaries model surfaces that represent resistive loads such as thin films 
on conductors. The following condition holds at resistor boundaries:

where:
 tan is the component of the E-field that is tangential to the surface.E
 is the H-field.H
 is the resistance at the boundary in ohms per square meter.R

Radiation Boundaries

Radiation boundaries model surfaces that represent open space. Energy is allowed 
to radiate from these boundaries instead of being contained within them. At these 
surfaces, the second order radiation boundary condition is employed:

where:
 tan is the component of the E-field that is tangential to the surface.E

is the unit vector normal to the radiation surface.

k  is the free space phase constant,  .0

 is equal to  .j

To ensure accurate results, radiation boundaries should be applied at least one 
quarter of a wavelength away from the source of the signal. However, they do not 
have to be spherical. The only restriction regarding their shape is that they be 
convex with regard to the radiation source.
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Computing Radiated Fields

Electromagnetic Design System maps the E-field computed by the 3D solver on the 
radiation surfaces to plane registers and then calculates the radiated E-field using 
the following equation:

where:

s represents the radiation surfaces.

 is the imaginary unit,  .j
ω is the angular frequency, 2πf.
µ  is the relative permeability of the free space.0

 tan is the component of the magnetic field that is tangential to the surface.H
 normal is the component of the magnetic field that is normal to the surface.H
 tan is the component of the electric field that is tangential to the surface.E
 is the free space Green's Function, given by:G

where:

k  is the free space wave number,  .0

 and  represent, respectively, points on the radiation surface and points beyond r
the surface as shown in Implementing Green's Function When Computing Radiated 

.Fields

Implementing Green's Function When Computing Radiated Fields

http://edadocs.software.keysight.com/display/ads2017/Theory+of+Operation+for+Digital+Predistortion#TheoryofOperationforDigitalPredistortion-ImplementingthePredistortionFunction
http://edadocs.software.keysight.com/display/ads2017/Theory+of+Operation+for+Digital+Predistortion#TheoryofOperationforDigitalPredistortion-ImplementingthePredistortionFunction
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Displaying Field Solutions

The 3D solver is also used to manipulate field quantities for display. The system 
enables you to display or manipulate the field associated with any excitation wave 
at any port-for example, the field inside the structure due to a discrete mode 2 
excitation wave at port 3. Waves excited on different modes can also be 
superimposed, even if they have different magnitudes and phases-for example, the 
waves excited on mode 1 at port 1 and mode 2 at port 2. In addition, far-field 
radiation in structures with radiation boundaries can be displayed.

The available fields depend on the type of solution that was performed:

For adaptive solutions, the fields associated with the solution frequency are 
available.

For frequency sweeps, the fields at each solved frequency point are 
available.

For fast frequency sweeps, the fields associated with the center frequency 
point are initially available.

Ports-only Solutions and Impedance Computations

This section addresses how impedances are computed for multi-conductor 
transmission line ports. Some examples of such structures are:

Two coupled microstrip lines

Coplanar waveguide modeled with 3 separate strips

Shielded twin-wire leads

For structures with one or two conductors, you will need to define a single line 
segment, called an "impedance line", for each mode. Some examples of such 
structures include:

microstrip transmission line (two-conductor structure)

grounded CPW (two-conductor structure) where the CPW ground fins are 
also attached to the  groundOUTER

For these structures, the port solver will compute the voltage V along the 
impedance line which is used to calculate Z  = V  /(2*Power). The power is pv

2

always normalized to 1 Watt.

If one models N-conductor structures where N>2, then FEM Simulator uses a 
different algorithm for computing Z  and Z  . The user must define an pv pi
impedance line for each interior conductor. The impedance lines should go from 
the center of each interior conductor to the outer conductor.

The port solver computes a voltage along the first N line segments for each of the 
first N modes when the port solver detects that there are N+1 conductors. This 

becomes a "voltage vector"  
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(of length N) for each of the N quasi-TEM modes. Then, when computing Z  , the pv
square of the scalar voltage is now replaced by the dot product of the voltage 
vectors, for example:

For a more detailed explanation as to why this is done, refer to reference [1] at the 
end of this section.
For Z  , the current is generally computed by adding the currents flowing into and pi
out of the port and taking the average of the two. (If the simulator computed 
currents to perfect accuracy, the inward and outward currents would be identical.) 
For all mode numbers >= N, where N = number of conductors, the currents are 
calculated in this way.
For the first (N-1) quasi-TEM modes, the currents are computed on the N-1 interior 
conductors producing a current eigenvector. Then the impedance:

The result is that the FEM Simulator impedance computations for such structures 
as coupled microstrip lines match the published equations for even- and odd-mode 
impedances.

As an example, take a CPW modeled as three interior strips surrounded by an 
enclosure. The ground strips do not touch the enclosure. Such a model is in the 
examples directory of FEM Simulator and is called  . The port solver shows cpwtaper
us that the desired CPW mode is not the dominant mode, but is actually mode 3. 
To identify the modes, one can use the arrow plots in the Port Calibration menu or 
the Arrow display of the E-field in the post processor.

Each port consists of a 4 conductor system, the outer (ground) conductor, the inner 
strip, and the two "ground" strips. This results in 3 quasi-TEM modes. Mode 1 has 
E-field lines predominately in the substrate, all pointing in the same direction. This 
is the common mode (+V, +V, +V). Mode 2 also has E-field lines predominately in 
the substrate, but in opposite directions under the two "ground" strips. This is the 
slot mode (-V, 0, +V). Mode 3 has nearly zero E-fields everywhere because the 
fields are predominately between the inner strip and the "ground" strips. This is the 
CPW mode (0, +V, 0).

For further help in identifying modes in such a structure, one can look at the 
distributions with the "full" scale. One will notice that modes 1 and 3 obviously have 
the same "even" symmetry in the E fields, while mode 2 has an odd symmetry. The 
CPW mode has an "even" symmetry, so it has to be mode 1 or 3.

Modes 1 and 2 have significant E-field strengths in the substrate, especially under 
the "ground" strips. So, there is a potential difference between the "ground" strips 
and the outer ground for these two modes. However, for mode 3, the "ground" 
strips are at the same potential as the outer ground, which is consistent with the 
CPW mode.
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1.  

Thus one can identify the modes. For mode 3, the "ground" strips are at 0 volts with 
respect to the outer ground, and the signal line has +V. The Z  impedance pv
computed for this mode using a dot product of the voltage vector for mode 3 gives 
the same Z  as by computing the simple voltage between center strip and either pv
"ground" strip. That is because the voltage vector for mode 3 along the three 

impedance lines is  =[0,V,0] and 

However, the impedances for the other modes now match accepted impedance 
definitions found in the literature for multi-conductor transmission lines.

G.G. Gentili and M. Salazar-Palma, "The definition and computation of modal 
characteristic impedance in quasi-TEM coupled transmission lines," IEEE 
Trans. Microwave Theory Tech., Feb. 1995, pp. 338-343.

Calculating S-Parameters

A generalized S-matrix describes what fraction of power associated with a given 
field excitation is transmitted or reflected at each port.

The S-matrix for a three port structure is shown below:

where:

All quantities are complex numbers.
The magnitudes of a and b are normalized to a field carrying one watt of power.
|a  |  represents the excitation power at port i.i

2

|b  |  represents the power of the transmitted or reflected field at port i.i
2

The full field pattern at a port is the sum of the port's excitation field and all 
reflected/transmitted fields.
The phase of a  and b  represent the phase of the incident and reflectedi i

/transmitted field at t=0,  
represents the phase angle of the excitation field on port i at t=0. (By default, it is 
zero.)

represents the phase angle of the reflected or transmitted field with respect to the 

excitation field.
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S  is the S-parameter describing how much of the excitation field at port j is ij
reflected back or transmitted to port i.

For example, S  is used to compute the amount of power from the port 1 31
excitation field that is transmitted to port 3. The phase of S  specifies the phase 31
shift that occurs as the field travels from port 1 to port 3.

When the 2D solver computes the excitation field for a given port, it has no 
information indicating which way is "up" or "down". Therefore, if ports have not 
been calibrated, it is possible to obtain solutions in which the S-parameters are 
out of phase with the expected solution.

Frequency Points

The S-parameters associated with a structure are a function of frequency. 
Therefore, separate field solutions and S-matrices are generated for each 
frequency point of interest. FEM Simulator supports two types of frequency sweeps:

Discrete frequency sweeps, in which a solution is generated for the structure 
at each frequency point you specify.

Fast frequency sweeps, in which asymptotic waveform evaluation is used to 
extrapolate solutions for a range of frequencies from a single solution at a 
center frequency.

Fast frequency sweeps are useful for analyzing the behavior of high Q structures. 
For wide bands of information, they are much faster than solving the problem at 
individual frequencies.

Within a fast frequency solution, there is a bandwidth where the solution 
results are most accurate. This range is indicated by an error criterion using a 
matrix residue that measures the accuracy of the solution. For complex 
frequency spectra that have many peaks and valleys, a fast sweep may not be 
able to accurately model the entire frequency range. In this case, additional 
fast sweeps with different expansion frequencies will automatically be 
computed and combined into a single frequency response.

Renormalized S-Matrices

Before a structure's generalized S-matrix can be used in a high frequency circuit 
simulator to compute the reflection and transmission of signals, the generalized S-
matrix must be normalized to the appropriate impedance. For example, if a 
generalized S-matrix has been normalized to 50 ohms, it can be used to compute 
reflection and transmission directly from signals that are normalized to 50 ohms, as 
in:
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where the input signals, Vi  , and output signals, Vo  , are both normalized to 50 ohms.i i

To renormalize a generalized S-matrix to a specific impedance, the system first 
calculates a unique impedance matrix associated with the structure. This unique 
impedance matrix, Z, is defined as follows:

where:

S is the  x  generalized S-matrix.n n
 is an  x  identity matrix.I n n
Z  is a diagonal matrix having the characteristic impedance (Z  ) of each port as a 0 0
diagonal value.

The renormalized S-matrix is then calculated from the unique impedance matrix 
using this relationship:

where:
 is the structure's unique impedance matrix.Z

 and  are diagonal matrices with the desired impedance and admittance as 
diagonal values. For example, if the matrix is being renormalized to 50 ohms, then 

 would have diagonal values of 50.

Visualize the generalized S-matrix as an S-matrix that has been renormalized to the 
characteristic impedances of the structure. Therefore, if a diagonal matrix 

containing the characteristic impedances of the structure is used as  in the 
above equation, the result would be the generalized S-matrix again.

Z- and Y-Matrices

Calculating and displaying the unique impedance and admittance matrices (Z and 
Y) associated with a structure is performed in the post processor.

Characteristic Impedances

FEM Simulator calculates the characteristic impedance of each port in order to 
compute a renormalized S-matrix, Z-matrix, or Y-matrix. The system computes the 
characteristic impedance of each port in three ways-as Z  , Z  , and Z  pi pv vi
impedances.

You have the option of specifying which impedance is to be used in the 
renormalization calculations.
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PI Impedance

The Z  impedance is the impedance calculated from values of power (P) and pi
current (I):

The power and current are computed directly from the simulated fields. The power 
passing through a port is equal to the following:

where the surface integral is over the surface of the port.

The current is computed by applying Ampere's Law to a path around the port:

While the net current computed in this way will be near zero, the current of interest 
is that flowing into the structure, I  or that flowing out of the structure, I  . In - +

integrating around the port, the system keeps a running total of the contributions 
to each and uses the average of the two in the computation of impedances.

PV Impedance

The Z  impedance is the impedance calculated from values of power (P) and pv
voltage (V):

where the power and voltage are computed directly from the simulated fields. The 
power is computed in the same way as for the Z  impedance. The voltage is pi
computed as follows:

The path over which the system integrates is referred to as the impedance line, 
which is defined when setting up the ports. To define the impedance line for a port, 
select the two points across which the maximum voltage difference occurs. FEM 
Simulator cannot determine where the maximum voltage difference will be unless 
you define an impedance line.
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VI Impedance

The Z  impedance is given by:vi

For TEM waves, the Z  and Z  impedances form upper and lower boundaries to a pi pv
port's actual characteristic impedance. Therefore, the value of Z  approaches a vi
port's actual impedance for TEM waves.

Choice of Impedance

When the system is instructed to renormalize the generalized S-matrix or compute 
a Y- or Z-matrix, you must specify which value to use in the computations, Z  , Z pi pv
, or Z .vi

For TEM waves, the Z  impedance converges on the port's actual impedance and vi
should be used.

When modeling microstrips, it is sometimes more appropriate to use the Z  pi
impedance.

For slot-type structures (such as finline or coplanar waveguides), Z  impedance is pv
the most appropriate.

De-embedding

If a uniform length of transmission line is added to (or removed from) a port, the S-
matrix of the modified structure can be calculated using the following relationship:

where:

is a diagonal matrix with the following entries:

γ = α + jβ is the complex propagation constant, where:

αi is the attenuation constant of the wave of port .i
βi is the propagation constant associated with the uniform transmission line at port i
.
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 i is the length of the uniform transmission line that has been added to or removed l
from the structure at port . A positive value indicates that a length of transmission i
line has been removed from the structure.

The value of γ for the dominant mode of each port is automatically calculated by 
the 2D solver.

Equations

The sections below describe some of the equations that are solved in a simulation 
or used to define elements of a structure.

Derivation of Wave Equation

The solution to the following wave equation is found during a simulation:

where:

E(  ) is a phasor representing an oscillating electric fieldx,y,z

k  is the free space wave number,  .0
ω is the angular frequency, 2πf.
µ (  ) is the complex relative permeability.r x,y,z

ε (  ) is the complex relative permittivity.r x,y,z

The difference between the 2D and 3D solvers is that the 2D solver assumes that 
the electric field is a traveling wave with this form:

while the 3D solver assumes that the phasor E is a function of x, y, and z:

Maxwell's Equations

The field equation solved during a simulation is derived from Maxwell's Equations, 
which in their time-domain form are:
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where:

E (t) is the electric field intensity.

D (t) is the electric flux density, ε  (t), and ε is the complex permittivity.E

H (t) is the magnetic field intensity.

B (t) is the magnetic flux density, µ  (t), and µ is the complex permeability.H

J (t) is the current density, σ  (t).E

ρ is the charge density.

Phasor Notation

Because all time-varying electromagnetic quantities are oscillating at the same 
frequency, they can be treated as phasors multiplied by  ω  (in the 3D solver) or ej t
by  ω  -γ  (in the 2D solver).ej t z
In the general case with the 3D solver, the equations become:

By factoring out the quantity  ω  and using the following relationships:ej t

Maxwell's Equations in phasor form reduce to:
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where  ,  ,  , and  are phasors in the frequency domain. Now, using the B H E D
relationships  = µ  ,  = ε  , and  = α  , Maxwell's Equations in phasor form B H D E J E
become:

for  = 0

where  and  are phasors in the frequency domain, µ is the complex permeability, H E
and ε is the complex permittivity.

H and  are stored as phasors, which can be visualized as a magnitude and phase E
or as a complex quantity.

Electric and Magnetic Fields Can Be Represented as Phasors

Assumptions

To generate the final field equation, place  in the equation in terms of  to obtain:H E
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Then, substitute this expression for  in the  equation to produce:H

Conductivity

Although good conductors can be included in a model, the system does not solve 
for any fields inside these materials. Because fields penetrate lossy conductors only 
to one skin depth (which is a very small distance in good conductors), the behavior 
of a field can be represented with an equivalent impedance boundary.

For perfect conductors, the skin depth is zero and no fields exist inside the 
conductor. Perfect conductors are assumed to be surrounded with Perfect E 
boundaries.

Dielectric Loss Tangent

Dielectric losses can be modeled by assuming that the relative permittivity,  , is 
complex:

Expressed in terms of the dielectric (electric) loss tangent,  , 

the complex relative permittivity,  becomes:

Magnetic Loss Tangent

Losses in magnetic materials can be modeled by assuming that µ  is complex.r

Expressed in terms of the magnetic loss tangent,  , the complex 
relative permeability becomes:
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Definition of Freespace Phase Constant

Using the relationships  and  , the wave equation being solved 
can be placed in this form:

Now, if the free space phase constant (or wave number) is defined as, 

 , the above reduces to the following equation that the 2D and 3D 
engines solve.:

Setting up FEM Simulations

Setting up FEM Simulations

This section describes the process of creating and simulating a design with FEM.

Creating a Physical Design

You start with the physical dimensions of a planar design, such as a patch antenna 
or the traces on a multilayer printed circuit board. You can create a design in the 
following ways in ADS:

Convert a schematic into a physical layout.

Draw the design using Layout.

Import a layout from another simulator or design system. Advanced Design 
System can import files in a variety of formats.

For information about converting schematics or drawing in Layout, see Schematic 
 documentation. For information on importing designs, see Capture and Layout

.Importing and Exporting Designs

Specifying Simulation Settings

In the EM Setup window, options required for specifying simulation settings are 
listed in the left pane. You can select the required option to open the settings in the 
right pane of the EM Setup window, as shown in the following figure:

http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Importing+and+Exporting+Designs
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For more information about the EM Setup window, see  EM Setup Window Overview
and .Setting up EM Simulations

You can specify settings for the following options:

Layout: You can view information about the workspace, library, cell, and 
view by selecting . For more information, refer Layout Viewing Layout 

.Information

Partitioning: You can configure a circuit simulation to use an EM-based 
model for a cell instance or parts by using the EM Cosimulation view and EM 
Model view. For more information, see .EM Circuit Cosimulation

Substrate: You can open a predefined substrate file from ADS by selecting 
. For more information, refer .Substrate Defining Substrates

Ports: You can refresh layout pins information, create, delete, and 
resequence ports, and search the required S-parameter ports or layout pins 
by selecting . For more information, see , , and Ports Ports Defining Ports

.Ports for FEM

Frequency Plan: You can add or remove frequency plans for your EM 
simulations by selecting . For more information, see Frequency Plan Defining 

.a Frequency Plan

Output Plan: You can specify the data display settings for your EM 
simulations by selecting . For more information, see Output Plan Defining a 

.Frequency Plan

Options: You can define the preprocessor, mesh, simulation, and expert 
settings by selecting . For more information, see Options Defining Simulation 

.Options

Resources: You can specify the local, remote, and third party settings by 
selecting . For more information, see Resources Specifying Simulation 
Resources

Model: You can generate an EM model by selecting . For more Model
information, see .Generating an EM Model

Notes: You can add comments to your EM Setup window by selecting .Notes
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Defining Substrates

A substrate is the media upon which the circuit resides. For example, a multilayer 
PC board consists of various layers of metal, insulating or dielectric material, and 
ground planes. Other designs may include covers, or they may be open and radiate 
into air. A complete substrate definition is required in order to simulate a design. 
The substrate definition includes the number of layers in the substrate and the 
composition of each layer. This is also where you position the layers of your 
physical design within the substrate, and specify the material characteristics of 
these layers.

For specifying a substrate for your FEM simulation, see Defining Substrates in an 
.EM Simulation

Assigning Port Properties

Ports enable you to inject energy into a circuit, which is necessary in order to 
analyze the behavior of your circuit. You apply ports to a circuit when you create 
the circuit, and then assign port properties in FEM Simulator. There are several 
different types of ports that you can use in your circuit, depending on your 
application.

For assigning ports in an FEM simulation, see .Ports

Defining the Frequency and Output Plan

You can set up multiple frequency plans for an FEM simulation. You can also 
specify the data display settings for your EM simulations by using the EM Setup 
Window.

For specifying a frequency and output plan, see Defining the Frequency and Output 
.Plan

Defining Simulation Options

You can specify global options, such as physical model, preprocessor, and mesh for 
FEM simulations. You can either use a predefined set of simulation options or or 
create a new set in Simulation Options of the EM Setup window. You can specify 
the following simulation options for an FEM simulation:

Defining Preprocessor Settings

Specifying Physical Model Settings for FEM

Defining Solver Settings for FEM

Defining FEM Mesh Settings

Setting up Local, Remote, or Third Party Simulation

You can run FEM simulations on a local or remote machine, or take advantage of a 
third party load balancing and queuing system such as LSF, Sun Grid Engine, and 
PBS Professional.

For more information, see .Specifying Simulation Resources
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1.  

2.  

Adding a Box or Waveguide

These elements enable you to specify boundaries on substrates along the 
horizontal plane. Without a box or waveguide, the substrate is treated as being 
infinitely long in the horizontal direction. This treatment is acceptable for many 
designs, but there may be instances where a boundaries need to be taken into 
account during the simulation process. A box specifies the boundaries as four 
perpendicular, vertical walls that make a box around the substrate. A waveguide 
specifies two vertical walls that cut two sides of the substrate.

For more information, see .Adding Boxes, Waveguides, and Symmetry Planes

Running FEM Simulations

You set up a simulation by specifying the parameters of a frequency plan, such as 
the frequency range of the simulation and the sweep type. When the setup is 
complete, you run the simulation. The simulation process uses the mesh pattern, 
and the electric fields in the design are calculated. S-parameters are then 
computed based on the electric fields. If the Adaptive Frequency Sample sweep 
type is chosen, a fast, accurate simulation is generated, based on a rational fit 
model.

For more information, see .Running FEM Simulations

Viewing FEM Simulation Results

You can display the results of an FEM simulation by using the Data Display and 
Visualization window. You can display the various type of results from an FEM 
simulation such as S-parameters, radiation patterns (far-field plots) and derived 
antenna parameters.

For more information, see  and Visualizing 3D View before EM Simulation Visualizing 
.FEM Simulations

Computing Radiation Patterns

Once the electric fields on the circuit are known, you can compute electromagnetic 
fields. The electric fields can be expressed in the spherical coordinate system 
attached to your circuit. For more information on radiation patterns, see Computing 

.Radiation Patterns

Example- Designing a Microstrip Filter

Example- Designing a Microstrip Filter

This section describes the process of designing a microstrip coupled-line filter.

Drawing the Circuit

The circuit is drawn as a schematic, then converted to a layout. To start the process 
of designing a Microstrip filter, you need to draw the circuit by:

Creating a new workspace.
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2.  

3.  

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

10.  

11.  

1.  

2.  

3.  

4.  

5.  

1.  

2.  

Adding Microstrip components to the schematic.

Converting the schematic to a layout.

Creating a New Workspace

To create a new workspace:

From the ADS Main window, choose  >  >  to display File New Workspace New 
.Workspace Wizard

Click .Next

In the  field, type .Workspace Name step1

Enter a path in . Click  to select the location.Create In Browse

Click .Next

Under , select the libraries to be included in the Workspace, as Add Libraries
shown in the following figure:

Click .Next

Under , enter a unique library name.Library Name

Click .Next

Under , choose .Technology ADS Standard: length unit - mil

Click .Finish

For more information about a workspace, refer .Workspace

Adding Components to the Schematic

The steps in this section describe how to select microstrip filter components.

In the Schematic window, click the Palette List arrow. The Palette List drops 
down.

Scroll and select  __ from the Palette List.T-lines Microstrip

In the component palette, locate and click . This selects the Libra Mcfil
Microstrip Coupled-Line Filter Section component.

Crosshairs and a ghost icon of the component appear as you move the 
cursor over the Schematic window. Position the cursor and click.

End the command either by clicking the  button or by Cancel Command
choosing  or the  button.Insert arrow

Editing the Component

This section describes how to edit several component parameters, such as the 
length and width, and also how to change the parameters that are displayed below 
the component.

To edit the component parameters, double click the component.

Select a parameter and set the values for these parameters:

http://edadocs.software.keysight.com/display/ads2017/Workspace
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2.  

3.  

1.  

2.  

3.  

4.  

1.  

2.  

3.  

4.  

W = line width = 0.25 mm

S = spacing between lines = 0.044 mm

L = line length = 1.8 mm

W1 = width of the line that connects to pin 1 = 0.25 mm

W2 = width of the line that connects to pin 2 = 0.25 mm

Click  to accept the edits and dismiss the dialog box.OK

Copying and Placing another Component

This section describes how to make a copy of the filter section and add it to the 
schematic.

Click the filter component on the schematic to select it. A black outline 
appears around it.

From the Schematic window, choose  > .Edit Copy

Choose  > . ** Move the crosshairs so that they are directly over the Edit Paste
left connector of the first component and click.

End the current command.

Adding Ports

Ports are required on a circuit. If you forget to add ports to the schematic, you can 
always add them later after the schematic is converted to a layout. In this exercise, 
ports will be added to the layout.

With FEM, you can define additional characteristics to a port.

Generating the Layout

This section describes how to covert the microstrip coupled-line filter schematic 
that you just finished to a layout.

From the Schematic window, choose  > . The Layout Generate/Update Layout
Generate/Update Layout dialog box and a Layout window appear.

From the  window, choose  > . Click the Layout Options Preferences Layout 
 __ tab and set the Resolution to . Click .Units 0.001 mm OK

In the Generate/Update Layout dialog box, enter  in the X field and  -1.8 0.294
in the Y field. This step identifies the placement of P1 on the layout. This step 
is usually optional, but specifying the location will be helpful later when the 
box is added to enclose the filter. Click .OK

A window displaying the results of the conversion is displayed. Click .OK
A layout representation of the schematic appears in the Layout window. It 
should resemble the figure here.
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4.  

5.  

1.  

2.  

3.  

4.  

5.  

6.  

7.  

8.  

9.  

10.  

From the layout window, choose  > . The layout name is . You File Save filter
now have a layout and a schematic as part of your project.

Defining a Substrate

This circuit uses a relatively simple substrate. In this exercise, the thickness of some 
of the layers is modified. A more important task is that ground planes are added to 
the top and bottom of the substrate. These ground planes form the top and bottom 
of the metal box in which the filter will be enclosed. The substrate will have the 
following layers:

A ground plane representing the top of the box

A layer of air

The microstrip filter traces

A layer of Alumina

A ground plane representing the bottom of the box.

Select  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Substrate

Click  to create a substrate.New

Specify the library and view name and select a template.

Click .OK

Select the top layer in the Substrate Layers field. Specify the bounding area 
layer. The top ground plane is added to the substrate.

In the Substrate Layers list, select . Change the Thickness to Free_Space
. This sets the layer of air to an appropriate thickness.2846 um

In the Substrate Layers list, select . Change the Thickness to .Alumina 254 um

Keep the bottom ground plane, but select and  any other layers that may Cut
appear in the substrate.

The top and bottom of the box enclosure are defined with groundplanes, 
the sides of the enclosure will be defined later in this exercise.
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10.  

11.  

1.  

2.  

You currently see four of the five substrate layers that you need. In this 
instance, the metal layer is automatically positioned between the Alumina 
and air layers.
Note the following points about this layer:

Metal layers are identified by a dashed line.

The word  identifies the layout layer that is mapped to this cond
position. Refer to the Layout window, and you will see that the 
microstrip circuit was automatically applied to the layout layer named 

 during the translation process.cond

The word  defines the layer such that the microstrips are metal strip
and what surrounds the microstrips on that layer is air or dielectric. 
Other choices are slot and via. These are described in the exercise in 
the next section.

Choose  . Specify the file name as  and click . The File > Save As filter Save
substrate file  is saved as part of the project.filter.slm

Adding Ports to the Layout

In FEM, you can define the ports in your circuit to be one of several types. 
Depending on the type you choose, the ports will be characterized in different 
ways. This can impact the result of a simulation, because the simulation can take 
these characteristics into account. With different port types, you can select one 
that best matches the intended application of your layout.

Ports are defined in a two-step process. First, ports are added to a circuit when the 
circuit is drawn. Then, in FEM Simulator, you specify the port type in order to tailor 
the port to your circuit. Note that you can add the port components at any time as 
you draw the circuit, but before a port type can be specified, a substrate must be 
defined for the circuit.

This section describes how to add ports to a layout and how to specify a port type 
for them.

From the Layout window, click the pin icon. If necessary, set  = . layer cond
The ports must be on the same layout layer as the microstrip filter. Click .OK

Move the cursor over the open port on the left side of the layout and click. 
Move the cursor over the open port on the right side of the layout and click. 
End the command. The layout should resemble the figure here.
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2.  

3.  

4.  

5.  

6.  

7.  

1.  

2.  

3.  

From the Layout window, select  >  to open the EM Simulation Setup EM Setup
window.

Select  in the left pane of the EM Setup window.Ports

If necessary, drag the window away from the Layout window so that both 
ports are visible. Click the connector .P1

Select TML.

Click the connector . Select TML.P2

The internal port type is selected because it can be applied to the interior of a 
circuit. While normally this placement of the ports on the filter would not be 
considered internal, they are in this case because the filter is enclosed within the 
box.

Finishing the Box around the Filter

Boxes and waveguide enclosures are useful because they introduce vertical 
boundaries to the design. Adding a box enables you to look at box resonance, 
which can have a significant effect on S-parameters in a small band centered 
around the box resonance frequency.

Recall that when you defined the substrate, you defined ground planes as the top 
and bottom of the metal box that will enclose the filter. This section describes how 
to specify the dimensions and location of the sidewalls of the box.

From the Layout window, choose  > .EM > Box & Waveguide Add Box

Type x, y coordinates for the left and right sides of the box. Choose  > Insert
. Type  ,  in the X,Y fields of the Coordinate Entry Coordinate Entry -4.5 -4.5

dialog box and click .Apply

Type  ,  in the X,Y fields of the Coordinate Entry dialog box and click +4.5 +4.5
. The box appears as shown below (you may need to click  to Apply View All

see the box). Click  to close the dialog box.Cancel
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Performing the Simulation

This section describes how to set up and run the simulation. In this exercise, the 
adaptive sweep type is used in the simulation process. This the preferred sweep 
type, because it used a fast, highly accurate method of comparing simulated data 
points to a rational fitting model. Unlike the linear sweep type, where simulated 
data points are chosen in a linear fashion based on step size, adaptive sweep type 
data points are chosen based on where the most variance seen. Wherever S-
parameters vary from the rational fitting model the most, more samples are taken.

From the Layout window, choose  .EM > Simulation Setup

Select .FEM

Select  in the left pane of the EM Setup window.Frequency Plan

Select the   and set these parameters to the following Adaptive Sweep Type
values:

Fstart = 1 GHz

Fstop = 40 GHz

Npts = 50

Click .Add

Make sure that  is enabled The Open data display when simulation completes
S-parameters will automatically be plotted and displayed at the end of the 
simulation.
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Click . The simulation will be performed and its progress and Simulate
completion will be indicated in the status window.

Select  to view EM > Show Most Recent > Mesh Generation Summary
simulation details. You can also print the report.

Viewing Simulation Results

The S-parameter simulation results are automatically displayed on both 
rectangular plots and Smith charts in a Data Display window. An example of S12 
plotted on a rectangular plot is shown here.

Guidelines For Optimal Performance of FEM Simulation

The default settings are a good starting point to get an optimal performance of the 
FEM simulation. The following guidelines can be used to further improve simulation 
performance. The usage of these settings is application specific.

Mesh and Solver Settings

Target Mesh Size

The default Target Mesh size in the Initial Mesh tab is by default set to Automatic. 
For the complex designs where the small detail of the design is not expected to 
have any meaningful impact on the electrical behavior, you can use the Minimal 
memory option to reduce the size of the original mesh. Going one level deeper, you 
can specify the value of the initial mesh size using the Use initial minimal mesh size 
setting under the Advanced tab.

In the following situations, the Use initial minimal mesh size setting can be useful:
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In case there are curved surfaces where the meshing process potentially 
over-meshes the structure. Here, use a value that is small enough to 
describe the curved shape. For example, choose a distance value that is 
equivalent to 15-45 degree resolution of an arc or a curved surface.

For stacked conductors in an IC technology where the stacked metal layers 
are not strictly aligned. Here, set the Minimal Mesh size to a number that is 
smaller than the typical line width but larger than the misalignment 
distance.

Conductor And Edge Mesh

By default, no conductor edge mesh is applied, which means that refinement of the 
meshes near the edges of conductors is a result of the automated mesh refinement 
process. In some applications, for example, planar filter or planar patch antennas, 
seeding the initial mesh using an edge mesh can speed up the mesh convergence 
process:

If the edge mesh is expected to be required on specific conductor objects in 
the geometry, you can use the object specific mesh setting.

For designs where the width of the ports is representative for all the 
conductor widths in the design, the Automatic Conductor Mesh option can 
be used

For more details on how to use these settings, see .Defining Mesh Settings for FEM

Solver Settings

The  in the Solver tab is by default set to . For designs Discretization Order 2nd order
where there are large regions with low field values and small field variation, you can 
use the  setting.Mixed order

Parallel And Distributed Simulations

The calculations of the frequencies in the frequency sweep can be parallelized . For 
more details, see . Performance improvements to Specifying Simulation Resources
expect depend on the specific design. The designs requiring more frequency points 
typically see a bigger performance improvement when doing parallel frequency 
point calculations.

Parallel and Distributed simulation requires one or more Distributed Computing 
8-pack licenses. One Distributed Computing 8-pack license allows to do 8 
processes in parallel. Specifying a number  that is bigger than 8 requires N
multiple Distributed Computing 8-pack licenses.
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Memory usage

The log files of a FEM simulation report the amount of physical memory that is used 
by the FEM simulation process. This is a change in EMPro 2017 versus earlier 
releases where virtual memory was reported.

If the memory required for a simulation job exceeds the amount of physical 
memory, the reported memory will be maximized by the amount of physical 
memory.

Simulation logs where during the mesh refinement steps, the reported memory 
no longer increases monotonically, is a sign that the simulation is exceeding 
the computer resources and that the simulation process is going into memory 
swap, leading to slower performance.
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Getting Started with a Layout for EM Simulations

Getting Started with a Layout for EM Simulations

Creating a Layout for EM Simulations

Using the Cookie Cutter

Defining Component Parameters

Converting Layers between Strip and Slot Representation

Example- Designing a Microstrip Line

Creating a Layout for EM Simulations

Creating a Layout for EM Simulations

You can create a layout in the following ways:

Directly in a Layout window.

From the Schematic window.

Import a layout from another simulator or design system.

This section describes how to create a layout automatically from a finished 
schematic, and how to use the basic features in a Layout window to create a layout 
directly.

Creating a Layout from a Complete Schematic

To create a layout from a schematic:

In the Schematic window, build the schematic shown here, then choose the 
menu command  >  (the schematic is the Layout Generate/Update Layout
source representation). The Generate/Update Layout dialog box appears.
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By default, the layout will begin with P1, at 0,0, with an angle of 0 degrees. 
There is no existing layout, so the Equivalence (the layout component that 
corresponds to the starting component in the schematic) is shown as not 
created.
At this point, all of the elements in the schematic are highlighted, indicating 
that they all need to be generated.

Click .OK
The Status of Layout Generation dialog box appears. It displays the number 
of designs processed, the number of items regenerated (created) in the 
layout, the number of items that are oriented differently in the layout than in 
the schematic, and the number of schematic components that were not 
placed in the layout.
The program automatically opens a Layout window and places the generated 
layout in it. The orientation of the layout is different from that of the 
schematic, because the layout is drawn from left to right across the page, 
beginning at the .Starting Component
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Creating a Layout Directly

Launch Advanced Design System and create a workspace. To display a Layout 
window, choose  >  from the ADS main window, or choose Window New Layout

 >  from an open Schematic window.Window Layout
The following tasks are performed the same way in a Layout window as they are in 
a Schematic window:

Selecting components

Placing and deselecting components

Changing views

Hiding component parameters

Coping and rotating components

Using named connections

Connecting Components with a Trace

As in a Schematic window, you can connect components without having them 
actually touch. In a Layout window, this is done by placing a trace between the 
component (in the same way a wire is used in the Schematic window). Either 
choose  > , or click the  button in the toolbar.Component Trace Trace

Unlike wires in a Schematic window, a trace in a Layout window may be inserted 
alone (click twice to end insertion). For more information, see .Traces

Shapes

In Layout you can insert shapes, using either Insert commands or toolbar icons:
With each shape, you can either click and drag to place it, or define points by 
coordinate entry (choose the shape, then choose  ).Insert > Coordinate Entry

http://edadocs.software.keysight.com/display/ads2017/Traces
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path : starting point, segment end (click), and end point (double-click)

polygon : starting point, vertex (click), and end point (double-click) that 
closes the shape

polyline : starting point, segment end (click), and end point (double-click)

rectangle : two diagonal corners

circle : center and circumference point

arc : (Insert command only) center and circumference point

The final segment of polygons and polylines can be entered by pressing the 
space-bar rather than double-clicking the mouse.

Layers

In a Layout window, items are placed on a layer. The name of the current insertion 
layer is displayed in the toolbar and in the status bar.

Changing the Insertion Layer

There are many ways to change the insertion layer:

In the toolbar, retype the name of the layer and press .Enter

In the toolbar, click the arrow next to the layer name. Choose a name from 
the list of currently defined layers.

Choose the command  >  and select a layer from the list.Insert Entry Layer

Choose the command  >  and select a layer from the list of Options Layers
defined layers in the Layer Editor dialog box.

Choose the command Insert >

Change Entry Layer To , and click an object whose layer you wish to make 
the current insertion layer.

Use the Layers window, that is opened when a Layout window is opened and 
select a name in the list of currently defined layers.
Experiment with placing shapes on different layers. Remember to click  to OK
accept a change in a dialog box.

Copy to a Different Layer

Experiment with copying shapes from one layer to another; use the command  Edit
>  >   . Note that the copied shape is placed at Advanced Copy/Paste Copy to Layer
exactly the same coordinates as the original. Move one to see them both.

Default Layer Settings

Choose the command    to display the Layer Editor. This is where Options > Layers
you can edit the parameters of any defined layer, add layers, or delete existing 
layers.
Clicking  updates layer definitions but does not dismiss the dialog box.Apply
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Experiment with layer parameters. Note that you can toggle the visibility of all 
items on a layer. Protected means you can not select items on that layer.

Adjust Grid Visibility and Color

In the Display area, choose Major, Minor, or both.

Choose the Type of display (Dots or Lines). You may have to zoom in to see 
the grid display.

Click the colored rectangle next to the word Color, and choose the desired 
color for the grid. Click  to dismiss the color palette.OK

Click . Experiment with different settingsApply

The drawing area color is the  color under the  tab.Background Display

Adjust Snap and Grid Spacing

The ability to display a major grid as an increment of the minor grid enables you to 
gauge distances and align objects better in a layout.

In the Spacing area, change the Minor Grid display factors for both X and Y. 
The larger the number, the wider the grid spacing.

Click . Experiment with different settings. If a display factor makes the Apply
grid too dense to display, it is invisible unless you zoom in.

Now experiment with the Major Grid.

Adjust Pin/Vertex Snap Distance

Pin/vertex snap distance represents how close the cursor must be to a pin of a 
component or a vertex of a shape before the cursor will snap to it.

A large value makes it easier to place an object on a snap point when you are 
unsure of the exact location of the snap point. A small value makes it easier to 
select a given snap point that has several other snap points very near it.

Place several components and several shapes in the drawing area and experiment 
with different settings of Pin/Vertex Snap.

Screen pix specifies sizes in terms of pixels on the screen. For example, if you 
choose 15, the diameter of the snap region is 15 pixels.

User Units specifies sizes in terms of the current units of the window. For example, 
if you are using inches and choose 0.1 user units, the diameter of the snap region is 
0.1 inch.

Experiment with Snap Modes

Snap modes control where the program places objects on the page when you 
insert or move them; you can change snap modes when inserting or moving a 
component, or drawing a shape. When snap is enabled, items are pulled to the 
snap grid.
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Experiment with different snap modes turned on or off to see how they affect the 
placement of items in a Layout window.

Snap Mode Priority

You can restrict or enhance the manner in which
the cursor snaps by choosing any combination of
snap modes. This table lists the snap modes,
and their priorities.

Pin 1

Vertex 2

Midpoint

Intersect

Arc/Circle Center

Edge 3

Grid 4

 automatically occurs when  Pin snapping is enabled and you Angle Snapping only
place a part so that the pin  connects to an existing part. The placed at the cursor
part rotates so that it properly aligns with the connected part.

For example, if you have a microstrip curve at 30° and place a microstrip line so that it 

connects to it, the microstrip line will snap to 30° so that it properly abuts the curve.

Enable Snap toggles snap mode on and off. You can also toggle snap mode from 
the Options menu itself, and there are snap mode buttons on the toolbar.

Except for pin snap, the pointer defines the selected point on the inserted object.

When you set all snap modes OFF, you can insert objects  where you release exactly
them on the page. This is sometimes called raw snap mode. Like other snap modes, 
the raw snap mode also applies when you move or stretch objects.
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Pin When a  on an object you insert, move, or stretch is within the snap distance pin
of a pin on an existing object, the program inserts the object with its pin connected 
to the pin of the existing object. Pin snapping takes priority over all other snapping 
modes.

Vertex When the selected location on an object you insert, move, or stretch is 
within the snap distance of a vertex on an existing object, the program inserts that 
object with its selected location on the vertex of the existing object.

In vertex snap mode, a vertex is a control point or boundary corner on a primitive, 
or an intersection of construction lines.

Midpoint When the selected location on an object you insert, move, or stretch is 
within the snap distance of the midpoint of an existing object, the program inserts 
that object with its selected location on the midpoint of the existing object.

Intersect When the selected location on an object you insert, move, or stretch is 
within the snap distance of the intersection of the edges of two existing objects, the 
program inserts that object with its selected location on the intersection of the 
existing objects.

Arc/Circle Center When the selected location on an object you insert, move, or 
stretch is within the snap distance of the center of an existing arc or circle, the 
program inserts that object with its selected location on the midpoint of the 
existing arc or circle.

Edge When the selected location on an object you insert, move, or stretch is within 
the snap distance of the edge of an existing object, the program inserts that object 
with its selected location on the edge of the existing object. Once a point snaps to 
an edge, it is captured by that edge, and will slide along the edge unless you move 
the pointer out of the snap distance.

Because edge/centerline snapping has priority 3, if the cursor comes within snap 
distance of anything with priority 1 or 2 while sliding along an edge, it will snap the 
selected location to the priority 1 or 2 item. 

Grid When the selected location on an object you insert, move, or stretch is within 
the snap distance of a grid point, the program inserts that object with its selected 
location on the grid point.

All other snap modes have priority over grid snap mode.

Whenever possible, keep grid snapping on. Once an object is off the grid, it is 
difficult to get it back on.

Use 45 or 90° angles to ensure that objects are aligned evenly, and to reduce 
the probability of small layout gaps due to round-off errors.

Drawing Tips

This section provides suggestions and examples when drawing layouts to be 
simulated using Momentum or FEM. These examples take into consideration things 
that are necessary during the drawing phase to ensure that requirements for an EM 
simulation are met.

Using Grid Snap Modes
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Using Grid Snap Modes

Working in Layout enables you to control all geometry precisely. The variety of 
available snap modes can help you draw and position shapes. As an example, if you 
are connecting shapes, you should have the vertex snapping mode turned on. You 
will also want to review snap mode settings prior to adding ports to a layout.

Snap grid spacing also helps control the positioning shapes. In general, snap grid 
spacing should be about 1/2 of the minor grid point value. For example, if the 
minor grid points are 1.0, then the snap grid spacing should be 0.5. This makes it 
easy to know how your geometry will snap into place.

For more information on snap modes and snap grid spacing, refer to .Layout

Choosing Layout Layers

The standard set of layout layers begins with the layer named . Do not use default
this layer for drawing your circuit. The first valid layer for an EM simulation is . cond
For more information on layout layers, refer to .Schematic Capture and Layout

Keeping Shapes Simple

In general, when drawing shapes, you should use a minimal number of vertices per 
shape, since this will make the mesh easier to compute. When drawing curved 
objects, consider using a relatively large value for Arc/Circle Radius (under Options 

 ). This will minimize the number of vertices, and facets > Preferences > Entry/Edit
used to represent the shape.

Merging Shapes

Merging shapes is often useful for eliminating small geometry overlaps and can 
also, in some cases, result in simpler mesh patterns. For example, if you draw a 
layout using multiple polygons and you suspect there is some overlap, merging the 
polygons will prevent the system from returning an overlap error. To merge the 
shapes, select each shape that you want to merge, then choose .Edit > Merge

Viewing Port and Object Properties

Any item selected in a layout, including ports, shapes, or other components, has 
associated properties. One way to view the properties is to select the object of 
interest, then choose  This method also enables you to change Edit > Properties.
object properties. If you want to change properties that have been attributed to an 
object for an EM simulation, you should change these properties only through the 
EM Menu selections.

To view the properties of the entire layout, choose Options > Info.

Adding a Port to a Circuit

You can add a port to a circuit either from the Schematic window or a Layout 
window. The procedures below include considerations for adding ports to a circuit 
that will be simulated using an EM simulation. For more information, see .Ports

Considerations

Keep the following points in mind when adding ports to circuits to be simulated 
using Momentum or FEM:

http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
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The components or shapes that ports are connected to must be on layout 
layers that are mapped to metallization layers that are defined as strips or 
slots. Ports cannot be directly connected to vias.

Make sure that ports on edges are positioned so that the arrow is outside of 
the object, pointing inwards, and at a straight angle.

Make sure that the port and the object you are connecting it to are on the 
same layout layer. For convenience, you can set the entry layer to this layer; 
the Entry Layer listbox is on the Layout tool bar.

A port must be applied to an object. If a port is applied in open space so that 
is not connected to an object, Momentum will automatically snap the port to 
the edge of the closest object. This will not be apparent from the layout, 
however, because the position of the port will not change.

If the Layout resolution is changed  adding ports that are snapped to after
edges, you must delete the ports and add them again. The resolution 
change makes it unclear to which edges the ports are snapped, causing 
errors in mesh calculations.

Using the Cookie Cutter

Using the Cookie Cutter

The Cookie Cutter feature enables you to crop only the required area from an 
original design. During cookie cut, a new cell view is created, which contains the 
cookie cut area around the selected objects. This feature is useful when you want 
to analyze the behavior of a specific area or nets in your design.

You can select nets/objects by using the Navigator tab or manually create a shape 
as a boundary box. Navigator is preferred for selecting the desired nets in HSD 
designs. This section provides information about how to create a desired portion of 
your board/design using cookie cutter.

Selecting Nets Using Navigator for Cookie Cutter

The Navigator tool allows you to view and work with all the objects such as traces, 
paths, rectangles, polygons, circles, pins, components, vias, or cell instances in a 
design (layout or schematic).

To generate a cookie cutter boundary based on the selected nets in a layout:

Display the  tab. For more information about how to access the Navigator
navigator, see .Using the Navigator

Select the required nets in the Navigator tab, as shown highlighted in the 
following figure. You can use the search feature in the Navigator to search 
for nets.

http://edadocs.software.keysight.com/display/ads2017/Viewing+Designs#ViewingDesigns-UsingtheNavigator
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Select  >  > . The Cookie Cutter dialog box is displayed.EM Tools Cookie Cutter

Select a boundary type. For more information, see Specifying a Boundary

Specify the  distance to expand the cookie cutter Cut proximity nets within
boundary and include proximity nets. Setting the distance to zero will create 
a tight boundary around selected objects.
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Accept the Temporary Drawing layer, which is a boundary shape drawn 
temporarily on the selected layer.

Accept the default output layout. To create a new output design layout, Click 

 .

Expand the  button and select the required boundary option.Option

Click  to verify your boundary shape.Preview

Click . The cookie cut layout is displayed in a different cell called cell_1, Cut
which includes all the nets, component footprints, and component pins 
inside the cookie cutter.
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Selecting Objects Manually for Cookie Cutter

You can manually create an arbitrary shape polygon around the original design for 
creating a new design using the Cookie Cutter feature.

To use a cookie cutter, you need to define a boundary layer, which is drawn for 
previewing and cutting operation. Note that cookie cutter is not applied to the 
shapes on a boundary layer. Therefore, you need to select a layer that does not 
include real patterns where you want to use this feature.

To create a cookie cut cell view:

Select  >  > .EM Tools Cookie Cutter

Create an arbitrary polygon shape on any unused layer and select it in the 
layout window.
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Select the boundary type.

Specify the Cut proximity nets within distance.

Accept the Temporary Drawing layer, which is a boundary shape that will be 
drawn temporarily on the selected layer.

Accept the default output layout. To create a new output design layout, Click 

 .

Expand the  button and select the required boundary option.Option

Click  to check boundary shape.Preview

Click  to create a cut boundary. Another layout window opens, which OK
contains the area that was cut by the boundary.
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Copying the Selected Design to a New Cell View

To copy selected objects:

Select  >  > .EM Tools Copy To Design

Select the required objects in the layout window by manual selection, using 
the Navigator, or any other method

Click  to select a target layout.

Click  to copy selected objects to the layout.Copy

Using the  feature, you can copy only those shapes and components Copy to design
that you have selected in the layout design. An error message is displayed, if you 
do not select any shape.

Example

In the following example, it is illustrated how to copy selected nets using the Copy 
 feature.to design

Display the  tab. For more information about how to access the Navigator
navigator, see .Using the Navigator

Select the required nets in the Navigator tab, as shown highlighted in the 
following figure. You can use the search feature in the Navigator to search 
for nets.

http://edadocs.software.keysight.com/display/ads2017/Viewing+Designs#ViewingDesigns-UsingtheNavigator
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Right-click on the selected nets and choose Select shapes and component 
.on Net

Select  >  > .EM Tools Copy To Design

Click  to copy selected objects to the layout. The selected nets are Copy
copied to cell_2.

Cookie Cutter Options

This section describes the various options provided in the Cookie Cutter dialog box.

Specifying a Boundary

Cookie cutter is operated on a boundary that can be specified by selecting nets or 
selecting shapes. You can choose the following boundary types:

Bounding Box: Represents the smallest rectangle that contains the selected 
nets or shapes.

Convex Hull: Represents the smallest convex set that contains the selected 
nets or shapes.

You can select nets or shapes either manually or using the Navigator feature. This 
section provides information about how to create the cookie cutter design by 
selecting objects manually and using the navigator.

Specifying the Cut Proximity Nets within Option

The Cut Proximity nets within option sets the boundary away from the nets by a 
specified distance.

Temporary Drawing Layer

Temporary Drawing layer, which is a boundary shape that will be drawn temporarily 
on the selected layer. To use a cookie cutter, you need to define a boundary layer, 
which is drawn for previewing and cutting operation. Note that cookie cutter is not 
applied to the shapes on a boundary layer. Therefore, you need to select a layer 
that does not include real patterns where you want to use this feature.

Output

You can create a new layout for displaying the design that you are copying using 
Cookie Cutter. The New Layout window is displayed where you can specify the 
required library, cell, and view. The shapes and nets of the objects inside the cookie 
cut boundary is preserved. Objects on the boundary are converted to polygons 
during cookie cut operation. If the original design has instances, then the instances 
on or inside the boudary is preserved by default.

Options

The following options are provided by Cookie Cutter for specifying a boundary 
layer:

Include Instance bounding box for boundary creation
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Cut instances if it is on the boundary: If you select this option, the instances 
with its box intersects with the boundary will be cut and the instance itself 
will be deleted. Otherwise, such instances are not displayed in the output 
design.

Highlight boundary for preview

Keep boundary after cut

Cookie cutter works with objects that are selected by any type of selection 
mechanism provided by ADS, such as manual selection and Physical 
Connectivity Engine. Therefore, you can use the Cookie cutter, even if the 
Physical Connectivity Engine is switched off.

Edge and Area Pin Manipulation Utilities

The EM Tools menu also provides utilities for quickly creating and manipulating 
edge and and area pins. The following utilities are available in the  >  EM Tools
menu:

Create One Pin From Selection: Creates a single pin containing all selected 
shapes that are not yet part of a pin.

Create Multiple Pins From Selection: Creates a different pin for each 
selected shape that is not yet part of a pin.

Add Selection To Touching Pins: Adds each selected shape to a touching pin 
if such a pin exists and is unique.

Add Selection To One Selected Pin: Adds each selected shape that is not yet 
part of a pin to the unique selected pin.

Dissociate Selection From Pins: Dissociates each selected shape from its 
associated pin.

Force Center As Snap Point For Selected Pins: Removes the dot shape from 
each selected pin that consists of a unique dot shape and at least one other 
figure.

Force Explicit Snap Point For Selected Pins: Adds a dot shape at the snap 
point of pins without any dot shape.

Defining Component Parameters

Defining Component Parameters

You can create user-defined components from a layout window in ADS. You can 
insert these components in a schematic window just like any other component, and 
represents the (parametric) layout from the layout page. The symbol representing 
this component in schematic can either be a black box or a layout lookalike symbol. 
You can also create an EM Model to model a component by using the S-
parameters generated by an EM simulation.

After creating a component, you can use it in one of the following ways:
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You can directly include the component in a schematic. During circuit 
simulation from the schematic environment, a solver is called automatically 
to generate a model. The user-defined layout parameters and the relevant 
simulation parameters (e.g., model type, mesh density) can be set from the 
schematic page. The EM model consists of a built-in database mechanism 
that stores previously calculated Momentum simulation results. Therefore, 
after Momentum simulation is done for a certain layout component, no new 
EM simulations are required, unless there is a change in the parameters for 
this component.

You can use the components as the starting point of Advanced Model 
Composer (AMC), for more details see . Using Advanced Model Composer
AMC is a generalization of Model Composer, for details see Model Composer
, enabling you to generate a parameterized electrical model for a 
Component from within the layout window. After defining and creating the 
component, you can specify the ranges for the parameters (with continuous 
and discrete parameter range options) and launch the AMC model 
generation tool from within the layout environment. In contrast to the EM 
Circuit cosimulation feature, AMC is a model generation tool. This means 
that the parameterized electrical model is calculated before the component 
is used in a schematic design, based on a number of simulations that run in 
the background. No EM simulations need to be performed when the 
component is used in schematic. Using an AMC component in schematic is 
as fast as using any other ADS built-in component. The AMC components 
can be added to a standard ADS design kit for easy sharing between 
workspaces and users.

Components and EM Circuit Cosimulation

The Electromagnetic-Circuit cosimulation feature enables you to combine EM and 
circuit simulations from the schematic. From a layout in Advanced Design System, 
you can create and insert a (parametric) component in a schematic. The symbol 
representing this component in a schematic can either be a black box or a layout 
lookalike symbol.

For more information, see Performing an EM Circuit Cosimulation with an EM 
.Model View

Editing Component Parameters

You can define parameters for a component in a layout that enable you to sweep, 
tune, or optimize geometrical (shape) variations of planar layout objects. You can 
specify the following parameters for a component:

Dimensions such as lengths, widths, gaps, spacing, or diameters.

Interdependent layout modifications such as length and width varying 
simultaneously.

Unconventional layout modifications such as varying port locations.

There is a limit of 100 layout parameters per component.

http://edadocs.software.keysight.com/display/ads2017/Using+Advanced+Model+Composer
http://edadocs.software.keysight.com/display/ads2017/Model+Composer
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There are two ways to create a parameterized layout:

Using nominal/perturbed designs.

Using subnetwork parameters.

These approaches are mutually exclusive and you cannot combine them when 
defining parameters for a single component. Nominal/perturbed parameters can be 
defined when the layout is flattened and contains only ports and primitive artwork 
shapes (such as polygons, rectangles, and circles). When a combination of existing 
(built-in or custom defined) layout components and any other type of artwork 
primitives are used, the layout is hierarchical and only subnetwork parameters can 
be used.

Using Nominal/Perturbed Designs

To define a parameter, you need to provide a separate design to show the program 
how an incremental change in that parameter value affects your original layout. The 
original layout is referred to as the  and the new layout is called a nominal design

. The program will guide you through this process. When you add perturbed design
a new parameter a separate design containing a copy of the nominal design is 
created. You should make your changes in this design by applying perturbations as 
specified in the Edit/View perturbation dialog. The modified copy is then saved as 
the perturbed design. You need to define a separate perturbed design for each 
parameter.

Select  >  >  to open the Design Parameters dialog EM Component Parameters
box.

Type a parameter name in the Name text box.

Ensure  is selected in the  drop-down list.Nominal/Perturbed Type

Type a nominal value and select a unit from the drop-down list.

Type a perturbed value.
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6.  Click  to add the parameter or  to display the EditAdd Edit/View Perturbation
/View Perturbation dialog box where you can specify a , Linear Stretch Radial 

, or  perturbation for the specified parameter.Stretch Rotation

The values that are specified as Nominal and Perturbed value correspond to the 
parameter values later, when an EM component is created. The Nominal value 
entered in this dialog will be the default value for this parameter in the EM 
component.

The following section describes the Linear Stretch, Radial Stretch, and Rotation 
values.

Linear Stretch

Specifying a linear stretch for a parameter enables you to move a single selected 
vertex point or a group of selected vertex points linearly using a deltaX, deltaY 
specification.

The value that you enter for deltaX or deltaY is not necessarily the same as 
(Perturbed Value – Nominal Value) in the Design Parameters dialog box. You can 
use the same values, but it is not compulsory. The deltaX and deltaY values are 
defined only internally, to move certain vertices of the layout. If deltaX or deltaY do 
not correspond with (Perturbed Value – Nominal Value) in the Design Parameters 
dialog box, a mapping will take place.

Radial Stretch

Specifying a radial stretch for a parameter enables you to move a single selected 
vertex point or a group of selected vertex points radially by specifying the centerX, 
centerY coordinates of the center point and a factor. The following illustration 
shows the effect of the factor on the selected vertex points.
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The value that you enter for ‘factor’ is not necessarily the same as (Perturbed Value
/Nominal Value) in the Design Parameters dialog box. It is probably the most 
practical to use the same values, so they correspond, but it is not compulsory. The 
‘factor’ value is defined only internally, to stretch certain parts of the layout. If 
‘factor’ does not correspond with (Perturbed Value/Nominal Value) in the Design 
Parameters dialog box, a mapping will take place.

Rotation

Specifying a rotation for a parameter enables you to move a single selected vertex 
point or a group of selected vertex points by rotating over a specified angle around 
a center point specified by the coordinates centerX and centerY.
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The value that you enter for ‘angle’ is not necessarily the same as (Perturbed Value 
– Nominal Value) in the Design Parameters dialog box. It is probably the most 
practical to use the same values, so they correspond, but it is not compulsory. The 
‘angle’ value is defined only internally, to rotate certain parts of the layout. If ‘angle’ 
does not correspond with (Perturbed Value – Nominal Value) in the Design 
Parameters dialog box, a mapping will take place.

Using Existing Components

You can set up a parameterized layout by using a combination of several built-in 
components. Use the Design Parameters dialog box (  >  > EM Component

 ) to specify subnetwork parameters for the layout component. Once a Parameters
subnetwork parameter is defined, it can be used to set the parameters values of 
one or more component instances used in the layout. A parameterized layout can 
be set up using a combination of several built-in components. You can define a 
subnetwork for hierarchical components only.

Only the top-level design parameters can be used to set the lower-level 
instance parameters. The use of any other variable is prohibited.

To specify subnetwork parameters for the layout component:

Select  >  >  to open the Design Parameters dialog EM Component Parameters
box.
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Type a parameter name in the Name text box.

Select  in the  drop-down list.Subnetwork Type

Type a default value and select a unit from the drop-down list.

Click  to add the parameter.Add

Once a subnetwork parameter is defined, it can be used to set the parameters 
values of one or more component instances used in the layout. For example, in the 
following figure, subnetwork parameter L1 is used to set parameter value L of the 
MLIN instance.

Converting Layers between Strip and Slot Representation

Converting Layers between Strip and Slot Representation
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You can convert between Strip and Slot Layer representations by using the EM 
 utility. This opens the following dialog box that >Tools > Convert Strip <-> Slot

enables you to convert strip and slot layer representation:

The Convert Strip to Slot dialog box processes a complete layout in one go for all 
the layers. It consists of the following options:

Select the source and destination substrate. You can define a new one by 
typing the name in the destination field or use an existing one by selecting 
from the drop-down list.
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Cutter oversize Distance: The cutter/conversion area for the layout is 
defined by all polygon shapes on the layer selected under Cutter Layer. You 
can use an oversize setting to avoid slivers.

Select the layers to process in the conversion. In the Source Layer list, all 
the layers from the source substrate are displayed. In the Destination list, all 
the destination layers are displayed. If you select  in the --no change --
Destination Layer, the source layer is retained in the destination.

You can select a source layer in the table and at the bottom fill in or select a 
destination layer. If not specified the layer purpose will be “drawing”.

Example- Designing a Microstrip Line

Example- Designing a Microstrip Line

In this section, you will be introduced to the concept of setting up EM simulation 
for a Microstrip Line design. You will use default settings and a simple circuit to 
create a Microstrip Line design with step in width.

For designing a Microstrip Line component, you will perform the following tasks:

Draw a simple Microstrip Line design with step in width as a schematic.

Generate a corresponding layout.

Create a simple substrate.

Define a mesh.

Perform an EM simulation using both Momentum and FEM.

Analyze the results.

The schematic representation of the Microstrip Line design is displayed below:

The layout representation of the Microstrip Line design is displayed below:
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Drawing the Circuit

To start the process of designing a Microstrip Line component, you need to draw 
the circuit by:

Creating a new workspace.

Adding Microstrip components to the schematic.

Converting the schematic to a layout.

Creating a New Workspace

To create a new workspace:

From the ADS Main window, choose  >  >  to display File New Workspace New 
.Workspace Wizard

Click .Next

In the  field, type .Workspace Name step1

Enter a path in . Click  to select the location.Create In Browse

Click .Next

Under , select the libraries to be included in the Workspace, as Add Libraries
shown in the following figure:

Click .Next

Under , enter a unique library name.Library Name

Click .Next

Under , choose .Technology ADS Standard: length unit - mil

Click .Finish

For more information about a workspace, refer .Workspace

http://edadocs.software.keysight.com/display/ads2017/Workspace
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Adding Microstrip Line components to the Schematic

To create a new schematic:

Choose  >  > .File New Schematic

Create a new schematic step_1 in library step_1_lib.

For more information about a schematic, refer to .Creating a New Schematic

After creating a schematic, select a component and place it in the Schematic 
window.

Placing Components in a Schematic

To select and place components in a Schematic window:

Click the  drop-down list.Palette

Select  from the list.TLines-Microstrip

Click  in the Microstrip Transmission Lines palette.MLin

Move the crosshairs to the Schematic window and click once to place the 
component. A schematic representation of the component is placed in the 
Schematic window.

http://edadocs.software.keysight.com/display/ads2017/Designs#Designs-CreNewSche
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Move the cursor to place the crosshairs directly on the right pin of the first 
component, and then click once to place the second component.

Canceling Commands

If you continue to click without ending the current command, you will add another 

component with each click. To cancel a command, click the arrow button (  ). 
You can also end a command by pressing the  key.Escape

Editing Component Parameters

This section describes how to change the width of one of the strips to create a 
Microstrip Line step in width transmission line.

To edit components:

Click twice on the second component that you placed. The Libra Microstrip 
Line dialog box opens.

In the  field, select the  to specify the width. When the Select Parameter W
field to the right shows the value of the width, change the value in this field 
to 35 mil.

Click .Apply

Click .OK
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If a parameter for a component is displayed in the Schematic window, 
you can also edit that parameter by clicking the value and entering a 
new value.

Verify that the width of component on the left is set to 25 mil.

Adding Pins to the Circuit

To complete the circuit, you must add pins, one at the beginning of the Microstrip 
Line component step in width and one at the end. This section describes how to 
add pins to the circuit.

To add pins:

Click  (  ) in the menu bar.Pin

Move the cursor over the Schematic window and note the orientation of the 
ghost icon of the pin.

Click  to rotate the port to the necessary orientation.Rotate

Move the cursor over the open pin on the left side of the left component, 
then click once.

To insert a second port, change the orientation appropriately, move the 
cursor over the open pin on the right side of the right component, then click 
once.

Click  to cancel the current command. Your schematic displays a 
Microstrip Line step in width. The width of the first part of the line is 25 mil, 
and it increases to a width of 35 mil. The overall length is 200 mil, as shown 
in the following figure:

Diamond-shaped pins indicate that pins are not connected. You need to 
select and move components to form complete connections.

Saving a Design

To save your design, choose  > .File Save
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Generating a Layout

Since EM simulations require a circuit in the layout format, it gives you the option 
of drawing your circuits either as schematics or as layouts.

If you choose to draw in a Schematic window, footprints of the components you 
use must also be available in Layout. Components that are available in Layout 
include transmission lines and lumped components with artwork.

To covert the Microstrip Line design with step in width schematic:

In the Schematic window, choose  > . The Layout Generate/Update Layout
 dialog box appears. It is not necessary to edit fields.Generate/Update Layout

Click . The Layout Generation message appears indicating that the OK
conversion is complete.

Click .OK

A Layout window appears, which displays a layout representation of the 
schematic. This window may be hidden by the Schematic window, so you 
may need to move some windows to locate the Layout window.

From the Layout window, choose  > . You now have a layout and a File Save
schematic as part of your library step_1.

Creating a Simple Substrate

A substrate is required as part of your planar circuit. The substrate describes the 
media where the circuit exists. An example of a substrate is the substrate of a 
multilayer circuit board, which consists of:

Layers of metal traces

Layers of insulating material between the traces

Ground planes

Vias connecting traces on different layers

Air surrounding the circuit board

In ADS 2011, substrates are part of the Technology dialog box used for a library. 
For the Microstrip Line design having step in width example, a substrate having the 
following layers is used:

Ground plane

Dielectric(insulation), such as Alumina

Metal layer for the Microstrip Line component

Air layer above the Microstrip component

Defining the EM Setup

In the EM Setup window, you can specify settings for running a successful EM 
simulation. If you do not provide correct information, an invalid symbol (  ) 
appears against the options in the left pane of the EM Setup window.
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To specify the EM simulation settings:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Substrate

Select  and add the frequency range for simulation. By Frequency Plan
default, an adaptive frequency plan from 0 Ghz to 10 Ghz is added. The EM 
setup becomes valid on adding the frequency plan. For more information, 
refer to .Defining a Frequency Plan

At this stage, if you want to start the simulation, click the  Simulate
button at the bottom of EM Setup window.

Select  to gather information about the Layout for which this EM setup Layout
is prepared. For more information, refer to .Viewing Layout Information

Select  to display the substrate used for the simulation. For more Substrate
information, refer to .Defining Substrates

Select  to gather information about the ports being generated from the Ports
pins defined in the layout. EM simulations need ports to inject energy into 
system. For more information, refer to .Ports

Select  to specify a name for the EM dataset.Output plan
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Select  to specify mesh, preprocessor, and solver options. For more Options
information, refer to .Defining Simulation Options

Select  to specify computer resources options. For more Resources
information, refer to .Specifying Simulation Resources

Select  to generate an EM model and symbol. For more Model/Symbol
information, refer to .Generating an EM Model

Select  to add any specific note about the simulation.Note

Save the EM settings by selecting  > .File Save

Click  in the EM Setup window to start the EEsof Job manager and Simulate
EEsof Job log window for the currently running momentum simulation.

After the simulation is complete, the Data Display window opens 
automatically:

Viewing Results

Load S11 plot on the Data Display window, as shown in the following figure:
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Switching Simulation Engines

For changing the mode of simulation to FEM, open the  window and EM Setup
select . Once the mode is changed to FEM, the EM setup remains valid for the FEM
FEM simulator.

Selecting the FEM simulator changes the dataset name in Output plan to 
.step1_fem

Clicking  in the EM Setup window launches the EEsof Log window for the Simulate
FEM simulation. After completion of the FEM simulation, a data display window is 
displayed:

S11 plot for FEM is shown below:
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Comparing Momentum and FEM Results

Load the plots from both Momentum and FEM and compare the results. 
Comparison plots are shown below:
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Substrates

Substrates

Defining Substrates

Sweeping Substrate Name and Mesh Density

Adding Boxes, Waveguides, and Symmetry Planes

Modeling Through-Silicon Vias

Variables in Substrates and Materials

Dielectric Substrate Modeling

Defining Substrates

Defining Substrates

A substrate defines the cross-section of a physical design. It is a pre-requisite for 
3D viewing and/or EM simulations. For example, the substrate of a multilayer 
circuit board consists of layers of metal traces, insulating material, ground planes, 
and vias that connect traces and the air that surrounds the board. The substrate 
editor enables you to specify properties such as the number of layers in the 
substrate, select the materials, specify the height of each layer, etc. You can save 
the substrate definitions and use with other circuits.

A substrate consists of the following types of alternating items:

Substrate Layer: This layer defines the dielectric media, ground planes, 
covers, air, or other layered material.

Interface Layer: This is the conductive layer in between the substrate layers. 
Typically conductive layers are the geometries that are drawn on the layout 
layers in layout window. By mapping layout layers to interface layers, you 
can position the layout layers that your circuit is drawn on within the 
substrate.

Another way to look at the substrate is: Substrate provides a side view of your 
design (not to scale, for ease of illustration) while the geometries drawn on layout 
layers in layout window provides a top view of your design. They together give a 3D 
picture of your design. The top and bottom of the substrate either end with a Cover 
(Interface) or an infinitely thick Substrate Layer, as shown in the following figure:



147 Electromagnetic

1.  

2.  

3.  

To see if a substrate definition/feature is supported by an EM simulator, click .here

Opening the Substrate Editor

You can open the Substrate Editor window in the following ways:

From the ADS Main window, choose  >  >  and click .File New Substrate OK

From the ADS Main window, select  tab. Right-click any library Library View
or cell and choose .New Substrate

From the Layout window, choose  > .EM Substrate

From the EM Setup window, select  in the left pane. Then, click Substrate
.New

The Substrate Editor window is displayed, as shown in the following figure:

The key components of substrate editor are listed below:

Main Menu bar: Contains menu options to edit or create a new substrate.

Toolbar: Contains the most commonly used buttons.
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Substrate view: Displays 3D cross-section view of substrate stack with mask 
mappings, it has basic operations to edit the substrate definition.

Layer table: Lists the layers included in the substrate to perform quick checks 
and edits.

Via table: Lists the Vias included in the substrate to perform quick checks 
and edits.

Status bar: Notifies about warnings or errors for the substrate.

Properties panel: This panel, on the right, allows editing the properties of the 
currently selected item of the substrate.

Selecting a Predefined Substrate

To open a predefined substrate:

Select  >  to open the  window.EM Simulation Setup EM Setup

Select .Substrate

Select an existing ADS substrate file from the drop-down list.

To open the  window, click .Substrate Open

Creating a Substrate

To create a new substrate:

Select  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Substrate

Click  to display the  dialog box, as shown below:New New Substrate

Select the required library from the  drop-down list.Library

Type a name in the  text box.Substrate

Click .Create Substrate
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Saving a Substrate

A substrate definition can be saved to a file. This enables you to store the definition 
outside of the current project, making it easier to use the substrate definition in 
other designs.

A substrate definition file is saved with file extension  by default..subst

Substrate Editor provides three options to save:

Save: This option saves the changes in the current substrate.

Save As: The  command allows you to save the current substrate with Save As
a new name. Select the library from the  drop-down list and type the Library
File Name of the substrate. The specified substrate is created in the selected 
library and displayed in the Substrate Editor.

Save a Copy As: The  command allows you to save a copy of Save a Copy As
the current substrate. Select the library from the  drop-down list and Library
type the File Name of the substrate. A copy of the current substrate is 
created in the specified library.

Deleting a Substrate

This command removes the selected substrate file (.subst). If the substrate has 
been precomputed, the calculations remain in the database.

To delete a substrate:

Right-click the required substrate in the ADS Main window

Select the  option, as shown in the following figure:Delete
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Adding, Moving, and Deleting Layers

The Substrate View enables you to visualize the substrate stack and do basic 
editing. To add or delete an item in the substrate, right-click in the substrate view 
and select from the list of option displayed in the pop-up menu. After selecting the 
desired action, the properties associated with it are displayed in the right panel of 
the Substrate Editor.

To organize your substrate layers in the correct order, you can delete, add, and 
move layers.

To add a substrate layer:

Right-click a substrate layer in the  list that has the same Substrate Name
basic property (open boundary, closed boundary, or finite thickness) as the 
layer you are adding.

Click  or  to add a Insert Substrate Layer Above Insert Substrate Layer Below
new layer.

Context menus

Right-click on a Substrate Layer and you may see some of the following menus 
depending on the interface position and properties:

Insert Substrate Layer Above - Inserts a new substrate layer with an 
interface layer above the selected layer.
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Insert Substrate Layer Below - inserts a new substrate layer with an 
interface layer below the selected layer.

Delete with Upper Layer - Deletes the substrate layer above the selected 
layer.

Delete with Lower Layer - Deletes the substrate layer below the selected 
layer.

Map Conductor Via - Inserts a new conductor via in the selected substrate.

Map Semiconductor Via - Inserts a new semiconductor via in the selected 
substrate.

Map Dielectric Via - Inserts a new dielectric via in the selected layer.

Move Up With Upper Interface - Moves the Substrate Layer and the 
Interface above it up, along with items on that interface.

Move Up With Lower Interface - Moves the Substrate Layer and the 
Interface below it up, along with items on that interface.

Move Down With Upper Interface - Moves the Substrate Layer and the 
Interface above it down, along with items on that interface.

Move Down With Lower Interface - Moves the Substrate Layer and the 
Interface below it down, along with items on that interface.

Depending on the position of the substrate layer you can move the layer up or 
down the stack. If the layer is either at the top or bottom, you can add cover above 
or below the substrate layer, as applicable.

Right-click on a Interface Layer and you may see some of the following menus 
depending on the interface position and properties:

Map Conductor Layer - Inserts a new conductor layer on the selected 
interface.

Map Semiconductor Layer - Inserts a new semiconductor layer on the 
selected interface.

Map Dielectric Layer - Inserts a new dielectric layer on the selected 
interface.

Insert Nested Substrate - Inserts a new Nested Substrate on the selected 
interface.

Delete Cover - Deletes the Cover leaving the adjacent Substrate Layer as an 
infinite thickness layer.

To unmap the already mapped item, right-click on a  or  and Conductor Layer Via
select  option from the pop-up menu.Unmap
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Moving Conductor Layers

Use the left mouse button to move a Conductor Layer up or down to a different 
interface or to drag the item to the new location. This method also works for 
Semiconductor Layers, Dielectric Layers, and Nested Substrates.

Moving Vias

Using the left mouse button, drag a via on the upper or lower 1/3 of its body and 
you will be able to stretch the via so that it goes through more or less Substrate 
Layers. Dragging it from the middle of its body allows you to move the via up or 
down without stretching it.

To move a substrate layer:

Right-click a substrate layer that you want to move in the  Substrate Name
list.

Select one of the following options:

Move Up With Upper Interface

Move Up With Lower Interface

Move Down With Upper Interface

Move Down With Lower Interface

To delete a substrate layer:

Right-click a substrate layer.

Select  or  to delete a layer Delete with Upper Layer Delete with Lower Layer
definition.

Using Layer and Via Table Views

Starting ADS 2017, the layer and via table views are introduced in the substrate 
editor. The two table views provides the following adequate functionalities:

Enables you to cross-check and edit the essential data such as material and 
thickness.

Selecting a via or layer on substrate automatically highlights the respective 
row in the table.
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Double-click the Material or Thickness to edit a particular layer or view from 
the table.

You can change the table position from .View > Change Table Position

You can view or hide the views from  or .View > Layer Table View > Via Table

You can sort the table using the gear icon (  ) on the top of the tables.

Editing Substrate Properties

After adding a substrate layer, you can set the properties in the right panel of the 
Substrate Editor window.

Editing Properties for the Entire Substrate

Click in the background of the substrate to deselect any specific item. This allows 
you to edit the properties of the entire substrate on the right panel of the window.

You can define a bounding area layer, which is a layout layer, to specify an area 
delimiting the design. It specifies the extent of substrate layers, slot layers and 
covers for simulators operating in a finite simulation domain. This includes the finite 
element simulator and exporting to EMPro. It excludes Momentum, which 
continues extending these layers to infinity. All layout outside the bounding area 
layer is discarded.

All layout outside the bounding area layer will be discarded.

The bounding area layer can be selectively overridden on substrate and interface 
layers in their respective property sheet. Note that individual vias can only be 
discarded as a whole; having them simultaneously inside the bounding area layer of 
one substrate layer and outside the bounding area layer of another substrate layer 
in unsupported and leads to undefined behavior.

The top level bounding area layer definition does not descend into nested 
substrates.
However, the shared interface layer between a substrate and a nested substrate 
uses the Boolean OR of all defined bounding areas. In this respect, the absence of a 
bounding area layer definition in one of the substrates is being treated as if the 
entire infinite plane is to be used as bounding area.
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For the entire substrate, you may select one bounding layer that applies to the 
entire substrate, unless it is overridden on a specific interface or substrate layer.

Open the Substrate Editor window.

Select in the open area that is not part of the substrate. This will show 
properties of the "Entire Substrate" on the right.

Select a layer from the  drop-down list.You can also click Bounding area layer
  to open the Layer Definitions window if you need to add an Edit Layer

additional layer.

Click .Save

After adding a bounding layers the substrate will appear to be cut on the right edge 
and will display the name of the layer that bounds each interface and substrate 
layer.

Note that individual vias can only be discarded as a whole; having them 
simultaneously inside the bounding area layer of one substrate layer and outside 
the bounding area layer of another substrate layer is unsupported and leads to 
undefined behavior.

The top level bounding area layer definition does not descend into nested 
substrates. However, the shared interface layer between a substrate and a nested 
substrate uses the Boolean OR of all defined bounding areas. In this respect, the 
absence of a bounding area layer definition in one of the substrates is being treated 
as if the entire infinite plane is used as a bounding area.

Editing Substrate layer Properties

The bounding area layer can be selectively overridden on substrate and interface 
layers in their respective property sheet. You can choose to have no bounding layer 
or inherit the bounding layer defined for the entire substrate or choose a different 
layer to bound this interface or substrate layer.
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Following are the properties that can be edited:

Material - This property allows you to select the layer material from the 
 drop-down list. Materials are defined in the Materials Definition Material

dialog box. Click the  button to open the Material Definition dialog box 
where you can define a new material. The defined material is added 
automatically in the drop-down list.Material

For more information about specifying material properties, see 
.Material Definitions

Thickness - This property allows you to define the thickness of the layer. The 
units can be selected from the  drop-down list.Thickness

Editing Interface Layer Properties

Select an Interface layer to define the interface layer as one of the following:

Strip: A  allows the mapping of Conductor, Semiconductor, and Strip
Dielectric Layers, and the insertion of Nested Substrates.defines the objects 
on the layout layer as conductive, the area surrounding the objects is not, as 
shown in the following figure:

Slot: A  is the inverse of a strip, it defines the objects on the layout layer Slot
as not conductive, but the area of this layer surrounding the objects is 
conductive. When simulated, Momentum and FEM considers the electric 
field distribution (the equivalent magnetic current flow) in the slot.

Conductivity in slot metallization is ignored and perfect 
metallization is assumed.

http://edadocs.software.keysight.com/display/ads2017/Material+Definitions


Electromagnetic 156

Cover: A cover is available only for the top or bottom Interface. If it is 
enabled, you can also set the following properties:

377 Ohm Termination - Select this option to enable this termination. 
If this option is selected, you cannot specify  and .Material Thickness

Material - This property allows you to select the layer material from 
the  drop-down list. Materials are defined in the Materials Material
Definition dialog box. Click the  button to open the Material 
Definition dialog box where you can define a new material. The 
defined material is added automatically in the  drop-down Material
list.

Thickness - This property allows you to define the thickness of the 
layer. You can also select the units for thickness.

Some examples of using strips and slots include:

The patches of the Double_Patch antenna example. They are drawn on the 
layout layer named top_met, and are conductive. This layout layer is 
mapped to a metallization layer that is defined as a strip.

The slots of the Slot_dipole antenna example. The slots are drawn on the 
layout layer named slot. The slots are not conductive, but the area 
surrounding the slots is. This layout layer is mapped to a metallization layer 
that is defined as a slot.

Note that a layout can have many other layers that are not part of the actual 
circuit, such as text or error reporting layers. For the purposes of an Momentum 
simulation, they are ignored. If layout layers containing parts of the circuit are not 
mapped to metallization layers, they are ignored as well.

Editing Via Properties

Select a Conductor Via layer to edit any of the following properties:



157 Electromagnetic

1.  

2.  

3.  

4.  

5.  

Layer - Allows you to map the mask layer with layout layer from the  Layer
drop-down list. To add new layout layer click the  button (next to Layer 
drop-down list).

Process Role - Allows to select a process role to s pecify the role that the 
layer represents in a design.

Material - Defines material property for the mask layer from the  Material
drop-down list. To add new material layer click the  button (next to 
Material drop-down list).

Surface roughness model - Allows you to select Surface roughness model 
for the sides of the via.

Precedence - Precedence specifies which layout layer has precedence over 
another if two or more layout layers are assigned.

Plated - Allows you to specify a plated via. Select the option and then Plated 
specify the and  A non-plated via is a cylinder Thickness Dielectric Material.
filled with the specified . A plated via consists of a cylinder wall with Material
a thickness and the center of the via has a dielectric, as illustrated in the 
following figure:

To see if a substrate definition/feature is supported by an EM simulator, click .here

Mapping a Layout Layer

Layout layers that contain any shapes or components that are part of the circuit 
must be mapped to metallization layers. If layout layers are not mapped to 
metallization layers, they are not included in the simulation.

To map a layout layer:

Open the Substrate Editor window.

Select an interface layer.

Select the  or  option.Strip Plane Slot Plane

To map the layer as a via, right-click the substrate layer that you want the via 
to cut through.
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Select either , , or Map Conductor Via Map Semiconductor Via Map Dielectric 
.Via

After mapping vias, it is recommended to convert the vias to rectangles 
or square vias in the layout design to reduce memory consumption.

To define the conductivity characteristics of this layer, see Editing Conductor 
.Layer Properties

If you have overlapping layers, you need to set overlap precedence. For more 
information, see .Setting Overlap Precedence

Click .Save

Unmapping a Layer

If you want to change the location of a layer or remove one from the substrate 
definition, use .Unmap

To unmap a layer:

Open the Substrate Editor window.

Select a mapped layout layer from the  list.Layers

Right-click a substrate layer or the interface where the layout layer is 
mapped.

Click . A message box appears.Unmap

Click . This removes all layout layers assigned to this position.OK

To remap a layer, refer to the steps in Mapping a Layout Layer.

Editing Conductor Layer Properties

You can define a layout layer as a conductor or a semiconductor. If the layout layer 
is defined as a strip or via, you define the conductivity of the strip or via. However, if 
the layout layer is defined as a slot, it is not possible to define the conductivity of 
the metal around the slot. This is because a slot is assumed to be surrounded by a 
perfect conductor.

Select a Conductor layer to define any of the following properties:

Layer - Allows you to map the mask layer with layout layer from the  Layer
drop-down list. To add new layout layer click the  button (next to  Layer
drop-down list).

Only pins and pin shapes from layer - Allows you to only map the pins and 
pin shapes into the substrate, but not the geometry.

Material - Defines material property for the mask layer from the  Material
drop-down list. To add new material layer click the  button (next to 

 drop-down list).Material

Operation - The operation transforms 2D shapes drawn on a mask into 3D 
objects. For example, select the proper expand operation to define the 
thickness of a conductor mask.
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Position - Defines the position of the layer.

Thickness - Defines the thickness of the layer.

Surface roughness model - Allows you to select Surface roughness model at 
Top and Bottom.

Precedence - Precedence specifies the precedence of a layout layer over 
another layer, if two or more layout layers are assigned to the same interface 
or substrate layer and objects overlap. Precedence is used by the mesh 
maker so that objects on the layer with the greatest precedence number are 
meshed and any overlap with objects on layers with lesser numbers are 
logically subtracted from the circuit. If you do not set the precedence, and 
there are overlapping objects, a mesh will automatically and arbitrarily be 
created, with no errors reported.

To define conductor properties:

Open the Substrate Editor window.

Right-click an interface layer and select  or Map Conductor Layer Map 
. A conductor layer is added, as shown in the following Semiconductor Layer

figure:

You can set properties in the conductor layer panel, as shown in the 
following figure:
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Select the required layer from the  drop-down list.Layer

Select the  to that s Process Role pecifies the role that the layer represents in 
a design.

Select a material from the  drop-down list.Material

Select an option from the Operation panel. For more information, see 
.Automatic 3-D Expansion for Thick Conductors

Type the conductor thickness in the  text box and select a unit.Thickness

Specify the surface roughness model.

Set overlap precedence. For more information, see Setting Overlap 
.Precedence

Repeat these steps for the remaining mapped layout layers.

Click .Save
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Automatic 3-D Expansion for Thick Conductors

Conductors with finite thickness can be modeled using the 3D metal expansion 
feature. This feature automatically expands the mask of a conductor with finite 
thickness in the direction orthogonal to the layered medium, using the specified 
thickness of this conductor.

3D expansion is activated by selecting either the  or Intrude into Substrate Expand 
 option. In both cases, an extra dielectric layer is included in the the Substrate

internal substrate model. This is done for each metal layer that is expanded. The 
thickness values of the dielectric layers in between the metal layers are not 
changed, which preserves the capacitance value between two conductors lying on 
top of each other in the substrates.

To select the automated 3-D Metal Expansion Substrate items:

Open the Substrate Editor window.

Select the  layer.cond

In the  panel, select the substrate layer or the interface Conductor Layer
where the layout layer is mapped.

Choose either  or .Intrude into Substrate Expand the Substrate

Select the required position:  or .Above Interface Below Interface

Simulations with automatic expansion require more simulation time and memory, 
but result in more accurate simulation results. Typically, when the width/thickness 
aspect ratio is smaller than a factor of 5, the effect of accounting for the finite 
thickness of the conductors need to be allowed in Momentum simulations.

Consider an example, where an extra dielectric layer is inserted (indicated with 
[new] in the figure), which in the case of an above interface expansion has the 
dielectric properties of the layer above the metal layer. In the case of a below 
interface expansion, the new layer has the material properties of the layer below 
the metal layer. The following figure illustrates the internal substrate model when 
using the  option and selecting the  expansion Expand the Substrate Above Interface
for a conductor.
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The following figure illustrates the internal substrate model when using the Expand 
 option and selecting the  expansion for a conductor.the Substrate Below Interface

If you select , the above expansion is illustrated in the Intrude into Substrate
following figure:

Extra internal metallization layers are  added in Momentum and automatically
FEM to model the currents on all four sides of the finite thickness conductor.

Trapezoidal Cross-section Angle Parameter

If you activate 3D expansion by selecting either the  or Intrude into Substrate
 option, you can also specify an angle for the conductor layer. Expand the Substrate

For example, the following figure displays a conductor layer at 135 degrees:
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Currently, only the Controlled Impedance Line Designer and components 
on the TLines-LineType palette support trapezoidal cross sections. The 
trapezoidal conductor shape is not yet supported by an EM simulator.

Angle Parameter Conventions

Angle Parameters

W: Width of widest edge (≈ width of etch resist). The widest edge can be 
either the top edge or the bottom edge, either the edge at the interface or 
not.

Lateral Etch = ΔW / 2, where ΔW = difference in width between bottom and 
top edge = Wbottom – Wtop

1/Etch Factor = Lateral Etch / Thickness = (ΔW / 2) / T = cotan(α)

You can enter the angle (α) in Substrate Editor. The top and bottom width are 
derived from it.

In the Substrate Editor, only absolute values are shown and radio buttons replace 
the signs.
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Setting Overlap Precedence

Overlap precedence specifies which layout layer has precedence over another if 
two or more layout layers are assigned to the same metallization layer and objects 
on the metallization layer overlap. Precedence is used by the mesh maker so that 
objects on the layer with the greatest precedence number are meshed and any 
overlap with objects on layers with lesser numbers is logically subtracted from the 
circuit. If you do not set the precedence, and there are overlapping objects, a mesh 
will automatically and arbitrarily be created, with no errors reported. Resistive 
layers generated from schematics are automatically set to the highest precedence.



165 Electromagnetic

1.  

2.  

3.  

4.  

5.  

1.  

2.  

3.  

4.  

In some cases, you may be designing with an intentional overlap because of 
manufacturing layout guidelines. In this case, assign a precedence number to the 
layout layers that overlap with precedence order in reverse numerical order (largest 
to smallest). The system will draw the boundary at the edge of the higher 
numbered layer without returning an error.

Precedence affects only how the mesh is created, it does not affect or alter the 
layout layers in your design.

To specify overlap precedence:

Open the Substrate Editor window.

Select one of the overlapping layout layers.

Assign its order of precedence in the  field. Either type a value Precedence
directly into the field or use the arrow keys to select a value.

Click .Save

Repeat these steps for the remaining overlapping layers.

Updating the Layer Bindings from a Substrate

The ADS Physical Connectivity Engine enables you to establish electrical 
interconnects based on polygon shaped layout artwork and performs interconnect 
information extraction. The Physical Connectivity Engine requires a proper 
definition of the shape and pin layer binding. The layer binding setup can be 
derived automatically from a valid Momentum or FEM substrate setup. For more 
information on the Physical Connectivity Engine, refer to Physical Connectivity 
Engine

Click  (  ) to open the Layer Definition window.Edit Layer

Click  to synchronize the layer bindings from the Update Layer Bindings
substrate setup. The Update Layer Binding dialog box is displayed.

Select the required substrate.

http://edadocs.software.keysight.com/display/ads2017/Physical+Connectivity+Engine
http://edadocs.software.keysight.com/display/ads2017/Physical+Connectivity+Engine
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Click . An information dialog box is displayed to confirm that the layer OK
bindings are updated.

The layer binding rules applied are:

All layout layers mapped at a specific dielectric interface (as STRIP or SLOT) 
or through a specific dielectric layer (as VIA) will bind.

Every via layer additionally binds to all strip layers just above, just below, or 
somewhere along the via.

The layer binding of layout layers that are not mapped will be cleared.

SLOT layers require special attention! With this command, SLOT layers 
only bind to themselves or to other SLOT layers mapped at the same 
interface. The interconnect highlighting will not go through a SLOT 
layer. If you want a different behavior, you have to update the layer 
binding manually.

Editing Nested Substrate Properties

Select a Nested Substrate to edit any of the following properties:

Use a nested technology - Check this if your nested substrate represents a 
substrate from a different technology. With this un-checked you may nest 
two substrates from the current technology.
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Nested Technology - Choose a Nested Technology from the Nested 
 drop-down list. The chosen Nested Technology determines if Technology

the substrate appears flipped or not. Click the  button to create or edit 
Nested Technologies.

Nested Library - This is the name of the library specified in the chosen 
Nested Technology. This is not editable.

Flipped - The shows if the nested technology is flipped. This is not editable.

Nested Substrate - Choose a Substrate from the Nested Library to specify 
the EM properties of the layouts that will be placed on layouts using this 
substrate.

Alignment within nested substrate - This chooses a location within the 
nested substrate that will be aligned with the interface of the current 
substrate. Choosing the  of the nested substrate places the Bottom interface
nested substrate on top of the current substrate interface. Choosing the Top 

 of the nested substrate places the nested substrate on bottom of interface
the current substrate interface. You may also choose a strip, slot, or via layer 
of the nested substrate that will be aligned with the current substrate 
interface. The  or  choice option is used to choose the bottom or Bottom Top
top of the strip or via layer that was selected.

Offset - This allows you to move your Nested Substrate up or down relative 
to the interface it is on.

Precedence increase - Precedence specifies which substrate has 
precedence over another if two or more substrates are at the same location. 
The substrate with the higher precedence occupies the overlapped area.

See  and  for more Nested Technology Setting up Multi-Technology Designs
information about using Nested Technologies and Nested Substrates.

Verifying Substrate Definition

After creating the substrate definition, choose  (from the Substrate File > Check
Editor window) to verify the created substrate definition. The verification result or 
errors (if any) are displayed in the Check Substrate message window.

Setting a Default Substrate

A default substrate can be specified for each library. This substrate can be any 
substrate in the library or from any library referenced by the technology of the 
library. A default substrate will be the initial value of the substrate name when any 
new emSetup views are created. A design kit can have a default substrate and any 
other libraries that uses the design kit technology will inherit the default substrate 
from the design kit.

The Set Default Substrate dialog can be opened from the Options > Set Default 
Substrate menu on the Substrate Window. It can also be open from the Set Default 
Substrate context menu on substrates in the ADS Main window.

http://edadocs.software.keysight.com/display/ads2017/Nested+Technology
http://edadocs.software.keysight.com/display/ads2017/Setting+up+Multi-Technology+Designs
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The Library combobox specifies which library the default substrate is for. The 
Default Substrate combobox specifies the default substrate. The substrate choices 
include those in the specified library and any libraries referenced by the technology 
of the specified library. It also includes the choice to Inherit from referenced 
libraries. If this is chosen, the referenced libraries are searched for a default 
substrate specification and the first found will become the default substrate.

Importing a Substrate

You can import an SLM substrate file, substrate from database, substrate from 
Schematic, and an ltd substrate file. To import a substrate choose  File > Import
from the Substrate editor window or the ADS Main window. The following import 
options are available:

SLM Substrate File: Select  > .File > Import SLM Substrate file

ltd Substrate File: Select  > .File > Import ltd Substrate file

Substrate From Database: Select  > .File > Import Substrate From Database

Substrate From Schematic: Select  > File > Import Substrate From Schematic
.

Substrate Definitions Supported by EM Simulators

  Momentum FEM PIPro SIPro

Slot layer Supported Supported NA NA

Svensson/Djordjevic dielectric model Supported Supported Supported Supported

Plated via NA NA Supported
for PI-DC

NA

Surface impedance conductor model incl. skin 
effect (sheet/thick)

Supported Supported Supported Supported
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  Momentum FEM PIPro SIPro

Field modeling of conductor (Meshed interior) NA Supported NA NA

Conductor roughness model (surface top/bottom) Supported NA NA Partially 
supported 
(traces only

Conductor roughness model (via sides) Supported NA NA NA

Sweeping Substrate Name and Mesh Density

Sweeping Substrate Name and Mesh Density

To support sweeps over a substrate name, you can add a cell parameter, , Substrate
of the string type. Use the Substrate Editor to define and save different substrate 
setups to sweep through. Add a custom parameter to the design called  Substrate
by performing the following steps:

In the layout window, select  > File Design Parameters.

Click the  tab.Cell Parameters

Add a parameter named , of type , with a Default Value set to Substrate String
an existing substrate, using the  format. "<libraryName>:<substrateName>"
Double quotes are also included.

Click .Add
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Click .OK

For more information about how to define a parameter, see . Defining Parameters
Similarly, for Momentum only, you can define  as a cell parameter of MeshDensity
the real type to support sweeps over the mesh density.

Setting up Substrate Sweep

You can instantiate the  cell in a testbench schematic and setup a sweep over xline1
the substrate name. By using the  component, which can be accessed StringList
from the  palette, you can sweep over multiple substrates in an Simulation-Batch
EM/Circuit co-simulation.

A StringList component is used to sweep through a list of substrate file 
names. This component consists of an index parameter that is used to return 
the filename with the associated index value.

Define variables for substrate name and index to sweep. Note the syntax for 
defining the substrate variable. The  parameter expects a string Substrate
value of the "<libraryName>:<substrateName>" format. The order in which 
these components are placed/defined in the schematic does not matter.

http://edadocs.software.keysight.com/display/ads2017/Defining+Controls#DefiningControls-DefiningParameters
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Set the component's  parameter to the substrate variable.Substrate

Add a Simulation controller and a Parameter Sweep controller to sweep the 
index variable.

You can now view results in the data display window:

You can also use an example for illustrating the sweeping substrate name by 
performing the following steps:

Select  >  > . The  File Open Examples Choose an Archived Example to open
dialog box is displayed.

Double-click  and then open .Momentum emcktcosim

Select .Sweep_Substrate_Parameters_wrk.7zap

Click .Open

Adding Boxes, Waveguides, and Symmetry Planes

Adding Boxes, Waveguides, and Symmetry Planes
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Adding Boxes, Waveguides, and Symmetry Planes

While specifying the substrate definition of a circuit, only the vertical dimension of 
the substrate and not the horizontal dimension are defined. This extends the 
substrate layers to infinity in the horizontal direction. For many circuit designs this 
is not relevant and does not affect the simulation. However, there may be instances 
where you want to introduce horizontal boundaries. For these instances, you can 
use boxes or waveguides.

Boxes and waveguides enable you to specify substrate boundaries in the horizontal 
direction. A box enables you to set boundaries on four sides of the substrate. A 
waveguide enables you to set boundaries on two sides.

More specifically, for a box, you define four perpendicular vertical planes of perfect 
metal as the horizontal boundaries of the substrate. These four vertical planes, or 
walls, form a rectangle, if you are looking at the circuit from the top, along the z-
axis. A box can be used only where the top and bottom layers in the substrate 
definition are groundplanes or impedance termination. Thus, the four vertical metal 
walls, plus the top and bottom groundplanes result in a box, hence the name (the 
walls are the sides, and the top and bottom ground planes are lid and base of the 
box).

A waveguide is similar, although for a waveguide you specify only two parallel walls. The 

substrate is therefore only bounded in the horizontal direction perpendicular to these 

walls. In the horizontal direction parallel to these walls, the substrate still extends to 

infinity. The top and bottom layers of the substrate must also be defined as 

groundplanes. The two sidewalls in combination and the top and bottom covers form a 

waveguide.
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Adding a Box

A box defines the boundaries on four sides of the circuit substrate. Either one box 
or one waveguide can be applied to a circuit at a time. A box can be applied to a 
circuit only if the top and bottom layers of the substrate definition are defined as 
ground planes or impedance termination. The walls of the box are perfect metal. 
The ground planes can be defined either as perfect metals or a losse metal.

Adding a box to the circuit enables you to analyze the effects of enclosing the 
circuit in metal, for example, to identify box resonance. Box resonance can have a 
significant effect on S-parameters in a small band centered around the box 
resonance frequency. When a simulation is performed, the resonance frequencies 
will be noted in the status window when the circuit is simulated, along with the 
frequency bands where no smooth S-parameters can be calculated.

During a simulation, all current directions on the sidewalls of the box are taken into 
account.

Calibrated ports in the circuit (i.e., Single, Differential, Coplanar and Common 
mode ports) must be located on and perpendicular to the box edge, or an error 
will occur. Internal (uncalibrated) ports may be placed anywhere in the circuit 
and point in any direction.

To add a box:

Choose .EM > Box-Waveguide > Add Box

Position the mouse and click to define a corner of the box. Move the mouse 
to the diagonal corner and click once in the layout window.

You can also add a box by performing the following steps:
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Choose .EM > Box-Waveguide > Add Box

From the Layout menu bar choose  to open the Insert > Coordinate Entry
Coordinate Entry dialog box.

Specify a value in the  and  fields to Coordinate Entry X Coordinate Entry Y
specify a corner of the box.

Click .Apply

Editing a Box

Once the box is applied, you cannot change its dimensions. If you want to change 
the size, you must delete the current box and add a new one.

Deleting a Box

To delete a box, choose .EM > Box-Waveguide > Delete Box

Viewing Layout Layer Settings of a Box

The box is defined as a layout layer named . You may review the momentum_box
layout layer settings, but it is a protected layer, so you should not change the 
settings of this layer.
To view the box layer specifications:

Choose .Options > Layers

Select  from the  list. The layer settings are displayed. momentum_box Layers
For more information on these parameters, refer to Schematic Capture and 

.Layout

Adding a Waveguide

A waveguide defines the boundaries on two, parallel sides of the circuit substrate. 
Either one box or one waveguide can be applied to a circuit at a time. A waveguide 
can be applied to a circuit only if the top and bottom layers of the substrate 
definition are defined as ground planes or impedance termination. The walls of the 
waveguide are perfect metal. The ground planes can be defined either as perfect 
metals or metal with loss.

During a simulation, all current directions on the sidewalls of the waveguide are 
taken into account.
To add a waveguide:

Choose . This opens the Add EM > Box-Waveguide > Add Waveguide
Waveguide message window, as shown in the following figure:

http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
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Select the direction of the waveguide. To insert the waveguide parallel to the 
x-axis, click . To insert the waveguide parallel to the y-axis, click X-axis Y-axis
.

Position the mouse and click to define one wall of the waveguide. Move the 
mouse to the position of a point on the second wall and click once in the 
layout window.

You can also add a waveguide by performing the following steps:

Choose .EM > Box-Waveguide > Add Waveguide

Select the direction of the waveguide. To insert the waveguide parallel to the 
x-axis, click . To insert the waveguide parallel to the y-axis, click X-axis Y-axis
.

Choose  in the layout.Insert > Coordinate Entry

Specify a value for the  and  fields to Coordinate Entry X Coordinate Entry Y
specify a point on the edge of the substrate.

Click .Apply

Enter the coordinates of a point on the second, parallel edge of the substrate 
and click .Apply

These boundaries specify the edges of the substrate and the width of the 
waveguide.

Editing a Waveguide

Once the waveguide is applied, you cannot change its dimensions. If you want to 
change the size, you must delete the current waveguide and add a new one.

Deleting a Waveguide

To delete a waveguide,

Select  >  > .EM Box-Waveguide Delete Waveguide

Click  in the message window to remove the waveguide from the layout.Yes

Viewing Layout Layer Settings of a Waveguide

The waveguide is defined as a layout layer named . You may review momentum_box
the layout layer settings, but it is a protected layer, so you should not change the 
settings of this layer.

To view the waveguide layer specifications:

Choose .Options > Layers

Select  from the  list. The layer settings are displayed. momentum_box Layers
For more information on these parameters, refer to Schematic Capture and 

.Layout

http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
http://edadocs.software.keysight.com/display/ads2017/Schematic+Capture+and+Layout
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About Boxes and Waveguides

You may need to simulate a circuit in a box or waveguide in the following 
situations:

The actual circuit is enclosed in a metal box: Circuits are often encased in 
metal enclosures. By adding a box to your design, the metal sidewalls that 
are present in the real structure may be included in the simulation. This is 
useful is you suspect that the presence of these sidewalls will have an 
immediate effect on the behavior of the circuit. For example, "broad-coupled 
filters" are placed in metal enclosures (a box) and the sidewalls can have an 
significant influence on the filter characteristics.

The nearby metal sidewalls may affect circuit performance: You may want to 
use a box or waveguide because metal sidewalls are present in the real 
structure and there may be an effect from these sidewalls on the 
characteristics of the circuit. This can be a parasitic, unwanted effect. If the 
effects of the sidewalls were not taken into account while designing the 
circuit, you can verify any effect that the sidewalls may have on your circuit. 
In most cases, when the sidewalls are not too close to the actual circuit, the 
effect of the sidewalls on the simulation results will be marginal. There is, 
however a specific, significant condition, which is unique for structures with 
sidewalls.

The box may resonate: A resonating box is a physical effect where, under the 
condition of certain frequency and box size combination, the box actually 
starts resonating at a certain frequency. Because a box resonance has a 
significant effect on S-parameters in a (small) band centered around the box 
resonance frequency which cannot be represented by a smooth function, no 
smooth adaptive S-parameters will be available in this frequency band. 
When simulating such a circuit, Momentum will inform you of these box 
resonance frequencies, of the frequency bands where there will not be 
smooth S-parameters available and of the quality factor (a measure for the 
sharpness of the box resonance, depending on the losses). In the case of 
waveguide, the effect is the excitation of a waveguide mode. If your circuit 
will be positioned near sidewalls, you may want to add a waveguide to 
determine whether they have an effect on the performance of the circuit.

The propagating modes may be present: You may have a situation where 
there are no metal sidewalls in the structure, but the substrate definition is 
bounded by other material (for example, you have a finite-size substrate 
where the dielectric material abruptly ends, so you have a dielectric-air 
transition). Although Momentum boxes and waveguides are defined as 
perfect metals and not dielectric material, you may decide that defining a 
metallic enclosure in the simulated circuit may be more representative of the 
real structure than using no enclosure.

Adding Absorbing Layers under a Cover

You may want to model your box or waveguide as having absorbing layers between 
the covers and the layout. You can use a substrate interface layer, define its 
thickness, and its absorbing properties using ε and µ (make sure that ε and µ are 
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accurate specifications for this layer). Adding absorbing layers to a box would have 
an effect on any box resonances that would occur by producing a weaker 
resonance, that is, the quality factor of the box resonances would lower 
significantly.

Boxes, Waveguides, and Radiation Patterns

If you have a structure enclosed in a box or waveguide and you want to calculate 
radiation patterns for it after the simulation, you need to set the top and bottom 
planes to values between 376 and 378. There are also other considerations.

Adding a Symmetry Plane

A symmetry plane defines the boundary on one side of the circuit substrate. Only 
one box, or one waveguide, or one symmetry plane can be applied to a circuit at a 
time. When a symmetry plane is defined, the simulation results will be equivalent to 
the results of a larger circuit that would be created by mirroring the circuit about 
the symmetry plane. For symmetric circuits, this enables faster simulations that 
require less memory because only half the actual structure needs to be simulated.

To add a symmetry plane:

Choose  >  > .EM FEM Symmetry Plane Add Symmetry Plane

Select the direction of the symmetry plane. To insert the symmetry plane 
parallel to the x-axis, click X-axis. To insert the symmetry plane parallel to 
the y-axis, click Y-axis.

Insert the symmetry plane using one of the following two methods:

Position the mouse and click to define the location of the symmetry 
plane.

From the Layout menu bar choose  >  and use Insert Coordinate Entry
the Coordinate Entry X and Coordinate Entry Y fields to specify a point 
on the edge of the substrate.

Click .Apply

This boundary specifies the edge of the substrate where the plane of symmetry will 
be applied.

A symmetry plane is not supported by Momentum simulations.

Editing a Symmetry Plane

Once the symmetry plane is applied, you cannot change its location. If you want to 
change the location or orientation, you must delete the current symmetry plane 
and add a new one.

Deleting a Symmetry Plane

To delete a symmetry plane:
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1.  Choose  > > . The symmetry EM FEM Symmetry Plane Delete Symmetry Plane
plane is removed from the layout.

Modeling Through-Silicon Vias

Modeling Through-Silicon Vias (TSV)

Through silicon via (TSV) technology is a key enabling technology for 3D integration 
of System on Package (SoP). Modeling of the TSV interconnect array will be 
important for high speed or high frequency applications.

The TSV structure provides a conductive path through the semiconductor die 
between a bond pad on the front side and a land on the rear side. The conductive 
path is isolated from the semiconductor by a linear dielectric.

Modeling Theory

Important effects to model are resistance, self and mutual inductance and 
capacitance of the TSVs.
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There are two effects that influence the capacitive behavior of the TSV.

The Liner Oxide Capacitance

The TSV oxide layer introduces an excess oxide capacitance that blocks the TSV 
metal - silicon bulk DC contact.

The MOS Depletion Capacitance

The TSV Metal - Oxide - Semiconductor (silicon) structure introduces an effect of 
accumulation, depletion or inversion of the major carriers in the silicon that 
depends upon the intrinsic semi-conductor properties, the substrate doping and 
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the TSV metal - silicion bulk bias voltage. The voltage dependent depletion layer in 
the silicon bulk changes the TSV oxide capacitance. The MOS structure yields a 
non-linear voltage dependent capacitive effect as shown below.

For a p-type substrate, when applying a negative bias voltage on the TSV, we get 
an accumulation of majority carriers at the TSV surface and therefore a high 
capacitance to the semiconductor bulk. As a result the total TSV capacitance is 
close to the oxide capacitance. When the negative voltage is reduced sufficiently, a 
depletion layer is formed which acts as a dielectric in series with the oxide and the 
total capacitance decreases. When further increasing the voltage, the capacitance 
goes through a minimum and then increases again as an inversion layer of minority 
carriers is formed at the surface.The increase of the capacitance depends on the 
ability of the minority carriers to follow the applied signal. This only happens at low 
frequencies where the recombination-generation rates of the minority carriers can 
keep up with the signal variations. Experimentally, it is found that for a metal-oxide-
silicon system this happens only below 100 Hz. As a consequence, C-V curves 
measured at higher frequencies do not show the increase of capacitance. We 
obtain the C-V curves under depletion, where the capacitance flattens out as the 
voltage increases more.

Tayloring the fixed oxide charge density (Qf) during the TSV oxide fabrication 
process gives extra shift in the C-V curve. This enables to obtain minimum 
depletion capacitance in the desired operation voltage region (0-Vdd). Typical 
values for Qf depend on the TSV oxide deposition process:

Wet oxidation: Qf = 5.1e10 cm-2

SACVD (SubAtmospheric Chemical Vapor Deposition): Qf = 7.8e10 cm-2

http://edadocs.software.keysight.com/download/attachments/54530082/TSV_CapacitanceVersusVoltage.png?version=1&modificationDate=1506735613000&api=v2
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Example workspace

$HPEESOF_DIR/examples/EM/RF_Microwave/tsv_example_wrk

Modeling TSVs with Momentum

Momentum includes the effect of both the liner oxide and MOS depletion 
capacitances in the EM model without the introduction of extra unknowns in the 
matrix. The model does not require extra computational resources. There is no 
performance and/or capacity penalty and can be applied to cover large arrays of 
TSV’s.

For the MOS depletion capacitance model, four depletion modes can be selected:

No depletion (accumulation)

HF depletion (default, high frequency behavior)

LF depletion (inversion, low frequency behavior, below 100 Hz)

Deep depletion

The TSV liner oxide dielectric is not physically created for a Momentum 
simulation. Consequently, the 3D viewer does not show the silicon oxide 
coating on the TSV.

The TSV conductor radius is the radius of the through hole (the circle drawn on 
the TSV layer) minus the liner thickness! The Momentum mesh is located at the 
conductor surface.
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Modeling TSVs with FEM

FEM includes the effect of the liner oxide capacitances only. The fixed oxide charge 
density and MOS depletion effects are ignored. Changing the corresponding 
parameters will have no effect on the FEM model.

The TSV liner oxide dielectric is created for a FEM simulation. Consequently, 
the 3D viewer shows the silicon oxide coating on the TSV.

Defining a TSV in the Substrate Editor

You can define a Through Silicon Via in the Substrate Editor similar to a Conductor 
or Dielectric Via.

To define a TSV:

Open the Substrate Editor.

Right-click on a substrate layer and select . A TSV is Map Through Silicon Via
added.

Specify the Through Silicon Via attributes on the right side.

Shapes on the selected designate where a hole Through Silicon Via Layer 
through the silicon will be etched.

The  and  specify the oxide coating that is Liner Thickness Liner Material
deposited on the side walls of the through holes

The remainder of the hole is filled with the conductive Through Silicon Via 
. The TSV conductor radius is the radius of the through hole (the Material

circle drawn on the TSV layer) minus the liner thickness!

The depletion capacitance is influenced by the , the Depletion mode Fixed 
 and parameters.charge Bias voltage

Besides the bias voltage, the doping type of the semiconductor material 
where the TSV passes through plays a role in the calculation of the depletion 
capacitance. Semiconductor materials have a doping property, p-type or n-
type. The default is p-type.
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Variables in Substrates and Materials

Variables in Substrates and Materials
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Overview of Using Variables in Substrates

Overview of Using Variables in Substrates

You can use variables in a technology substrate after defining the variables in a 
defaults design. All variables defined in the defaults designs of a library and the 
defaults designs of referenced libraries are visible in the entire library, and can be 
used in the substrate and materials of that library.

You can replace real numbers in the substrate and material definitions with 
expressions that use the variables, such as layer thickness and angle, conductivity, 
permittivity, roughness, and TSV bias voltage.

The expressions will be evaluated when running a simulation. If the variables are 
swept, optimized, tuned or used in a statistical simulation, the substrate is 
evaluated for each iteration.

The different components and simulation flows that use technology substrates are:

EM simulation from layout

EM simulation triggered by EM Model view or EM Cosimulation view.

Line Type components

Controlled Impedance Line Designer

The variables defined in the defaults design are not only accessible in the 
substrate definitions, but also accessible and controllable from any design.

The following flowchart depicts the process of using variables in substrates and 
materials:
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The following sections provide more information about how to use variables in 
substrates and materials:

Defining Variables in a Defaults Design

Using Variables in Substrates and Materials

Simulation Flows

Update EM Model Database when Parameter Set is Modified

Defining Variables in a Defaults Design

Defining Variables in a Defaults Design

Technology substrates are defined at the library level. Therefore, to use variables in 
a technology substrate, these variables must be defined at the library level. This is 
done by defining the variables in a . All variables defined in the defaults design
defaults designs of a library and the defaults designs of referenced libraries are 
visible in the entire library, and can be used in the substrate and materials of that 
library.

To avoid unexpected results, use different names for variables in defaults 
designs, variables on normal schematics and cell parameters.

There are two methods to define variables in a defaults design:

Using the Library Variables Dialog

Manually creating a defaults design and placing variables on it like on any 
other schematic

Library Variables Dialog

http://edadocs.software.keysight.com/display/ads2017/Defaults+Designs
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Library Variables Dialog

The library variables dialog can be opened from and design window or the ADS 
main window from the menu Options > Technology > Variable Definitions.

In the substrate editor it can be opened by clicking on the VAR icon:  .

To add a variable

Select the library.

Click on .Add Variable

Enter a name and value in the dialog that pops up.

If multiple defaults designs and/or multiple variable component instances 
exist, select one in the drop down list.

If no defaults design exists in the library, a new design will be created.

Additional variables are added to the existing design and variables components.
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To delete a variable:

Select the variable.

Click on .Delete Variable

Manually Creating a Defaults Design and Placing Variable Components

Creating variables at the library level without the Library Variable Dialog requires 
three steps:

Create a schematic.

Add the schematic to the defaults designs.

Place a variable on the schematic.

Creating a Defaults Design

To create a new schematic with a defaults design:

Click  in the Main window.New Schematic Window

Select a library from the  drop-down list.Library

Type a name in the  field, e.g., "defaults".Cell

Accept the default view.

Remove selection from the  option.Use Schematic Wizard

Click . A schematic is created in the cell.OK

Adding the Schematic to the Defaults Designs

After creating a schematic, add it to default designs:
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Select  >  > . The Defaults Designs Options Technology Defaults Designs
window is displayed.

Click . The Open Cell View window is displayed.Add Defaults Design

Select the new cell, which was created in the previous step.

Click . The selected schematic is added to the  list, as OK Defaults Designs
shown in the following figure:

Click .OK
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Placing a Variable on the Defaults Design

To place a variable on the defaults design:

Open the schematic in the defaults cell.

Click the  button on the toolbar.Insert Var: Variable Equation

Place a variable on the schematic.

Rename the variable.

Specify a new value, as shown in following figure:

Using Variables in Substrates and Materials

Using Variables in Substrates and Materials

After placing a variable in the defaults design, you can use the variable in 
substrates and materials. All real numbers in the substrate and material definitions 
can be replaced with expressions that use the variables. For example, layer 
thickness and angle, conductivity, permittivity, roughness, and TSV bias voltage. 
The expressions will be evaluated when running a simulation. If the variables are 
swept, optimized, tuned or used in a statistical simulation, the substrate is 
evaluated for each iteration.

To see which variables are used in a substrate or its materials, click in the white 
area that surrounds the substrate. Double clicking on a variable in the table will 
open the Library Variables Dialog. Right clicking will open a context menu that 
leads you to the locations where the variable is used.
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Using a Variable in a Substrate

To use a variable in a substrate:

Place a variable in a defaults design. For more information, see Defining 
.Variables in a Defaults Design

Open a substrate.

Select the required layer or via.

Change the required field with an expression using the variable. For example, 
in the following substrate, the thickness of the dielectric between ETCH_TOP 
and SLOT_L2_GND is changed to H mil. Note that the value of the variable 
H, itself, should not contain a unit. For example, H=5 will result in a thickness 
of 5 mil.

It is possible to fill in more complex expressions. Below is a list of valid example 
expressions (assuming all variables are defined)

2*H

H + T
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ln(T)

c0*f

In the last example c0 is a built-in constant (speed-of-light), not a variable.

Using a Variable in Materials

To use variables in a material:

Place a variable in a defaults design. For more information, see Defining 
.Variables in a Defaults Design

Open the Material Definitions window. This can be done in two ways:

Options >  > .Technology Material Definitions

Select a layer in the substrate editor and click the  Edit materials
button (  ) next to the  drop-down list.Material

Replace the value in the required field with an expression that uses the 
variable. For example, in the following figure the  field is replaced Permittivity
with the variable Er:

Click .OK

Using Variables before they are Defined

Instead of first creating a variable and then using it, it is also possible to first use a 
variable and then define it.

In the example below "H_al" is used in the thickness expression of the dielectric 
layer. Though, it is not defined yet as can be seen in the variable table.
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Double clicking on it will directly open the Add Variable dialog of the library 
variables dialog, with the name of the variable filled in.

Example: Using a Variable in a Material Parameter

Open the example workspace Sweep_Substrate_with_Variables_wrk from the 
following location:

$HPEESOF_DIR/examples/EM/Cosim/Sweep_Substrate_with_Variables_wrk

We will create a new variable for the conductivity of the layer cond.

Open the substrate sub.subst.

Click on the layer mapped on the layer .cond

Click on the  button (  ) next to the  drop-down list.Edit materials Material
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Select the real part of the conductivity and copy the value to the clipboard 
using Ctrl-C

Type "Cond" as value in the conductivity field.

Click .OK

Click in the white area that surrounds the picture of the substrate stack-up. 
We can see that "Cond" is not defined yet.
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Double click on "Cond" or on "Not defined". The  dialog will Add Variable
open.

Select the Value field and paste the value using .Ctrl-V

Click .OK

We see that the variable has been added in the  dialog.Library Variables
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11.  

12.  Click  to save the changes.OK

Simulation Flows

Simulation Flows

The different components and simulation flows that use technology substrates are

EM simulation from layout

EM simulation triggered by EM Model view or EM Cosimulation view

Line Type Components

Controlled Impedance Line Designer
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EM Simulation from Layout

At the start of an EM simulation, the substrate will be evaluated using the variable 
values assigned in the defaults designs.

It is not allowed to use a cell parameter in a substrate or material. If a cell 
parameter has the same name as a variable used in the substrate or material 
there will be an error message. Either the cell parameter or the variable will 
have to be renamed.

EM Simulation triggered by an EM Model View or EM Cosimulation View

Variables defined in a defaults design can be used in expressions in substrate and 
material parameters. By sweeping these variables, you can sweep over substrate 
parameter values in an EM/Circuit co-simulation. Also optimizations and statistical 
simulations are possible.

Creating and Using an EM Model View is done in the same way as for substrates 
that do not use variables.

The parameters of the EM Model database is the union of the cell parameters and 
the variables used in the substrate and materials. When placing an instance of a 
cell, it is required to only assign values to the cell parameters. The variables used in 
the substrate and materials are passed automatically to the EM Model. The 
Database and Interpolation tab of the EM Model will show which parameters are 
cell parameters and which are variables used in the substrate or materials.

It is not allowed to have a cell parameter with the same name as a variable on a 
defaults design.
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Example

The example workspace examples/Momentum/emcktcosim
/Sweep_Substrate_with_Variables_wrk.7zads illustrates how to sweep the 
thickness or the permittivity of a dielectric in an EM/Circuit co-simulation.

To open this workspace, select  and select MomentumFile > Open > Example
/emcktcosim/Sweep_Substrate_with_Variables_wrk.7zads.

The substrate "sub" uses the variables "H" and "Er" as can be seen after opening 
the substrate editor. The dielectric thickness is "H mil" and the permittivity of the 
material Alumina is "Er".

"H" and "Er" are defined in the defaults design "defaults":
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For more information about how to place variables, see Defining Variables in a 
.Defaults Design

The schematic "Sweep_Substrate_Thickness" has a parameter sweep component 
that sweeps "H" from 2 to 22 with a step of 10. The variable "Er" is not swept and 
thus keeps its value from the defaults design, i.e. 3.

The cell "xline1" does not have cell parameters. It uses the substrate "sub". As a 
result, "H" and "Er" will become the parameters of the EM Model database.

The schematic simulation will trigger an EM simulation for each value of "H". The 
results are stored in the database of the EM Model and picked up by the circuit 
simulator.
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The schematic "Sweep_Substrate_Dk" is very similar. Here, "Er" is swept from 2 to 
6 with a step of 2 and "H" is kept constant at 25.

Line Type Components

With respect to variables in substrates, Line Type components are very similar to 
components with an EM Model. The variables used in the substrate are passed 
automatically to the simulation model. The Line Type component parameters are 
the same as for a fixed substrate.

Example

The example workspace examples/HSD/ControlledImpedanceLineDesigner_wrk.
7zads illustrates how a channel simulation with Line Type components can be 
performed with varying substrate and material parameters.
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To open this workspace go to the ADS Main Window and choose File > Open > 
 and select HSD/ControlledImpedanceLineDesigner_wrk.7zads.Example

The folder "03_Pre_Layout_Substrate_Variables Channel Design" contains two 
example schematics.

'Channel_Simulation_Substrate_Variables' analyzes a single-ended serial 
channel. The thickness of the microstrip's dielectric is varied to analyze the 
impact on the eye opening at the pre and post equalization stages.

'X-Talk_Simulation_Substrate_Variables' analyzes the same channel with 2 
aggressor microstrip lines running in parallel. Tuning of the line spacing, 
dielectric thickness, Er and tanD allows to quickly see the impact on the eye 
opening.

The substrate "6_Layer_Substrate_With_Variables" uses the variables "H", "Er" and 
"tanD" as can be seen after opening the substrate editor. The dielectric thickness 
between ETCH_TOP and SLOT_L2_GND is "H mil" and the permittivity and loss 
tangent of the material FR_4_Var are "Er" and "tanD", respectively.

The schematic "Channel_Simulation_Substrate_Variables" has a Batch Simulation 
component that varies "H" from 2.8 to 4.8 with a step of 0.5. The variables "Er" and 
"tanD" are not swept and thus keep their value from the variable definition, i.e. 4.3 
and 0.03 respectively.
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The variables used in the substrate and materials are not visible on the schematic 
in contrast with the line_width variable. To shortest way to access them is by 
opening the Simulation Variables Setup: .In Simulate > Simulation Variables Setup...
this dialog the value and tuning, optimization, ... settings of all variables and 
component parameters can be set.

The two LTLINE1 components model a microstrip with a signal line on ETCH_TOP 
and SLOT_L2_GND as ground plane. This is shown in the component parameter 
dialog and in the Line Type edit dialog. We can observer that Thickness_2 is "H mil"
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The schematic simulation will trigger a channel simulation for each value of "H". 
The results are displayed in the datadisplay as below. We see how the dielectric 
thickness modifies the eye size.
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The second example "X_Talk_Simulation_Substrate_Variables" is very similar. Here, 
the substrate and material variables are tuned in addition to the spacing between 
the central signal line and the two aggressors.
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Controlled Impedance Line Designer

The nominal value of variables in the Controlled Impedance Line Designer is 
initialized by evaluating the expressions in the substrate and materials.

The  option will only fill in constant Update Substrate/Material Parameters
numbers in the substrate and materials. It will not modify the value of variables 
in defaults designs.

Update EM Model Database when Parameter Set is Modified

Update EM Model Database when Parameter Set is Modified

The EM Model database items are indexed with the values of the cell parameters 
and the variables used in the substrate. When adding a variable to the substrate, or 
removing one, the database of the EM Model needs to be updated to correspond 
with its new parameter set. This is possible without loosing all the simulation 
results stored in the database.This will be illustrated with a simple example.

Open the following example:

Examples/Momentum/emcktcosim/Sweep_Substrate_with_Variables_wrk.7zads

This example contains a substrate that depends on the variables H and Er. After 
running the simulation in the schematics Sweep_Substrate_Dk and 
Sweep_Substrate_Thickness, the EM model is populated as shown in the following 
figure:
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By sweeping Er, you can analyze the impact of variations in the permittivity of the 
dielectric material.

Removing a Variable

If you do not want to analyze the impact due to variations in the material parameter 
Er, replace the value of the permittivity of the material with its fixed value.

Now, if you open the EM model, or start a simulation that uses it, the following 
message box is displayed:
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If you click , all simulation data in the EM model database will be lost.No

If you click , the following dialog box enables you to select the data you want to Yes
keep. In this example, the value of permittivity is modified from Er to 3. Therefore, 
you need to keep the simulation results that were done for Er=3.

After clicking , the EM model database is updated, as shown in Update Database
the following figure:
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Adding a Variable

If you want to analyze the impact of variations in the loss tangent of our dielectric, 
replace the  loss tangent column of our dielectric material with .0 tanD

Since there is no variable with the name tanD, the following message is displayed 
after closing the material editor.

Click  and assign value  to the variable, which corresponds with the value the Yes  0
loss tangent had in all our simulations run until now.
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Click  to create the variable and save the variables and the substrate.OK

Now, if you open the EM model, or start a simulation that uses it, the following 
dialog box is displayed:

If you click , all simulation data in the EM model database will be lost.No

Clicking  the following dialog box enables you to enter which value of the new Yes
EM Model parameter, tanD, corresponds with all the simulation results saved in the 
database. Enter 0, since you replaced the fixed value 0 with the variable tanD.

After clicking , the EM model database is updated as follows:Update Database
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Dielectric Substrate Modeling

Dielectric Substrate Modeling

This section provides information about the following dielectric parameters:

Dielectric Permittivity

Dielectric Loss Tangent

Dielectric Conductivity

Dielectric Relative Permeability

Dielectric Magnetic Loss Tangent

Dielectric Permittivity

The relative permittivity of all dielectrics is as follows:

 

which can also be expressed as:

 

where ε' is the real portion of ε and ε''/ε' is the dielectric loss tangent.

Examples of materials and their typical permittivity are shown in the following table:

Material Relative Permittivity
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Material Relative Permittivity

Alumina 9.8

Sapphire 9.3 - 11.7

Berrylia 6.0

Rutile 100.0

GaAs 12.9

The values listed in the table are for illustrative purposes only; use values 
specifically measured for the materials that you are using.

Dielectric Loss Tangent

The dielectric loss tangent associated with a material is a function of frequency. 
Examples of dielectric loss tangents for 10 GHz fields are shown in the following 
table:

Material Dielectric
Loss Tangent

Alumina .0002

Glass .002

Berrylia .0001

Rutile .0004

GaAs .0016

These values are listed for illustrative purposes only. Use values specifically 
measured for the materials that you are using.

Dielectric Conductivity

For some materials (for example, Silicon), the substrate loss effects are better 
described using the combination (ε' , σ = conductivity) instead of (ε' , loss tangent). 
The complex dielectric constant is related to (ε' , conductivity) using the following 
formula:
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where:

 = 2  ω π frequency

 = 8.85e-12 F/m (absolute dielectric constant free space)ε0

Often, resistivity ( ρ ) is specified instead of conductivity. The relationship between 
resistivity and conductivity is as follows:

 

Resistivety is usually specified in Ω cm, conductivity is specified in S/m.

Example:

A typical value for resistivity of a Silicon material is as follows:

ρ = 10  Ω cm

which corresponds to a conductivity value of the following:

 = 10 S/m.σ

Dielectric Relative Permeability

The relative permeability of all dielectrics is assumed to be complex:

 

can also be expressed as:The relative permeability 

 

where μ' is the real portion of μ and μ''/μ' is the magnetic loss tangent.

Examples of relative permeabilities are listed in the following table:

Material Relative Permeability

Gold .99996

Air 1

Aluminum 1.00002

Nickel 250

Iron 4000

The values listed in the above table are for illustrative purposes only. Use 
values specifically measured for the materials that you are using.
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Dielectric Magnetic Loss Tangent

The magnetic loss tangent associated with a material is a function of frequency. An 
example of a material with a magnetic loss tangent is polyiron which, at 30 GHz, 
has a loss tangent of 0.0208.

Generating Thermal Technology Files Using Substrate Editor

Generating Thermal Technology Files Using Substrate Editor

To create , you can consider the following options:thermal technology files

Define the thermal technology in text editor. This makes the thermal 
technology files generation process less intuitive, time-saving, and less error-
prone.

Define the thermal technology in UI. This is the recommended option.

This section describes the option 2. Let us look at an example. The thermal 
technology file consists of the following files:

streamLayerTable.txt

heatLayers.cfg

tech.tcl

user_tech.tcl (optional)

Here is a sample  file:tech.tcl

#{name thickness(m) bkgnd-material {layer1 material1}...
{lyrN matN}}
    set  layerList {        
      { substrate  100.000e-6  GaAs               
{Layer10 Au}   }
      { mesa       0.978e-6  Si3N4 {Layer01 GaAs} 
{Layer02 NiCr} }
      { nicr       0.022e-6  Si3N4 {Layer01 GaAs} 
{Layer02 NiCr} } }
# {name volumetric-heat-capacity in J/(K*m^3) = c*d }
    set materialCvList {   
      { GaAs       1.73e6 }  
      { Si3N4      2.75e6 }  }

You do multiple calculations to slice layers when multiple processes are laterally 
juxtaposed, as in a multi-technology or nested-technology setup.

In contrast to the option 1, the option 2 offers the following advantages:

The Substrate Editor generates the thermal technology files (all three files) 
directly using a thermal substrate.

http://edadocs.software.keysight.com/display/ads2017/PDK+Files
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You can define the substrate that represents the thermal cross-section, the 
thermal properties in the material database, and the heat sources.

You can export the thermal technology files from a substrate after ensuring 
that all the layers with relevant thermal information are defined in the 
substrate. The technology files are manually editable if required for 
customizations.

You can map the layers that are important for thermal simulation in the top 
technology for multi-technology setup.

To avail these advantages, you must meet the following prerequisites.

Prerequisites

To use this option efficiently, you must be familiar with:

ADS Substrate Editor Terminology

Thermal Technology

Generating Thermal Technology Files

The process of generating the thermal technology files involves the following steps:

Define Substrate. See .Defining Substrates

Specify the following thermal properties in Material Definition Dialog:

Conductivity (W/mK)
Measure of a material's ability to conduct or transfer heat. It varies 
with temperature.

Heat Capacity (J/m^3*K)
Ability of a given volume of a substance to store internal energy while 
undergoing a given temperature change, but without undergoing a 
phase transition.

e- Mean Free Path (m)
Average distance traveled by a moving electron between successive 
impacts which modify its direction or energy or other properties.

Identify the heat source layer in the layout. An additional set of layers is 
added to the layout for the heat source. You must have a layerItem in the 
substrate whose process role is heat source. In this case, MyHEAT is the 
“outname” that is used for the third (and fourth) column of heatLayers.

 file.cfg

Define temperature dependent property material database. Use the 
user_tech.tcl file that allows you to add custom tcl variables for material 
properties and use these variables later in the Substrate Editor. The file must 
be saved in the THERMAL_DIR directory.

Specify the layer mask precedence.
Precedence for layer in the substrate reflects in thermal technology as well. 
Higher is the number, higher is the precedence. If there are two shapes at 
the same location (say, M0anM1), the thermal properties of the layer with 
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higher precedence are used. The other layer is ignored (at that particular 
location). You can control this behavior by setting the precedence of the 
layer and/or via objects in the substrate. For example, if a layer has M0 and 
M1 and user needs M1 to take precedence, then M1 precedence number 
must be greater than M0 precedence number (say M0 take 0 as default and 
M1 is set to 1).

 Thermal tech output -> sub M1 metal1 {M0 Metal0}M1 [1] > M0 [0]

 Thermal tech output -> sub M0 metal0 {M1 Metal1}M0 [1] > M1 [0]

Select File > Export > Thermal Tech file from the substrate window.
Currently, there is no UI, so the three files (tech.tcl, streamLayerTable.txt and 
heatLayers.cfg) are created in the workspace directory.

Now, you can choose the exported tcl file for ElectroThermal Simulation.
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Ports

Ports

Ports Overview

Viewing Ports

Defining Ports

Ports for Momentum

Ports for Momentum Overview

Applying TML Ports Calibration in Momentum

Applying SMD Port Calibration in Momentum

Applying Delta Gap Port Calibration in Momentum

Ports for FEM

Ports Overview

Ports Overview

Before an electromagnetic simulation can be performed on a design, you need to 
define points of excitation/measurements on your design. These points are 
identified in ADS using ports. A port is a set of two terminals on the layout at which 
ADS computes the circuit impedance, etc. Momentum and FEM generate an N-
port S-parameter model for your circuit. The S-parameter ports define where 
energy can enter or leave the structure. They are also required to connect the 
physical structure with other electrical circuit components in a circuit/EM co-
simulation.

A port (  ) always consists of two terminals, a  terminal (signal) and  terminal 
(reference). The port terminals make a connection with the layout through one or 
more layout pins (  ). Current will enter or leave the structure through the layout 
pins. The port voltage will be measured between the two terminals of the port.
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Using the Port Editor window, you can edit, view, and set up ports and layout pins 
in an EM simulation. This window consists of two panels S-parameter Ports and 
Layout Pins:

Layout Pin: Specifies a location in layout, either point, edge or area.

S-parameter Port: Specifies a circuit port connecting two Layout Pins

Layout Pins

The physical size of a layout pin depends on the location of the pin symbol (  the 
top of the arrow) in the layout. A layout pin can be a point, an edge or an area pin.

Point pin: the pin symbol is inside a metal shape. Current can enter the 
structure through this point or a small area around it. The EM simulator will 
determine that.

Edge pin: the pin symbol is at an edge segment of a metal shape. By default, 
the size of the edge pin will be all collinear segments. Current can enter the 
structure through the edge segments. The entire edge is forced at the same 
electric scalar potential.

The size of an edge pin can be limited by explicitly associating a polyline 
with the pin. See  to learn how to create such pins.Using Edge and Area Pins

http://edadocs.software.keysight.com/display/ads2017/Artwork#Artwork-UsingEdgeandAreaPins
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An edge pin can be defined internal to a metal shape.

FEM does support edge pins when the edge is a line segment. Arcs and 
polylines with two or more segments are not supported. A point pin, at the 
location of the pin symbol, will be used for the unsupported edge pins.

Area pin (Momentum only): the pin symbol is internal to a metal shape and a 
(polygon) shape has been associated with the pin. See Using Edge and Area 

 to learn how to create such pins. Current can enter the structure Pins
through the area. The entire area is forced at the same electric scalar 
potential.

ADS FEM does not support area pins. The cylinder ports are created 
automatically and does not depend whether an area pin is defined or not, i.e., 
these ports are created even if the pin is not an area pin. The generation of 
cylindrical ports is automated, as it has better behavior related to the parasitic 
port effects. For any port (pin) that is in the middle of some metal, cylindrical 
port are created and its size is determined automatically. It can be referred as 
an ‘automated area pin’. Therefore, “wire” ports no longer exist in FEM. You 
cannot control the size and it does not depend on the area size defined by area 
pin

http://edadocs.software.keysight.com/display/ads2017/Artwork#Artwork-UsingEdgeandAreaPins
http://edadocs.software.keysight.com/display/ads2017/Artwork#Artwork-UsingEdgeandAreaPins
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S-parameter Ports

The port current flows from the + terminal into the circuit and leaves the circuit via 
the - terminal. The port voltage is defined as the difference of the electric scalar 
potential between the two terminals:

Vp = V(r+) - V(r-)

The scalar potential V(r) at infinity is zero. S-parameters model the difference in 
voltage between the + and - terminal only. One never knows the absolute voltage 
of the reference terminal(s). On a schematic, an N-port S-parameter model can 
have either N+1 or 2N terminals. The two are equivalent because you don't know 
the absolute voltage at any of the N reference terminals. It doesn't matter if you 
short them all together or not. In case of a symbol with 2N terminals, only the 
voltage difference will be applied to the S-parameter model.

While the + terminal is always explicitly defined, the - terminal can be defined in 
the following ways:

When there is an infinite ground plane, the - terminal is implicitly located in 
the infinite ground plane closest to the + terminal.

In the absence of an infinite ground plane, the - terminal needs to be 
explicitly defined somewhere close to the + terminal.

For , when there is no explicit – terminal defined and no Momentum
infinite ground plane, the port voltage is defined as the value of the 
electric scalar potential at the + terminal: Vp = V(r+). You can rewrite 
this as follows:
Vp = V(r+) – V (at infinity)
Therefore, you can consider infinity as the location of the implicit - 
terminal for this case.

For , - terminals need to be defined in all cases in absence of an FEM
infinite ground.

Caution must be taken when making a connection with a port that has an 
explicit reference terminal. Incoming current through the plus terminals must 
be the same as the current leaving through the minus terminals. Only pure 
differential components can be connected between the + and - terminals. 
There should be no shunt path that allows current to leak to ground or other 
components. If this requirement is violated, S-parameter data will be useless.

Defining Ports

Defining Ports

Ports are defined in a two-step process:

Add layout pins in the circuit layout. These pins define the places where 
current can enter or leave the circuit. You can also import pins from other 
designs.
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Specify how the layout pins are used to define S-parameter ports in an EM 
simulation by using the Port Editor window.

Adding Pins to a Layout

A pin can be applied at the midpoint of the edges of a component or object (such 
as a rectangle or polygon), usually at the midpoint or at the surface of an object. To 
add a pin:

Select  >  or click the Pin icon from the toolbar.Insert Pin

Position the mouse where you want the port and click. Verify that the 
connection has been made.

For more information about adding pins, see , Using Edge and Area Pins Edge and 
, and .Area Pins Designating Edge and Area Pins

Use Layout Pins to Define S-parameter Ports

To define S-parameter ports:

Open the Port Editor window.

Create connections between the terminals of a port.

Specify Feed Type.

Specify Reference Impedance.

Open the Port Editor

To define ports, open the Port Editor by using one of the following ways:

From a Layout window:

Select  >  orEM Port Editor

Click the  icon (  ) on the EM Toolbar.Port Editor

From an EM Setup window:

Select  in the left pane of the EM Setup window.Ports

Click  to open the Port Editor.Edit

Port definitions are stored with the layout. The Layout window will open along with 
the Port Editor dialog.

http://edadocs.software.keysight.com/display/ads2017/Artwork#Artwork-UsingEdgeandAreaPins
http://edadocs.software.keysight.com/display/ads2017/Physical+Connectivity+Engine#PhysicalConnectivityEngine-EdgeandAreaPins
http://edadocs.software.keysight.com/display/ads2017/Physical+Connectivity+Engine#PhysicalConnectivityEngine-EdgeandAreaPins
http://edadocs.software.keysight.com/display/ads2017/Creating+a+Layout+Manually#CreatingaLayoutManually-DesignatingEdgeandAreaPins
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The port definitions are stored in a layout.

If any layout change occurred since the dialog was opened the 
refresh button will be orange Pressing it will refresh the port 
definition display but only modify it if the layout change affected 
the ports

Multiple EM Setup views for a given Layout view will share the 
same port definition.

It is recommended to enable the Save all designs when 
simulation starts under Design Management in the Main 
Preference dialog box that can be opened from the ADS Main 
window,  > .Options Preferences

Show me How Do I Define Ports

 How to Define Ports

http://youtu.be/gFJxg8CWHx0
http://youtu.be/gFJxg8CWHx0
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Port Editor window Overview

S-Parameter Ports

The S-Parameter Ports section displays the plus and minus terminals of a port. The 
name besides the plus and minus pins specifies the pin name that is connecting 
with these terminals. The following table describes the S-parameter Ports fields:

Field Description

Number Specifies the S-parameter port number.

Gnd Layer Only applicable for ports with a '  minus pin! Specifies the name of the layer where a Gnd'
reference pin will be inserted automatically during the EM simulation flow.

Name Specifies the name of the first positive pin added. You cannot edit a port name.

Feed Type Allows you to select a feed type: TML, TML (zero length), SMD, DeltaGap, or None. For more 
information, see .Specify Feed Type

Ref 
Impedance 
[ Ohm]

Specifies the reference impedance value in ohms.

Ref Offset [ 
mil]

Specifies the Ref Offset value (shown in layout units).

Term Type No longer in use.

Layout Pins

The Layout Pins section displays the list of unconnected pins. You make 
connections between the positive and negative terminals of the port and layout 
pins by dragging/dropping layout pins For more information, see Create 

. The following table describes the Layout Pins fields:Connections

Field Description

Name Specifies the layout pin name.

Layer Specifies the layer name.

Net Specifies the net name.

Connected To Specifies the connecting terminal name.

Purpose Specifies the purpose.
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Field Description

X [ mm] Specifies the X axis value (shown in layout units).

Y [ mm] Specifies the Y axis value (shown in layout units).

Number Specifies the number.

Layer Num Specifies the layer number.

Purpose Num Specifies the purpose number.

Pin Type Specifies the type of pin used in the design.

Refreshing layout pins and S-parameter ports information

Click Refresh pins and ports (  ) to update the list of pins and ports with the 
latest information in the Layout window.

Automatically creating new ports

Click Auto-create new ports (  ) to automatically generate one port per pin in 
the S-parameter Ports. You can edit the port list as per your requirements.

Creating new ports

To manually create a new port, click Create New Port (  ) in the Ports toolbar. 
Then, select the required layout pins in Layout Pins and drag and drop them on the 
positive or negative terminal of the port to make connection.

There must be an unconnected pin in the layout pins to create a new port.

Setting the Minus Pin

Specifying a minus pin appropriately is critical for EM simulation: it determines the 
return path of the current.

You can either set it manually (see Create connections between the terminals of a 
) or automatically.port.

There are two ways to set the minus pin automatically:

By Layer

If no explicit layout pin is assigned to the minus pin of the port,  will be Gnd
displayed. In this case you can dedicate a layer where the EM engine will auto-
create pin(s) on that layer by copying the properties (except the layer) of the pin(s) 
assigned to the + terminal of the port. If you have not dedicated a specific layer 
<Implicit> will be shown as the Gnd layer. For Momentum, not using <Implicit> 
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means that the substrate will define the return path of the current. This is normally 
OK if the substrate itself has a cover or contains a slot plane. If this is not the case 
Momentum will warn you that its results may not be accurate due to numerical 
problems and advise you to set the minus pin.

By Pin

You can search a pin on the following parameters:
This search is done based on the preferences that you can specify in the dialog. 
You can choose search type from “Net”, “Layer:Purpose” and “Within”. ( 
Combination of them is allowed. In case these are used with combination, it means 
“AND”. )

Net: Search will be limited to pins only on specified net.

Layer:Purpose: Search will be limited to pins on specified Layer:Purpose.

Within: Search will be limited to pins within a certain distance from plus pin
(s). ( In case you have multiple plus pins, center of gravity of plus pin 
coordinates is used.)

To assign a minus pin:

Click the   .Set Nearest Minus Pin

Select a Minus Pin Candidate option:  or All non-used Pins All non-used Pins 
.with Restriction

Search appropriate pins for the minus terminal of ports that do not have an 
explicit minus pin.

Assign the pin to all ports or selected ports.

Click .OK

Deleting ports

To delete the selected ports in S-Parameter Ports, click Delete selected items (  
) in the Ports toolbar.
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The port number will always be retained in sequence.

Resequencing ports

Click Resequence Ports (  ) to open the Reorder Port Numbers window. From 
the Reorder Port Numbers window, select the required port and click the Up and 
Down keys to change the ports sequence according to your requirements.

Expanding S-parameter ports tree

To display the detailed information about each port in S-Parameter Ports, click 

Expand S-parameter Ports tree (  ).

Collapsing S-parameter ports tree

To hide the details of ports in S-Parameter Ports, click Collapse S-parameter Ports 

tree (  ).

Searching the required information

For easy filtering and sorting commands, click Toggle Search Filter On/Off (  ). 
Type the required string in the Search text box. In the Layout Pins panel, you can 
also right-click any required field and select Set texts to filter. This option picks up 
the text of current item in Layout Pins and sets it in the filter, as shown in the 
following figure:

Viewing Controls

You can specify how pins are selected in a layout by selecting one of the following 
options:

Auto select: Selects pin(s) automatically.

Auto center: Selects pin(s) from the center.

Auto zoom: Increases the layout window zoom to the selected pin(s).

Create Connections between the Layout Pins and Terminals of a Port

You can create a connection between the positive (  ) and negative (  ) terminal 
of the port and layout pins by dragging/dropping layout pins. To create a port:

Select a pin row in . For example,  row is selected in the Layout Pins P2
following figure:
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Drag the pin from Layout Pins and drop it on the  or  terminal of the 
required port in . For example, P2 is dragged and dropped S-parameter Ports
on the - terminal of  in the following figure:Port1

To specify a minus pin automatically, use the  Set Nearest Minus Pin
option. For more information, see .Set Nearest Minus Pin Automatically 

A message box is displayed if your target pin is already used by other ports.
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4.  Click in the message box.Delete Ports and Continue 

You can drag and drop multiple layout pins and connect with a S-
parameter port.

Caution must be taken when making a connection with a port that has an 
explicit reference terminal! Incoming current through the plus terminals must 
be the same as the current leaving through the minus terminals. Only pure 
differential components can be connected between the + and - terminals. 
There should be no shunt path that allows current to leak to ground or other 
components. If this requirement is violated, S-parameter data will be useless.

Specify the Feed Type

The default Feed Type is  The EM simulator will automatically determine the Auto.
most appropriate port feed mechanism. The  feed type will be treated in the Auto
EM simulators (Momentum and FEM) as  feed type, except for Momentum Direct
ports on slot layers which will be treated as  feed type ports.TML

The  feed type connects the source directly at the S-parameter port terminal Direct
pins. It is the simplest way to feed a structure. By selecting another feed type, you 
can add or remove a particular effect of the feed mechanism. This is known as 
'calibration'. Calibration in simulation is distinct from what you do in 
measurements. The source in a measurement setup is in the measurement 
instrument and, by calibrating, you want to remove the effect of everything in 
between that source and the DUT. In simulation, you can position the source 
directly at the right location. By calibrating, you can add or remove an effect of the 
feed.

The following types of calibration are available:
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The calibration is only applied for ports that connect to pins that are on the edges 
of a conducting shape. In case the pin is internal to a conducting shape, no 
calibration process will be performed by the EM simulator. The following table 
describes the feed types used in Momentum and FEM. For more details, refer to 
respectively  and .Ports for Momentum Overview Ports for FEM

Feed 
Type

Momentum FEM

Direct If none of the available feed types is valid for 
the connecting component, specify Direct. 
Depending on placement, this will excite 
either an edge or a point and will include self-
induced parasitics.

If none of the available feed types is valid for the 
connecting component, specify Direct. Depending 
on placement, this will excite either an edge or a 
point and will include self-induced parasitics. 
When placed on an edge, a sheet port is created 
that inherits the edge widths at the + and – pins.

TML This feed type assumes the structure is fed 
through a transmission line. The open end 
effect is removed. Mutual coupling between 
parallel feed lines is removed, but mutual 
coupling induced by the feeding transmission 
line to the rest of the structure is added.

This feed type assumes that the structure is fed 
through a waveguide and enforces the waveguide 
mode field distribution at the port. The feedline is 
fully calibrated.

TML 
(zero 
length)

This feed type removes the open end effect 
through an RLC lumped-element calibration.

The TML (zero length) option is automatically 
converted to TML calibration for FEM. No unique 
calibration technique for TML (zero length) exists 
for FEM.

SMD This feed type is defined across a physical gap 
in the layout artwork. It removes the open-end 
effect at the port and adds the mutual 
coupling between the current flowing from the 
+ to – pins and the rest of the circuit, 
assuming the area between both pins would 
be filled with metal.

While the reference offset specification is ignored 
for this option in FEM, a sheet port is created with 
calibration that removes the self-inductance effect.

Delta 
Gap

This feed type is defined across a physical gap 
in the layout artwork. It adds the effect of 
metal filled in the area between the + and – 
pins of the port. A gap in the middle remains 
during the calibration process for the source 
connection.

The Delta Gap option is automatically converted to 
SMD calibration for FEM. No unique calibration 
technique for Delta Gap exists for FEM.

The global scope calibration setting available in 2016.01 is deprecated in this 
version. If a design with a global scope is found its value will be forwarded as 
the Feed Type for each port.
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To assign a feed type:

Open the Port Editor window.

Click  . The  dialog box is shown:Specify the Port Feed Type

Select a  from the drop-down list.Feed Type

Select an option for applying the setting to  or .All Ports Selected Only

Click .OK

Reference Offset

The calibrated ports enable you to shift the location of the reference lines used for 
the S-parameters. In TML, TML (zero length) or SMD calibration, you can 
additionally shift the reference plane over a certain distance. The transmission line 
(Momentum) or waveguide (FEM) effect will be removed (offset > 0) or added 
(offset < 0).

Specifying a positive reference offset: Shifts the reference planes in the 
direction towards the circuit, as shown in the following figure:

Specifying a negative reference offset: Shifts the reference planes in the 
direction away from the circuit, as shown in the following figure:
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Why Use Reference Offsets?

The need to adjust the position of ports in a layout is analogous to the need to 
eliminate the effect of probes when measuring hardware prototypes. When 
hardware prototypes are measured, probes are connected to the input and output 
leads of the Device Under Test (DUT). These probes feed energy to the DUT, and 
measure the response of the circuit. However, the measured response 
characterizes the entire setup, that is, the DUT plus the probes. This is an 
unwanted effect. The final measurements should reflect the characteristics of the 
DUT alone. The characteristics of the probes are well known, so measurement labs 
can mathematically eliminate the effects of the probes, and present the correct 
measurements of the DUT.

There are significant resemblances between this hardware measurement process 
and the way Momentum and FEM operate. In the case of Momentum and FEM, the 
probes are replaced by ports, which, during simulation, will feed energy to the 
circuit and measure its response. The port feeding scheme also has its own, 
unwanted effect: low-order mode mismatch at the port boundary, although this is 
eliminated by the calibration process.

However, for a calibration process, it is necessary that the fundamental mode is 
characterized accurately. This can only be accomplished when the distance 
between the port boundary and the first discontinuity is sufficiently large, that is, 
there exists a feed line that is long enough to provide this distance.

As a basic example, consider a line width that varies abruptly in some part of your 
circuit, as shown in the following figure:

You need to characterize only the variation of the step-in-width itself, as shown in 
the following figure:



229 Electromagnetic

As mentioned previously, it takes a little distance for the fundamental mode to 
settle, which means that this  structure might not yield the accuracy that you short
expect from the simulation. In this case, allow for some feed line length, as shown 
in the following figure:

Now, the simulation will yield accurate results, but the results will also contain the 
extra line lengths. To resolved this issue, use reference offsets. Although, the circuit 
has been calculated with the long lines, reference offset shifting allows you to 
produce the S-parameters as if the short structure had been simulated instead, as 
shown in the following figure:

The effect of the extra feed lines is mathematically eliminated from the S-
parameter solution. This process of adding or subtracting line length is generally 
referred to as de-embedding. During the solution process, the impedance and 
propagation constant has been calculated for the ports, based on their physical 
location in the circuit. When you know the impedance, propagation constant, and 
the distance of de-embedding, you can cancel out the extra lengths of line from the 
S-parameter results, by compensating for the loss and phase shifts of those lines. 
The net result is a set of S-parameters, calculated as if the extra line lengths were 
not there.

De-embedding Considerations

It is possible to de-embed up to the discontinuity itself. However, make sure that 
you do not shift the reference offset beyond the first discontinuity. This would yield 
incorrect simulation results, as there is another line width beyond that 
discontinuity, which means that there is another set of impedance and propagation 
values that applies there.

Specify Reference Impedance

A reference impedance is needed for each port to compute the S-parameter model. 
By default, the reference impedance is 50 Ohm. To modify the reference 
impedance:
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Click once in the  column in the S-parameter Ports Ref Impedance (Ohm)
panel, as shown in the following figure:

Specify the required values in the Ref Impedance (Ohm) field.

Customizing Ports Options

Copy/Paste Port Properties

You can also copy the value of an S-parameter Ports field and paste it on multiple 
fields. This enables you to update multiple S-parameter Ports fields. This applies for 
reference impedance, calibration type and reference offset.
To copy/paste values:

Edit the required S-parameter Ports field.

Right-click and copy the value that you have edited in the field.

Select the fields for updating the copied value.

Right-click and paste the value on the selected fields, as shown in the 
following figure:

Selecting S-Parameter Ports Title Fields



231 Electromagnetic

1.  

2.  

3.  

1.  

Selecting S-Parameter Ports Title Fields

You can select the required heading fields in S-parameter Ports by performing the 
following steps:

Right-click the title bar and then select . This opens the View Option View 
 dialog box, as shown in the following figure:Option

Select the required fields.

Click .OK

Using Layout Pins

Creating Ports with Selected Layout Pin

In the Layout pins panel, you can create port in the following ways:

Creating a port with selected pins: Right-click the required layout pin and 
select . It creates a port with the selected layout pin.Create Ports

Creating a port with clustering pins: Right-click the required layout pin and 
select . It creates a port with all selected Create a Port with clustering pins
layout pins for the plus pin of a S-parameter port.

Selecting the Layout Pins Title Fields

You can select the required heading fields in Layout Pins by performing the 
following steps:

Right-click the title bar and select . This opens the  View Option View Option
dialog box, as shown in the following figure:
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The Tool-related parameters such as Name (from Tool) are available 
only when the pins are imported through Allegro ADFI. Otherwise, these 
parameters are shown as , if you try to select in the View Option N/A
dialog box.

Select the required fields.

Click .OK

You cannot edit the layout pin properties, as these are read-only fields.

Hiding Layout Pins

You can hide the layout pins that are connected to S-parameter Ports by selecting 
the  check box. The layout pins that are connected with Hide connected layout pins
S-parameter Ports are hidden in the Layout Pins panel. For example, if all layout 
pins are connected to S-parameter ports, no layout pins are displayed in the layout 
pins panel.

The following figure highlights the  check box:Hide connected layout pins

Displaying Hidden Layout Pins
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Displaying Hidden Layout Pins

You can display the layout pins that are connected to S-parameter Ports by 
deselecting the  check box. The layout pins that are Hide connected layout pins
connected with S-parameter Ports are hidden in the Layout Pins panel. For 
example, if all layout pins are connected to S-parameter ports, no layout pins are 
displayed in the layout pins panel.

See Also
Viewing Ports
Ports for Momentum
Ports for FEM

Ports for Momentum

Ports for Momentum

Ports for Momentum Overview

Applying TML Ports Calibration in Momentum

Applying SMD Port Calibration in Momentum

Applying Delta Gap Port Calibration in Momentum

Ports for Momentum Overview

Ports for Momentum Overview

The port setup determines how the structure is excited. The source excitation 
mechanism is specific to the EM simulator that is used. In this chapter, details 
about the Momentum source excitation mechanism are provided.

Momentum connects a voltage source with series source impedance between the + 
and - terminal of each port. Then, it will solve the structure for as many 
independent excitation states as there are ports (N). For each excitation state, the 
source amplitude at a particular port is set to 1 Volt and all other ports are 
terminated by their source impedance. The S-parameters can be computed from 
these N solutions.

Port Size Restriction

Due to the lumped character of the source used by Momentum, there are two 
restrictions with regard to the port size. A first has to do with the distance between 
the + and – terminal. The other has to do with the physical size of the pins. Failing 
to comply with these restrictions may lead to unphysical S-parameters.

In the source, electric current flows from the – to the + terminal without delay. This 
is a valid assumption only when the distance between the + and – pins (or infinite 
ground plane) is electrically small. Rule of thumb is that the physical distance must 
be smaller than 1/10 of the wavelength at the highest frequency.
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Momentum enforces a constant potential over the entire edge or area pin. This 
assumption is only valid when the length of the edge pin or the diameter of the 
area pin is electrically small. Rule of thumb is that the size is smaller than 1/10 of 
the wavelength at the highest frequency.

To comply with these restrictions in case of a circuit without infinite ground 
plane in the substrate:

S-parameter ports should always be defined between two 
explicit layout pins, or

The S-parameter model (which can be unphysical because the 
reference of the ports is at infinity) should only be used in a 
circuit schematic with sources and loads connecting pins that are 
electrically close.

What's the Port Feed Type

In a Momentum simulation, by specifying the port feed type you want to  or add
 a specific effect of the feed.remove

In case you choose 'Auto' as the feed type, Momentum will auto-determine one of 
the feed types described below from the layout of the port terminal pins.

In case you choose 'Direct' as the feed type, the source will be directly connected 
at the S-parameter port terminal pins. By choosing another feed type, you can add 
or remove a particular effect of the feed mechanism. The following feed types apply 
only for ports that connect to pins that are on the edges of a conducting shape. In 
case at least one pin of a port is internal to a conducting shape, no feed effects can 
be added/removed.

TML: Assumes the structure will be fed through a transmission line. This 
calibration type removes the open end effect and adds the mutual coupling 
induced by the current flowing on the calibration feed line.

TML (zero length): Removes the open end effect. Nothing gets added.
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SMD: Removes the open end effect and adds the mutual coupling between 
the current flowing from the + to – pins and the rest of the circuit assuming 
this current flows through extended feed lines from + and - pin that are 
joined in the middle.

Delta gap: Extends the + and - pin with feed lines that are joined in the 
middle of the gap with the source. This adds the effect of metal filled in the 
area between the + and – pins.

Direct: The source will be directly connected at the S-parameter port 
terminal pins.

Direct Feed Ports

The simplest setup is to not add/remove any feed effects. Therefore, set the Feed 
Type to  in the Port Editor. The following figure shows the source excitation Direct
used for direct feed ports, which applies to point (shown on right), edge (shown on 
left) and area pins (not shown here).

Connection to an edge pin

An illustration of how the source is connected for an edge pin is shown below.

The source is connected to all of the edges of the mesh cells generated for that edge pin. 

In the example shown above, there are 3 mesh edges affected by the edge pin. The sum 

of the currents through the pin edges make up the source current. All 3 pin edges are 

forced at the same potential, they are short-circuited.

When an edge pin becomes electrically wide and multiple mesh cell edges make up 
the pin, spurious current loops can be induced as shown below that do not flow 
through the source. When this loop current becomes significant, the simulation 
result with the port left open will be different from the simulation result with the 
port removed.
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Limit the size of the edge pin if you want to avoid such spurious current loops.

Connection to a point or area pin

An illustration of how the source is connected for a point pin is shown below.

The lumped source is directly connected to the node in the equivalent LC network 

corresponding with the cell in the mesh around the point pin. In case of an area pin, one 

or more mesh cells will make up the pin area. The source is connected to all of these 

mesh cells in parallel. The sum of the currents through the cell nodes make up the source 

current. All pin mesh cells are forced at the same potential, they are short-circuited.

In case multiple mesh cells make up the pin, spurious current loops can be 
induced, similar to what was described for edge pins.

Connection to a reference pin

In ADS, any negative – pin can serve as a reference pin, whether it is a local 
potential/voltage reference or a global ground. A direct port connected between a 
+ pin and a - pin is considered to excite the structure in a differential way. The – pin 
is just a reference point for the excitation port. The S-parameters associated with 
direct ports are calculated by exciting the circuit with a lumped voltage source 
connected to the branches in the equivalent LC network corresponding with the 
port edges in the mesh.

Note for direct ports associated with reference pins: ADS uses a lumped voltage 
source to excite the circuit at the direct port + pin and reference - pin 
combinations. Lumped implies that the distance between + pin and - pin is 
electrically small (<  /10) at all frequencies. You can define direct ports associated 
with a reference pin that do not follow this rule. However, you might get unphysical 
simulation data as a result.
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For reference pins associated with direct ports placed either on edges of structures 
or within structures, a lumped source excitation is applied and no feed type 
technique is used. Also, local ground recombination and grouping is applied to the 
associated ports.

Assumptions for reference pins associated with direct ports are:

Same as for direct ports.

The port voltage is referenced to a local ground. The reference points for the 
excitation ports are explicit definitions of the negative terminal of the 
associated port. This explicitly defines a ground return path for the 
uncalibrated port.

A local open end effect is included in the DUT model. This is a result of the 
direct feed being applied to the edge port.

An illustration of the excitation used for structures with this port type is shown in 
the following figure:

In this figure, the direct edge port scenario is displayed on the left side, while on 
the right side is the direct point port scenario. From this connection approach, the 
recombined/grouped S-parameters can be directly calculated. This applies to both 
edge ports (shown on left) and to point ports (shown on right). The direct port is the 
+ pin while the reference point is the - pin of the recombined port. The recombined 
S-parameters are derived from this.

Show me How Do I Define Ports

 How to Define Ports

See Also
Defining Ports

Viewing Ports

Applying TML Ports Calibration in Momentum

Applying TML Ports Calibration in Momentum

If you select the TML calibration, Momentum automatically adds a transmission line 
feed line to the circuit. A source is added at the end of the feed line to excite the 
structure.

http://youtu.be/gFJxg8CWHx0
http://youtu.be/gFJxg8CWHx0
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In case the feed line overlaps with another object in the layout, the port calibration 
type will be changed to 'TML (Zero Length)'. A warning message will be issued 
indicating the change.

A model for the feed structure is extracted from simulating a calibration standard. 
That model allows to deembed the feed structure but leaves the mutual coupling 
effect with the circuit in the S-parameter model.

Applying TML Calibration

The Transmission Line Calibration (TML) technique is used in Momentum for TML 
port positive pin, common, and differential ports.

This calibration technique removes the “open end” discontinuity effects of 
TML mode ports.

This calibration technique is based on extending the ports with finite feed 
lines (uniform transmission lines) of length  /2 at each analysis frequency. 
The characteristic impedance and propagation constant is calculated for this 
line at each frequency.

The extended feed lines are modeled through the simulation of a calibration 
standard.

The effect of the feed lines is removed from the extended circuit simulation 
results.

Extended feed lines are filtering out the (non-propagating) higher-order 
modes excited by the source.

The port model after calibration is valid for a single propagating 
fundamental transmission line mode.

Port with single positive pin

The following figure illustrates how the DUT gets extended with calibration feed 
lines at the input and output pins.

A calibration standard is simulated behind the scenes and the resulting model is 
used to deembed the calibration feed lines.
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Ports sharing the same reference plane

Parallel feed lines of ports that share the same reference plane will be calibrated as 
a group. This is necessary to remove the mutual coupling effect between the feed 
lines.

In case the parallel feed lines do not share the same reference plane, they will be 
calibrated separately. The mutual coupling between the feed lines will not be taken 
into account (is not added to the coupling matrix) when simulating the structure to 
improve the accuracy of the calibration process.

There may be significant coupling between the parallel calibration feed lines that 
are added to the circuit.

A single calibration standard modeling these coupled feed lines is used to deembed 
them.
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Parallel ports not sharing the same reference plane will calibrated individually. The 
mutual coupling between the calibration feed lines will be neglected in the 
computation process .

Common Mode Port

For two or more ports having common polarity, a coupled transmission line (TML) 
excitation is applied and a coupled extended calibration line technique is used. For 
example, two ports having + terminals can be assigned as common ports, as shown 
in the following figure:

TML excitation setup for a DUT with associated common polarity ports attached at 
the input and output

Assumptions for common polarity ports are:

Same as for TML Port positive pin.



241 Electromagnetic

The ports are aligned in the same reference plane and are desired to be 
considered as same-polarity (common-mode) combined ports.

The following figure displays the calibration standard used for structures with 
common ports in the following figure:

From this, the calibrated and recombined S-parameters can be calculated.

Differential, Coplanar or GSG Port

These ports do have one or more explicit reference pins.

For a differential mode port, a coupled transmission line (TML) excitation is applied 
and a coupled extended calibration line technique is used.

TML excitation setup for a DUT with associated differential ports attached at the 
input and output

Assumptions for differential ports are:
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Same as for TML Port positive pin.

The ports are aligned in the same reference plane and are desired to be 
considered as opposite-polarity (differential-mode) combined ports.

Coplanar ports are used specifically for coplanar waveguide (CPW) circuits. It is 
similar to differential ports, but coplanar ports are applied to objects on slot layers.

In case of multiple ground reference pins, a local ground recombination and 
grouping is applied to the associated ports.

The TML excitation setup for a DUT with reference pins associated with a TML port 
positive pin attached at the input and output

Assumptions:

Same as for TML Port positive pin.

The ports are aligned in the same reference plane and are desired to be 
considered as combined ports where the reference pins are explicit 
definitions of the negative terminal of the associated port.
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The TML calibration standard used for a DUT with reference pins associated with 
TML port positive pins attached at the input and output is displayed in the following 
figure:

From this, the calibrated and recombined S-parameters can be calculated.

Source Type Switch for TML Calibrated Ports in Microwave Mode Simulations

The Momentum TML calibration procedure becomes less accurate when radiation 
effects become important. The feed lines added in the Momentum simulation 
process will radiate as well. The radiation by the feed line will be different when in 
combination with circuit versus when in combination with a mirrored equivalent of 
itself as part of the calibration standard. Consequently, the radiation effect of a 
calibration line cannot be perfectly removed.

To lower the radiation of the feed line, above a certain frequency, a floating source 
is used instead of the default grounded source. The displacement current through 
the substrate will ensure a closed loop with the ground. This source type only 
works above a certain frequency because the capacitive internal impedance of the 
source through the substrate blocks the current flow at low frequencies.

For Microwave-mode simulations, the simulator automatically uses a grounded 
source below the quasi-static frequency and a floating source above the quasi-
static frequency (fqs). The quasi-static frequency is chosen automatically by 
Momentum. The simulator switches between source types at the quasi-static 
frequencies to avoid these issues.
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Grounded source excitation

For the grounded source, consider the following factors:

This source is used in Momentum RF for all frequencies.

This source is used in Momentum MW at low frequencies (below ~10 MHz, 
the exact transition frequency is substrate dependent).

This source is a grounded source (connected between the port and the 
ground). The + terminal is connected to port and the - terminal connected 
to ground below port.

This is a "lumped" source. (Based on the assumption that the distance 
between port and ground is electrically small (<  /10), hence yields good 
results at low frequencies down to DC and yields less accurate results at 
higher frequencies where the "electrically small" distance assumption is 
violated. In the RF mode, this assumption should always be met, since it is 
based on a quasi-static approach.)

At some high frequency, when distance between two terminals becomes 
electrically large (substrate thickness >  /10), the grounded source can 
yield unphysical results.

The grounded source can be used from DC to fmax.
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Floating source excitation

For the floating source, consider the following:

This source is used for TML calibrated ports in Momentum MW at higher 
frequencies (above around 10 MHz, the exact transition frequency is 
substrate dependent).

This source is a "floating" source (not physically connected to the ground, it 
is capacitively connected to ground). The + terminal is connected to a port 
and the - terminal connected to the floating local ground.

The distance between two terminals is “lumped” at all frequencies. Hence, 
this source is electrically small (<  /10) at all frequencies by construction; 
however, due to the capacitive connection to ground, it blocks the DC 
current and yields incorrect results at low frequencies (due to breakdown of 
the solution).

Towards lower frequencies, the (capacitive) source impedance to ground 
becomes so large that it is no longer a suitable source to excite the 
structure.

The floating source can be used from fmin to fmax.

The transition between the grounded and floating source in Momentum MW is set 
at a frequency that is substrate dependent, typically around 10 MHz, where both 
are valid sources, hence, the S-parameters should be identical and the transition 
can be made safely. In some cases, the transition frequency is too low, causing a 
discontinuity in the S-parameters. In case of an adaptive frequency sweep, this 
discontinuity may lead to non-convergence. In such case, consider to use the TML 
zero length calibration instead or force to use the grounded source at all 
frequencies. You can do this by adding following configuration variable in a 
momentum.cfg file.

MOM3D_USE_SOURCETYPE=0
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1.  

2.  

3.  

A value of 1 forces the floating source at all frequencies, but note that this is not a 
suitable source at low frequencies.
This variable can be set in either one of following locations:

$HPEESOF_DIR/Momentum/<version>/custom/config/momentum.cfg

$HOME/hpeesof/config/momentum.cfg

TML zero length Calibration

If you select the TML (zero length) calibration, Momentum directly adds a source at 
the port to excite the structure. The parasitic effect of the open-end at the port is 
automatically removed from the simulated S-parameters.

See Also
Defining Ports

Viewing Ports

Applying SMD Port Calibration in Momentum

Applying SMD Port Calibration in Momentum

If you select the SMD calibration, Momentum automatically adds two feed lines to 
the two layout pins of the port. A source is added over the delta-gap connecting 
the two feed lines. The parasitic effect of the feed lines is automatically removed 
from the simulated S-parameters. SMD calibration should be used for connecting 
with a 2-pin SMD component whose model includes parasitics.

Defining SMD Ports

To assign a layout pin to the S-parameter port:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Ports

Select  from the drop-list available in the  column, as shown SMD Calibration
in the following figure:
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3.  

4.  

5.  

6.  

7.  

8.  

9.  

Click once in the   column of a port and specify the Ref Impedance [Ohm]
required value.

Click once in the   column of a port and specify the required Ref Offset [um]
value.

Select a pin row in .Layout Pins

Drag the pin from Layout Pins and drop it on the  or  terminal of the 
required port in .S-parameter Ports

A message box is displayed if your target pin is already used by other ports.

Click in the message box.Delete Ports and Continue

You can drag and drop multiple layout pins and connect with a S-
parameter port.

Show me How Do I Define SMD Ports

 Define SMD Ports

Example SMD Port Calibration

A circuit model for the SMD component is displayed in the following figure:

http://youtu.be/gFJxg8CWHx0
http://youtu.be/gFJxg8CWHx0
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This model:

Includes parasitic self impedance (between the two port pins).

Does not include mutual impedance (coupling) with the interconnection 
traces.

For creating this circuit model in the layout:

Define two edge pins (P1 and P2).

Define an S-parameter port connected to pins P1 and P2.

Set feed type to SMD.

Specify the reference offset (OPTIONAL).

For creating this circuit model in the schematic:

The (layout lookalike) symbol view includes 2 pins for the SMD port.

The SMD component is connected between these two pins.

SMD calibration in the Momentum engine:

Feed lines are automatically added to create a delta-gap.

Delta-gap lumped source used to excite the port.

Calibration standard used to de-embed the feed lines. Note that the mutual 
coupling effect of the feed lines with the rest of the circuit remains in the S-
parameter model.
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Assessment of calibration accuracy
Simulation with SMD replaced by matching line section should give SAME result as 
simulation of straight line without SMD ports

Perfectly calibrated means these two simulations give identical results

SMD circuit component
parasitic self impedance included
mutual impedance NOT included

SMD port calibration:

Feed lines with delta-gap source

Includes self and mutual impedance

SMD calibration removes the parasitic self impedance
(NOT the mutual impedance)

Reference shift can be used to control amount of self impedance removed
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1.  

2.  

3.  

Assessment of calibration accuracy

Simulation with very small (delta) gap in layout with NO calibration gives SAME 
result as simulation of physical SMD gap with DeltaGap calibration.

Show me How Do I Define Ports

 How to Define Ports

See Also
Defining Ports

Viewing Ports

Applying Delta Gap Port Calibration in Momentum

Applying Delta Gap Port Calibration in Momentum

If you select the Delta gap calibration, Momentum automatically adds two feed 
lines to the two edge pins of the port. The lines will fill the gap and a (differential) 
source is added over the delta-gap connecting the two feed lines. The (parasitic) 
effect of the feed lines is not removed from the simulated S-parameters. You 
should use Delta gap calibration

when connecting with a 2-pins SMD component whose model does not yet 
includes the parasitics associated with 'bridging the gap'.

when you want to create a gap on a transmission line to, for example, 
measure the current passing through in a circuit simulation.

Defining Delta Gap Calibrated Ports

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Ports

Select  from the drop-list available in the  column.Delta Gap Calibration

http://youtu.be/gFJxg8CWHx0
http://youtu.be/gFJxg8CWHx0
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Example Delta Gap port Calibration

In this section, a physical structure is connected with a Delta Gap component. 
Assumptions for the circuit model for the Delta Gap component:

Does NOT include parasitic self impedance (between the two port pins).

Does NOT include mutual impedance (coupling) with the interconnection 
traces taken into account through DeltaGap port calibration.

User defines two edge pins (P1 and P2).

User defines an S-parameter port connected to pins P1 and P2.

User sets feed type to DeltaGap.

The following Use Model is used in schematic:

The (layout lookalike) symbol view includes 2 pins for the DeltaGap port.

The SMD component is connected between these two pins.

DeltaGap calibration in the Momentum Engine:

Feed lines are automatically added to create a delta-gap

Delta-gap lumped source used to excite the port

Show me How Do I Define Ports
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 How to Define Ports

See Also
Defining Ports

Viewing Ports

Ports for FEM

Ports for FEM

Ports enable energy to flow into and out of a circuit. Energy is applied to a circuit 
as part of the simulation process. A circuit solved using FEM Simulator must have, 
at the minimum, one port. Ports are defined in a two-step process. First, layout pins 
are added to a circuit when the circuit is drawn. Then, you specify the type of port 
in order to tailor the port to your circuit. This facilitates the simulation process.

Considerations

While adding pins to circuits to be simulated using FEM:

The components or shapes that pins are connected to must be on layout 
layers that are mapped to metallization layers that are defined as strips or 
slots. Pins cannot be directly connected to vias.

Ensure that pins on edges are positioned so that the arrow is outside of the 
object, pointing inwards, and at a straight angle.

Ensure that the pin and the object you are connecting it to are on the same 
layout layer. For convenience, you can set the entry layer to this layer; the 

 listbox is on the Layout tool bar.Entry Layer

A pin must be applied to an object. If a pin is applied in open space so that it 
is not connected to an object, Momentum will automatically snap the pin to 
the edge of the closest object. However, FEM leaves the pin unattached to 
the structure. This difference is not apparent from the layout, however, 
because the position of the pin will not change.

ADS FEM does not support area pins. The cylinder ports are created 
automatically and does not depend whether an area pin is defined or not, i.e., 
these ports are created even if pins are not defined as area pins. The generation 
of cylindrical ports is automated, as it has better behavior related to the 
parasitic port effects. For any port (pin) that is in the middle of some metal, 
cylindrical port are created and its size is determined automatically. It can be 
referred as an . Therefore,  ports no longer exist in FEM. automated area pin wire
You cannot control the size and it does not depend on the area size defined by 
area pin.

When impedance lines are displayed in the 3D EM preview mode, the 
endpoints for the lines will be placed in the middle of thick conductors. During 
the solution process, the lines are processed, moving their endpoints to the 
correct surface, based on the solution setup.

http://youtu.be/gFJxg8CWHx0
http://youtu.be/gFJxg8CWHx0
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Selecting a Feed Type

Ultimately, FEM supports three levels of calibration:

Fully calibrated ports

Ports that exist on the virtual 'bounding-box' that strictly surrounds 
all polygons on layers mapped in the substrate  have the feed AND
type  are fully calibrated.TML

Sheet port calibration

Ports that are attached to at least one edge are realized as sheet 
ports. The self-inductance of an equivalent sheet of current is 
calibrated for  feed types (unless the port meets the fully ALL
calibrated criteria above).

This calibration does  remove port parasitic effects due to port not
capacitance, current fan-in/fan-out, or mutual inductance between 
sheet port currents.

Uncalibrated ports

Ports that are not attached to at least one edge (i.e. they only attach 
to a points within polygons) are  calibratednot

These ports include parasitic effects due to port current self-
inductance as well as port capacitance, current fan-in/fan-out, and 
mutual inductance between port currents.

In ADS 2014.01, an automatic calibration routine is added for FEM sheet 
sources to remove the self-inductance of the sheet of current that flows 
through the source. This calibration is always enabled for ports attached to at 
least one edge (geometry edge or edge port) - this calibration takes place for 
for  feed types, including . Ports that do not connect to any edges are ALL None
not yet calibrated (and thus include excess inductance).

TML Calibration

TML is the default calibration in FEM ports. It has the following properties:

The port is connected to an object that is on either a strip or slot 
metallization layer.

The port is external and calibrated. The port is excited using a calibration 
process that removes any undesired reactive effects of the port excitations 
(mode mismatch) at the port boundary.

The port boundary can be moved into or away from the geometry by 
specifying a reference offset. S-parameters will be calculated as if the phase 
reference were at this position. For more information, refer to Applying 
Reference Offsets.

In FEM, TML ports have the following restrictions:

The positive pin of the port must be attached to edge of an polygon, or be 
an edge pin.
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2.  

3.  

4.  

The pins that define the port must be on the strict  that bounding box
surrounds all polygons on layers mapped in the substrate definition.

TML is the default feed type, but it will revert to None if the port does not 
satisfy the restrictions above.

To define a TML port calibration:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select .FEM

Select  in the left pane of the EM Setup window.Ports

Select  in the Calibration column.TML

FEM uses the Waveguide ports or TML calibration to shift the location of the 
reference lines used for the S-parameters. It consists of the following features:

Calibrated 2D-plane source

User defines a 2D plane for the port in the simulation domain with a source 
impedance

You can select the following types of reference offsets:

Specifying a positive reference offset: Shifts the reference planes in the 
direction towards the circuit.

Specifying a negative reference offset: Shifts the reference planes in the 
direction away from the circuit.

TML (zero length) Calibration

For FEM, a TML (Zero Length) calibration is the same as a TML calibration.

SMD Calibration

While performing an FEM simulation, the SMD ports are treated as sheet ports and 
the reference offset specification is ignored (i.e. the reference offset is always zero). 
The self-inductance of an equivalent sheet of current is calibrated out of the 
results.

Delta Gap Calibration

While performing an FEM simulation, the Delta Gap calibration is equivalent to an 
SMD calibration.

None Calibration

The None port calibration enables you to apply a port to the surface of an object in 
your design. By using None calibration, all the physical connections in a circuit can 
be represented, so your simulation can take into account all of the EM coupling 
effects that will occur among ports in the circuit. These coupling effects caused by 
parasitics are included in your simulation results because ports are not calibrated. 
You should avoid geometries that allow coupling between TML and None calibrated 
ports to prevent incorrect S-parameters.
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An example of where an internal None port is necessary is a circuit that consists of 
transmission lines that connect to a device, such as a transistor or a chip capacitor, 
but this device is not part of the circuit that you are simulating. An internal None 
port can be placed at the connection point, so even though the device is not part of 
the circuit you are simulating, the coupling effects that occur among the ports and 
around the device will be included in your simulation.

A None calibrated port has the following properties:

None ports that are connected to either a geometry edge or are connected 
to an internal edge created with a polyline to create an edge pin will be 
implemented as sheet ports.

The self-inductance is calibrated out for  sheet ports, even if the feed type ALL
is . If the following configuration variable does not exist in the fem.cfg file, None
by default 0.5 of the port inductance is subtracted:

FEM_PORT_CALIBRATION_FACTOR = 1

It can be applied to the interior of a circuit by applying it to the surface of an 
object.

It can be applied to the edge of an object.

It can be applied to objects that are on strip layers only.

The orientation of the port is not considered if it is on the surface of an 
object.

FEM uses None Calibration Ports to inject energy into a structure as an alternative 
to ports. Sources are useful for modeling internal ports within a structure. Some 
examples are:

Your structure consists of transmission lines that connect to a device, such 
as a transistor, but this device is not part of the structure that you are 
simulating. A source can be connected at that point, so even though the 
device is not part of the circuit you are simulating, the coupling effects that 
occur among the connections around
the device will be included in your simulation.

To define a None calibration:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select .FEM

Select  in the left pane of the EM Setup window.Ports

Select  in the Calibration column.None

See Also
Defining Ports

Viewing Ports
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Setting up EM Simulations

Setting up EM Simulations

The EM Setup view and its associated editor centralize all settings for your EM 
simulation (Momentum or FEM) from a single interface. You can select a substrate, 
inspect port definitions, define a frequency sweep, specify EM simulator options, 
specify simulation resources, and required output data.

This section provides the following information about setting up EM simulations:

EM Setup Window Overview

Viewing Layout Information

Automatic EM Circuit Partitioning

Viewing the Substrate

Viewing Ports

Defining a Frequency Plan

Defining Simulation Options

Specifying Physical Model Settings for Momentum

Specifying Physical Model Settings for FEM

Defining Preprocessor Settings

Defining Mesh Settings for Momentum

Defining FEM Mesh Settings

Defining Solver Settings

Defining Expert Options for Momentum

Defining an Output Plan

Specifying Simulation Resources

Generating an EM Model

EM Setup Tools

Open and Create a Symbol View

Creating an SnP Schematic

Customization

Using an EM Setup Template

EM Setup Window Overview

http://edadocs.software.keysight.com/display/ads2017/Open+and+Create+a+Symbol+View
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EM Setup Window Overview

ADS provides an improved EM Simulation usability. It is now easier to create and 
use EM models for arbitrary parts of a layout by designers who are not EM experts. 
ADS provides a new EM GUI, EM Setup window, which provides a single interface 
to control all EM setup related features. It provides a:

Unified EM interface to reduce maintenance efforts.

User-friendly interface for defining Momentum and FEM simulations.

To open the EM Setup window, choose  > . The EM Setup EM Simulation Setup
window enables you to define simulator options such as substrate, ports, and 
frequency plan. The following figure displays an EM Setup window:

The following sections describe the EM Setup window:

Setup Type

EM Setup Options

EM Simulators

EM Setup Summary

EM Setup Window Menu Options

EM Toolbar Options

Setup Type

You can select the following types of setup for performing a simulation:
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EM Simulation/Model: This option generates the S-parameter model 
extracted by an EM simulator for the entire (flattened) layout.

EM Cosimulation: This option facilitates combining EM simulation of a layout 
with circuit simulation of instances that cannot be simulated by the EM 
simulator (e.g. a nonlinear device) or for which a model already exists (e.g. a 
built-in primitive, a schematic, or an EM Model).

EM Setup Options

In the EM Setup window, options required for specifying simulation settings are 
listed in the left pane. You can select the required option to open the settings in the 
right pane of the EM Setup window, as shown in the following figure:

Layout: You can view information about the workspace, library, cell, and 
view by selecting . For more information, refer Layout Viewing Layout 

.Information

Substrate: You can open a predefined substrate file from ADS by selecting 
. For more information, refer .Substrate Defining Substrates

Ports: You can refresh layout pins information, create, delete, and 
resequence ports, and search the required S-parameter ports or layout pins 
by selecting . For more information, refer to .Ports Ports

Frequency Plan: You can add or remove frequency plans for your EM 
simulations by selecting . For more information, see Frequency Plan Defining 

.a Frequency Plan

Output Plan: You can specify the data display settings for your EM 
simulations by selecting . For more information, see Output Plan Defining a 

.Frequency Plan

Options: You can define the preprocessor, mesh, simulation, and expert 
settings by selecting . For more information, see Options Defining Simulation 

.Options

Resources: You can specify the local, remote, and third party settings by 
selecting . For more information, see Resources Specifying Simulation 
Resources
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Model/Symbol: You can generate an EM model and symbol by selecting 
. For more information, see .Model/Symbol Generating an EM Model

Notes: You can add comments to your EM Setup window by selecting .Notes

EM Simulators

In the EM setup window, you can select one of the following types of EM 
simulators:

Momentum Microwave

Momentum RF

FEM

For more information, see  and .FEM Momentum

EM Setup Summary

You can view a summary of the EM simulation options in the Setup Overview 
section of the EM Setup window.

EM Setup Window Menu Options

You can perform the following tasks by using the menus and toolbar options 
present in the EM Setup window:

Saving Simulation Settings

Click  (  ) in the EM Setup window to save the settings specified for your Save
EM simulation. You can also use the following commands from the File menu for 
saving an EM setup:

The Save command enables you to save changes to an existing design. If 
you choose Save in an untitled window, the Save Design As dialog box 
appears.

The Save As command enables you to save an existing EM setup with a new 
name. You can change the Library name, cell name, and view name. Type 
represents the type of cell to identify whether it is a EM setup, schematic, 
layout or symbol view. You cannot change the cell Type.
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1.  

The Save a Copy As command enables you to save a copy of an existing EM 
setup with a new cell name in new library and in new view. Select  > File

 to provide the required library name, cell name, and view.Save a Copy As

To reuse the saved EM setup, select  >  >  in the ADS File Open EM Setup View
Main window. Select the required EM Setup view in the Open Cell View dialog 
box. You can also open an existing EM setup by using the EM toolbar.

Import from another EM Setup

To import the contents of another EM Setup in the EM Setup window:

Choose  >  or click the  icon (  ) to open the File Import EM Setup... Import
 dialog box, as shown in the following figure:Import EM Setup
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1.  

2.  

3.  

4.  

1.  

2.  

Click  to open the Specify EM Cell View dialog box. For more Browse
information, see .Opening an EM Setup View

Select the required sections from the list. Clicking on the Sections to include 
Sections to include Checkbox will toggle between selecting or deselecting all 
the sections. A summary of the content can be seen by hovering over the 
section label or by pressing the toggle near the Sections to include 
Checkbox. To view the full content in a read-only EM Setup dialog, press the 

icon (  ).Inspect 

Click .Import

Opening an EM Setup View

To open an EM setup view, perform the following the steps:

Start ADS and open an existing workspace.
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2.  

3.  

4.  

5.  

6.  

7.  

8.  

From the ADS Main window, choose  to open File > Open > EM Setup View
the Specify EM Cell View dialog box.

Select  from the  drop-down list.EM Setup View Type

If you want to open a built-in ADS design (read-only), check the Show ADS 
 check box to display the list of all libraries under .Libraries Library

Under , select the Library name where the view exists.Library

Under , select the cell name.Cell

Under , select the required EM setup view name.View

Click  to open the selected EM setup view.OK

Opening the 3D Preview window

Choose  >  or click the  icon (  ) to preview Tools 3D EM Preview 3D EM Preview
your simulation.

Opening the Layout window

Choose  >  or click the  icon (  ) Tools Open Layout Window Open Layout Window
to display a layout window.
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Simulating a Design

You can save the current settings and start the simulation process by clicking the 

 button or click (  ) to simulate an EM simulation. You can also press Simulate
 to start the EM simulation. If you have specified invalid EM settings, an error F7

message is displayed.

EM Toolbar Options

You can also use the EM toolbar to perform EM simulations. The EM toolbar 
provides shortcuts to the frequently-used menus. It is present in the Layout 
window. You can perform the following tasks by using EM toolbar options:

Starting an EM simulation: Click  (  ) to initiate the Start EM Simulation
simulation process.

Stopping an EM simulation: Click  (  ) to stop an EM Stop EM Simulation
simulation and release the license.

Opening the EM Setup window: Click  (  ) to display EM Simulation Setup
the EM Setup window.

Opening the substrate editor window: Click  (  ) to open Substrate Editor
the substrate editor window.

Opening the 3D Preview window: Click  (  ) to preview 3D EM Preview
an EM simulation.

Opening the 3D Viewer window: Click  (  ) to open the 3D Visualization
Viewer and load the simulation results of the current EM setup.

Calculating far fields: Click  (  ) to calculate far fields from the Far Field
simulation results of the current EM setup.

Viewing Layout Information

Viewing Layout Information

You can view information about the current layout in the EM Setup window. This 
window provides the following information about the location of a workspace, 
library, cell, and view of the current layout:

Workspace: Specifies the complete path to the location where you have 
saved the workspace file.

Library: Specifies the name of the library.

Cell: Specifies the name of the cell.
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1.  

2.  

3.  

4.  

5.  

View: Specifies the view that is opened for setting up the EM simulation.

For more information about a workspace, library, cell, and view, see New 
.Terminologies

From the EM Setup window, you can also open the structure in the following 
window:

3D view

Layout window

Displaying Layout Information

To display the layout information for your EM simulation:

Select  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the  window.Layout EM Setup

View the , , , and  information in .Workspace Library Cell View Input Layout

Click  to open the layout window.Show in Layout Window

Click  to open a 3D view for your EM simulation.Show in 3D View

Automatic EM Circuit Partitioning

http://edadocs.software.keysight.com/display/ads2017/New+Terminologies
http://edadocs.software.keysight.com/display/ads2017/New+Terminologies
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Automatic EM Circuit Partitioning

The Automatic EM/Circuit Partitioning feature facilitates combining EM simulation 
of a layout with circuit simulation of instances that cannot be simulated by the EM 
simulator (e.g. a nonlinear device) or for which a model already exists (e.g. a built-
in primitive, a schematic, or an EM Model). Automatic EM/circuit partitioning 
reduces cosimulation setup time.

The partitioning policy defined for an EM Setup and the partitioning rules defined 
for a cell allow ADS to automatically determine which instances will be EM 
simulated and which will be circuit simulated. Traditional EM-only simulation of a 
layout is prohibited if it uses instances not supporting EM simulation. Instead, an 

 can be generated from the EM Setup window.EM Cosimulation View

A circuit simulation is required to use an EM Cosimulation view. It is a netlistable 
view that integrates an EM model for the EM simulated partition with circuit models 
for the circuit simulated instances. You can either directly use an EM Cosimulation 

 as 'View for Simulation', or alternatively, integrate it into a synchronized View
schematic using an .EM Cosimulation Controller

Partitioning Rules

A partitioning rule determines how a cell instance can be processed, the , Action
during the generation of the  view. There can be multiple rules EM Cosimulation
defined for a cell.
By default, the following rules are assigned to all components:

A rule “em” to use EM simulation.

A rule “circuit” to use circuit simulation.

The following table provides a description of these default rules:

Rule 
Name

Action Simulators

circuit Do not descend into the instance. Add cell ports to the EM Partition. The circuit 
simulation hierarchy policy is used to resolve the model that is used for simulation. This 
rule requires that the component can be simulated using circuit simulation.

All

em Descend into the instance. Model all shapes by EM and re-examine the cell instances All

For cells that haven't been specifically configured, both default rules are assumed 
to be valid choices. However, user-defined rules can be used to define a special 
behavior for a cell, see .#Creating User-defined Partitioning Rules for a Cell

How Does ADS Select Partitioning Rules?

ADS applies partitioning rules based using the following scheme:

If you select a rule in the EM Setup window, the specified rule is applied. For 
more information, see .From the EM Setup window
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Otherwise, ADS looks for a rule specified on the instance. A particular 
partitioning rule can be enforced for a particular instance of a cell, see 

.#Enforcing Partitioning Rules for an Instance

If there is no override in the EM setup or on the instance, ADS uses this 
partitioning policy:
preferred em circuit

The names are tested in order against the available rule names for the cell. 
The first matching rule will be used. You can override the policy at the top of 
the partitioning. For more information, see .Partitioning Policy

Creating User-defined Partitioning Rules for a Cell

The cell specializations can be configured from the EM/Circuit Partitioning Rules Of 
Cell dialog box. While creating a new rule, you need to specify the action and EM 
simulator.
You can set up your own rules and actions in the partitioning rule editor. Use the 

 column to define simulator specific rules. You can also switch to a EM Simulator
specific view of the same cell:

To select a particular port setup as circuit simulated instance.

To select a simplified layout or empro view for EM simulation.

Rules for view switching:

Ordering and geometry of the pins must be identical to the original layout.

Port setup, instances and shapes may be different.
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1.  

2.  

The following table describes the various types of actions that can be assigned to a 
rule:

Action Description

circuit using 
ports from 
placed layout

Simulate with the circuit simulator using the pins and ports defined in the placed layout to 
connect to the EM simulation.

circuit using 
ports from other 
views

Simulate with the circuit simulator using the pins and ports defined in the named layout to 
connect to the EM simulation.

descend into 
placed layout

Include shapes and vias inside the placed layout in the EM simulation. The partitioning 
analysis is repeated for all instances in this layout.

descend into 
other view

Include shapes and vias inside the named layout or EMPro view in the EM simulation. In 
the case of a normal layout, the partitioning analysis is repeated for all instances in this 
layout.

deactivate view Act as if this cell was not instantiated.

Ignore rule for 
EM simulator

The partitioning policy will not select this rule, even if it contains its name.

To create a new partitioning rule:

Open a Layout view of a cell and select . You File > EM/Circuit Partitioning...
can also right-click a cell and select . The EMFile > EM/Circuit Partitioning...
/Circuit Partitioning Rules Of Cell dialog box is displayed.

Select .Specify custom rules
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2.  

3.  

4.  

5.  

6.  

7.  

1.  

2.  

Click . A new row of rule is created.Add partitioning rule

Click once in the Name column and specify a name for the new rule.

Select a action from the drop-down list in the  column.Action

Select an EM simulator from the drop-down list.

Click . A new partitioning rule is created.OK

To remove a rule, select the rule and click . To assign Remove partitioning rule
default rule, click .Reset factory defaults

Enforcing Partitioning Rules for an Instance

A specific rule can be enforced for a specific instance in the following two ways:

From the Layout window

From the EM Setup window

From the Layout window

To apply a partitioning rule for a selected instance in the layout window:

Select an instance in the layout design.
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2.  

3.  

4.  

1.  

2.  

3.  

4.  

5.  

Click the  button (  ) on the EM Toolbar. The Choose View For Simulation
 window is displayed.Choose View for Simulation

Select the  tabEM/Circuit Partitioning

Override the policy selection by selecting a specific rule and click .OK

From the EM Setup window

To apply a partitioning rule for a selected instance in the EM Setup window:

Select an instance in the layout design.

Select  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Partitioning

Select the row of the instance for which you want to specify the partitioning 
rule.

Select the required rule from the drop-down list in the  column:Partition Rule
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5.  

6.  

1.  

2.  

3.  

You can select the Auto-select, Auto center, or Auto Zoom check box. If you 
select these options and open the layout window of the parent cell by 
clicking on the instance name (e.g. I__0), it will perform the appropriate 
action in the layout window. To open the layout window a right-click menu 
has been added to the Instance-name cell : Open Parent Layout Window.

It is recommended to uncheck the Auto select, Auto center, and Auto 
Zoom options, if you do not want to open the layout window, as it may 
slow down the operation process.

Partitioning Policy

The partitioning policy is an ordered list of rule names. When processing a cell 
instance, the cell rule that appears earliest in the list will be applied. The default 
partitioning policy is as follows:

preferred

em

circuit

If no matching rule can be found for the cell, an error message will be 
issued.

The following figure highlights the partitioning policy in the EM Setup window:
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1.  

2.  

3.  

Removing a Partitioning Rule

You can remove a partitioning rule to prohibit EM or circuit simulation. For 
example, if you remove the  rule, ADS will not perform any EM simulation for this em
cell. ADS will automatically choose circuit simulation.

To remove a rule:

Open a Layout view of a cell and select . You File > EM/Circuit Partitioning...
can also right-click a cell and select . The EMFile > EM/Circuit Partitioning...
/Circuit Partitioning Rules Of Cell dialog box is displayed.

Select a rule.

Click .Remove partitioning rule
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3.  

4.  Click .OK

See Also
EM Circuit Cosimulation
Manual Versus Automatic EM Circuit Partitioning

Viewing the Substrate

Viewing the Substrate

A drop-down list shows the available substrate definitions. Select the appropriate 
substrate from the list. The graphical area underneath provides a view on the cross-
section.
You cannot edit the substrate from the EM Setup window. Instead, click  to Open
open the Substrate Editor. In that window, editing of the substrate is possible.

In case there is no substrate defined yet, click , which will allow you to New define a 
.substrate

Viewing Ports
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2.  

Viewing Ports

You can view ports in the EM Setup window. However, you cannot define or edit 
ports from the EM Setup window.

To view ports:

Select  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window. The ports are Ports
displayed, as shown in the following figure:

To edit ports, open the Port Editor window from a layout or from the EM Setup 
window.

To open the Port Editor window from a layout, click the  icon ( Port Editor
) present on the EM toolbar.

To open the Port Editor window from the EM Setup window:

Select  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Ports

Click  to open the Port Editor dialog in the Layout window.Edit

See  for more information on how to define ports.Defining Ports
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Port Overview in the EM Setup Window

This section provides information about the port options available in the EM Setup 
window.

S-Parameter Ports

The S-Parameter Ports section displays the plus and minus terminals of a port. The 
name besides the plus and minus pins specifies the pin name that is connecting 
with these terminals. The following table describes the S-parameter Ports fields:

Field Description

Number Specifies the S-parameter port number.

Name Specifies the name of the first positive pin added. You cannot edit a port name.

Ref Impedance 
[ Ohm]

Specifies the reference impedance value in ohms.

Calibration Allows you to select a feed type: TML, TML (zero length), SMD, DeltaGap, or None. For more 
information, see .Defining Ports

Ref Offset [ mil] Specifies the Ref Offset value (shown in layout units).

Layout Pins

The Layout Pins section displays the list of unconnected pins. You make 
connections between the positive and negative terminals of the port and layout 
pins by dragging/dropping layout pins For more information, see Create 

. The following table describes the Layout Pins fields:Connections

Field Description

Name Specifies the layout pin name.

Layer Specifies the layer name.

Connected To Specifies the connecting terminal name.

Net Specifies the Net name.

Purpose Specifies the purpose.

X [ mm] Specifies the X axis value (shown in layout units).

Y [ mm] Specifies the Y axis value (shown in layout units).
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Field Description

Number Specifies the number.

Layer Num Specifies the layer number.

Purpose Num Specifies the purpose number.

Pin Type Specifies the type of pin used in the design.

Refreshing Layout Pins and S-parameter Ports Information

Click Refresh pins and ports (  ) to update the list of pins and ports with the 
latest information in the Layout window.

Expanding S-parameter Ports Tree

To display the detailed information about each port in S-Parameter Ports, click 

Expand S-parameter Ports tree (  ).

Collapsing S-parameter Ports Tree

To hide the details of ports in S-Parameter Ports, click Collapse S-parameter Ports 

tree (  ).

Searching Ports

For easy filtering and sorting commands, click Toggle Search Filter On/Off (  ). 
Type the required string in the Search text box. In the Layout Pins panel, you can 
also right-click any required field and select Set texts to filter. This option picks up 
the text of current item in Layout Pins and sets it in the filter, as shown in the 
following figure:

Viewing Controls

You can specify how pins are selected in a layout by selecting one of the following 
options:

Auto select: Selects pin(s) automatically.

Auto center: Selects pin(s) from the center.

Auto zoom: Increases the layout window zoom to the selected pin(s).
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See Also
Defining Ports
Ports for Momentum
Ports for FEM

Defining a Frequency Plan

Defining a Frequency Plan

You can set up multiple frequency plans for a simulation. For each plan, you can 
specify that a solution be found for a single frequency point or over a frequency 
range. You can also select a sweep type for your frequency plan. However, the 
collection of frequency plans run as a single simulation. You can also specify the 
data display settings for your EM simulations by using the EM Setup window.

Setting up Frequency Plans

To add a new frequency plan, you need to specify the following parameters in the 
EM Setup window:

Column Description

Type Specifies the type of frequency:

Adaptive: It is the preferred sweep type. It uses a fast and accurate method of 
comparing sampled S-parameter data points to a rational fitting model. The value 
entered in the Sample Points Limit field is the maximum number of samples used 
in an attempt to achieve convergence. The solutions from the final attempt will be 
saved. If convergence is achieved using fewer samples, the solutions are saved 
and the simulation will end.
Two datasets will be the written, one with the actually simulated samples (<name>.

) and another one ( ) which is a densly sampled dataset based on ds <name>_a.ds
the rational fitting model.

Linear: It simulates over a frequency range, selecting the frequency points to be 
simulated in linear increments based on the step size you specify. Type the start 
and stop frequencies in the Start and Stop fields, and select frequency units for 
each. Enter the step size in the Step field, and select units.

Log: It simulates over a frequency range, selecting the frequency points to be 
simulated in logarithmic increments. Type the start and stop frequencies in the 
Start and Stop fields, and select frequency units for each. Enter the number of 
frequency points to be simulated in the Points/Decade field, and select units.

Single: It simulates at a single frequency point. Type a value in the Frequency field 
and select units.

Dec: This option creates a frequency plan with logarithmically distributed 
frequencies with the number of points specified per decade. It is similar to the 
frequency plan created by using the log option. For example, Logs from 1 to 100 
with 21 points, is same as dec from 1 to 100 with 10 points/decade.
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Column Description

Fstart Specifies the frequency start value. Set a unit, such as Hz, KHz, MHz, GHz, or THz, for the selected 
value.

Fstop Specifies the frequency stop value. Set a unit, such as Hz, KHz, MHz, GHz, or THz, for the selected 
value.

Npts Specifies the number of frequencies to simulate. For Adaptive, this is the maximum number of 
samples to use.

Step Specifies the step value. Set a unit, such as Hz, KHz, MHz, GHz, or THz, for the selected value.

Enabled Allows you to enable the frequency plan.

Adding a Frequency Plan

To add a frequency plan:

Choose >  to display the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Frequency Plan

To add a new frequency plan, click .Add

Select a sweep from the  column.Type

Specify the frequency start value in the  column.Fstart
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Specify the frequency stop value in the  column.Fstop

Specify the value of N points in the  column.Npts

Specify the step value in the  column.Step

Select the check box in the  column to enable the frequency plan.Enabled

Repeat the preceding steps to insert additional frequency plans.

In a simulation, the frequency plans are executed in the order they 
appear in this list with the exception that the Adaptive sweep only starts 
if all others have been executed

Removing a Frequency Plan

To delete a frequency plan:

Choose > .EM Simulation Setup

Select  in the  window.Frequency Plan EM Setup

Select the required frequency plan.

Click .Remove

Defining Simulation Options

Defining Simulation Options

You can specify engine-specific options, such as physical model, preprocessor, and 
mesh for EM simulations. You can either use a predefined set of simulation options 
(e.g. from an EM Template) or your own customized options.

To view the simulation options:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window, as shown in the Options
following figure:
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To modify the simulation options, either select another preset from the drop down 
box -if multiple presets are defined- or modify a setting in the dialog. In the latter 
case the preset <none> will be created with the contents of the selected preset and 
the modification just made. The selected preset will change to <none>. The content 
of the previously selected preset is not altered.

All other modifications to fields in the options dialog will be stored in <none>. If you 
are pleased with the modified settings you can save them as your own preset using 
Save As... and provide a meaningful name.

The names of presets imported from EM Templates or other EM Setups are 
reserved: they cannot be used as the name for a Save As... . They can be removed 
or renamed. The presets created with Save As... can be overwritten, removed or 
renamed. When you expand the preset drop down box, presets created with Save 
As will be shown in bold, imported presets in plain text as shown below.

Specifying Simulation Options

You can specify preprocessor, mesh, and simulation settings by using the 
Simulation Options dialog box. It consists of the following tabs:

Description

Substrate

Preprocessor

Mesh

Simulation

Expert
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In the Description tab, you can add information about the simulation options. The 
following sections provide information about the other tabs available in the EM 
Setup window:

Specifying Physical Model Settings for Momentum

Specifying Physical Model Settings for FEM

Defining Preprocessor Settings

Defining Mesh Settings for Momentum

Defining FEM Mesh Settings

Guidelines for Specifying FEM Mesh Settings

Performing FEM Broadband Refinement

Defining Solver Settings

Defining Expert Options for Momentum

Specifying Physical Model Settings for Momentum

Specifying Physical Model Settings for Momentum

The physical model options provide control over how the surface current flow on 
thick conductors and vias will be modeled. You can specify these options either 
globally, for selected layers or for selected nets.

Thick Strip Conductor Models

3D Distributed

This option provides the most accurate modeling approach.

Top, bottom and side-wall currents seperately modeled

Any surface current flow

2D Distributed

This option is preserved for compatibility with older versions. It may also serve to 
more efficiently model a stacked conductor configuration where a via array 
interconnects top and bottom conductor.
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Top and bottom currents seperately modeled

Vertical side-wall currents only

Sheet

This option provides an approximate but faster modeling approach that can be 
useful to speed up the simulation of thick planes.

Top and bottom currents collapsed

No side-wall currents

Via Conductor Models

3D Distributed

This option provides the most accurate modeling approach.

DC resistance and skin effect
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All self and mutual inductance and capacitance

Any surface current flow

2D Distributed

This option is useful when the via object is the result of a via array simplification. In 
such via array, no horizontal current can flow and this model will exclude such 
current.

DC resistance and skin effect

All self and mutual inductance and capacitance

Vertical side-wall currents only

Wire

This option removes the via from the structure before meshing and adds a circuit 
element network connection between mesh cells at the top and bottom of the via.

DC resistance and skin effect

Wire self inductance

Mutual wire-wire and wire-infinite ground inductance

Mesh-less equivalent circuit model

Lumped
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Lumped

This option removes the via from the structure before meshing and adds a circuit 
element network connection between mesh cells at the top and bottom of the via.

DC resistance and skin effect

Wire self inductance

Mesh-less equivalent circuit model

Lumped and wire via model options

Additional layout simplification options are available when the Lumped or Wire via 
model is selected. They can be chosen for faster simulation of layouts with a large 
number of vias. The following figure shows the lumped and wire via options:

The following table describes the new options:

Option Description

Remove 
the via 
outline

Disabling the  option includes via outline in the mesh, which generates an Remove the via outline
accurate modeling of the via current flow. If you enable this option, the via outline is ignored 
during meshing, which results in a mesh with fewer cells around the via connections.
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1.  

2.  

3.  

4.  

Option Description

Remove 
pads not 
connected 
to a trace

Disabling the  option includes the via pads in the mesh, Remove pads not connected to a trace
which generates an accurate modeling of the via current flow. If you enable Remove pads not 

, the via pads (not connected to a trace) are ignored during meshing, which connected to a trace
results in a mesh with fewer cells.

Remove 
antipads 
within 
radius

Disabling the  option includes the via antipads (clearances in the Remove antipads within radius
ground plane) in the mesh, which generates accurate modeling of the ground plane current flow. 
If you enable , the via antipads within a radius smaller than the Remove antipads within radius
specified number of via radii is ignored during meshing, which results in a mesh with fewer cells.

Remove 
thermal 
reliefs 
within 
radius

Disabling the  option includes the via thermal reliefs in the Remove thermal reliefs within radius
mesh, which generates accurate modeling of the via current flow. If you enable Remove thermal 

, the via thermal reliefs within a radius smaller than the specified number of reliefs within radius
via radii is ignored during meshing, which results in a mesh with fewer cells.

If you convert a project from an older ADS version, the wire vias options are 
disabled, by default. Therefore, results are same in the original project and the 
converted workspace.

The lumped and wire via models are subject to the following restrictions:

Vias that are strictly partially connecting to a pad, trace, or plane cannot be 
simulated using a lumped or wire model. The 3D Distributed model will be 
used instead.

Via shapes whose center is outside the shape uses the 3D Distributed model 
for simulation.

Via outlines can only be removed from the mesh if they stay clear of other 
outlines.

No current can flow in a lumped or wire via stub having an unconnected 
end. For example, if an outer pad is removed, current cannot flow in a 
lumped or wire via. Such vias are automatically discarded.

Defining Physical Model Options

You can specify the physical model options either global (lowest precedence), for 
selected layers or for selected nets (highest precedence).

Defining Global Physical Model Options

To specify physical model definition globally:

Choose  to open the EM Setup window.EM> Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Physical Model
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4.  

5.  

6.  

7.  

1.  

2.  

3.  

4.  

Ensure that the  tab is displayed, as shown in the following figure:Global

Select a value from the  drop-down list.Thick Conductor

Select a value from the  drop-down list.Via

Select the required lumped and wire via model options.

Defining Layer Specific Physical Model Options

To specify physical model definition for a specific layer:

Select  to open EM Setup window.EM> Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Physical Model

Click the  tab, as shown in the following figure.Layer Specific
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5.  

6.  

1.  

2.  

3.  

4.  

5.  

Select a value from the  drop-down Model Type for Currents Thick Conductor
list in the required layer.

Select a value from the  drop-down list in the required Model Type for Via
layer.

Defining Net Specific Physical Model Options

To specify physical model definition for a specific net:

Select  to open EM Setup window.EM> Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Physical Model

Click the  tab, as shown in the following figure:Net Specific

Select a value from the  drop-down Model Type for Currents Thick Conductor
list in the required layer.
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6.  Select a value from the  drop-down list in the required Model Type for Via
layer.

Specifying Physical Model Settings for FEM

Specifying Physical Model Settings for FEM

You can specify the physical model parameters such as model type, substrate 
layout and outline, and merge adjacent layers with same material properties in an 
FEM simulation. You can specify these parameters at the global or layer level and 
set advanced physical model options for FEM simulations.

Specifying Global Options

Model type for metals

The fields inside a good conductor decay exponentially with the decay rate given by 
the skin depth. To get accurate results for the fields inside a good conductor, it is 
necessary to generate a mesh that has a cell size that is smaller than the skin 
depth. At high frequencies, this would require very small cells and is thus 
computationally expensive. The FEM simulator offers a choice to approximate the 
fields inside good conductors to reduce this expense. You can specify these choices 
by specifying the "Model type for metals" options: Surface Impedance and Mesh 
Interior.

In FEM simulations, the default behavior is to not model the fields inside 
conductors. Instead, an approximate Surface impedance model is used on the 
surface of conductors. This gives the correct loss modeling at high frequencies. It 
also gives the correct DC losses for conductors with a uniform cross section. 
Slightly more accurate DC and low frequency losses for structures of varying cross 
section can be obtained by selecting the Meshed interior option. However, this can 
significantly degrade the accuracy of the high frequency losses from FEM 
simulations.

Substrate and Layout Outline

When you specified the substrate definition of a circuit, you specified only the 
vertical dimension of the substrate and not the horizontal dimension. Given this 
definition, the base substrate layers extend all the way to infinity in the horizontal 
direction. For many circuit designs this is not relevant and does not affect the 
simulation. However, there may be instances where you want to introduce 
horizontal boundaries. For these instances, you can use boxes or waveguides.

Additionally, since the FEM Simulator uses a Finite Element simulation technique, 
the EM problem domain needs to have a finite extent. Even if your actual substrate 
is much larger than the circuit you want to simulate, the problem domain will be 
automatically truncated by the FEM Simulator. The following options enable you to 
control how this truncation is computed:

Substrate LATERAL Extension
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2.  

3.  

Prior to simulation, the FEM Simulator will create a bounding box that surrounds 
the layout. All the four edges of this bounding box are extended in the X- and Y-
directions by the distance specified, unless:

A Box is defined (the Box specification is used)

A Waveguide line is parallel to the bonding box edge (the Waveguide 
specification is used)

A TML calibrated port lies on the bounding box edge (the domain is 
truncated at the port)

The FEM Simulator problem domain is truncated by this modified bounding box. 
You can view the effect of this truncation by selecting FEM > 3D EM Preview.

Substrate VERTICAL Extension

If the uppermost or lowermost substrate layer is specified as an Open Boundary, 
then the uppermost/lowermost substrate will be constructed as a layer with the 
given Vertical Extension thickness and an Open (absorbing) boundary condition to 
truncate the problem domain.

The FEM Simulator problem domain is truncated by this modified bounding box. 
You can view the effect of this truncation by selecting FEM > 3D EM Preview.

Substrate Wall Boundary

The selected boundary condition is applied to all the side walls of the problem 
domain. The boundaries that can be selected are:

Open: an absorbing boundary is applied to approximate an infinite 
extension.

Perfect Conductor: the side walls are perfect (lossless) conductors.

Perfect MagWall: the side walls are perfect (lossless) magnetic walls.

Merge Adjacent Layers with same Material Properties Option

using the Merge Adjacent Layers with same Material Properties option, you can 
merge adjacent layers that share the same material properties.

In an FEM simulation setup, you can specify three types of merge options: 
Merge Adjacent Layers with same Material Properties option in the Physical 
Model tab, Merge shapes touching each other where possible in the 
Preprocessor tab, and Merge Objects with Same Material in the Advanced 
subtab of the Mesh tab. The Preprocessor merge is done first. Layout objects, 
drawn on the same layer, touching each other are merged. Shared edges are 
not preserved during mesh generation. The merge option in the Physical Model 
merges adjacent layers that share the same material properties. Finally, during 
FEM mesh generation, and after the 3D objects are added if any, another merge 
can happen, based on material properties.

To specify the physical model settings globally:

Choose  to open the  window.EM> Simulation Setup EM Setup

Select  as the EM simulator.FEM

Select  in the left pane of the EM Setup window.Options
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5.  

6.  

7.  

8.  

9.  

10.  

1.  

2.  

3.  

4.  

5.  

Select the  tab.Physical Model

Ensure that the  subtab is displayed, as shown in the following figure:Global

Select a value from the  drop-down list.Model Type for Metals

Type a value in the  text box and select a unit.Substrate Lateral Extension

Type a value in the  text box and select a unit.Substrate Vertical Extension

Select a value from the  drop-down list.Substrate wall boundary

Select .Merge adjacent layers with same material properties

Specifying Layer-specific Options

In the Layer Specific tab, you can set the model type for metals value for each layer 
independently. There are following three options:

<Global>: take the model type for metals defined in the Global tab

Surface impedance: See .#Model type for metals

Meshed interior: See .#Model type for metals

To define substrate overrides for a specific layer:

Choose  to display the  window.EM> Simulation Setup EM Setup

Select  as the simulator.FEM

Select  in the left pane of the EM Setup window.Options

Select the  tab to display the substrate options that you can Physical Model
specify for FEM.

Select the  subtab to override substrate at the layer level.Layer Specific
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5.  

6.  Select a value from the  drop-down list in the required Model Type for Metals
layer.

Specifying Advanced Options

The Advanced options are used to determine the port surface for calibrated (TML) 
ports that are on the bounding box of the geometry. You can set the Port Surface 
Scaling and Port Surface Boundary options.

Port Surface Scaling

The port surface scaling options control how large the port surfaces are that the 
FEM simulator will generate for calibrated (TML) ports on the bounding box of the 
layout. You set the following options:

Port LATERAL Scale: The port surface will be extended laterally at both sides 
 times the width of the conductor connected to the Port LATERAL scale

positive pin of the port in case of an infinite ground plane. In case of a finite 
ground plane the port surface will be extended  times Port LATERAL scale
the widht of the smallest bounding box containing both strips.

Port VERTICAL Scale: The port surface will be extended vertically Port 
 times the vertical distance between the positive and VERTICAL scale

negative pin of the calibrated port. In case of a finite ground plane the port 
surface is extended both above and below the ground plane. In case of an 
infinite ground plane only at one side, the side where the positive pin of the 
port is located.

By setting these options to a very large value (say 1.0e6 or larger) you can ensure 
that the port surface covers the entire boundary surface. This will give the most 
consistent value for port de-embedding and is recommended when the Reference 
Offset of the port is non-zero. In the following example, a port has a positive pin on 
a strip and a negative pin on a strip or plane that is wider and is a vertical distance 
H below the positive pin. The smallest bounding box containing the two strips has 
width W:
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The port surface consists of a vertical extension from a distance 'Port VERTICAL 
scale x H' above the positive pin and the same distance below the negative pin.
The horizontal extension has a distance span of 'Port LATERAL scale x W' at both 
sides of the bounding box containing the two strips.
The scaling factors are 0 are larger, which means that the minimal port surface is 
the box with dimension W x H.
If the scaling factors are large, the port surface can be cropped by the bounding 
box of the geometry.

Treat finite strip (ground plane) as infinite plane

In cases where one of the pins, typically the negative or ground pin, is on a strip or 
plane that is much wider than the strip on which the other pin, typically the positive 
pin, lies, it is normally desired to model this strip as an infinite plane and set it as a 
border of the port surface. For this, you can use the parameter Finite (ground) 

, below abbreviated to 'f'. If the smallest strip has a width W plane detection factor
and the widest stripe spans a distance of at least f x W at both sides of the smallest 
strip, the widest strip/plane is treated as an infinite plane. Note that this does not 
only influence the vertical extension, but also the horizontal extension as the 
horizontal extension is now a factor of the smallest strip instead of the bounding 
box containing both strips.
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6.  

7.  

The  does not take care of the polarity of the Finite (ground) plane detection factor
pins. If the positive pin is on the widest strip, then this strip is modelled as an 
infinite plane and becomes the border of the port surface. Hence, the brackets 
around 'ground' in the name of the parameter.

Setting Advanced Options

Choose . The  window is displayed.EM> Simulation Setup EM Setup

Select  in the  section.FEM Simulator

Select  in the EM Setup window.Options

Select the  tab.Physical Model

Select the  subtab to specify advance options for your FEM Advanced
simulation.

Type a value in the  text box.Port Lateral Scale

Type a value in the  text box.Port Vertical Scale
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8.  

1.  

2.  

3.  

Type a value in the  text box.Finite (ground) plane detection factor

Defining Preprocessor Settings

Defining Preprocessor Settings

The EM Preprocessor prepares a layout for electromagnetic simulation. It converts 
a given layout into a new layout by applying the specified transformations.

EM Simulation Transformations Overview

The duration of an EM simulation with a conformal mesh is dependent on the 
number of edges in the mesh. This relation is superlinear. If the number of edges 
increases, the simulation time increases more than proportionally. Reducing the 
complexity of the mesh improves performance, especially for larger designs. 
Besides the complexity of the mesh, the quality of the mesh is also important. A 
mesh containing triangles with acute angles can lead to a reduced accuracy of the 
solution or even cause numerical issues while solving. The global preprocessor 

 alter the way the EM meshers interpret the input options applied to all shapes
layout geometries to improve the quality and complexity reduction of a generated 
mesh.

In addition, preprocessor options are provided that simplify specific patterns in the 
layout: metal fill and via arrays. Metal fill

Specifying the Preprocessor Settings

To specify preprocessor settings:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the EM Setup window.Options

Click the  tab.Preprocessor
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3.  

The  options are organized in 3 tabs.Preprocessor

Preprocessor Options Applied to All Shapes

The preprocessor settings alter the way the EM meshers interpret the input layout 
geometries to improve the quality and complexity reduction of a generated mesh. 
You can write the preprocessed version of the layout to a new cell view.

You can view a graphical representation of the available optional 
transformations by clicking .Show Visual Aid
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You can specify the following global preprocessor options that will be applied to all 
shapes:

Layout healing: Layout healing merges vertices and edges in close proximity. 
It corrects numerical issues in the layout that obstruct the creation of a high-
quality conformal mesh. Layout healing:

Closes unintentional gaps between adjacent shapes that are 
frequently created by layout generators and import or export 
processes, as shown in the following figure:

Ensures that stacked vias have only one joint boundary instead of two 
nearly identical boundaries, as shown in the following figure:

Eliminates acute angles, as shown in the following figure:

Defining snap distance: Within the same substrate layer, the vertices 
and edges that are closer together than the snap distance distance 
are merged. The distances for layout healing are calculated using the 
L ∞ metric. In this metric, the distance between two points is the 
largest absolute difference between both horizontal and between 
both vertical components. Any set of points equidistant to a given 
point is an axis-aligned square. Distances calculated using the L ∞ 
metric always amount to a fraction between 1/√2 and 1 of the 
Euclidean distance.
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The layout healing algorithm starts from an empty layout and inserts 
all edges of all polygons and polylines one by one. The stack of 
substrate layers is processed from top to bottom. Within one 
substrate layer, longer edges are inserted before shorter edges. 
Newly inserted edges merge with already present features on the 
same substrate layer within the snap distance. You can define 
automatic snap distance that enables the preprocessor to 
automatically provide a snap distance. Layout healing is enabled in 
this mode by default.

Merge shapes touching each other where possible: This EM transformation 
merge the shapes that are touching each other in the design. In this type of 
transformation, shared edges in the are not preserved. The following figure 
displays an example of such transformation:

In an FEM simulation setup, you can specify three types of merge 
options: Merge Adjacent Layers with same Material Properties 
option in the Physical Model tab, Merge shapes touching each 
other where possible in the Preprocessor tab, and Merge Objects 
with Same Material in the Advanced subtab of the Mesh tab. The 
Preprocessor merge is done first. Layout objects, drawn on the 
same layer, touching each other are merged. Shared edges are 
not preserved during mesh generation. The merge option in the 
Physical Model merges adjacent layers that share the same 
material properties. Finally, during FEM mesh generation, and 
after the 3D objects are added if any, another merge can happen, 
based on material properties.

Layout simplification: This EM transformation replaces polygons by nearly 
identical polygons with less vertices. The main purpose is to generate a 
conformal mesh containing minimum number of edges. Layout simplification 
also creates higher quality meshes as it removes many small segments.
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Layout healing and simplification can be applied in isolation or together.

Layout Scaling after Preprocessing: The layout scaling feature scales an 
entire design in the X and Y direction, but not in the Z direction. Pins are 
also taken into account. The scale factor value is forwarded to the simulation 
engine that multiplies all X and Y coordinates with the given scale factor. For 
example, a scale factor of 0.9 will reduce the layout by 10%. A scaled 
version of the layout is simulated. Any 3D visualization and simulation is 
done including the XY-scaling. When the mesh is written, the scaling is 
reversed to have the mesh match the original layout. The 3D viewer will also 
show the non-scaled layout. The currents visualization will show the 
dimensions of the simulated structure, therefore, it is recommended to turn 
off the visibility of the 3D objects, as they are not scaled.
To set the scale factor, select the  Scale the layout after preprocessing
option. Type a value in the  field. The default scale factor is 1.0 Scale factor
(no scaling).

Describing the Preprocessor Parameters

The following table describes the preprocessor parameters:

Option Description

Heal the 
layout

This option enables the layout healing feature. It merges the vertices and edges closer than 
an automatically determined or a user-specified snap distance. Detailed information about 
the algorithm is in the section dedicated to layout healing. It is recommended to specify 
automatic snap distance setting healing. If an aggressive healing approach is required, 
choose a value between 1-10% of the width of the smallest trace or the tightest clearance.

This option controls whether edges shared between adjacent shapes need to be preserved in 
the result.
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Option Description

Merge shapes 
touching each 
other where 
possible

Simplify the 
Layout

This option toggles the usage of the layout simplification feature. In this section, you can 
specify the following parameters:

Constraints (upper limits):

Upper displacement limit (layout simplification): This value is around 
one third of the width of the smallest trace in the layout.

Upper shrinkage/growth limit (layout simplification): The reasonable 
values are in the range of 5 to 15%. For specific requirements, such 
as via simplification, the values up to 30-50% can be acceptable 
(this reduces circles to squares or triangles).

Use different constraints for vias: You may need to simplify the vias more 
than the rest of the layout. You can specify a different set of constraints for 
vias:  and .Displacement Shrinkage/growth limit

Ignore shapes 
on the 
following 
purposes

Shapes on the indicated purposes are ignored. An application of this feature is to ignore 
dummy metal fill, although more advanced options are now available, see Preprocessor 

. Use spaces to separate the purposes.Options to Model Unrelated Metal Fill

Generate and 
replace 
shapes on 
derived layers

When enabled, existing shapes on  are ignored and the layers are regenerated. derived layers
When disabled, only the existing shapes are being used.

Scale the 
layout after 
preprocessing

When enabled, scales an entire design in the X and Y direction, but not in the Z direction

Save 
Preprocessor 
Messages as 
a DRC Result

This option enables you to display the location-bound information and warning messages in 
the layout using the DRC Results Viewer. The name of the DRC Result and the ADS layer 
where errors are shown can be configured.

Guidelines for Defining Preprocessor Settings

While defining the preprocessor parameters, you can refer the following guidelines:

http://edadocs.software.keysight.com/display/ads2017/Adding+Derived+Layers
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Layout healing can change the layout topology. Therefore, the healing 
algorithm is designed to make small changes to the layout topology. It is 
important to keep the snap distance below the minimal clearance between 
different layout nets, otherwise short circuits might appear. The snap 
distance must also be smaller than the width of thin layout traces, otherwise 
these traces will disappear.

Specify a snap distance at least 10 times smaller than the minimal clearance 
and trace width.

Whenever layout healing performs an actual layout change, a warning is 
displayed in the status window. The details of the change are written to the 
DRC Result or the layout processing report (dependent on the setup option 
Save preprocessor messages as a DRC Result). Refer the DRC result or the 
layout processing report to verify these changes.

Do not use layout healing as a polygon simplification tool. It is 
recommended to avoid choosing a large snap distance. For this purpose, the 
layout simplification feature provides a better and safe alternative.

Preprocessor Options to Simplify Via Arrays

Simulating via arrays in detail requires significant simulation resources. For typical 
RFIC designs, accurate results can obtained much faster by merging them upfront. 
The underlying assumption is that the impedance presented by the via array is low 
and has little effect on the device performance.

Merging Standard Via Arrays

When this option is enabled, standard (i.e. OA) via arrays are merged before being 
passed to the EM simulation engine. The merge replaces the individual cuts of 
standard via arrays by their hull. Non-standard (non-OA) via array cannot be 
merged by this option. Consider to use the alternative method to merge 
rectangular via shapes during the layout preprocessing step of an EM simulation.

Merging Rectangular Via Shapes

The merge of rectangular via shapes occurs during the layout preprocessing step of 
an EM simulation. Two distinct types of via clustering are provided:  Local Via Array
(recommended) and .Stacked Conductor

Local Via Array

Only axis aligned or 45 degree turned rectangles are being considered. The other 
shapes are left unchanged. First the shapes are grouped per contiguous area where 
the top and bottom via cover presence are the same (present or absent). Shapes 
having their center exactly on a boundary between areas are left unchanged. In 
each such group, the algorithm looks for arrays of exactly identically sized 
rectangles. The arrays can be axis aligned or 45 degree turned. The spacing 
between the cuts across the array axes does not need to be uniform. The 
combination of axis aligned rectangles and 45 degree arrays (or 45 degree 
rectangles and axis aligned arrays) is only detected as an array if the rectangles are 
square.
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You can optionally limit the distance between cuts where arrays are detected by 
setting  either in absolute terms (e.g. 1 um) or as a multiple of the cut Max Space,
size (e.g 3 ) along the direction of the array (i.e. for 45 degree array of axis via sides
aligned squares, the diagonal is taken into account). Specify a strictly positive value 
to turn this on. 0 will turn it off.

The shapes of arrays with only one cut are left unchanged. Otherwise, the 
algorithm looks at the array as a bitmap of cuts. For each bitmap, a hull around the 
cuts is constructed and limited to fit inside the contiguous top/bottom area. The 
resulting shapes become "cluster shapes". The bitmap can be modified before 
cluster shape construction occurs. You can optionally divide an array into smaller 
arrays not larger than not larger than a specific dimension by specifying a strictly 
positive . Arrays will not be larger than this amount of pixels in either Max Array Dim
dimension. This allows to find a middle ground between all original cuts and 
merging everything.

In the second stage, final shapes are generated from cluster shapes according to 
the selected clustering :Method

keep boundary: returns the cluster shapes as-is.

keep area: shrinks the cluster shapes until they have the same area as the 
original via cuts they are replacing

keep boundary and area: constructs donut shapes with the same outer 
boundary as  and the same area as .keep boundary keep area

increment and clip to lid boundary: extends the cluster shape bitmap 
horizontally, vertically and diagonally by 1 pixel. The cut distance applied to 
the extension is the average cut distance in that dimension (or in the other 
dimension if the array is 1D). This allows you to make arrays that almost fill 
the top/bottom conductor they are in to fill the conductor surface up to the 
boundary.

Stacked Conductors

In the first stage, each contiguous intersection area of interface layer masks 
present at both the top and bottom via interfaces becomes a cluster shape, 
provided there is at least one via shape present in the intersection. Sections of via 
shapes where there are no shapes on both top and bottom interface masks are 
discarded. In the second stage, final shapes are generated from cluster shapes 
according to the selected clustering :Method

<upper> AND <lower>: returns the cluster shapes as-is.

shrink <upper> AND <lower>: shrinks the cluster shapes with the distance 
amount specified by .Shrink Size

Specifying the Preprocessor Settings

The via simplification options are specified globally, i.e. applied to patterns on all 
via layers, but can be overriden for a specific layer.

Global
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Layer Specific
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Preprocessor Options to Model Unrelated Metal Fill

RFIC designs often contain unrelated metal fill (aka dummy fill or tiling) on selected 
strip layers. Simulating those in detail requires significant simulation resources. 
Often, when keep-out regions are respected, the metal fill will have limited impact 
and can be ignored during the simulation. In case of a uniform metal fill distribution 
underneath the RF device, one can obtain fast simulation results by replacing the 
metal fill with an equivalent dielectric layer. The preprocessor tries to identify the 
metal fill and takes action based on the selected modeling approach.
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Presence

Presence option specifies how unrelated metal fill is distinguished from functional 
metal.

Not used: there will be no identification of unrelated metal fill.

Used but not present in layout: the metal fill is not drawn in the layout but a 
certain percentage of the area might be uniformly filled on selected layers 
before tape out. This selection is specified per strip layer and goes with the 
equivalent dielectric layer modeling approach.

Drawn in layout on dedicated purposes: all shapes drawn in the specified 
 will be treated as unrelated metal fill. Use spaces to Dedicated purposes

separate the purposes.

Drawn in layout as individual shapes: all shapes that fit within the Enclosing 
 size will be treated as unrelated metal fill.bounding box

Modeling Approach

The  option specifies the modeling approach for the unrelated metal fill.Model

Remove unrelated metal: the unrelated metal fill will be ignored in the 
simulation.

Keep unrelated metal: the unrelated metal fill will be simulated as-is.

Replace by equivalent layer: the unrelated metal fill is removed from the 
layout passed to the simulator and the substrate stack is adjusted with an 
equivalent layer. This approach assumes a uniform distribution of the 
unrelated metal fill, no other usage of that layer and requires an area fill 

 which is the fraction of the area that gets filled. This is a value fraction
between 0 and 1.

Specifying the Preprocessor Settings

The unrelated metal fill options are specified globally (i.e. applied to patterns on all 
strip layers) but can be overriden for a specific per layer.

Global
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Layer Specific
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1.  

2.  

Generating Preprocessed Geometry

Before simulating your design, you can preprocess your design to automatically 
perform layout healing, merge shapes, and simplify the layout. To generate a 
preprocessed geometry:

Select  from the  drop-down list in the EM Preprocessed geometry Generate
Setup window.

Click .Go

Defining Mesh Settings for Momentum
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Defining Mesh Settings for Momentum

In the Momentum solution approach, any electromagnetic configuration of a 3D 
design can be represented without loss of generality as a voltage/current 
distribution on its surfaces. This continuous distribution is approximated by a finite 
number of unknowns using a mesh. This mesh is a grid-like pattern of triangular and
/or quadrilateral cells tessellating all surfaces.

In an S-parameter simulation, coupling effects between cells are being calculated 
using the Green function database. The currents passing through mesh edges are 
then derived from mesh cell voltages to match the calculated coupling effects. 
From these results, S-parameters are calculated for the circuit.

The quality of the mesh determines the quality of a solution. The cells need to be 
small enough in order to capture real world spatial variations of the current/voltage 
distribution. However, covering low-variability regions with larger cells is necessary 
to keep the problem size within reasonable limits.

The default configuration of the mesh generator produces suitable meshes in the 
vast majority of situations. When desired, this configuration can be adjusted 
through a number user-adjustable parameters. The default parameters are used 
automatically. The mesh is normally computed as part of the simulation process; no 
specific user intervention is required. It is also possible to explicitly preview the 
mesh without simulating in order to assess its quality.

Defining a Mesh

A  is a grid-like pattern of triangles and rectangles, and each triangle or mesh
rectangle is a . This pattern of cells is based on the geometry of a circuit and, cell
optionally, user-defined parameters, so each circuit will have a unique mesh 
calculated for it. The mesh is then applied to the circuit in order to compute the 
current within each cell and identify any coupling effects in the circuit during 
simulation. From these calculations, S-parameters are then calculated for the 
circuit. The mesh that was calculated for the double patch example is shown below.

Creating a mesh consists of two parts:

Defining mesh parameters

Previewing the mesh
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It is not necessary to set up mesh parameters; default parameters will be 
used instead. You can preview the mesh before simulating in order to view 
the mesh, otherwise the mesh will be computed as part of the simulation 
process. A mesh is required in order to simulate.

You can define mesh parameters for the following areas:

Entire circuit

Objects on a layout layer

Shape of an object

It is not necessary to specify parameters for all levels. For example, you can 
specify mesh parameters for a single object and use default values for the rest 
of the circuit.

Adjusting The Mesh Density

A minimal mesh density is guaranteed by enforcing all cells to be smaller than a 
certain maximum cell size limit. When this maximum cell size is not stated 
explicitly, it is calculated from the mesh frequency and the number of cells per 
wavelength. The cells need to be small enough in order to capture real world 
spatial variations of the longitudinal current distribution. The spatial extent of 
waves is shortest at the highest frequency. Consider wave phenomena to be 
described by a sinusoid of a certain wavelength. Each mesh cell is able to 
approximate only the portion of the sinusoid it covers with a linear function. The 
accuracy of this piecewise linear fit improves as the number of cells per wavelength 
increases. For example, if you use 30 cells per wavelength, the maximum deviation 
between the sinusoid and the linear approximation is about 1 percent.

Increasing either the mesh frequency or the number of cells per wavelength makes 
the mesh denser. When a denser mesh is desired, it is generally better to increase 
the number of cells per wavelength than the mesh frequency. The optimal value for 
the mesh frequency is the highest simulation frequency that will be eventually 
used. In fact, an increase of the mesh frequency may trigger a recalculation or 
extension of the Green's functions database.

Only the  cell size is enforced and not the  cell size. A polygon maximal minimal
with  sides can be tessellated with no less than  triangles (or half as many N N-2
quadrilaterals). This imposes a minimal cell size dependent on the level of 
detail of the geometry.

Sometimes the geometric detail is much smaller than a fraction of the 
wavelength (typically when including integrated circuits in the simulation). In 
this case it is advised to choose an explicit maximal cell size not larger than 
four times the regular trace width. Otherwise the mesh may contain cells with a 
very large aspect ratio that cannot properly model the actual current flow.

Effect of Mesh Reduction on Simulation Accuracy

Mesh reduction is a technology that aims at removing mesh complexity originating 
from the meshing of geometrically complex shapes. In a normal situation, you 
specify the mesh density (the number of cells per wavelength) that needs to be 
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used in the simulation in order to obtain a specific accuracy. However, due to 
geometrical constraints, the mesher can be forced to use more cells than strictly 
needed by the wavelength criterion. In this case, the mesh introduces "redundant" 
degrees of freedom in the solution process ("redundant" with respect to the 
electromagnetic behavior). Mesh reduction is a technology that automatically 
removes these redundant degrees of freedom, prior to the solution of the problem. 
Hence, it should have a negligible impact on the accuracy of the results.

About the Edge Mesh

An edge mesh is important when conductors are modelled as a sheet. The edge 
mesh feature automatically creates a relatively dense mesh pattern of small cells 
along the edges of metal or slots, and a less dense mesh pattern of a few large 
cells in all other areas of the geometry. Because most of the current flow occurs 
along the edges of conductors, the edge mesh provides an efficient solution with 
greater accuracy. Use the edge mesh to improve simulation accuracy when solving 
circuits where the modeling of sheet current flow in any edge area is a critical part 
of the solution. This includes circuits where the characteristic impedance, or the 
propagation constant are critical for determining the electrical model, circuits in 
which close proximity coupling occurs, or circuits where edge currents dominate 
the circuit behavior.

The use of an edge mesh is typically not required when the conductors are defined 
as thick conductors with a 3D-Distributed model. In the latter case, the current 
crowding at the edges is already accounted for by the horizontal current flowing on 
the side walls of the thick conductor. Enabling the edge mesh for thick conductors 
will additionally allow to capture the current crowding effect in corners. However, 
that is secondary effect that in the vast majority of cases is not required for a 
sufficient accuracy.

The edge mesh option is available at all levels of meshing: global, 
per layer, per net or per object meshing.

When enabled for thick conductors, an edge mesh is created at 
all 4 sides of the conductor: top, bottom and side walls.

Setting the Width of the Edge Mesh

When using an edge mesh, choose  to let Momentum Auto-determine Edge Width
determine an appropriate width. Alternatively, enter an explicit width. To this end 
you can use  >  to measure distances on the layout.Insert Measure...

About the Transmission Line Mesh

Use the transmission line mesh when you want to explicitly specify the number of 
cells in the direction perpendicular to the current flow. This has no effect on the 
mesh density in the direction of the current flow.

This setting can be used to improve the accuracy of transmission line simulations 
with a coarse mesh density. For example, the simulation results for a single 
transmission line with one or two cells across its width will be equal. If you have 
coupled lines, the results will differ.
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When enabled for thick conductors, a transmission line mesh is 
created at all 4 sides of the conductor: top, bottom and side 
walls.

Specifying a transmission line mesh will significantly increase the 
number of unknowns and consequently increase the simulation 
time and memory requirements.

Combining the Edge and Transmission Line Meshes

Both transmission line mesh and edge mesh can be used together. The total 
number of cells wide will be the total number of transmission line cells plus edge 
cells. The minimum value permitted when using this combination is 3.

The edge and transmission line mesh settings affect the transverse current distribution. 

The accuracy of transverse current approximations improves as the number of cells 

specified using edge mesh and transmission line mesh increases.

The plot below illustrates the hairpin example simulated with and without and edge 
mesh. Although the simulation that includes the edge mesh takes more time, the 
results are closer to the actual measured results of the filter.
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Processing Object Overlap

The parameter  should be used in designs that have Thin layer overlap extraction
thin layers in-between overlapping objects. It is possible that mesh cells are 
generated that cross the overlap region and this is not desirable.
Typical situations where this is important are:

Parallel plate capacitor: The charge will be accumulated where the plates 
overlap. Just next to that overlap area, charge will be much lower. As charge 
is assumed to be uniformly distributed on a mesh cell, when such cell 
crosses the plate overlap area, the charge will be spread out too much, 
resulting in a less accurate capacitance extraction.

Transmission line above a finite ground plane: The return current in the 
ground plane will concentrate just under the transmission line at higher 
frequencies. Large mesh cells under the transmission line do not allow to 
describe that return current flow accurately. The overlap extraction provides 
a way to force a mesh that follows the shape of the transmission line 
allowing a more accurate approximation of the return current flow.

As an example, consider two layers, one above the other, and close together. They 
carry a large charge density where they overlap, which increases proportionally to 1
/distance. If there is no metal above the layers, the charge density is nearly zero 
where there is no overlap, and the change is very rapid-nearly a step-at the point 
of overlap.
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If no overlap extraction is performed, the mesher can create cells that will cross the 

border of the overlap. In the actual circuit, this cell would have a partially high charge 

density area where the overlap is present, and a partially low charge density area where 

there is no overlap. However, Momentum simulates cells with a  charge density, constant

and approximating the strongly-varying charge in the cell with a constant is not an 

adequate representation. Thus, by enabling thin layer extraction, no cells will be created 

that cross an overlap region.

All possible overlaps are being imprinted when using the  setting. This Aggressive
can lead to a very dense mesh. Therefore, when using the  option, some Normal
rules are in place that determine whether any particular overlap instance is 
sufficiently important to warrant imprinting. To this end, every pair of overlapping 
shapes is analyzed. Only direct overlap (not shielded by a third shape) is being 
considered. Both shapes take turns being the aggressor and the victim. However, it 
needs to be decided whether or not to imprint the boundary of the aggressor onto 
the victim, as shown in the following figure:

The following analysis determines whether the overlap should be imprinted:

Capacitive overlap
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Relevance: To determine whether this is a relevant capacitive overlap 
region, the width of the overlap must be large in comparison to the 
distance between the planes containing both shapes. The parameter 

 determines the threshold for oe_capacitor_width_threshold

the ratio between the overlap width and the effective z-plane 
distance. The effective z-plane distance is the z-plane distance 
divided by the relative static permittivity.
Above this threshold, capacitive overlap is considered to be relevant.

Accuracy: Edges of a relevant capacitive overlap region are imprinted 
according to an accuracy specification. Edges of relevant capacitive 
overlap regions that don't pass both of the following two limit checks 
are imprinted:

The parameter  sets an upper oe_capacitor_accuracy

limit for the ratio between the effective maximal cell size of the 
victim and the effective overlap width.
The  maximal cell size is the maximal cell size effective
decreased with the z-plane distance times 

.oe_maximal_cell_size_height_shrink_factor

Likewise, the  overlap width is the overlap width effective
increased with the z-plane distance times 

.oe_overlap_width_height_grow_factor

The product of the parameters  oe_capacitor_accuracy

and 
oe_capacitor_inv_rel_sens_to_delta_w_div_eff_h

sets an upper limit for the ratio between the maximal cell size 
and the effective z-plane distance.

Inductive overlap

Relevance: Only sufficiently long boundaries are considered for 
inductive overlap. The length of the boundary must exceed 

 times the minimal wavelength.inductor_length_threshold

In addition, the ratio of the overlap width to the aggressor width must 
exceed .oe_inductor_width_threshold

Accuracy: Edges of a relevant inductive overlap region are imprinted 
according to an accuracy specification. The parameter 

 determines the threshold for the ratio oe_inductor_accuracy

between the effective maximal cell size of the victim and the effective 
overlap width. Above this threshold, edges of relevant inductive 
overlap regions are imprinted.

When an edge is being imprinted, it is allowed to snap to existing geometry if the 
snap distance is small enough to uphold the specified accuracy. This snap distance 
is additionally limited to  times the oe_maximal_overlap_width_change

overlap width.



313 Electromagnetic

The final Boolean parameter  can be used to impose the most strict oe_pedantic

overlap extraction rules. When enabled, it forces all other parameter values to zero. 
The  overlap extraction setting has been implemented in practice by Aggressive
forcing  to .oe_pedantic ON

You can set all parameters by selecting  >  in the EM Setup window. Options Expert
When unset, corresponding  configuration variables are consulted momentum.cfg

for default values. Finally, built-in default values are being used. These values 
guarantee proper overlap extraction across a wide range of designs.

The following table summarizes all overlap extraction related parameters. Note that 
all numerical parameters are dimensionless quantities.

Options >  key in EM Setup (highest priority)Expert momentum.cfg variable name

oe_capacitor_width_threshold MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_CAPACITOR_WIDTH_THRESHOLD

oe_capacitor_accuracy MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_CAPACITOR_ACCURACY

oe_inductor_length_threshold MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_INDUCTOR_LENGTH_THRESHOLD

oe_inductor_width_threshold MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_INDUCTOR_WIDTH_THRESHOLD

oe_inductor_accuracy MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_INDUCTOR_ACCURACY

oe_capacitor_inv_rel_sens_to_delta_w_div_eff_h MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_CAPACITOR_INV_REL_SENS_TO_DELTA_W_DIV_EFF_H

oe_maximal_cell_size_height_shrink_factor MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_HEIGHT_SHRINK_FACTOR

oe_overlap_width_height_grow_factor MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_HEIGHT_GROW_FACTOR

oe_maximal_overlap_width_change MOM_MESHER_OVERLAP_EXTRACTION_DEFAULT_MAXIMAL_OVERLAP_WIDTH_CHANGE

oe_pedantic EMPREP_PEDANTIC_OVERLAP_EXTRACTION

To specify expert options, see .Defining Expert Options for Momentum

Guidelines for Meshing

The default mesh will provide an adequate and accurate answer for many circuit 
applications. For most other circuit applications, the using the global mesh 
parameters will be all that is needed to provide greater accuracy. In a few special 
cases, you may need to use the layer or primitive mesh controls.
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1.  

2.  

3.  

4.  

For applications such as highly accurate discontinuity modeling or for geometries 
that have tightly coupled lines, the default mesh may not be dense enough in 
particular areas to provide enough accuracy. In such cases, edge mesh should be 
used or the mesh density must be increased. For example, noise floor and dynamic 
range are typically small numbers. In some cases, geometry solutions may show a 
low value of S21, like -60 dB, using a dense mesh. Such values are different for a 
default mesh, which may result in -40 dB for the same circuit.

In any design, you can use any combination of the four types of mesh control. In 
general, greater mesh density provides better accuracy. However, a greater density 
increases the computation time (more cells to solve). You can refer to the following 
guidelines:

Meshing Thin Layers: Thin layers must be meshed so that the mesh cells are 
entirely within or entirely outside of the overlapping area. If the mesh cells 
and object boundaries are not aligned correctly, the simulation data may be 
less accurate.

Meshing Thin Lines: When the geometry has narrow lines, like thin 
transmission paths in a spiral, it may be difficult to have a mesh that is more 
than one cell across the width if the default global mesh is used. If needed, 
use Edge Mesh or Transmission Line Mesh to capture the current 
distribution across the line.

Meshing Slots: Slots should be meshed exactly the same as strips-there is 
no difference. For example, the edge mesh can be used for slots because 
the current distribution is basically the same, that is, it is concentrated on 
the edges of a slot.

Adjusting the Mesh Density of Curved Objects: Vias or other curved objects, 
when drawn in a layout, have a default value for the number of facets used 
to draw the object, based on the command  >  > Options Preferences Entry

 > . If the value is small, a relatively large /Edit Arc/Circle Resolution (degrees)
number of facets are used to draw the circle, and this can result in more 
triangular cells created the curved areas during the mesh process. To 
change the number of facets for all arcs and circles, use the command 
shown above. To change them for a single object, select the object, then 
choose  >  > . Then, increase the number of Edit Modify Arc/Circle Resolution
degrees for the radius, as required, to reduce the number of triangles. 
However, this alters the geometry of a circuit.

Defining Global Mesh Parameters

Global mesh parameters affect the entire circuit. To set up global parameters:

Select  to open the  window.EM> Simulation Setup EM Setup

Select  as the EM simulator.Momentum

Select  in the left pane of the EM Setup window.Options

Select the  tab. By default, the Global parameters are displayed.Mesh
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4.  

5.  

6.  

7.  

Specify the mesh frequency. You can select one of the following options:

Select . Set the value of the mesh Highest Simulation Frequency
frequency to the highest frequency that will be simulated. For more 
information, refer to .#Adjusting Mesh Density

Type the mesh frequency in the  field and select the Mesh Frequency
units. The wavelength of this frequency is used to determine the 
density of the mesh.

Specify the mesh density. You can select one of the following options:

Specify the  value and select the units.Maximum Cellsize

Enter . This value will also be used to Number of Cells per Wavelength
determine the density of the mesh. For more information, refer to 

.#Adjusting Mesh Density

Enable to add a relatively dense mesh along the edges of objects. Edge Mesh
Due to the flow of current along the edges of objects, the edge mesh can 
improve the accuracy and speed of a simulation. An edge mesh will similarly 
be created on thick conductor side walls. You can select one of the following 
options:

If you want the edge mesh to be sized automatically, select Auto-
.determine Edge Width

To specify the edge width, select  and select the units. For Edge Width
more information about the edge mesh, refer to #About the Edge 

.Mesh

An edge mesh that is specified with a width larger than the 
cell size set by the wavelength

 will be ignored. This is /number_of_cells_wavelength,
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7.  

8.  

9.  

10.  

11.  

1.  

2.  

3.  

4.  

5.  

because such edge meshes would be very inefficient. 
However, if these edge mesh values must be used, you 
can decrease the number_of_cells_wavelength, which is 
specified in the  field.Number of Cells per Wavelength

Enable  to specify the number of cells along the Transmission Line Mesh
width of a geometry. This option is most useful for circuits with straight-line 
geometry.

Enter the number of cells that the width will be divided into in the Number of 
 field. This will be the total number of cells along the width of the Cells Wide

circuit. For more information about the transmission mesh, refer to #About 
.the Transmission Line Mesh

Enable  to obtain an optimal mesh with fewer small cells and Mesh reduction
an improved memory usage and simulation time.

Enable to extract objects for the following Thin layer overlap extraction
situations:

Two objects on different layers overlap.

The objects are separated with a thin substrate layer.
If this is enabled, the geometry will be altered to produce a more 
accurate model for the overlap region. The  setting is Normal
recommended for most layouts. The  setting is only Aggressive
recommended when tiny overlap differences are expected to lead to 
significant result variations as this option will considerably increase 
the problem size. For more information, refer to #Processing Object 

.Overlap

This should always be enabled for modeling thin layer 
capacitors.

Specifying Layer-specific Mesh Options

You can use the Layer Specific tab to define the mesh options for a specific layer. 
Perform the following steps:

Select >  to open the  window.EM Simulation Setup EM Setup

Select  as the EM simulator.Momentum

Select  in the EM Setup window.Options

Select the  tab to display the mesh options for Momentum.Mesh

Select the  subtab to specify settings at the layer level, as Layer Specific
shown in the following figure:
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6.  

7.  
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2.  

3.  

4.  

5.  

Select a value from the  drop-down list in the required layer.Mesh Density

Select a value from the  drop-down list in the required Edge Mesh Width
layer.

Select a value from the  drop-down list in the Transmission Line Mesh Width
required layer.

Defining Net-specific Mesh Options

To specify mesh definition for a specific net:

Select >  to open EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Options

Click the  tab.Mesh

Click the  tab, as shown in the following figureNet Specific

Specifying Shape-specific Mesh Options

You can customize the selected shape by using the Shape Specific tab. Perform the 
following steps:

Choose >  to open the  window.EM Simulation Setup EM Setup

Select  as the EM simulator.Momentum

Select  in the left pane of the EM Setup window.Options

Select the  tab to display the mesh options for Momentum.Mesh
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5.  

6.  

7.  

8.  

Select the  subtab to specify settings at the shape level, as Shape Specific
shown below.

To enable shape-specific options, you need to select a shape in the 
layout before specifying the options. As soon as you click the Shape 

 tab from another tab, immediately move your mouse over to the Specific
layout window. Use the mouse to select a shape in layout and then go 
back to Shape Specific tab to select the required options. You must 
have the white cross hair at the tip of the mouse before selecting a 
shape. Otherwise, options will not be enabled. You can always go to 
another tab and then come back to this tab to invoke the white cross 
hair at the tip of mouse when you move your mouse to layout window.

Enable the section. You can select one Override Layer Specific Mesh Density
of the following options:

Select . Set the maximum value of the mesh density Maximum Cellsize
that will be simulated. For more information, refer to #Adjusting Mesh 

.Density

Type the number of cells per wavelength in the  text Cells/Wavelength
box.

Enable . You can select one of the Override Layer Specific Edge Mesh
following options:

No Edge Mesh

Auto-determine Edge Width

Use Edge Width

Enable the section. You can Override Layer Specific Transmission Line Mesh
select one of the following options:
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8.  

1.  

2.  

3.  

4.  

No Transmission Line Mesh

Cells in Width

Defining FEM Mesh Settings

Defining FEM Mesh Settings

To perform a FEM simulation, the entire 3D problem domain is divided into a set of 
tetrahedra (or cells). The pattern of cells, called the mesh, is based on the 
geometry of a layout and optionally, user-defined parameters, so each layout has a 
unique mesh calculated for it. The mesh is then applied to the geometry to 
compute the electric fields within each cell. It also helps to identify any coupling 
effects in the layout during simulation. From these calculations, S-parameters are 
then calculated for the layout.

The FEM simulator implements an adaptive meshing algorithm, where an initial 
mesh is generated and the electric fields (and S-parameters) are computed on that 
initial mesh for a single frequency or multiple frequencies if Performing FEM 

 is used. An error estimate is generated for each Broadband Refinement
tetrahedron. The tetrahedrons with the largest estimated errors are refined to 
create a new mesh where the electric fields (and S-parameters) are computed 
again. The S-parameters from consecutive meshes are compared. If the S-
parameters do not change significantly, then electric fields (and S-parameters) are 
computed for all the requested frequencies. If the S-parameters do change 
significantly, then new error estimates are computed, a new mesh is generated and 
new electric fields (and S-parameters) are computed.

Specifying Mesh Settings for FEM

To define FEM mesh settings using the EM Setup window:

Select  >  to open the EM Setup window.EM Simulation Setup

Select the  simulator.FEM

Select  in the left pane of the EM Setup window.Options

Click the  tab, as shown in the following figure:Mesh
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4.  

In the Mesh tab, you can specify the following settings:

Specifying Stop Criterium Settings

Specifying Refinement Settings

Specifying Initial Mesh Settings

Specifying Advanced Settings

Specifying Stop Criterium Settings

Using the Stop criterium tab, you can specify delta error and adaptive phase 
values. The following figure displays the stop criterium options:

The following table describes the stop criterium options:
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Option Description

Delta Error Global Delta S-parameter sets a value that is applied to all S-parameters in the solution. Enter 
a value in the Delta Error field. It is the allowable change in the magnitude of the vector 
difference for all S-parameters for at least the number of consecutive refinement passes 
specified in the field "Consecutive passes of delta error required".

Consecutive 
passes of 
delta error 
required

Specify the required number of consecutive passes with a delta error smaller than or equal to 
the value specified in the field "Delta Error".

Minimum 
number of 
adaptive 
passes

Enter the minimum number of refinement passes. The number of refinement passes is at least 
this number even if the convergence criterium based on the delta error is met with less 
refinement passes. If you have concerns about convergence, you can increase this value, 
otherwise, use the default value of 2.

Maximum 
number of 
adaptive 
passes

Enter the maximum number of passes to be attempted. If the number of refinement passes 
entered is reached before the delta error criterium is met, the refinement process ends, based 
upon this limit. Typically, a value between 10 and 20 is recommended.

Use 
Memory 
Limit

If the memory used by the FEM solver exceeds the specified memory limit, the mesh refinement 
process will end and the simulation will continue with the solve phase, even if the delta error 
does not satisfy the convergence criterium.

Specifying Refinement Settings

Using the  tab, you can control the frequencies at which the mesh will Refinement
be adaptively refined. The following figure displays the Refinement tab options:



Electromagnetic 322

The following table describes the Refinement tab options:

Option Description

Maximum 
frequency

The refinement frequency will be the highest frequency found in the frequency plan.

Chosen 
automatically 
after initial 
pass

Refinement frequencies are chosen by the solver. This strategy is recommended when you are 
not aware about the important characteristics that can occur in your frequency, but you know 
the frequency transitions are not extremely sharp (i.e. are not high Q resonances).

Chosen 
automatically 
after each 
pass

Refinement frequencies are not fixed, but can vary from level to level. This is an automated 
option and tends to generate accurate results, but it also tends to result in the longest 
simulation times. This strategy is recommended:

For structures with high Q resonances.

During final analysis of a structure where accuracy is preferred over fast 
simulations.

Manual 
Selection

Refinement frequencies are specified manually.

Performing FEM Broadband Refinement

Specifying Initial Mesh Settings
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Specifying Initial Mesh Settings

Using the  tab settings, you can control how an initial mesh is Initial mesh
generated. If the initial mesh is made finer, the adaptive mesh refinement may 
converge faster. However, a finer mesh results in higher computation times. 
Therefore, to avoid overmeshing, the intial mesh size should not be too small.

For some resonating structures, such as patch antennas, the adaptive refinement 
may fail to converge, if the initial mesh is not fine enough. This is because the 
resonance frequency depends heavily on the mesh and a small difference in this 
frequency causes a large delta S. In these cases, the initial mesh settings are 
required to get the adaptive refinement converging.

Global Initial Mesh Settings

Using the Global tab, you can set initial target size, automatic, and edge mesh 
length. The following figure displays the initial mesh options:

You can specify Target Mesh Size and Conductor Mesh options for FEM mesh.

Target Mesh Size

You can specify the following target mesh size options:

Automatic (recommended): The initial target mesh size is determined 
automatically. The length is computed based on the frequency plan 
available when the request is made.

Minimal memory: Minimum memory is used for calculating the mesh.

Custom: Provides an initial denser mesh. If used, no edge in the initial mesh 
will be longer than the given length.



Electromagnetic 324

Automatic is the recommended setting. The target mesh length will be one third of 
the free space wavelength at the maximum frequency. It is a compromise between 
accuracy and simulation performance.

The target mesh length is used for the full simulation domain. No tetrahedron in the 
simulation domain will contain an edge which is longer than the target mesh 
length. If there is a large area of the simulation domain that does not contain any 
fields, then using a global target mesh length can generate too many tetrahedral 
and it is advised to revert to the “custom target mesh size” setting or use the 
“minimal memory”.

When  is chosen the initial mesh will generate a mesh with the Minimal Memory
least amount of tetrahedra as possible. A typical mesh is then determined by the 
geometric detail of the design, the wavelength does not play any role at all. The 
advantage of using this setting is that no part of the design will contain more 
tetrahedral than necessary. However, there might be insufficient tetrahedra to have 
an accurate simulation result. When using the “Minimal Memory” it is advised to 
either:

have a sufficient number of mesh refinement steps;

or to further customize the mesh with additional dedicated settings.

The  works similar to the automatic target mesh except that as custom target mesh
a user you have the liberty to specify the mesh size. This choice can be used when 
the automatic derived mesh length is not sufficient. For example: not the maximum 
frequency but another frequency has to be used, or the design contains little to no 
free space and a different wavelength is important.

Conductor Mesh

You can specify the following conductor mesh options:

Automatic: When automatic conductor meshing is selected, the mesher 
estimates where mesh lengths need to be reduced to improve the accuracy 
and convergence speed of the simulation. The algorithm to produce this 
mesh is based on the DC connectivity of geometry with ports. Only parts 
electrically connected to a port are affected. For those parts the edge and 
vertex mesh is set. The length of the edge and vertex mesh is based on the 
estimated width assuming the structure being excited starts with a strip-like 
construction. The mesh process will report the estimated width in the 
simulation output window.

Fixed for all conductors: The following options are used for specifying the 
mesh for all conductors:

Conductor edge mesh length: Specifies a target mesh size of all 
edges that belong to the geometry of a conductor. Edges do not 
necessarily have to be straight lines. A value of 0 means that no initial 
conductor edge mesh length is applied.

Conductor vertex mesh length: Specifies a target mesh size for all 
vertices that belong to the geometry of a conductor. A value of 0 
means that no initial conductor vertex mesh length is applied.
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For all lengths a parameter or formula is allowed. The formula is always evaluated 
at the time the simulation is being created.

“Conductor Mesh” specifies the mesh lengths on conductive objects in the mesh. 
To obtain an accurate simulation result, typically the mesh on conductive objects is 
finer than on its surrounding elements.

There are two ways to specify the mesh lengths to be applied to conductors:

Automatic conductor mesh: during the simulation process will extract the 
DC connectivity of the design and consider all conductive objects connected 
to a port. At each of the pins of the port the actual width of the conductive 
object is determined. The estimated width is reported at the start of the 
mesh generation process. That width is used to set the edge mesh length on 
the connected pieces of conductive objects. The length set for the edges is 
by default 1/5 of the width. This factor can be tweaked on the “Advanced” 
tab of the “Mesh/Refinement Properties”.

Automatic conductor mesh performs a best-effort to determine the widths 
at all conductors and will report when there was a failure. The effective port
/pin location contributes to the success of the estimation. Pins located at 
the edges of a conductor help disambiguating the width. The automatic 
conductor mesh will typically back out when a pin is connected to a curved 
surface or curved edge.

Fixed for all conductors: all conductors receive the specified mesh length. In 
contrast with the automatic conductors is there no difference between a conductor 
attached through a conductive path to a pin and a so called floating conductor.

Number of Bondwire Segments

This option enables you to specify the number of bondwire segments.

Global Vertex, Edge, and Surface Mesh

You can specify the following options:

Global Vertex Mesh Length: Defines the value of the Global field used in 
Layer Specific Initial mesh tab.

Global Edge Mesh Length: Defines the value of the Global field used in Layer 
Specific Initial mesh tab.

Global Surface Mesh Length: Defines the value of the Global field used in 
Layer Specific Initial mesh tab.

To avoid difficult convergence during adaptive refinement and large number of 
unknowns, use the initial mesh options, Initial target mesh size, and edge mesh 
size.

Layer-specific Initial Mesh Settings

Using the Layer Specific tab, you can set the vertex, edge, and surface mesh 
options for each layer. The following figure displays the Layer Specific tab options:
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If a mesh setting of a layer is set to <Global>, it will inherit its value from the 
corresponding global mesh setting on the Global Initial Mesh tab, which is also 
shown on the first row in the Layer Specific tab.
It is also possible to enter a maximum cell size that differs from the global value. 
The value is then displayed in bold. A value of 0 always means that no initial mesh 
size is applied.

Vertex Mesh

Vertex meshing reduces the mesh length around vertices. When combined with 
edge meshing the shortest length of both is chosen in any given region. The region 
where the value is applied by the vertex mesh length setting is roughly twice its 
length in each direction: the actual region is still being optimized. The region 
affected by it depends on local geometry.

The following figure displays the result of a vertex mesh setting:

Edge Mesh

Edge meshing reduces the mesh length around the edges. A fan-out effect is 
created to maintain the tetrahedron quality. The edges do not need to be straight 
lines, any shape is allowed.

The following figure displays the result of an edge mesh setting.
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Surface Mesh

Surface meshing reduces the mesh length on surfaces of objects.

The following figure displays the result of a surface mesh setting.

Specifying Advanced Settings

Using the  tab, you can specify the target mesh growth, initial mesh size, Advanced
and automatic conductor mesh settings. The following figure displays the advanced 
options:
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The following table describes advanced options:

Option Description

Target 
Mesh 
Growth

Specifies the percentage by which each adaptive mesh grows relative to the previous mesh.

Use Initial 
Mesh Size

Enables you to set a minimum length of edges in the initial mesh. During mesh refinement, the 
individual length of edges in the mesh can be shortened where deemed necessary by the 
adaptive refinement process. Using this option, you can restrict the meshing process to a more 
limited set of possible solutions. It is advised to only use this option when the initial mesh is 
unreasonably dense in some areas due to some combination of geometric features triggering that 
behavior. This situation can arise close to curved surfaces or arcs or discretized curved surfaces 
or arcs with small angle results where the meshing process potentially over-meshes the 
structure. When this happens, you should use a value that is small enough to describe the curved 
shape. For example, choose a distance value that is equivalent to 15-45 degree resolution of a 
curved surface or arc.

Merge 
Objects 
with 
Same 
Material

This option controls if two objects that have the same material properties may be merged prior to 
meshing. This option can be used to reduce the number of tetrahedrons generated. Object 
merging is applied only when the objects also have the same mesh priority. In an FEM simulation 
setup, you can specify three types of merge options: Merge Adjacent Layers with same Material 
Properties option in the Physical Model tab, Merge shapes touching each other where possible in 
the Preprocessor tab, and Merge Objects with Same Material in the Advanced subtab of the 
Mesh tab. The Preprocessor merge is done first. Layout objects, drawn on the same layer, 
touching each other are merged. Shared edges are not preserved during mesh generation. The 
merge option in the Physical Model merges adjacent layers that share the same material 
properties. Finally, during FEM mesh generation, and after the 3D objects are added if any, 
another merge can happen, based on material properties.

This option is used when automatic meshing is applied. It determines the length of the edge 
mesh in relation to the estimated width of the conductor.
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Option Description

Automatic 
conductor 
mesh 
setting 
Edge 
meshing

Automatic 
conductor 
mesh 
setting: 
Vertex 
meshing

This option is used when automatic meshing is applied. It determines the length of the vertex 
mesh in relation to the estimated width of the conductor.

Advanced meshing controls should only be changed in case of meshing 
problems.

Guidelines for Specifying FEM Mesh Settings

Guidelines for Specifying FEM Mesh Settings

Target Mesh Size

The Automatic Target Mesh size is a good choice for most applications. For strong 
radiating designs, it can be recommended to set a smaller Custom Target Mesh 
Size, for example, one third of the wavelength at which the radiation occurs. For 
these radiating designs a second order discretization is recommended. If first order 
discretization is used further reducing the custom target mesh size to one fifth of 
the wavelength of radiation produces more accurate results.

Use the Minimal Memory setting for non-radiating designs. The initial mesh is 
primarily determined by the shapes of the design itself instead of a wavelength. 
This is useful for designs where the complexity of the shapes of the designs is 
ensuring dense enough starting meshes in the regions where the electromagnetic 
fields are concentrated. A set of thick conductors running through the design 
where the thickness is smaller than the width of the conductors is a typical 
example.

Common designs sharing these traits are package and module designs.

Minimal Mesh Size

The Minimal Mesh Size Setting located on the advanced properties are used to 
prevent the meshing process from generating too small tetrahedra. This situation 
can arise close to curved surfaces where the meshing process potentially over-
meshes the structure. When this happens you should use a value that is small 
enough to describe the curved shape: e.g. choose a distance value that is 
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equivalent to 15-45 degree resolution of an arc or curved surface.

Another situation where the minimal mesh size can be used is when you like to 
continue using the automatic conductor mesh setting but on some locations the 
estimated width leads to an unnecessary dense mesh.

Merge Objects with Same Material

Merging objects with the same material takes all objects that are assigned exactly 
the same material and share the same mesh priority and lumps them together in 
one object. Any seam lines that would arise from making the union of these objects 
are removed. The figure below shows the effect of merging of objects:

By default objects merged with same material is switched on. Using this option will 
typically give a smaller mesh with similar EM performance. Only in cases where it is 
deemed mandatory to keep seam lines between objects in the final mesh the option 
should be turned off. A possible use for this is to force objects lines to be in the 
mesh for seeding purposes.

Using Conductor Meshing

Using the Conductor Meshing you can control the density of the initial meshes 
close to conductors, e.g. to create a denser Edge Mesh type mesh there where you 
can expect a dense mesh is needed to get an accurate simulation. Using Conductor 
meshing to seed the initial mesh is useful to speed up the adaptive mesh 
refinement process.

You can use the Automatic conductor setting when the location of the pins of the 
port allow to get a good estimate on the edge and vertex values that would be 
required to obtain an accurate simulation. The estimated widths are reported by 
the simulator in the log window. Note that this setting will apply the edge to all 
conductors that are electrically connected at DC to the port (net). Any metal not 
connected to the port will not get this mesh seeding.

For the designs where metal not electrically connected to the ports is important for 
the electrical behavior, like a coupled line filter, the Automatic setting is not 
advised. In case multiple ports are connected to the same net the smallest estimate 
will be chosen.
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The Fixed for all conductors setting applies the specified Edge or Vertex setting to 
all the metal shapes in the designs which can be overkill in more complex designs. 
Applying the setting to specific models can be used to be more selective in 
applying the conductor mesh setting.

Choosing the Edge and Vertex Mesh Values

For microwave applications, like a coupled line filter, you can set the edge mesh 
value to 1/5th of the width of the strip.

For RF-type of applications, such as RF connectors, modules and packages, you 
can set the edge mesh value to 1/3th of the width of the strip.

Use vertex meshing to generate a locally denser mesh around vertices. The region 
in which the mesh is denser is limited and the impact on the total number of 
tetrahedral is often quite minimal. The results are that the accuracy of the 
inductance computation along the conductive paths will typically be more 
accurate.

If it is deemed overkill to apply the edge meshing on all conductors, apply the edge 
meshing at the minimum to the objects closest to a port.

Performing FEM Broadband Refinement

Performing FEM Broadband Refinement

You can automate the FEM broadband refinement process. You can select one of 
the following refinement strategies depending on your requirements:

Multiple fixed refinement frequencies

Refinement frequencies chosen automatically after the initial pass

Refinement frequencies chosen automatically after each pass

Manual refinement frequency

This section describes the refinement frequencies and provides guidelines for 
choosing a strategy.

Importance of Refinement Frequencies

Mesh refinement procedures in FEM typically consist of the following steps:

Simulate at the refinement frequencies.

If the calculated S-parameters did not reach convergence, perform the 
following steps:

Estimate the discretization errors of the field solution.

Refine the mesh at locations with high values for the error.

Repeat step 1.

In this procedure, the refinement frequencies play a key role:

Convergence monitoring: the convergence of the refinement process is 
monitored at the refinement frequencies (step 2).
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Field error estimation: the field error estimates, on which mesh refinement is 
based, are calculated at the refinement frequencies (step 2a).

Consequently, the choice of the refinement frequencies can have an important 
impact on the accuracy of the simulation results:

The mesh convergence is monitored at frequencies where the S-parameters 
change most during mesh refinement. If this is not the case, the refinement 
process might stop too early, i.e.,  the mesh refinement has reached before
convergence over the entire frequency range of interest.

All important electromagnetic phenomena should occur at one of the 
refinement frequencies. If this is not the case, this phenomena cannot be 
taken into account during mesh refinement. As a consequence, it is possible 
that the final mesh is not suited to represent this phenomena accurately.

Choosing a Refinement Strategy in FEM

You can select one of the following refinement strategies depending on your 
requirements:

Select the maximum simulation frequency for the adaptive refinement

Refinement frequencies chosen automatically after the initial pass of the 
adaptive refinement

Refinement frequencies chosen automatically after each pass of the 
adaptive refinement

Manual specification of one of more refinement frequencies

This section describes these refinement frequencies and provides guidelines for 
choosing a strategy.

Performing Automatic Broadband Refinement

Multiple Fixed Refinement Frequencies

You can specify a set of refinement frequencies by selecting the button ‘Manual 
selection’, and adding frequencies to the frequency table. This refinement strategy 
behaves as follows:

All refinement frequencies are simulated on  mesh level.each

Convergence is reached if the convergence criterium is satisfied for  all
refinement frequencies. In other words, convergence depends on the worst 

 on each level.case refinement frequency

The mesh refinement depends on the error estimates of  refinement all
frequencies.

The corresponding logfile shows:

Delta(S) for each simulated frequency

Worst case Delta(S) for each mesh level (last line)
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Refinement Frequencies chosen Automatically After Initial Pass

In this refinement strategy, the refinement frequencies are not user-defined, but 
chosen by the solver. For this purpose, the entire target frequency plan is simulated 
on the initial mesh. Based on an analysis of the resulting S-parameters, a set of 
refinement frequencies is chosen. Typically, these frequencies are the frequencies 
for which the diagonal elements of the S-parameter matrix reach a minimum. The 
selected refinement frequencies are used in all subsequent refinement passes.

Except for the AFS sweep on the initial mesh level, this refinement strategy is 
identical to the strategy based on user-defined refinement frequencies.
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Refinement Frequencies Chosen Automatically After Each Pass

In this refinement strategy, the refinement frequencies are not fixed, but can vary 
from level to level. This refinement strategy behaves as follows:

The entire target frequency plan is simulated on each mesh level using an 
.adaptive frequency sweep

The difference of the S-parameters of the , rational models is monitored
instead of the difference between the S-parameters of the simulated 
frequencies only. In other words, convergence depends on the worst case 
frequency in the entire frequency range of interest. This is the most detailed 
convergence monitoring possible.

Mesh refinement depends on the error estimates of all simulated frequencies
.

Selecting a Refinement Strategy
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Selecting a Refinement Strategy

You can refer the following guidelines while selecting a refinement strategy:

Multiple fixed refinement frequencies: This strategy computes the fewest 
frequency points during the adaptive refinement stage and therefore usually 
lead to the fastest simulations. This strategy is recommended for:

Electrically short transition structures. These can include matching 
networks, packages, and impedance transformations. If the 
transmission parameters accumulate less than 180 degrees of phase, 
it is sufficient to refine only at the highest frequency.

Designs where you know the frequencies of the critical features such 
as dual (or multi) band antennas and band pass filters. For these 
structures set the refinement frequencies to the frequencies of most 
interest (i.e. in each antenna frequency band, at the low end and high 
end of the band pass filter). It is advisable to include the maximum 
frequency of the simulation as a refinement frequency.

Initial analysis of a structure where speed is preferred over accuracy.

Refinement frequencies chosen automatically after the initial pass: This 
strategy is a compromise between manually selecting the refinement 
frequencies and letting the FEM simulator automatically select the 
refinement frequencies at each adaptive pass. This strategy is recommended 
when you do not have a good idea where the important characteristics 
occur in your frequency. However, you might know the frequency transitions 
are not extremely sharp (i.e. are not high Q resonances).

Refinement frequencies chosen automatically after each pass: This is the 
automated strategy and tends to generate accurate results, but it also tends 
to result in the longest simulation times. This strategy is recommended in 
the following situations:

Structures with high Q resonances.

During the final analysis of a structure where accuracy is preferred 
over fast simulations.

Defining Solver Settings

Defining Solver Settings

You can define the solver settings for both Momentum and FEM. The simulation 
process combines the Green functions that were calculated for the substrate of a 
circuit and mesh information that was calculated for the circuit and solves for 
currents in the circuit. Using these current calculations, S-parameters are then 
calculated for the circuit. The solver settings are EM simulator specific.

Defining the Solver Settings for Momentum

Specifying the Matrix Solver Settings

You can select the following types of matrix solvers used by Momentum during a 
simulation:
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Auto-select: If you select the  solver, Momentum automatically Auto-select
selects the most appropriate matrix solver. It is the default matrix solver 
selection option.

Direct Dense: If you select , Momentum selects the direct dense Direct dense
matrix solver for a simulation. This implies that the matrix is stored in a 
dense matrix format (requiring order N  memory) and solved using a direct 2

matrix factorization technique (requiring order N  computer time). The direct 3

dense matrix solver guarantees to provide a solution using a predetermined 
number of operations. The main disadvantage is that the computer time it 
requires scales qubic with the matrix size N, yielding larger simulation times 
for large problem sizes.

Iterative Dense: If you select , Momentum selects the iterative Iterative dense
dense matrix solver for a simulation. This implies that the matrix is stored in 
a dense matrix format (requiring order N  memory) and solved using an 2

iterative matrix solve technology (requiring order N  computer time). The 2

computer time scales quadratic with the matrix size N, yielding faster 
simulation times for large problem sizes when compared to the direct dense 
matrix solver. The main disadvantage is that the iterative solver does not 
guarantee to converge fast. The iterative solver monitors its convergence 
rate and automatically switches to the  matrix solver when it Direct dense
observes that the convergence stagnates or the convergence rate is too 
slow.

Direct Compressed matrix solver: When selecting , Direct compressed
Momentum selects the direct compressed matrix solver to be used in the 
simulation. This implies that the matrix is stored in a compressed matrix 
format (requiring order NlogN memory) and solved using a direct 
compressed matrix factorization technique (requiring order (NlogN)  1.5

computer time). The direct compressed matrix solver guarantees to always 
provide a solution using a predetermined number of operations. Moreover, 
the computer time it requires scales linear-logarithmic with the matrix size 
N, making it the preferred matrix solver for large problem sizes.

Defining the Compression Level

The optimal compression level is not automatically determined, but can be user-
controlled. You can select one of the following options:

Normal: This selection compresses the matrix to a level that preserves the 
accuracy of the solution for the large majority of cases.

Reduced: This selection lowers the amount of matrix compression. It can be 
used in cases where the normal compression level fails to provide an 
accurate solution. It may provide an accurate enough solution faster than 
the direct dense solver.

Aggressive: This selection increases the amount of matrix compression. It 
can be used to explore speeding up a simulation.
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Enabling the Port Solver

The Port Solver is a 2D EM cross-section solver that computes the characteristics 
of the transmission lines attached to TML-calibrated ports. Its simulation results 
are propagation constant and characteristic impedance. The propagation constant 
is written to dataset as ‘GAMMA’ and the characteristic impedance is written to 
dataset as ‘Z0’.

You can either enable or disable the port solver. Enabling the port solver also 
produces an additional set of S-parameters in the dataset which are renormalized 
to this characteristic impedance. The port solver works only on conductors defined 
as infinitely thin sheet conductor in the Substrate Editor, and it is automatically 
disabled when ports are connected to thick conductors. When available, the 
propagation constants are used in the estimation of the wavelength for the mesh 
cell size.

To specify the simulation solver options:

Select  >  to open the EM Setup window.EM Simulation Setup

Choose either  or  in the Simulator Momentum RF Momentum Microwave
panel.

Choose  in the left pane of the EM Setup window.Options

Click the  tab.Solver

Specify the Momentum solver settings.
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Defining the Solver Settings for FEM

You can select the following types of matrix solver methods for FEM:

Auto-select: On selecting Auto-select, the FEM Simulator automatically 
determines to choose the Direct or Iterative solver based on a heuristic rule 
related to number of ports in the setup. When the design has less than 15 
ports, the iterative solver is used. In other cases, the direct solver is chosen. 
For most designs, this leads to optimal performance of the simulation.

Direct: On selecting Direct, the FEM Simulator uses a multi-threaded sparse 
direct solver. The memory requirements and computing time of this solver 
typically scale as N^(3/2) to N^2 respectively, where N is the matrix size. 
This solver does not suffer from potential convergence problems and is 
guaranteed to yield a solution if sufficient memory is available.

Iterative: On selecting Iterative, FEM Simulator uses the iterative matrix 
solver. The memory requirements and computing time of this solver scale as 
N to N^(3/2) respectively where N is the the matrix size. In other words, the 
computing resources of the iterative solver are typically one order of 
magnitude lower then the computing resources of the direct solver. 
Especially, the iterative solver requires significantly less memory then the 
direct solver. However, contrary to the direct solver, the iterative solver is 
not guaranteed to converge.

You can also specify the  used to approximate the electric Order of basis functions
fields in all tetrahedra. You can set the following values:

2: Electric fields will be approximated with a quadratic variation in each 
tetrahedron, and the magnetic fields will be approximated with a linear 
variation in each tetrahedron. This gives the best accuracy.

1: Electric fields will be approximated with a linear variation in each 
tetrahedron, and the magnetic fields will be approximated as being constant 
in each tetrahedron. This requires less memory than the Order 2 basis 
functions given the same mesh, but typically requires a larger mesh to get 
the same level off accuracy. This setting is useful for electrically small 
structures.

Mixed order: The mixed order scheme uses a combination of first and 
second order bases functions depending on the location in the mesh. This is 
an automated scheme that uses first order basis functions in regions with 
lower field variation. It leads to faster overall simulations for designs where 
there are big enough regions with low field values and/or small field 
variation.

Using Modal TML Port Solver

If you enable the  option, all the waveguide ports are Use modal TML port solver
solved using the legacy port solver algorithm. This option provides the following 
advantages:

Numerically stable to a much lower frequency.
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Correct results for waveguides with independent conductors that are not 
associated with a port pin. Therefore, you need to setup only one port for a 
pair of coupled microstrip lines that terminate in the same plane.

However, it consists of the following disadvantages relative to the legacy port 
solver:

Does not support de-embedding.

Less accurate for dispersive waveguides.

Starting with ADS 2017 to generate Gamma, Zpi, Zpv, and Zvi outputs, you 
must enable this option.

Reusing Simulation Data

To reduce the time required to complete the current simulation, you can use 
sampled data from the previous simulation. Enabling the Reuse files from the 

 option reuses previously calculated S-50 parameters. This previous simulation
function is useful, if you extend or shift the frequency plan and re-simulate, or if you 
want more samples near a resonance frequency. If you change the circuit 
geometry, substrate, ports, or mesh parameters, the simulation data cannot be 
reused.

ADS does not verify that the design has not changed. Make sure that only the 
frequency plan has changed before attempting to reuse data.

To reuse data from the last simulation:

Select  >  to display the  window.EM Simulation Setup EM Setup

Choose  in the Simulator panel.FEM

Select  in the left pane of the EM Setup window.Options

Click the  tab.Solver

Enable . Sampled data from the Reuse files from the previous simulation
previous simulation will be used in the current simulation, which can 
decrease the simulation time.

Using the Advanced Options

The following simulation settings are available by clicking the Advanced button:
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Maximal Number of Iterations: Specifies the maximum number of iterations 
allowed during the iterative solve process. This value is increased to achieve 
a lower absolute tolerance. Typically, a value 500 is sufficient.

Tolerance iterative solver: Specifies the absolute error tolerance that the 
solver process must reach to achieve convergence. A typical value would be 
1.0e-5. You may need to increase the Maximum Number of Iterations, if you 
significantly decrease the tolerance.

Defining Expert Options for Momentum

Defining Expert Options for Momentum

You can define configuration variables for a Momentum simulation in the EM Setup 
window. Use the  tab, which is present in  of the EM Setup window.Expert Options

These variables can alter the default behavior of the simulator. They should 
only be used to workaround a specific issue.

Defining Configuration Variables

Select  >  to open the EM Setup window.EM Simulation Setup

Select  as the EM simulator.Momentum

Select  in the left pane of the EM Setup window.Options

Select the  tab.Expert

Click  to insert a new row.Add

Specify the name of the configuration variable in the Key field. Momentum 
 provides links to the appropriate sections where Configuration Variables

configuration variables are described.

Specify a value in the  field.Value

Variables specified on the Expert tab apply for this specific simulation only. All 
key-value pairs are written in the  file in the simulation momentum.cfg

directory (some variables are written in the ). This file has the proj.opt

highest priority when searching for configuration variables.
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Momentum Configuration File

By default, the simulator searches for variables in  files in the momentum.cfg

following order, and uses the first one found:

The simulation directory, <workspaceDirectory>/simulation
/<libName>/<cellName>/<layoutName>/<emSetupName>_MoM

/momentum.cfg

Variables defined on the Expert tab apply to that specific simulation.

Your personal directory, $HOME/hpeesof/config/momentum.cfg
Define configuration variables here that apply to all your simulations.

On the PC,  represents the path you specified as the %HOME%

 during installation (e.g. )Home Folder C:\users\default

The custom configuration directory under the ADS Momentum installation, 
$HPEESOF_DIR/Momentum/<version>/custom/config/momentum.

cfg

Define configuration variables here that apply to all users. Configuration 
variables defined here will not be overwritten by installation of subsequent 
program patches or updates.

The configuration directory under the ADS Momentum installation directory 
= $HPEESOF_DIR/Momentum/<version>/config/momentum.cfg
Define the default installed configuration variables here that apply to all 
users. Configuration variables should not be customized here.

Momentum Configuration Variables

The links below lead to specific locations in the documentation describing 
configuration variables.

Mesh, processing object overlap

Source type

Conductor Loss Model

Passivity Check
Specify (MOM3D_WRITE_PASSIVITY,TRUE) as Key-Value pair to verify the 
passivity of the S-parameters.
At each simulated frequency, the maximum eigenvalue of conj([S]^T)*[S] is 
computed. The square root of this maximum eigenvalue is available as 
PASSIVITY in the resulting dataset. Passivity requires that this value is 
smaller or equal than 1.

Phase center for Far Fields

Defining an Output Plan
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Defining an Output Plan

You can set up multiple frequency plans for a simulation. For each plan, you can 
specify that a solution be found for a single frequency point or over a frequency 
range. You can also select a sweep type for your frequency plan. However, the 
collection of frequency plans run as a single simulation. You can also specify the 
data display settings for your EM simulations by using the EM Setup Window.

You can specify a dataset for storing results by using the EM Setup window. You 
can perform the tasks described in this section.

Selecting an Output Dataset

When you run an EM simulation, the results are stored in a dataset. This dataset is 
then used by Data Display for viewing results. You can select the name and 
location of the dataset you want to use for a simulation. The default value is the cell 
name. Datasets are stored in a workspace or data subdirectory. You can also select 
a dataset name from the existing dataset file names. When using an existing name, 
new results overwrite existing contents. This means that you should provide unique 
names for the datasets that will be generated from different cells in the same 
workspace directory.

Specifying a Dataset

To select an output dataset where you want simulation data to be saved:

Select  >  to display the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Output Plan

Click . The dialog box is displayed.Edit Choose Output Names 

You can also select  >  to open the Choose EM Choose Output Names
Output Names dialog box.

By default, the  option is selected. To type a name for the Use cell name
dataset, remove selection from this option.

You can also click  to view the existing dataset names in the current Browse
workspace, as shown in the following figure:
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Select the required dataset and click .OK

The  check box is selected by Append text specified in simulation setup
default.

Click .OK

Customizing the Dataset Naming Convention

You can customize the naming convention of the dataset generated during a 
simulation by adding a prefix or suffix to the data name. To generate the dataset 
with the required naming convention, you can select Appending text to the dataset 

. You can select one of the following options for customizing the data name in name
:Append text to the name

View name: Select the  option in the  section View name From the layout view
to add text from the layout view.

Adding simulation type: Select  include the type of simulator Simulation type
in the dataset name by selecting .Simulation Type

Adding simulation options: Select  in the Simulation options From the 
 section to add text from the simulation setup view.simulation setup view

Adding user-defined text: You can add a suffix to the dataset name in the 
 field.This text

In case of an adaptive frequency sweep, two datasets will be the 
generated: one with the actually simulated samples ( ) and <name>.ds
another one ( ) which is a densly sampled dataset based on <name>_a.ds
the .adaptively fitted rational model

Specifying Data Display Settings

You can select options to open data display after completing the simulation 
process.
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Open data display when simulation completes: Automatically opens the data 
display window on the completion of a simulation.

You can also insert a template in a new or empty data display by using one of the 
following options:

Auto-select based on number of ports: Selects a template automatically 
based on the number of ports.

User-defined file: Enables you to specify a template. You can also perform 
the following steps to select the required template:

Click  to open the  window, as shown in Browse Data Display Insert Template
the following figure:

By default, the Momentum Product option is selected in the left pane of the 
Data Display Insert Template window.

Select the required template.

Click .OK

Saving Currents and Fields

You can select the following options from the  list for saving the Save fields for
current simulation settings:

All generated frequencies: This option enables you to save the field values 
for all the frequencies that are solved, including all the frequencies 
adaptively determined in any Adaptive sweep.

No frequencies: This option does not save the field value for any frequency.

User specified frequencies: This option enables you to describe all the 
frequencies explicitly and define a priority in the Frequency Plan. These 
include all instances of:

Fstart and Fstop in ‘enabled’ Adaptive plans (but none of the 
adaptively determined frequencies in between)

Fstart, Fstop, and all the intermediate frequencies in ‘enabled’ Linear 
plans

Fstart, Fstop, and all intermediate frequencies in ‘enabled’ Log plans
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Fstart, Fstop, and all intermediate frequencies in ‘enabled’ Dec plans

Fstart from ‘enabled’ Single plans

For more information about a frequency plan, see Defining 
.a Frequency Plan

Creating an Output Plan

To create an output plan:

Choose >  to display the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Output Plan

The default dataset name is displayed. To specify a new dataset, click . Edit
For more information, see .Selecting an Output Dataset

Select an option for appending text to the dataset name.

Select , if you want to open the Open data display when simulation completes
data display window automatically.

Specify the template to be used for displaying the data in . You can Template
also click  to select the required template.Browse

Select the required option in the section.Save fields for 

Specifying Simulation Resources
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Specifying Simulation Resources

You can run EM simulations on a local or remote host machine, or take advantage 
of a third party load balancing and queuing system such as LSF, Sun Grid Engine, 
and PBS Professional. You can choose one of the following simulation modes:

Local and Remote Simulation

Third Party (Distributed) Simulation

Momentum simulations launched on a remote host or load balancing system have 
the license auto-retry enabled. For more information, see . The license License Retry
auto-retry feature is disabled for simulations running on the Local host. If no 
license is available, a simulation will fail immediately.

Setting up Local and Remote Simulation

From the EM Setup window, you can start and stop the Job Manager. Click  to Start
initiate the Job Manager window and click  to close the Job Manager process. Stop
For more information, see .Using the Job Manager

You can specify the setup options described in the following sections for local or 
remote simulations:

Selecting a Simulation Directory

You can either specify a directory or use the shared directory for storing simulation 
data:

Selecting  displays the path of the local directory.Shared local

Selecting  allows you to type a new directory. If you select Specify Auto-
, sub-directories are created automatically.create subdirectory per job

Setting the Number of Threads Option

You can specify the number of threads used in the local simulation:

Auto: The number of threads are chosen depending upon the number of 
cores of the machine.

Limit to: Allows you to specify the number of threads. This number can be:

N: This would limit the threads to the N or #Cores of machine whichever is 
smaller.

#Cores - N: This would free N Cores of the machine. The threads would limit 
to #Cores - N. In the auto mode, the value of n is equal to 0.

The multi-thread calculations of a simulation are time consuming. The workload is 
then distributed over a number of threads of execution. The hardware of present-
day computers can run several threads in parallel, thereby reducing the simulation 
time. Using more threads, allows more parallelization. However, if you use this 
concept above a certain amount, it might not be beneficial due to the following 
reasons:

http://edadocs.software.keysight.com/display/ads2017/Remote+and+Distributed+Simulation+Licenses#RemoteandDistributedSimulationLicenses-LicenseRetry


347 Electromagnetic

1.  

2.  

3.  

The hardware can only run as many threads in parallel as it has logical CPU 
cores. The number of physical CPU cores times the number of hyper-threads 
per core. You cannot use more threads than this limit.

Several computing resources are shared, such as non-cached memory 
access hardware or the execution units on a hyper-threaded CPU core. 
Once a shared resource is saturated, adding more threads will not offer 
further speedups.

The number of threads can be specified in the simulation resources pane. The Auto 
setting will use as many threads as is deemed appropriate for an otherwise 
unoccupied machine. The Limit to setting allows to explicitly specify either the 
maximal number of logical CPU cores to use, or the minimal number of logical CPU 
cores to remain unused (to reserve them for other software than this simulation).

You can control the number of threads used by Momentum by setting 
OMP_NUM_THREADS environment variable. This variable takes precedence 
over what you set in the EM Setup window. If you limit the number for cores via 
OMP_NUM_THREADS, and try to specify more cores using the EM Setup 
window, you will not get extra cores.

Selecting a Process Priority

You can choose the Normal, Below Normal, or Idle types of process priority. This 
maps to the nice number under Linux/Unix and process priority under windows.

Specifying Queue Simulation

If you select , your simulation will be put on a queue and must be Queue simulation
started from the Queue Manager. You can set the following options:

Queue name: Specify a queue name.

Auto-start queue after submission: Selecting this option starts the 
simulation automatically after you have submitted the changes.

Specify a  other than 'Local' if you have multiple queues and Simulation host
you want the license auto-retry enabled.

Setting Local/Remote Setup Options

To specify the host settings for a local or remote simulation:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Resources

Select .ADS (Local/Remote)
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Specify the simulation directory.

Specify the number of threads.

Choose the process priority from the drop-down list.

Select  to queue your simulation.Queue simulation

Provide a queue name.

If you want the queue to start automatically, select Auto-start queue after 
.submission

Setting up Third Party (Distributed) Simulation

If you want to use a third party workload management system, such as LSF, PBS 
Professional, and Sun Grid Engine, you can use the Distributed mode. In the 
distributed mode, you have access to the third party workload/queue management 
system to submit an EM simulation to a cluster of machines.

Before using the distributed mode, you need to set up a connection between your 
personal machine and the target machine that you want to use as submit host to 
the workload management system. The submit host is the one machine that will 
add and monitor simulation jobs given to the workload management system on 
behalf of your ADS session.

The submit host can be your local machine or can be a remote machine. To create 
this connection with the submit host you must first make the Job Manager aware of 
the workload management system on the submit host by adding the necessary 
configuration settings of the workload management system to the startup 
environment of the PVM deamon on the submit host.
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On a Linux submit host, add the necessary environment variables, or source the 
required configuration script for your LSF/SGE/PBS system into the PVM boot script
~/.eesofpvmprofile. For instance, on LSF systems most configurations require to 
source the local profile.lsf script for the LSF cluster here. I.e. you need to place a 
line similar to . _path_to_local_LSF_configuration_dir_/profile.

 in ~/.eesofpvmprofile. Remember to use a dot (.) to source a ksh(sh) lsf

configuration script as .eesofpvmprofile requires Korn Shell syntax to work 
correctly. For SGE and PBS environments a similar configuration is also required. 
Contact the local LSF/SGE/PBS administrator for the appropriate configuration 
script or environment settings as names and locations of this information can differ 
depending on the installation.
On a Windows based submit host make sure the workload management system 
can be used by all users from a Windows command window. Refer to the 
documentation of your workload management environment for details on these 
configuration requirements. Next, ensure that the connection settings for the 
submit host are properly configured in the .Job Manager Preferences

For the distributed simulation with a third party workload management system 
where the local machine is a valid submit host, you do not need to define any 
formal PVM cluster configuration. A local PVM deamon will start and provide 
the submit and monitor capabilities with the workload management system.

To run simulations, the distributed mode assumes that the third party workload 
management system has been preconfigured to run ADS related tasks from the 
user command line environment on the submit host and on the execution hosts 
(the machines that will run the EM simulation) of the workload management 
system.

The distributed mode assumes that the third party workload management system 
has been preconfigured to run ADS related tasks from the command line 
environment. For setting up the third party workload management system refer to 
the documentation for your particular environment. You can find information for the 
supported workload management systems at the following location:

LSF: https://www.ibm.com/support/knowledgecenter/en/SSETD4_9.1.2
/lsf_foundations/lsf_introduction_to.html

PBS Professional: http://www.pbsgridworks.com/Default.aspx

Sun Gridengine: http://www.oracle.com/technetwork/oem/grid-engine-
166852.html

Make sure that the execution environment has the essential variables such as 
 and ADS license settings are correctly defined on the hosts in HPEESOF_DIR, PATH

the workload management system. For further details about the ADS configuration, 
refer to the ADS installation guide.

On Linux machines, you can add a ksh script .adsrc with the appropriate ADS 
environment settings inside your home directory on the cluster machines. The ~/.

 file is picked up by the simulation scripts just before a simulation starts. The .adsrc

https://www.ibm.com/support/knowledgecenter/en/SSETD4_9.1.2/lsf_foundations/lsf_introduction_to.html
https://www.ibm.com/support/knowledgecenter/en/SSETD4_9.1.2/lsf_foundations/lsf_introduction_to.html
http://www.pbsgridworks.com/Default.aspx
http://www.oracle.com/technetwork/oem/grid-engine-166852.html
http://www.oracle.com/technetwork/oem/grid-engine-166852.html
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adsrc script is run with two arguments the name of the simulator component 
(Momentum or fem) and the expected version of that simulator component. This 
allows the user to select and configure for the appropriate ADS installation on his 
system.

Third Party (Distributed) Setup Options

In the EM Setup window, you can specify the following setup options for the 
distributed mode:

The capability to start and stop the Job Manager: Click  to initiate the Start
Job Manager window and click  to close the Job Manager process. For Stop
more information, see .Using the Job Manager

Specifying a submit host: Choose the required submit host (this can also be 
the local machine, as the submission host) for distributed simulation. Click 

 to retrieve the list again.Refresh

Specifying a submit queue: Choose the required submit queue on the 
selected submit host for distributed simulation. Click  to retrieve the Refresh
list again.

Specifying parallel jobs for frequency sweep (Momentum Only): Allows to 
specify the number of frequency points that will be calculated in parallel. It 
controls how the frequency sweep is distributed over the cluster. If it is 
equal to 1, it specifies a normal momentum simulation. If the value is greater 
than 1, you need a momentum turbo license and this is only supported 
between a cluster of Linux machines. See .#Using Momentum Turbo

Specifying a simulation directory: You need to define the remote simulation 
directory on the submit host for your distributed simulations. It sets the 
directory on the remote computer holding the EM files while the simulation 
is running. If the host mode is remote but the host is set to the local 
machine, the remote directory should be set to .Shared local

For the distributed simulation with a third party workload management system 
it is very important that this directory is visible to all cluster hosts in exactly the 
same way. Make sure mount points are identical.

Specifying the number of threads: You can specify the number of threads 
used in the distributed simulation.

Specifying process priority: You can choose the process priority among the 
,  and . This maps to the nice number on the LinuxNormal Below Normal Idle

/Unix platform and process priority on the Windows platform.

Specifying job control settings: You can specify the following job control 
settings:

Submit user: Enables you to provide a user name if the local user 
name differs from that on the cluster.

Email notification: Enables you to specify this option for notification 
purposes.
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Job name: Enables you to specify a name for the job. Due to name 
limitations on various management systems the name can only 
contain upper and lower case a to z, 0-9 and an underscore and may 
not start with a 0-9.

Shell command at finish: Allows you to use shell commands.

Resource String: Allows you to specify a resource and option string 
that is passed to the submit command without modifications.

Export env. Variables: Enables you to export environment variables.

Specifying the start time: You can configure the simulation start time by 
selecting the required option from . You can choose either , Start Now At time
, or  option.After job(s)

Specifying the termination time: You can configure the simulation expire 
time by selecting the required option from . You can choose either Expire

 or type the required time in the  text box.Never At/After

Specifying Third Party (Distributed) Setup Options

To specify the distributed mode setup options:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Resources

Select the  option to specify the distributed setup 3rd Party (distributed)
options.
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Specify the simulation directory.

Specify the number of threads.

Choose the process priority from the drop-down list.

Specify the job control settings.

Select the  option.Start

Select the  option.Expire

Using Momentum Turbo

Momentum Turbo accelerates a Momentum simulation by solving frequencies in 
parallel on a compute cluster. This is especially useful for large simulations 
requiring many frequency samples.

A dedicated Momentum Turbo Element license (W2343) is required in addition to 
the standard Momentum Element license (W2341). One Momentum Turbo Element 
license allows that the frequency sweep runs on up to 8 nodes in parallel. Multiple 
Turbo Elements can be stacked to go above 8.

The compute nodes in the cluster must share the same OS and have similar 
performance for proper operation of Momentum Turbo.

The slowest machine will determine the actual speedup that can 
be obtained. The master process that distributes frequencies to 
the child processes waits until they all return before distributing 
a next batch of frequencies.

A mix of Linux and Windows in the cluster may introduce 
numerical noise in the solution (e.g. due to a slightly different 
mesh) that makes it hard to impossible for the adaptive 
frequency sampling to converge.

Amdahl's Law

The multi-processing performance can be measured using Amdahl’s law

Whereby S is the maximum speedup, p is proportion of the program that is parallelized, 

and N is the number of processors allocated.

The following graph shows the speedup versus parallelism for respectively 4, 8 and 
16 nodes.
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The law illustrates that, in order to obtain a decent speedup, the parallelism needs 
to be high enough.
For a Momentum simulation, this implies that:

A sufficient number of frequency samples is requested or required. The 
higher the number, the higher the parallelism and consequently the 
speedup.

The speedup of a microwave mode simulation will be higher than an RF 
mode simulation on the same design. An RF mode simulation has a higher 
fixed cost. Every node needs to load the quasi-static matrix, independent to 
the number of frequencies points that it will actually solve.

An adaptive frequency sweep will most likely require more frequency 
samples to converge. The 'next' samples are chosen in bulk, one for each 
parallel process, which doesn't guarantee they are chosen at the optimal 
location compared to a sequential simulation.

Example

An example (see Examples > Momentum > RF > PCBlines) was used to characterize 
the speedup on a Sun Grid Engine cluster that consists of 1 submit host and 8 
compute nodes.

The layout of 'PCBlines16', shown below, was simulated by Momentum.
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Following simulation settings were changed so that a large enough simulation time 
is needed per frequency point.

Mesh frequency = 4 GHz

Cells per wavelength = 50

Edge mesh = on

Mesh reduction = off

8 different simulations are compared:

microwave and RF mode simulation,

using an adaptive (Fstart = 0 GHz, Fstop = 4 GHz, Npts = 200 (max)) and a 
linear frequency sweep (Fstart = 0 GHz, Fstop = 4 GHz, Npts = 112),

performing the frequency sweep on 1 node (= standard Momentum 
simulation) and on 8 nodes in parallel (= Momentum Turbo simulation).

This example illustrates that:

The speedup is larger in microwave mode versus RF mode

The speedup of a linear (or log) frequency sweep is higher than an adaptive 
sweep.

That an adaptive sweep typically requires a couple of extra passes to 
converge. For example, a standard adaptive sweep in microwave mode 
requires 108 samples to converge. Ideally, this would require each parallel 
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node to compute 108/8=int(13.5)=14 frequencies. In the actual parallel 
adaptive sweep simulation, 16 passes or 16*8=128 samples were required to 
reach convergence. This is related to the fact that a bulk of 'next' samples 
are chosen at once in a parallel simulation.

Using the Job Manager

The EM Setup window provides the capability to start and stop the Job Manager. 
For for more information, refer . The Job Manager is Using the Job Manager
automatically started in mimimized mode when an EM Setup is being opened. Click 
the  button to restart a closed Job Manager or to restore its main window, as Start
shown in the following figure:

After the successful start of the Job Manager, the Simulation host list is populated 
with the active hosts and those defined in the . Select the Job Manager Preferences
desired host where you want to launch the simulation.

To close the Job Manager, close its main window or click the  button in Shutdown
the EM Setup window. Click  again if you need to bring the underlying Shutdown
PVM infrastructure to a halt (a confirmation dialog box is displayed).

Generating an EM Model

Generating an EM Model

An EM Model is used by a circuit simulator to model a component by using the S-
parameters generated by an EM simulation. The EM-based S-parameters can be 
precomputed or you can generate them while running the circuit simulation. An EM 
Model caches the S-parameters to improve circuit simulation performance. For 
more information about how to use an EM model, see Creating and Using an EM 

.Model View

You can generate an EM model from the EM Setup window.

How Do I Generate an EM Model

To create an EM model:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window. The EM Model Model
options are displayed:
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Accept the default name or type a new name for the EM model.emModel

The default name for an EM Model is . It is recommended to emModel
use the default name unless you are using model polymorphism.

Do not select , if you want to store all EM simulation Reduce to decrease size
files with the EM model. For example, all log files are stored in the EM model 
directory. It will also allow you to perform post-processing operations on the 
EM Model in case you specified to save the currents (Momentum) or fields 
(FEM) in the  tab.Output plan

Select to create Ensure the EM Model exists when the simulation is launched 
an EM model at the start of the simulation process if it does not exist yet.

Select  to auto-Update the existing EM Model when the simulation finishes
update the existing EM Model to use the results of this simulation. If there is 
no EM Model it will not be created.

To generate an EM model immediately, click .Auto-create Now

If the  button is labeled , an EM Model Auto-create Now Update Now
already exists for this cell.

The following figure displays an EM model:
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Customizing the EM Model Naming Convention

You can customize the naming convention of the EM model generated during a 
simulation by adding a prefix or suffix to the data name. To generate the EM model 
with the required naming convention, you need to specify the following parameters 
in the EM Setup dialog box:

Specifying the EM model name: You can specify the EM model name in the 
 field.Name

Appending customized text to the EM model name: If you want to include 
customized text with the EM model name, select . Append text to the name
You can customize the data name as follows:

Adding text from the layout view: Select the  option in the View name
 section to add text from the layout view.From the layout view
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Adding text from the simulation setup view: Select  in the View name
 section to add text from the From the simulation setup view

simulation setup view. You can also include the type of simulator in 
the EM model name by selecting .Simulation Type

Adding user-defined text: You can add a suffix to the EM model name 
in the  field.This text

To customize the EM model name:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Model

Specify the EM model name in the  field.Name

Select , as shown in the following figure:Append text to the name

Select  in the  section.View name From the layout view

Select  in the  section.View name From the simulation setup view

Select .Simulation Type

Add a suffix to the EM model name in the  field.This text

Using EM Setup Window Tools

Using EM Setup Window Tools

You can perform the following tasks by using the menus and toolbar options 
present in the EM Setup window:

Saving Simulation Settings

Click  (  ) in the EM Setup window to save the settings specified for your Save
EM simulation. You can also use the following commands from the File menu for 
saving an EM setup:
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The Save command enables you to save changes to an existing design. If 
you choose Save in an untitled window, the Save Design As dialog box 
appears.

The Save As command enables you to save an existing EM setup with a new 
name. You can change the Library name, cell name, and view name. Type 
represents the type of cell to identify whether it is a EM setup, schematic, 
layout or symbol view. You cannot change the cell Type.

The Save a Copy As command enables you to save a copy of an existing EM 
setup with a new cell name in new library and in new view. Select  > File

 to provide the required library name, cell name, and view.Save a Copy As

To reuse the saved EM setup, select  >  >  in the ADS File Open EM Setup View
Main window. Select the required EM Setup view in the Open Cell View dialog 
box. You can also open an existing EM setup by using the EM toolbar.

Importing from an EM Setup

To import from another EM Setup in the current EM Setup window:

Choose  >  or click the  icon (  ) to open the File Import EM Setup... Import
 dialog box, as shown in the following figure:Import EM Setup
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Click  to select the cellview to import from. For more information, see Browse
.#Opening an EM Setup View

Select the required sections in the . You can also select/deselect all the Filter
sections by clicking the checkbox .Sections to include

Click .Import

Opening an EM Setup View

To open an EM setup view, perform the following the steps:

Start ADS and open an existing workspace.

From the ADS Main window, choose  to open File > Open > EM Setup View
the Specify EM Cell View dialog box.

Select  from the  drop-down list.EM Setup View Type
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If you want to open a built-in ADS design (read-only), check the Show ADS 
 check box to display the list of all libraries under .Libraries Library

Under , select the Library name where the view exists.Library

Under , select the cell name.Cell

Under , select the required EM setup view name.View

Click  to open the selected EM setup view.OK

Opening the 3D Preview window

Choose  >  or click the  icon (  ) to preview Tools 3D EM Preview 3D EM Preview
your simulation.

Opening the Layout window

Choose  >  or click the  icon (  ) Tools Open Layout Window Open Layout Window
to display a layout window.

Simulating a Design

You can save the current settings and start the simulation process by clicking the 

 button or click (  ) to simulate an EM simulation. You can also press Simulate
 to start the EM simulation. If you have specified invalid EM settings, an error F7

message is displayed.
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Creating an SnP Schematic

You can create a new SnP schematic view by using the EM Setup window. This 
schematic can be used as a subcircuit for further circuit simulations.

To create an SnP schematic from the EM Setup window:

Open the EM Setup window.

Select  > . A new schematic view is created.Tools Create SnP Schematic

A message box is displayed that asks if you want FileName and FileType to 
be cell parameters.

If you select FileName and FileType as cell parameters, the SnP data 
item will contain FileName and FileType as file parameters. The 
default value for cell parameters will be Dataset for FileType and the 
dataset name in emSetup for FileName.

If you do not select FileName and FileType as cell parameters, the file 
parameters for SnP will be dataset for FileType and the dataset name 
in emSetup for FileName.

A new SnP schematic view is created, as shown in the following figure:

Creating an SnP Schematic

Creating an SnP Schematic

You can create a new SnP schematic view by using the EM Setup window. This 
schematic can be used as a subcircuit for further circuit simulations.

To create an SnP schematic from the EM Setup window:

Open the EM Setup window.

Select  > . A new schematic view is created.Tools Create SnP Schematic

A message box is displayed that asks if you want FileName and FileType to 
be cell parameters.

If you select FileName and FileType as cell parameters, the SnP data 
item will contain FileName and FileType as file parameters. The 
default value for cell parameters will be Dataset for FileType and the 
dataset name in emSetup for FileName.
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If you do not select FileName and FileType as cell parameters, the file 
parameters for SnP will be dataset for FileType and the dataset name 
in emSetup for FileName.

A new SnP schematic view is created, as shown in the following figure:

Using an EM Setup Template

While creating an EM Setup view, the data fields of the view are initialized with 
hard-coded factory default settings. To override these settings, an EM setup 
template with user-defined default settings can be used. You can use the settings 
for Simulator, Substrate, Frequency Plan, Output Plan, Momentum Options, FEM 
Options, Compute Resources, and EM Model found in the template to initialize a 
new EM Setup view.

Managing EM Setup Templates

Create EM Setup Template

Before creating an EM Setup Template prepare an EM Setup to contain all the 
values that have to be stored in the template.

Once the values have been set, from the menu bar select File > Create Template... . 
The below dialog will open.
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Enter a meaningful name for the template, as this name will be presented when 
creating a new EM Setup.

Choose the directory where the template will be stored. It can either be stored with 
a library or in an ADS configuration directory.

The ADS configuration directory mapping is:

local → current working directory

user → $HOME/hpeesof/em/setupTemplates (@EMSETUPT_USER)

site → $ADS_CUSTOM_DIR/em/setupTemplates (@EMSETUPT_SITE)
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The templates' absolute filepath will be displayed in a pop-up box when hovering 
over the location display after the label Creating:

You can filter out the section(s) you do not want to be part of the template, and you 
can add/modify some notes to ease template management (reload/delete)

Once the data is entered, Click the Create button.

The template can only be used when the storage directory is part of the EM 
Setup Template search path defined in emSetupTemplate.loc

Load EM Setup Template

To reset your current EM Setup to use the values in an EM Setup Template, from 
the File Menu in the EM Setup Dialog choose Load Template... . The following 
dialog will open:

Select the desired entry, optionally inspect the notes, and press Load.
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The values in the current EM Setup for which no values are defined in the EM 
Setup Template will keep their value.

Delete EM Setup Template

To delete an EM Setup Template, from the File Menu in the EM Setup Dialog, 
choose Delete Template... . The following dialog will open:

Select the entry to be deleted and click Delete.

Templates can only be deleted one after the other.

Finding EM Setup Templates

The search for EM Setup Templates is a 2-step process:

Finding emSetupTemplate.loc, the file that defines the EM Setup Template 
search path.
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2.  Finding the available EM Setup Templates

Finding emSetupTemplate.loc

The first emSetupTemplate.loc file found browsing the following, ordered directory 
locations will be used and stop the search:

1 . The current working directory

2 @ADS_WORKSPACE The current workspace

3 $ADS_EMTEMPLATELOC_FILEPATH Environment variable with the full PATH to the file

4 $HOME/hpeesof The hpeesof directory in your HOME directory

5 $ADS_CUSTOM_DIR If $ADS_CUSTOM_DIR not set use $HPEESOF_DIR/custom instead

6 $HPEESOF_DIR/config The config directory shipping with ADS

The config directory shipped with ADS contains a predefined emSetupTemplate.loc 
file, so an emSetupTemplate.loc file will always be found.

The search will always look for an emSetupTemplate.loc file in the designated 
directory, except for $ADS_EMTEMPLATELOC_FILEPATH that defines the full 
filePath, i.e. the directory and the file name.

To find out which emSetupTemplate.loc is used, open the Delete EM Template 
dialog (see below) and hover with your mouse just below the Existing templates 
text, an info box will pop-up with the full path to the emSetupTemplate.loc file.

Finding the available EM Setup Templates

The available EM Setup Templates is the list of  EM Setup Templates found in ALL
the search locations defined in the emSetupTemplate.loc file. I.e. unlike for the 
search for the emSetupTemplate.loc file the search is not stopped after finding the 
first template.

EM Setup Templates are files with a .emSetupT suffix (in case of legacy libraries .
emsetup is also accepted). They can be created using the methods described 
below or for the more expert users using an xml editor.

The available search locations that can be used in the emSetupTemplate.loc file are

.                        search the current working 
directory for templates
@LIBRARY                 search all the design 
libraries for templates
@LIBRARY_myLibrary       search the myLibrary design 
library for templates
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@ADS_WORKSPACE           search current user workspace 
for templates (in most cases the current working 
directory)
$ADS_EMSETUPT_SEARCHDIR  search the directory defined 
by the environment variable that may be set during 
startup for templates
@EMSETUPT_USER           search for user templates 
stored in $HOME/hpeesof/em/setupTemplates 
@EMSETUPT_SITE           search for site templates 
stored in $ADS_CUSTOM_DIR/em/setupTemplates 
;                           if ADS_CUSTOM_DIR is not 
set search in $HPEESOF_DIR/custom/em/setupTemplates
@EMSETUPT_SUPPLIED       search for shipped templates 
stored in $HPEESOF_DIR/em/setupTemplates
$ANY_ENV_VARIABLE        search the directory defined 
by the environment variable that may be set during 
startup for templates
"/a/fixed/path/to/a/directory"            search 
directory for templates
"/a/fixed/path/to/a/template.emsetupT"    add this 
template to the list if found.

The format of the file is

one entry per line

everything after blank or tab is comment (quote entries if containing blanks)

; or '#' or '//' at the start of a line is a comment.

$envvar, ${envvar} are expanded as needed. If an environment variable is 
not defined, then that entry is ignored.

No errors are generated during the parsing of the file.

A customizable example can be found in $HPEESOF_DIR/config/emSetupTemplate.
loc

Using the EM Setup Template

A list of available EM setup Templates is constructed using the algorithm described 
above.

If the list is empty, the factory default settings are used

If the list holds one entry, the settings from that template will be used to 
initialize the new EM Setup view.

If the list holds more entries, you can select from the list - the one previously 
used will be preselected -
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Give your EM Templates meaningful names, it will be easier to determine which 
one to choose.

Deprecated

Installing an EM Setup Template in a Library using scripting (for Experts)

To add an EM Setup template:

Create a (dummy) EM Setup cellview in the library, e.g. <libname>:
<cellName>:<emSetupViewName>, and initialize its data.

Optionally using an xml editor, edit the file emStateFile.xml in the emSetup 
cellview directory to remove the entries where you want to always use the 
factory defaults.

From the ADS Main window, select  >  to open the ADS Tools Command Line
Command Line Editor.

Type the following AEL command:

deemif_installSetupViewAsTemplateInLibrary("<libName
>", "<cellName>", "<emSetupViewName>", "<emSetupTemp
lateName>")

The template gets installed in the library and a file with the name 
 is saved in the library. After installation of <emSetupTemplateName>.emSetupT

the template, you can delete the EM Setup cellview.

Removing an EM Setup Template from a Library

To remove an EM Setup template from a library:

From the ADS Main window, select  >  to open the ADS Tools Command Line
Command Line Editor.
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2.  Type the following AEL command:

dex_em_removeEmSetupTemplateFromLibrary("<libName>",
"<emSetupTemplateName>")
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Managing EM Simulations

Managing EM Simulations

Running EM Simulations

Using the Job Manager

Viewing Simulation Summary

Running a Momentum simulation from Command Line

Running EM Simulations

Running EM Simulations

Before running a simulation, the following criteria must be met:

A substrate definition must be specified for the circuit.

The layout must contain at least one port.

A simulation frequency plan must be specified.

To run a simulation:

Create an EM setup.

Select an option from the Generate drop-down list in the EM Setup window.

Click the  button. Alternatively, press F7, which will start the action Go
specified in the EM Setup currently associated with the layout.

When you start a simulation, a new job is created in the Job manager. The Job 
 window provides a user interface to show the job status and messages, Manager

and allows you to cancel running jobs. For non-queued simulations, by default, a 
window with job status and messages will be opened. In the case of a queued 
simulation, double-click the job to open the detailed log window. If you close the 
log window and want to reopen it, double-click the job entry in the main Job 
Manager window. To open this window from a layout window, choose  > Window

.Simulation Status

To stop an EM simulation, choose  > . Alternatively, EM Stop and Release Simulator
the simulation can be stopped using  >  in the .Job Stop/Cancel Job Job Manager
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As a simulation progresses or after the simulation finished, you can view solution 
statistics. Some of the information returned includes time to solve, the resources 
required, mesh information, and any messages that were displayed in the status 
window. See Viewing Simulation Summary

Generating EM Cosimulation Views

To generate EM Cosimulation Views:

Select  from the  drop-down list in the EM Setup window.Views Generate

Click .Go

Generating EM Simulation Input Files

You can use the simulation input file for running command line simulations. To 
generate the input files:

Select  from the  drop-down list in the EM EM Simulation Input Files Generate
Setup window.

Click .Go

Generating Substrate (Momentum only)

The substrate output files contain the Green functions used by Momentum. These 
are precomputed and stored in a substrate database so that they can be reused for 
a subsequent simulation.

To generate substrate output files:

Select  from the  drop-down list in the EM Setup window..Substrate Generate

Click .Go

This mode always recalculates the substrate's Green functions. Existing local 
and/or remote substrates are removed from the database prior to the 
generation.

Viewing Substrate Generation Status

After the substrate calculations are started, any messages regarding the 
calculations will appear in the Job Manager status window. Messages usually refer 
to any errors found, and indicate when the calculations are complete. You can open 
the Job Manager window from the Layout menu bar choose  > Window Simulation 

.Status

Viewing the Substrate Generation Summary

If the substrate generation is successful, you can view the job status summary 
which informs about the time to compute and the resources required. To view the 
summary, choose  >  > . This EM Show Most Recent Substrate Generation Summary
displays the Substrate Summary window.
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The FEM simulator does not provide any substrate summary information.

Substrate Database Locations

By default, Momentum searches for substrate output files containing the Green 
functions in 3 locations. The locations are defined by following configuration 
variables in a  configuration file.momentum_ads.cfg

Variable Name Default Value File Location

SUPL_GF_DATABASE ^/ $HPEESOF_DIR/Momentum/<version>/substrates

SITE_GF_DATABASE ~/ $HOME/substrates ()

LOCL_GF_DATABASE ./ <workspaceDirectory>/substrates

If no output files are found that can be reused, new substrate output files will be 
computed and stored in the SITE_GF_DATABASE (when writable) or 
LOCL_GF_DATABASE location. By default, substrate files will be written to $HOME
/substrates.

You can change the default search location by adding a configuration variable into 
either $HPEESOF_DIR/custom/config/momentum_ads.cfg, $HOME/hpeesof/config
/momentum_ads.cfg, or <workspaceDirectory>/momentum_ads.cfg (create the 
directory path and configuration file if it does not yet exist).

Some examples are provided here. A ‘substrates’ subdirectory will be created 
automatically at the specified location! Environment variables can be used as well 
(Note: the unix notation with '$' and '/' are used).
To store new substrate output files

Under , set the <workspaceDirectory>/substrates

SITE_GF_DATABASE variable to a non-existing directory

SITE_GF_DATABASE=/non_existing_dir

Under the directory“, setC:/tmp/substrates

SITE_GF_DATABASE=C:/tmp

Under a design kit, assuming that an environment variable 
points to the location of a design kit, set$my_designkit_directory

SITE_GF_DATABASE = $my_designkit_directory/circuit
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will store substrate output files under $my_designkit_directory
./circuit/substrates

Embedding the substrate output files in the workspace

Computing the substrate output files can be time consuming. To avoid 
recomputing them when a workspace is shared with another user, you can move 
the substrate output files into the substrates directory of a workspace.

To identify which substrate output files to move, browse to the 
<workspaceDirectory>/simulation/<libName>/<cellName>/<layoutName>
/<emSetupName>_MoM directory and open the proj.qry file.
The line at the bottom will be like

Corresponding potentialname : C:\Users\default\\substrat
es\0214.sdb

Browse to this substrates directory and move the corresponding .sdb and .sci file to 
<workspaceDirectory>/substrates. No need to update the .ndx file there, this will be 
done automatically. Your next simulation will reuse the substrate output files from 
the workspace.

Generating a Mesh

To generate mesh at a specified frequency:

Select  from the  drop-down list in the EM Setup window.Mesh Generate

Click .Go

Using the Job Manager

Using the Job Manager

You can manage non-interactive processing jobs by using the Job Manager 
window. A new managed job is automatically created for various time-consuming 
operations. These operations currently include physical EM simulations and 3D 
model generations. The Job Manager window provides a user interface to show the 
job status and messages, and allows you to cancel running jobs. However, its 
scope is currently limited to physical EM simulation-related jobs.
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The Job Manager consists of an internal queuing concept. According to this 
concept, jobs submitted with the same queue name run sequentially. Queues can 
be suspended and resumed. Note that this internal queuing system is 
complimentary to the queuing system of distributed job management systems such 
as Platform LSF and Sun Grid Engine. For circuit simulation job management, refer 

.Circuit Remote Simulation

Besides running locally, physical EM simulation setups can be configured to run on 
a remote host or a submission host for a distributed cluster. The Job Manager 
maintains a  cluster of hosts ready to accept jobs, and dynamically adds hosts PVM
to the cluster as needed. Complete cluster host configuration and management 
capabilities are provided inside the Job Manager user interface.

Starting the Job Manager

A Job Manager window is automatically displayed in the background when an EM 
Setup is opened or a physical EM simulation is started. It can be brought to the 

front by clicking  icon on the task bar.

Alternatively, you can display the Job Manager window by using the EM Setup 
window. Perform the following steps:

Select  >  to open the  window.EM Simulation Setup EM Setup

Select  in the left pane of the EM Setup window.Resources

Click the  button in , as shown in the following figure:Start Job Manager

http://edadocs.software.keysight.com/display/ads2017/Circuit+Remote+Simulation
http://en.wikipedia.org/wiki/Parallel_Virtual_Machine
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The Job Manager main window is displayed, which lists a summary of all jobs 
created since the Job Manager was launched:

The Job Manager window closes automatically if the main window is 
closed. If active jobs are still pending, a message box is displayed asking 
for confirmation. After confirmation, these jobs will be canceled without 
cleaning up their working directories. All status and logging information 
is discarded at exit. If you just want to hide the main window, minimize 
it instead of closing it.
One exception: jobs that are actively running on a 3rd party cluster 
survive closing and reopening the Job Manager. To access these jobs, 
reopen the Job Manager from an EM Setup and the jobs will reappear in 
the main Job Manager window.

Double-click a job entry to view detailed log messages.
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This log window is immediately displayed when newly created jobs do not need 
to wait in the internal queuing system. Select  >  to View Show Main Window
open the main window from here. Newly created jobs that have to wait in a Job 
Manager queue will open the main window and highlight the summary line.

Job Progression

All jobs progress through the following states:

Creating a new job: A new job is created and the following job configuration 
information is displayed in the topmost part of the detailed log window.

ADS Workspace::Design: Specifies the workspace and design being 
simulated.

Simulator: Specifies the simulator  or  used for Momentum FEM
simulation.

Input/output directory: Specifies the directory used for containing 
input files and output files.

Working directory: Specifies the host directory where the job will 
perform the main task. This can be the same directory as the input
/output directory.

Queuing... or : After a job is created, it needs to Queuing (queue suspended)
wait until earlier jobs in the same Job Manager queue are complete.

Connecting with the remote host: The remote host is not yet part of the PVM 
cluster and is currently being dynamically added to the cluster.

Preparing Files: This preparation step consists of the following stages:

The input/output directory and working directory are locked to 
prevent double usage. The lockfile is an empty directory named .

.simlock

Local preparation work is performed in the input/output directory.

The contents of the input/output directory are copied to the working 
directory.

Performing the main task: The job is inside its main task. In the  Local/remote
mode, the status displays . For the mode, the following Running Distributed
third-party cluster submission and status tracking is performed:

Submitting to cluster

Cluster response: submitted.
In response to choosing  > :Job Query Status

Requesting status update

Cluster response: created/ / / / /submitted pending running suspended
 or ended Cluster did not answer

Waiting: This step allows dying processes and network disk operations to 
settle.
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Retrieving results: The contents of the working directory are copied back to 
the input/output directory.

Processing results: The final datasets are installed in this step.

Cleaning up: The working directory is cleaned up (only if this is not also the 
input/output directory). The  lockfile is removed from the input.simlock
/output directory.

Done

Managing Jobs

You can control the following operations using the  menu, which is available Job
from the Job window and log window:

Stopping or Canceling a Job: You can immediately cancel a job and perform 
the necessary cleanup operations by selecting  .Job> Stop/Cancel

Skipping simulation steps: Some iterative simulation steps can be 
interrupted, forcing the simulation to proceed with the next step. The 
generic name of this menu item is  . When enabled, Job> Interrupt simulation
this changes to a more specific name indicating precisely what will be 
interrupted. You can interrupt the adaptive mesh refinement or solve phase 
(frequency sweep) of an FEM simulation process before convergence. The 
simulation continues with the current mesh or the already calculated 
frequency points. Intermediate data of interrupted simulations can be reused 
in consequent simulations. Select   during the Job> Skip mesh refinement
mesh refinement step of an FEM simulation. Select  Job> Skip frequency 

 to stop frequency sweep, as shown in the following figure:sweep

Querying Status: You can query a status update for jobs submitted to a third-
party distributed cluster system by selecting  . The Job> Query Status
updated status will be shown in the status line. If the status indicates that 
the simulation is done, all results will be automatically fetched, available 
datasets are installed, and the remote working directory is cleaned up.
You can configure an interval for automatic status polling in the general Job 
Manager preferences (on by default using 60 second intervals). Automatic 
polling is suspended if the submit host is dropped from the PVM cluster. A 
manual status query triggers reconnecting to the submit host, after which 
automatic polling will resume.

Retrieving Intermediate Results: You can synchronize the remote working 
directory to the input/output directory and install currently available 
datasets by selecting . This option is Job>Fetch Intermediate Results
applicable only to jobs submitted to a third-party distributed cluster system.
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It is not necessary to use  at the Job > Fetch Intermediate Results
end of a distributed simulation. Use  >  instead, Job Query Status
which additionally cleans up the remote working directory and 
notifies other tools of the completion of the simulation.

Deleting logs: You can completely remove a job from the Job Manager by 
selecting  in the main window.Job > Delete Log

When using  on a running job, a message box is displayed Job > Delete Log
asking for confirmation. After confirmation, this job will be canceled without 
cleaning up its working directory. To avoid this, use  and Job > Stop/Cancel Job
delete the job only after the status has changed to .Done

The Job Manager provides a simple queuing system where jobs submitted with the 
same queue name run sequentially. The queue name is specified in the EM Setup. 
For more information, see . For complex queue Specifying Simulation Resources
management, use a dedicated job management tool such as Platform LSF and Sun 
Grid Engine.
Job manager queues can be suspended and resumed by selecting a queued job in 
the main menu and choosing  >  or  > .Queue Suspend Queue Queue Resume Queue

It is not possible to suspend a queued job once the job has started. Still,  Queue
>  can be used to suspend execution of subsequent queued Suspend Queue
jobs.
After a queue completes, it will automatically enter a suspended state. Use 

 >  >  in the Resources Simulation Resources Auto-start queue after submission
EM Setup if you want to automatically (re)start the queue when submitting a 
new simulation.

Managing Hosts

Select  >  from the main Job Manager window to display the status of all View Hosts
hosts in the PVM cluster. This window will also automatically pop up whenever 
hosts are dynamically being added to the cluster.
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One line is displayed for each running host in the cluster. The architecture and 
speed of each host are shown as well. The speed can be configured using the 
custom  eesofpvm option and is currently used for display purposes only.sp=value
See  for host configuration information.#Setting up Remote Hosts

Select or type a host name and click  to manually add a new Add host to cluster
host to the cluster. This will bring up a password prompt if authentication is 
required. If the operation fails, information about the failure is shown in the status 
bar.
To remove hosts from the cluster, select one or more entries in the  Active hosts
table and click . Attempts to remove the local Remove selected host(s) from cluster
host from the cluster are ignored.

Setting Preferences

The Job Manager is an improved version of the former EEsofPVM Simulation 
Console. Complete cluster host configuration and management capabilities are 
now provided inside the Job Manager user interface. The Legacy setups using a 
cluster configuration file and environment variables are still supported but 
deprecated. This support may be removed in a future release.

The Job Manager now automatically uses secure shell (SSH) to connect to 
other hosts. If it still needs to run some other third party remote shell tool for 
a legacy setup, the environment variable EESOFPVM_RSH_NOAUTO=<any 

 is now additionally required besides the existing nonempty string>
 variable.EESOFPVM_RSH

When migrating to the new GUI-based configuration, it is advised to remove 
all old eesofpvm configuration settings:

If coexistence with ADS 2009 (Update 1) is not necessary, remove the 
cluster configuration file at <home directory>/hpeesof/config

 and/or the path specified by the /pvmhost_cfg.txt <home 
 variable directory>/hpeesof/config/hpeesof.cfg

 (and remove this variable).EESOFPVMHOSTFILE

However, if ADS 2009 (Update 1) coexistence is required, the legacy 
eesofpvm host file can still be obscured to the Job Manager by 
overriding the hpeesof.cfg variable  with an EESOFPVMHOSTFILE

additional variable . The EESOFPVMHOSTFILE:390=/nonexistent

number  is the internal Job Manager version number as shown 390

when choosing  >  from the main Help About EEsof Job Manager
window.

If coexistence with ADS 2009 (Update 1) is not necessary, eliminate 
all environment variables containing  in the name from the EESOFPVM

Windows environment or Unix init scripts (e.g.  or ~/.bashrc ~/.

) and the  file. The only environment kshrc ~/.eesofpvmprofile

variable that does not lose its relevance is , the EESOFPVM_TMP

directory where the PVM daemon displays its configuration and 
writes logging information.
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Choose  >  from the Main window or the hosts window to open Settings Preferences
the Preferences dialog box.
These preferences are saved in <home directory>/hpeesof/config/simsys.

, which can be distributed towards other users if they all use the same remote cfg

simulation hosts.

General Options

Allow jobs to pop up their log: When selected, a new window pops up for 
each new job. Otherwise, new jobs will only be highlighted in the Job 
Summary list. It is selected by default.

Automatically query 3rd party cluster status every  : When xxx seconds
selected, the status of jobs running on a 3rd party cluster will be 
automatically polled using fixed time intervals. Automatic polling is 
suspended if the submit host is dropped from the PVM cluster. A manual 
status query triggers reconnecting to the submit host, after which automatic 
polling will resume. This option is selected by default using an interval of 60 
seconds.
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Specifying Startup/Shutdown Configuration

The Job Manager runs as a task of the PVM cluster it controls. The PVM 
infrastructure needs to start before the Job Manager starts, and can be allowed to 
continue running after the Job Manager has exited. To accommodate different 
requirements, several startup/shutdown options are available. Refer to the 
following recommended settings:

Start the eesofpvm backend when ADS starts: When selected, the PVM 
infrastructure will silently start when ADS is started. This reduces the 
response time to start the first simulation (at much lower cost). It is selected 
by default.

Close EEsof Job Manager when ADS exits: When selected, the Job Manager 
will exit when ADS exits. A confirmation message box will appear when there 
are unfinished jobs. It is selected by default.

Shut down the eesofpvm backend when both ADS and EEsof Job Manager 
have exited: When selected, the PVM infrastructure will be stopped when 
both ADS and EEsof Job Manager have exited. It is selected by default.

Shut down the eesofpvm backend when EEsof Job Manager exits: When 
selected, the PVM infrastructure will be stopped when the EEsof Job 
Manager exits. This check box can be partially selected, which displays a 
message box asking for your confirmation. It is not selected by default.

Use separate eesofpvm backends for different combination of user/host
/$DISPLAY/$HPEESOF_DIR: When selected , all internal files that are shared 
between different executables of the same PVM session will get a suffix to 
separate different PVM sessions from one another. This prohibits conflicts 
between different PVM sessions running on the same system. The suffix 
consists of eight lowercase letters and/or digits. It is selected by default.

If the presence of a legacy PVM cluster configuration is detected (if 
 is defined or EESOFPVMHOSTFILE $HOME/hpeesof/config/pvmhost_cfg.

 exists), the default settings will be different in order to mimic the original txt

behavior:

Preference name Normal default 
(recommended)

Legacy default

Start the eesofpvm backend when ADS starts Selected Not selected

Close EEsof Job Manager when ADS exits Selected Not selected

Shut down the eesofpvm backend when both ADS and 
EEsof Job Manager have exited

Selected Not selected

Shut down the eesofpvm backend when EEsof Job 
Manager exits

Not selected partially selected = prompt
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Preference name Normal default 
(recommended)

Legacy default

Use separate eesofpvm backends for different 
combinations of user/host/$DISPLAY/$HPEESOF_DIR

Selected Not selected

Default remote ADS installation directory Use the local 
$HPEESOF_DIR 
variable

As defined in the eesofpvm 
cluster configuration file

Setting up Remote Hosts

The  window allows you to configure jobs to run on a remote host or a EM Setup
distributed cluster.

The configuration and operation of a third party distributed cluster happens 
completely outside the Job Manager. The Job Manager only communicates 
with a  having access to the distributed cluster. The requirements submit host
and configuration of a submit host are identical to those of any other remote 
host as far as the Job Manager is concerned.

Requirements for Running Jobs

In order to run jobs on a remote host you need the following:

A compatible ADS installation on the remote host. Compatibility is only 
guaranteed if the versions of the local and remote ADS installations are 
identical.

An account on the remote host accessible over secure shell (SSH). An SSH 
service is available on all contemporary Unix-like systems. Setting up SSH 

 is described.  is supported but not on Windows Passwordless SSH operation
required.

A read/write file system location on the remote host that can temporarily 
support the working directory of a job.

The SSH service should not issue a welcome message when used to start the 
remote deamon as it will disturb the startup process.

Configuring a Remote Host

To configure a remote host, add a configuration line to the :Host specific overrides

Specify the following fields:
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Hostname: This is the DNS name of the remote host or its dotted IP address. 
If you want to limit the configuration to a specific ADS version, add  :version
and optionally additionally  after the host name. The current values .revision
for  and  are shown on the first line of the dialog shown when version revision
choosing  >  from the main window: Help About EEsof Job Manager EEsof 

.Job Manager (version.revision)

ADS installation directory: This is the path to the main ADS installation 
directory.

Working directory: The remote working directory is specified in the EM 
Setup window. The working directory entered in the Job Manager 
preferences is used as base directory to complete relative path 
specifications. However, if you append  to the end of the path, the :force

directory specified in the EM Setup is always ignored and the path 
preference is used exactly as specified.
Environment variables specified as ,  or  are expanded $VAR ${VAR} %VAR%
on the remote host.
Use } or  to expand environment variables on ${VAR:local %VAR:local%
the local host.
Escape a literal  as  and a literal  as .$ $$ % %%

The following local variables have a special meaning:

${HOSTNAME:local}: the local hostname

${PWD:local}: the input/output directory

${SESSION:local}: an identifier unique to each PVM cluster 
instance
(a string of eight lowercase letters and digits if Use separate 
eesofpvm backends for different combinations of user/host/$DISPLAY

 is selected, otherwise )/$HPEESOF_DIR default

${TAG:local}: a  identifier for the job that is M012345678901
unique within the Job Manager session
In case you want to avoid all directory conflicts, a good choice would 
be

%USERPROFILE%\Jobs\%SESSION:local%\%TAG:
local%:force

for remote Windows hosts and

/var/tmp/$USER/jobs/${SESSION:local}/${TAG:
local}:force

for remote Linux hosts.

Additional eesofpvm options: Enter a list of space separated name=value
options for PVM.



385 Electromagnetic

1.  

2.  

3.  

4.  

5.  

6.  

7.  

lo=username specifies an alternate login name to use.

dx=<path to eesofpvmd> specifies an alternate path to the 
eesofpvmd executable or script.
For further options, consult the .PVM documentation

Memory limit: This field specifies a hard limit for the memory available to 
individual job processes. It can be used to automatically stop jobs with an 
out of memory error before they use so much memory that the computer 
enters an unresponsive trashing state from which it is hard to recover. It 
does not allow you to run a simulation with less memory. This configuration 
option is applicable to local and remote processes, but not to processes 
running on 3rd party clusters. You can either specify , or an unlimited

absolute amount of memory ( ), or a negative offset from the total xxxMB
amount of RAM ( ).RAM-xxxMB

If the entries for ,  or  are ADS installation directory Working directory Memory limit
empty, the specified defaults are used. These defaults can be used to avoid 
redundant configuration repetitions. Each  specified in name Default additional 

 is only overridden if the same  is specified in the eesofpvm options name Host 
.specific overrides

Mode of Operation

The Job Manager window dynamically adds remote hosts to the PVM cluster as 
required or requested. A host is added as follows:

A secure shell (SSH) connection is initiated to the remote host.

The local host prompts for passwords.

The SSH connection is now established.

(Only on Unix remote hosts) The Bourne shell script file ~/.
 is sourced if it exists. This file can be used to set eesofpvmprofile

additional environment variables. A typical use case is extending the  PATH

and  environment variables to ensure accessibility of the LD_LIBRARY_PATH

tools required to control a third party job management framework.

The PVM daemon is started on the remote host. The choice between 32-bit 
and 64-bit executables is automatic (64-bit executables are used whenever 
possible). The command used to start the PVM daemon is <ADS installation 

.directory>/pvm3/bin/auto_eesofpvmd.exe

The remote PVM daemon contacts the local PVM daemon over a dedicated 
TCP/IP connection. The remote host is now part of the PVM cluster and 
remains in the cluster until this connection is closed.

The SSH connection is closed. The remote PVM daemon keeps running.

In case of remote simulation issues, check your firewall configuration at both 
ends (try disabling it temporarily to check if there is an issue). Several 
executables in the ADS installation directory communicate over dynamically 
allocated TCP and UDP ports. On each host involved you can limit the port 
range for inbound connections through the environment variable 

http://www.netlib.org/pvm3/book/pvm-book.html
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EESOFPVM_PORTRANGE= -  (e.g. using an  directive in the <from> <to> export

 file). Adjust the firewall rules to allow connections ~/.eesofpvmprofile

from/to these ports.

Setting up an SSH server on Windows
Since Windows 10

A SSH server is automatically deployed when the machine is configured into 
developer mode.

Use  >  >  >  and click the Start Settings Update & security For developers Developer 
 radio button.mode

Before Windows 10

The software package  can be used to deploy a SSH server on a Windows Copssh
host. A free version of this package is provided in the <ADS installation directory>

 directory. Install the package using the suggested \pvm3\tools\Copssh

settings (administrator privileges are required). Do not attempt to change the 
autogenerated password for the  user (remembering this password is SvcCOPSSH

also not necessary).

Follow these steps for each user:

Log on as a user having administrative privileges (possibly but not 
necessarily the user to be activated).

Launch  >  > .Start Copssh 01. Activate a user

Enter the name of an existing user on the host. The short %
 login name is required, not a first and last name. This USERNAME%

name will be the login name for SSH. If the user name exists inside a 
Windows domain, prefix the user name with the domain name and a 
backslash (these items are not part of the login name for SSH).

Use  as command shell/bin/bash

Select .Remove copssh home directory if it exists

Do not select .Create keys for public key authentication

Select .Create link to user's real home directory

Click . An acknowledgment message is displayed.Next

Click .OK

Browse to the required directory C:\Program Files\ICW\home/
 (  on a 64-bit username C:\Program Files (x86)\ICW\home/username

system).
Open the file  with a text editor. It is important to use an editor that .bashrc

upholds end-of-line conventions (do not use Notepad). A suitable editor is 
.Notepad++

At the end of the file, add an empty line followed by the following .bashrc

lines:

http://www.itefix.no/i2/copssh
http://notepad-plus-plus.org/
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3.  

export EESOFPVM_TMP="$USERPROFILE\\PVM"
export HOME="$USERPROFILE"
cd

Make sure that the file ends again with an empty line.

Save the  file and exit the editor..bashrc

Log on as the user to be activated and open a command prompt (  >  Start Run
> )cmd.exe

Execute  in the command prompt.mkdir "%USERPROFILE%\PVM"

Close the command prompt.

The user account is now accessible through ssh.

You can verify correct operation by using the shell login command  ssh <user>@
 from a Unix terminal or from a Windows command prompt (choose <hostname>

 >  > , then first type  Start Run cmd.exe cd <ADS installation directory>
 ). Log on over SSH and run \tools\bin <return> <ADS installation directory>

 (replace all backslashes by forward /pvm3/bin/auto_eesofpvmd.exe

slashes). If the output ends with a short string resembling either  7f000001:d789

or , configuration was successful (the exact (hexa)/tmp/eesofpvmtmp025108.0

decimal digits can be different). Otherwise an error message indicating the problem 
is shown (messages about an unreadable file  are normal and pvmhost_cfg.txt

can be safely ignored).

When accessing a Windows host remotely, network shares are generally not 
available as drive letters. When referring to remote network drives, use the 
UNC name (    ) <double backslash> <hostname> <backslash> <sharename>
instead of the drive letter.

The Copssh installer assigns some special rights to the administrative  SvcCOPSSH

user in order to support passwordless operation. However, when the host is part of 
a Windows domain, the domain's security policy is often configured to periodically 
reject these rights to all users, rendering Copssh unusable. Typically Copssh 
appears to be working after installation, but all SSH logins fail the next day (as a 
result of the domain's security policy being applied overnight).

To permanently fix this issue:

Make sure you are logged in as a user in the Administrators group.

Move the file  (C:\Program Files\ICW\etc\sshd_config C:

 on a 64-bit system) \Program Files (x86)\ICW\etc\sshd_config

to a writeable location, such as the Desktop.
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Open the moved file with a text editor. It is important to use an editor that 
upholds end-of-line conventions (do not use Notepad). A suitable editor is 

, which is provided as Notepad++ <ADS installation directory>
.\pvm3\tools\Notepad+\notepad+.exe

Find the following line of text:

#PubkeyAuthentication yes

Change this line into (be sure to remove the pound sign):

PubkeyAuthentication no

Save  and exit the text editor.sshd_config

Move  back to its original position.sshd_config

Open the Services control panel (As privileged user, choose  >  > Start Run
).services.msc

Double-click the entry for .Openssh SSHD

Stop the service.

In the  tab, change  to use  instead of Log On Log on as: Local System Account
the  user.SvcCOPSSH

Click .Apply

Go back to the  tab and start the service.General

After this fix, you cannot connect to the remote machine without specifying the 
password, yet normal password-based operation work again. If you plan to use 
password-based operation, this fix can be applied up-front (without running into 
the issue first).

Passwordless SSH Operation

SSH can be configured to use public key authentication without the need to enter a 
password. In this mode of authentication, the local host presents a private key that 
must match a public key known to the remote host. Perform the following steps:

Generate the public/private key pair on the local host (the one that runs the 
Job Manager)

On Windows, open a command prompt inside ADS (  > Tools Command 
 > Line... invoke_process("cmd",list(),"",FALSE,

) and type   TRUE,""); cd <ADS installation directory>\tools\bin
.<return>

On Unix, open a terminal.

Type  . Just hit the return key when ssh-keygen -t dsa <return>
prompted for the file location and the passphrase.

http://notepad-plus-plus.org/
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2.  

3.  

4.  

Remember the location of the public key which is displayed.

Copy the public key  from the local host to the remote host.id_dsa.pub

On the remote host, check for the existence of the  directory and create .ssh

it if missing. This directory must have read/write rights for the targeted user, 
and no rights assigned to anyone else.
On Windows, the  directory is .ssh C:\Program Files\ICW\home/

 (username/.ssh C:\Program Files (x86)\ICW\home/username/.
 on a 64-bit system).ssh

On Unix, the  directory is ..ssh ~/.ssh

On the remote host, append the contents of  to  id_dsa.pub <.ssh
. This file must not be writeable by other directory>/authorized_keys

users than the targeted user.
If the  file did not yet exist, just rename  to authorized_keys id_dsa.pub

 instead of creating an empty file and appending.authorized_keys

The configuration is now complete. If passwordless operation does not appear to 
work in the Job Manager, verify operation using the shell login command  ssh

 from a Unix terminal or from a Windows command prompt <user>@<hostname>
(choose  >  and run Tools Command Line... invoke_process("cmd",

, then first type  list(),"",FALSE,TRUE,""); cd <ADS installation directory>
 ).\tools\bin <return>

On Windows remote machines, network shares on the remote machine may 
refuse operation in passwordless mode because the user is not authenticated 
to the Windows domain.

Specifying Configuration Files and Environment Variables

Specifying Job Manager Preferences

The Job Manager preferences are stored as  lines in the file <name>=<value>
. These settings override <home directory>/hpeesof/config/simsys.cfg

those in the file , <ADS installation directory>/custom/config/simsys.cfg
which in its turn overrides settings in the file <ADS installation directory>/config

. The file /simsys.cfg <ADS installation directory>/custom/config/simsys.
 can be used for site-wide deployment of Job Manager preferences. Note cfg

however that the Job Manager GUI will always incrementally save preference 
changes to the file .<home directory>/hpeesof/config/simsys.cfg

The preferences are mapped to the  file as follows:simsys.cfg

Preference name Variable name in simsys.cfg Acceptable values

Allow jobs to pop up their log JOB_LOG_POPUP TRUE or FALSE

Automatically query 3rd party cluster 
status

AUTOQUERY_CLUSTER TRUE or FALSE
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Preference name Variable name in simsys.cfg Acceptable values

Interval between queries in seconds AUTOQUERY_CLUSTER_INTERVAL integer

Start the eesofpvm backend when ADS 
starts

ADS_STARTS_EESOFPVM TRUE or FALSE

Close EEsof Job Manager when ADS 
exits

ADS_STOPS_JOBMANAGER TRUE or FALSE

Shut down the eesofpvm backend 
when both ADS and EEsof Job 
Manager have exited

STOP_ORPHAN_EESOFPVM TRUE or FALSE

Shut down the eesofpvm backend 
when EEsof Job Manager exits

JOBMANAGER_STOPS_EESOFPVM TRUE,  or FALSE

ASK

Use separate eesofpvm backends for 
different combinations of user/host
/$DISPLAY/$HPEESOF_DIR

SEGREGATE_EESOFPVM_SESSIONS TRUE or FALSE

Use the local $HPEESOF_DIR variable DEFAULT_HPEESOF_DIR <local> (include 

the angular brackets)

As defined in the eesofpvm cluster 
configuration file

DEFAULT_HPEESOF_DIR empty

User defined: DEFAULT_HPEESOF_DIR string

Default working directory: DEFAULT_WORKING_DIRECTORY string

Default additional eesofpvm options: DEFAULT_EESOFPVM_OPTIONS string

Default memory limit: DEFAULT_MEMORY_LIMIT unlimited,  xxxMB

or RAM-xxxMB

Host specific overrides (one entry per 
override)

HOST_CONFIG_<unimportant unique 

suffix>

<Hostname>|<ADS 

installation directory>
|<Working directory>

|<Additional 

eesofpvm options>|

<Memory limit>
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Running PVM Boot Script

When a Unix host is added to the PVM cluster, the optional Korn shell script file 
 is sourced before the PVM daemon is started on the host. ~/.eesofpvmprofile

This file can be used to set additional environment variables. A typical use case is 
extending the  and  environment variables to ensure PATH LD_LIBRARY_PATH

accessibility of the tools required to control a third party job management 
framework. For instance in LSF environments a user very often needs to source the 
local profile.lsf script here to ensure that the PVM environment can find the LSF 
commands.

Specifying Environment Variables

The optional environment variable indicates the directory in EESOFPVM_TMP 

which the PVM daemon advertises its configuration and writes logging information. 
You can specify the following settings:

Windows: the environment variable , or if this is unset, TEMP C:\TEMP

Unix: /tmp

The optional environment variable indicates the socket EESOFPVMNETSOCKPORT 

port number which the PVM daemon uses to connect to other cluster clients. If it 
set PVM will use the indicated port number to set up the cluster. If it is not set it 
will search for an available valid port number.

Specifying Legacy Settings

The following settings are deprecated but supported for legacy setups:

The PVM cluster configuration file: this is by default <home directory>
. Its path can be overridden by /hpeesof/config/pvmhost_cfg.txt

the  variable <home directory>/hpeesof/config/hpeesof.cfg
.EESOFPVMHOSTFILE

The environment variable  pointing to a remote shell EESOFPVM_RSH

executable. This variable now additionally requires EESOFPVM_RSH_NOAUTO
=  to be set in order to be recognized.<any nonempty string>

Viewing Simulation Summary

Viewing Simulation Summary

During a simulation process, you can view the statistics of momentum mesh, S 
parameter, substrate, mesh, and geometry statistics. The simulation summary 
includes time to solve, the resources required, cell information, and any messages 
that were displayed in the status window. You can view the following types of 
summary for an EM simulation:

Momentum mesh

S-param simulation summary

Mesh generation summary
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Geometry preproc summary

Substrate generation summary

Viewing Momentum Mesh

You can view the momentum mesh by selecting  >  > EM Show Most Recent
. The mesh view is selected in the circuit, asMomentum Mesh

shown in the following figure:

You cannot view FEM mesh.

Clearing a Mesh

You can delete the view of the mesh from the circuit. Clearing a mesh only deletes 
the view from the Layout window; it does not erase mesh calculations.

To remove the mesh from the display:

1. Choose  > .EM Clear Momentum Mesh
2. If you want to redisplay the mesh, choose  > . Otherwise, you have to Edit Undo
compute the mesh again.

You cannot delete the mesh view of an FEM simulator.
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Viewing S-param Simulation Summary

You can view the S parameter simulation summary by selecting  > EM Show Most 
 > . The  window is Recent S-Param Simulation Summary EM Simulation Summary

displayed. The following example displays a summary window for the Momentum 
microwave simulation mode.

In the EM Simulation Summary window, you can view information about the matrix 
size after mesh reduction and the statistics for quasi-static calculations. The user 
time and elapsed time values are listed as separate entries in the Summary 
window. The elapsed time represents the overall time taken for completing the 
simulation, while user time only presents the time taken by the CPU to complete 
the calculations. Therefore, if the CPU exclusively works only on the simulation, the 
user time and elapsed time values are equal.

If the mesh computation process is successful, you can view the following mesh 
statistics:

The number of rectangular cells in the structure

The number of quadrangular cells in the structure

The number of triangular cells

The number of via cells

The number of edge currents
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Simulation setup information

For an FEM simulation, you can view information about the frequency, meshing 
time, and simulation time. The following figure displays the S-param summary for 
an FEM simulation:

Viewing Mesh Generation Summary

You can view the generated mesh statistics by selecting  >  > EM Show Most Recent
. The  window is displayed. The following Mesh Generation Summary Mesh Summary

example displays the summary window for the Momentum microwave simulation 
mode.
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In the Mesh Summary window, you can view the following mesh statistics:

Number of Quadrilateral cells

Number of triangular cells

Number of via cells

Number of edge currents

Computer resources used and time to solve

User Time and Elapsed Time

Viewing Geometry Preproc Summary

You can view the layout processing report by selecting  >  > EM Show Most Recent
. The  window is displayed. Geometry Preproc Summary Layout Processing Report

The following example displays a summary window for the Momentum microwave 
simulation mode:
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This summary window provides information about the minimum snap distance used 
for layout healing and frequency of mesh generation.

Viewing Substrate Generation Summary

You can view the substrate summary by selecting  >  > EM Show Most Recent
 . This displays the  window. The Substrate Generation Summary Substrate Summary

following example displays a summary window for the Momentum microwave 
simulation mode:
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This summary window provides information about the process size, user time, and 
elapsed time.

The FEM simulator does not provide any substrate summary information.

Running a Momentum simulation from Command Line

Running a Momentum simulation from Command Line

You can run the Momentum simulator from Command Line providing the necessary 
input files.

The files, file formats and process described below can change from release to 
release.

Create the layout and define the associated EM simulation setup in an ADS 
workspace.

From the EM Setup window, select  and hit Generate: Simulation input files
the  button to write the required input files.Go
Following files will be written to the <workspace>/simulation/<library>/<cell>
/<layout>/<emSetup>_<simulator> directory:
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3.  

Input File Content

proj.prt and proj.
pin

S-Parameter port and associated pin information

proj_a original geometries before layout pre-processing

proj.ltd substrate information

proj.opt simulation options (e.g. layout pre-processing, mesh and simulation related 
settings)

proj.sti frequency stimulus plan

proj.cfg configuration file (e.g. paths to user/site/supplied substrate database locations)

proj.vpl far field view plan, optional (for far field computation only)

Alternatively, use one of the AEL functions below.

dex_em_writeSimulationFiles(layoutContext, 
simulationDirectory)
dex_em_writeSimulationFiles(libName, cellName, 
emSetupViewName, simulationDirectory)

This step is platform dependent and will set all necessary environment 
variables, e.g. HPEESOF_DIR, ADS_LICENSE_FILE, PATH and 
LD_LIBRARY_PATH (for linux).

On Linux- Open a command line window. For example, when using a 
ksh or bash:

export 
HPEESOF_DIR=<path_to_ADS_installation_directory
> # for example: /hfs/d1/eesof/ADS2014_11
export 
ADS_LICENSE_FILE=<path_to_ADS_license_file_or_s
erver> # for example: /hfs/d1/eesof/licenses
/license.lic
export PATH=$HPEESOF_DIR/bin:$PATH

On Windows- Open a Command Prompt window.

# NOTE: do NOT use double quotes.
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4.  

set 
HPEESOF_DIR=<path_to_ADS_installation_directory
> # for example: set HPEESOF_DIR=C:\Progam 
Files\Keysight\ADS2014_11
set 
ADS_LICENSE_FILE=<path_to_ADS_license_file_or_s
erver> # for example: set ADS_LICENSE_FILE=C:
\Program 
Files\Keysight\EEsof_License_Tools\licenses\lic
ense.lic
set PATH=%HPEESOF_DIR%\bin;%PATH% 

You can verify whether the setup is correct by executing following 
command: . This should return the adsMomWrapper --version

Momentum engine version. If not, verify the environment variable 
settings.

Change directory (cd) to the simulation directory mentioned above. A 
complete Momentum simulation consists of different steps.

Simulation Step Engine 
Option

Output Files

Substrate file pre-processing (e.g. 
expanding substrate for thick conductors)

-T proj.sub including expanded layers for thick 
conductors

Substrate database generation (Green 
function calculation)

-DB proj.qry that contains information on where the 
Green function database file is located

Layout pre-processing and mesh 
generation

-M proj.mmd, proj.mrp, proj.stm, and others

S-parameter model generation -3D proj.cti, proj.afs, proj.msf, proj.sta, and others

Far Field calculation -FF proj.ant, proj.fff, proj.FFe

You can either invoke each step individually or when specifying the -O 
(capital letter O, not the number zero). option, the engine will run all steps 
from the beginning up to the one specified.
For example:

To run the simulation flow up to and including mesh generation, 
execute:

  adsMomWrapper -O -M proj proj

To run the simulation flow up to and including the S-parameter 
generation, execute:
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4.  

  adsMomWrapper -O -3D proj proj

The S-parameters are written to proj.cti (simulated points), proj.afs 
(interpolated curves) - both are in the citifile format - and statistics to 
proj.sta.

To run the far field generation step only (assumes that the flow up to 
S-parameter model generation has been completed before), execute:

  adsMomWrapper -FF proj proj

Extra command line options:

You can override the simulation mode (RF = quasi-static or MW = full 
wave) by providing an extra command line option:

  adsMomWrapper -O -3D --objMode=RF proj proj

Set to objMode to RF or MW to force respectively a quasi-static or 
fullwave simulation.

By default, the S-parameter model generation writes results in the 
CITI file format. Add following options to additionally generate the 
dataset.

  adsMomWrapper -O -3D --dsName=<datasetName> 
--dsDir=<datasetDirectory> proj proj

Omit the '.ds' extension in the dataset name. If you don't specify the 
dsDir, the dataset file(s) will be written in the current working 
directory.

Generating the dataset(s) after a simulation with existing results can 
also be done using the -CD option

  adsMomWrapper -CD proj proj



401 Electromagnetic

Viewing Simulation Results in 3D

Viewing Simulations Results in 3D

In the 3D Viewer, you can view and analyze the following types of simulation data:

Surface currents

Fields (FEM only)

Far fields and antenna parameters

Starting the 3D Visualization

Before using the visualization feature, you should complete the simulation process. 
After simulating your design, choose  >  >  to open EM Post-Processing Visualization
the Visualization window. You can also open this window by clicking  Visualization

 in the EM toolbar. The following figure displays a Visualization window:

The Visualization window controls the display of the individual mask layers, 
substrates, and port boundaries. In the Visualization window, the left pane contains 
the basic controls for the view in the docking widget.

This section provides information about the following topics:

Visualizing 3D View before EM Simulations
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Visualizing Momentum Simulations

Visualizing FEM Simulations

Computing Radiation Patterns

Visualizing 3D View before EM Simulations

Visualizing 3D View before EM Simulation

Before simulating a design, you can validate your three dimensional design in the 
3D Preview window. The representation seen in the 3D viewer consists of the same 
definition that will be used in the EM simulator. If a view is incorrect in the 3D 
viewer, it is essential to redesign before attempting a simulation. The following 
figure displays a 3D Preview window:

The key benefits of this visual confirmation are:

Correct Substrate Set Up: The substrate information within ADS is defined 
by using the Substrate menu options, which help you to define the height of 
each substrate and assign the corresponding layers. The Previewer window 
enables you to validate that correct height and mappings are specified for 
your design.

Correct Bondwire and Dielectric Brick Placement: Bondwires, which are 
described in the schematic window of ADS, are mapped to the ADS layout 
and incorporated into the overall FEM design for simulation. Dielectric bricks 
are defined as part of the substrate definition. Since these portions of the 
design are difficult to see in layout, you can use the Previewer window to 
validate the location and design of bondwires.

You can create the following types of 3D views:
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Momentum Simulator View: Click the  icon  from the EM 3D EM Preview
toolbar, EM menu, or EM Setup window with Momentum specified as 
simulator type to generate a 3D view that displays the design in 3D as seen 
by Momentum, including any specified pre-processing operations.

FEM Simulator View: Click the  icon  from the EM 3D EM Preview
toolbar, EM menu, or EM Setup window with FEM specified as simulator 
type to generate a 3D view that displays the design in 3D as seen by FEM, 
including any specified pre-processing operations.

If pins are not properly aligned on the bounding box of a design, it causes an 
invalid simulation set up. The 3D View from the Momentum perspective does 
not cause failure, since it does not support Waveguide Ports. On the FEM side, 
the waveguide ports are validated and if they fail validation, no design is 
exported for preview. To avoid this problem, move the pins in your ADS design 
so that they are properly aligned on the bounding box.

Validating Your Geometry Visually

You can validate a geometry by opening the 3D Preview window in a layout. Before 
reviewing your design, you need to start the previewer regularly, as it does not 
synchronize with the current ADS layout.

It is recommended that you do not keep more than one instance of the 
previewer open at a time. It will not interfere with the data, however, it may be 
confusing and cause an unnecessary error.

The previewer window contains a dockable widget that controls the display of the 
individual mask layers, substrates, and port boundaries. Upon startup, a dockable 
widget is docked on the left-hand side of the previewer.

Navigating in the 3D Environment

You can perform the following tasks in the 3D Preview window:

Rotating the view: You can rotate a design around its current origin by 
holding down the main mouse button and moving it around the screen. Click 

 (  ) on the toolbar or choose  >  to rotate a view.Orbit Window Orbit

Modifying the zoom settings: You can increase or decrease the zoom 
settings on a design by moving the mouse up or down on the image 

respectively. Click  (  ) on the toolbar or select  >  to Zoom Window Zoom
modify zoom settings.

Moving the design: You can move the design around on the screen by 
holding down the main mouse button and moving it around the screen. Click 

 (  ) on the toolbar or select  >  to move a design.Pan Window Pan
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Opening the standard view: You can change the view of a design to the 

standard view settings. Click  (  ) on the toolbar or Zoom to Extents
select  >  to open the standard view for your design.Window Zoom to Extents

Modifying the zoom settings of a specific area: You can zoom to a specific 
area of your design by placing a box around the desired view. Click Zoom to 

 (  ) from the toolbar or select  >  to Window Window Zoom to Window
change the zoom settings.

Changing Views: You can open your design in various types of standard 

views by clicking  (  ),  (  ),  (  ),  (  ), Front Back Top Bottom

 (  ),  (  ), and  (  ). You can also Left-side Right-side Isometric
access these views from the  menu.View

Querying the design: You can click an object edge or vertex to display the 
location and object name in the status bar, which is located in the lower 
right hand section of the window. In addition, the object is highlighted and 
the object is automatically selected in the Object and Material tabs in the 
Docking widget. Visually, a solid dot is placed if the selected location is on a 
vertex and a hollow dot is placed if the selected location is on an edge. Click 

 (  ) or select  >  to run a query.Query Tools Query

Specifying Material and Object Settings

In the 3D Preview window, you can control the material and object settings by 
using the  window. Click  to separate the Properties window from the Properties
3D Preview window. To include the Properties dialog box, double-click the 
Properties title bar. The following figure displays the Properties window:
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In the Properties window, you can:

Select the required material and object.

Control the visibility and shading settings for all the materials and objects.

Modify the color settings for a material or object.

Restore the color settings for a material or object.

Control the transparency settings.

The following sections provide information about how to select and highlight 
materials and objects.

Selecting Materials and Objects

You can select and highlight individual objects by using one of the following 
methods:

Selection on the screen: Objects can be selected graphically using the 
mouse. If the previewer is in Query mode, an object can be selected by 
clicking on any line or vertex of the object. Once selected, the object lines 
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are highlighted. The object is also selected in the material and object list 
and the coordinates of the selection point are displayed in the lower right 
area of the status bar.

Selection from the material or object list: Objects can be selected from 
either the material or object list box. Once selected, the object lines are 
highlighted.

Controlling the Visibility and Shading of Selected Objects and Materials

After selecting an object or material, you can control the visibility and shading by 
using the  and  tab, respectively. You can select the  and Materials Objects Visibility

 fields associated with a material and object to control the visibility and Shading
shading, as shown in the following figure:

It is also possible to control the visibility and shading for the substrate and mask 
layers. Within the Materials portion, each material and object has separate toggles 
for visibility and shading. By setting these controls appropriately, you can control 
the visibility and shading for all the objects that share this substrate or mask.

Controlling the Visibility and Shading of All Objects and Materials

You can control the visibility and shading of all the objects and materials by using 
the All and None buttons, as shown below:

In the Visible area:

Click  to apply visibility to all the objects and materials.All

Click  to apply visibility to all the conductors.Conductors

Click  to make all the objects and materials invisible.None

In the Shaded area:

Click  to apply shading to all the objects and materials.All

Click  to shade all the conductors and remove shading from all Conductors
the non conductors.
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Click  to remove shading from all the objects and materials.None

To set the transparency level for objects and materials, specify the transparency 
level on the range of 0 to 100 percentage.

Selecting Color

You can select, change colors, and highlight specific areas in your design. For 
example, to highlight the free space:

Click the check boxes associated with "Free_Space" from the 3D object tree.

Click  to open the  dialog box.Color Select Color
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Select a color and click .OK

You can revert the original color by clicking .Restore

Customizing the Simulation View

Measuring distances: You can measure the distance between a reference 
 and the current . The query point is updated after every point query point

mouse selection using the query command. The reference point remains 
fixed until it is explicitly updated using the . Move Current Point to Reference
Select  >  to open the  dialog box:Tools Measure Measure

Z-Scaling: You can change the geometry dimension of a model in the z-
direction using a sliding scale between 1 and 10. If you
move the dimension value of the slide bar up, the model is expanded in the 
z-direction. Select  >  to open the  dialog box.Tools Z Scale z-scale
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Cutting Plane: This feature enables you to slice through your design in the 
YZ, XZ, and XY planes. The check boxes associated with each slide bar 
activate the cut. It allows you to flip the cut and to show the plane as it 
moves through the design. Selecting  >  opens the  Tools Cut Plane Cut Plane
window, as shown below:

Viewing 3D Connectivity: 3D Connectivity can be viewed by using the  
button on the tool bar. When this button is pressed, the viewer does an 
initial processing of the project connectivity. A progress bar is displayed 



Electromagnetic 410

during this process. It is only done once per invocation of the viewer. After 
the initial processing, you can view the connectivity by clicking on the 
object. The selected object is highlighted. If the object is a conductor, it is 
shaded and all the connected conductors are shaded as well.

Viewing Object Statistics: You can view detailed information about the 2D 
and 3D object parameters such as substrate layer, mask, and top statistics.

Setting Up the Viewer on External X Window Displays

On Unix/Linux Systems, it is common practice to use a local machine as a display 
and do the actual processing on another machine. The display from the original 
machine is typically mapped back to the local display using the following 
command:

export DISPLAY=machine:0.0

In the 3D Previewer window, you need to set an additional environment variable, 
. This environment variable is set to the same value as the display HOOPS_PICTURE

variable with the addition of X11/ prior to the machine name. Using the above 
example, the  variable is set to the following values:HOOPS_PICTURE

export HOOPS_PICTURE=X11/machine:0.0

Visualizing Momentum Simulations

Visualizing Momentum Simulations

You can view and analyze the following type of data for Momentum simulations:

Surface Currents

Far fields and antenna parameters
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Starting Momentum Visualization

You must complete the simulation process to view data for a Momentum design. If 
you have already simulated a design, you can start the Visualization feature directly 
to view the existing data. Select  >  >  to open the EM Post-Processing Visualization

 window. You can also open this window by Keysight Momentum Visualization

clicking  (  ) in the EM toolbar.Visualization

To visualize Momentum simulations:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  or  in the EM Setup window.Momentum RF Momentum Microwave

Specify the required settings in the EM Setup window for a layout, substrate, 
port, frequency plan, output plan, options, resources and model or symbol.

Click  in the EM Setup window to simulate your design.Simulate

Select  >  >  to open the EM Post-Processing Visualization Keysight 
 window, as shown in the following figure:Momentum Visualization

The Keysight Momentum Visualization window appears similar to the EM Previewer 
window. The initial window layout is similar to that of EM Previewer. The left side 
contains the basic controls for the view in the docking widget. However, the 
Keysight Momentum Visualization window includes the following modifications:

Object shading is removed.

A shaded surface current plot is displayed.

In addition to the Properties tab, Solution Setup and Plot Properties tabs are 
added for controlling the view.
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In the Keysight Momentum Visualization window, the Properties tab provides the 
same functionality as the EM Previewer properties tab. However, in the Keysight 
Momentum Visualization window, you can also display mesh by selecting the Mesh 

 check box in the Properties tab, as shown in the following figure:Visible

For more information about the Properties tab, refer to Visualizing 3D View 
.before EM Simulations

You can plot results by using the  and  tabs. The Plot Properties Solution Setup
Solution Setup tab controls the excitations for the visualization, while the Plot 
Properties tab controls the visual display of the excitation.

Controlling Visualization Excitations

The Solution Setup tab is used to select the current excitation for the plots. All the 
plots automatically reflect the current solution configuration once it is selected. By 
selecting either a port or frequency, the excitation is changed and the plots are 
automatically updated.

Select the  tab present at the bottom of the window. In this tab:Solution Setup

Define the excitation (source voltage and series impedance) to be applied at 
each port.

Excitation 
Type

Details

Single Port 
Excitation

1 Volt source and 50 Ohm series impedance at the selected port, 50 Ohm 
terminations at all other ports

User 
Defined 
Excitation

User-defined source voltage (amplitude in Volt and phase in deg) and series 
impedance (real and imaginary part in Ohm) for each port

Extracted 
Excitation

Frequency dependent excitation computed by circuit simulator during EM
/Circuit co-simulation

Select the frequency for which you want to see results.

After the excitation and frequency selection is done, the plots are automatically 
updated for the new configuration.
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Plotting Properties

The Plot Properties tab enables you to control three basic plots, as well as, the 
animation settings. This tab is used to set up plots within the visualization tool. The 
visualization tool plots J, which is the current calculated within the Momentum 
solvers. Volume current is in A/m2, surface current (which is what Momentum 
computes) is in A/m. The following figure displays the plot properties tab:

Using the Plot Properties tab, you can create the following types of plots:

Shaded Plot

Arrow Plot

Contour Plot

Displaying a Shaded Plot

Displaying the shaded current plot is controlled by using the check box next to the 
plot name. When it is selected, the plot is visible. Within the plot there are some 
basic controls:

Log Scale - This controls whether the scaling and color representation uses 
a logarithmic scale or a linear one.

Transparency - This controls the transparency of the shaded plot.
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Displaying an Arrow Plot

After selecting the  tab, select  to display the arrow plot. You can Arrow Enable
control the following properties of an arrow plot:

Scaling arrows: You can select the  check box to control whether the Scale
arrows are scaled, based on the relative magnitude of the current density 
through out the design. When it is selected, the arrows will be scaled, 
making the lower current density areas have smaller arrows. If it is not 
selected, all the arrows are displayed with the same size. However, their size 
can still be changed by changing the arrow size.

Using a logarithmic scale: You can select the  check box to control Log Scale
whether the scaling and color representation use a logarithmic scale or a 
linear one. If scaling is not enabled, only the color weighting is affected.

Specifying arrow size: You can specify the relative size of the arrow in Arrow 
. Remember that if the arrows are not scaled, the default size of the Size

arrows appear to be larger than when the arrows are scaled.

Displaying a Contour Plot

After selecting the  tab, select  to display the contour plot. You can Contour Enable
control the following properties of a contour plot:

Using a logarithmic scale: You can select the  check box to control Log Scale
whether the scaling and color representation use a logarithmic scale or a 
linear one. If scaling is not enabled, only the color weighting is affected.

Specifying the number of divisions: You can specify the number of divisions 
in the  combo box.Divisions

Plotting Momentum Mesh

When a solution has been loaded, the momentum mesh can be displayed by 
checking the Mesh Visible box on the Properties Tab. The displayed mesh is the one 
which is used to display the field. This will most likely be more detailed than the 
one seen in the Layout View, which is the reduced mesh that is used in the 
Momentum solution computation.



415 Electromagnetic

1.  

2.  

3.  

Visualizing FEM Simulations

Visualizing FEM Simulations

You can view and analyze the following type of data for FEM simulations:

E Fields

Far-fields

Antenna parameters

Transmission line data

Starting FEM Visualization

You must complete the simulation process to view data for your FEM design. If you 
have already simulated a design, start the Visualization feature directly to view the 
existing data. Select  >  >  to open the EM Post-Processing Visualization Keysight 

 window. You can also open this window by clicking  ( FEM Visualization Visualization

 ) in the EM toolbar.

To visualize FEM simulations:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the EM Setup window.FEM
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Specify the required settings in the EM Setup window for a layout, substrate, 
port, frequency plan, output plan, options, resources and model or symbol.

Click  in the EM Setup window to simulate your design.Simulate

Select  >  > .EM Post-Processing Visualization

The Keysight FEM Visualization window appears similar to the EM Previewer 
window. The initial window layout is similar to that of an EM Previewer. The left side 
contains the basic controls for the view in the docking widget. However, the 
Keysight FEM Visualization window includes the following modifications:

EM Port surfaces are no longer displayed.

Object shading is removed.

A shaded current plot for Port 1 at the lowest frequency is displayed.

In addition to the Properties tab, Solution Setup and Plot Properties tabs are 
added for controlling the view.

The Properties tab provides the same functionality as the Previewer properties tab. 
However, in the  window, you can specify the type of Keysight FEM Visualization
mesh:  or , as shown in the following figure:Surface Volume Mesh
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For more information about the Properties tab, refer Visualizing 3D View before 
.EM Simulations

You can display the field quantities by using the Plot Properties and Solution Setup 
tabs. The Solution Setup tab controls the excitations for the visualization, while the 
Plot Properties tab controls the visual display of the excitation.

Controlling Visualization Excitations

The Solution Setup tab is used to select the current excitation for the plots. All the 
plots automatically reflect the current solution configuration once it is selected. By 
selecting either a port or frequency, the excitation is changed and the plots are 
automatically updated.

In the  window, select the  tab present at Keysight FEM Visualization Solution Setup
the bottom of the window. In this tab:

Define the port excitation value from the drop-down list in the  Port Setup
region. You can either select  for ports to be excited individually Single Port
or  excitation.User Defined

View the frequency changes in the  region. After the port or Frequency
frequency selection is changed, the plots are automatically updated using 
the new configuration.

The following figure displays a Solution Setup tab:
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Setting up Plots

In the Visualization window, click the Plot Properties tab to select fields, field 
sensors, basic plots, and animation settings. The following figure displays the Plot 
Properties tab:
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Selecting Field Types

You can select the required field quantity  to plot as well as the Vector ( E, H, or J)
component. All the field quantities are represented as steady state sinusoidal 
waves, so the field plots will be done at a specified phase. If you want to include the 
total field magnitude, select the  check box.Plot Magnitude
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Displaying Maximum Field Locations

You can view maximum field locations by clicking the Displaying Maximum Field 
 button in . This opens the Maximum E Field Locations Locations Plot Properties

window. This window provides information about the E field locations and their 
values. If you select a particular frequency, it is highlighted in the Advanced 
Visualization window. The following figure displays the Maximum Field Locations 
window:

The following figure displays the highlighted frequency in the Advanced 
Visualization window:
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Enabling Field Sensors

All the plots are displayed on surfaces. By default, surfaces that are connected to 
Ports are automatically created and listed in the Sensor Frame.

The Field Sensors region consists of two columns,  and . The Show Show Enable
check box allows you to display the triangular regions where the field quantities are 
plotted. The Enable check box allows you to plot the field quantities on that Sensor. 
The fields that are plotted are determined by the field plotting choices, Shaded, 
Arrow or Contour.

You can add new sensors by clicking the  button. There are three different Add
options for adding new sensors:
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Object Plane: You can select a shaded object by clicking on a face. If no 
object is currently shaded, you should first select an object edge to shade 
the surface. When an object plane is selected, a plane is defined through the 
entire design region. In this case, the plane will extend beyond the object 
definition.

Three Point Plane: You can select three points that determine plane.
add_plane2.gif

Object Surface: You can select a shaded object by clicking on a face. If no 
object is currently shaded, you must first select an object edge to shade the 
surface. Only the surface of the object is used. Unlike the object plane 
mode, the surface does not have to be planar. A second option also allows 
you to select all shaded objects.
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Using the Edit button, you can rename a plane or move it within the design area. 
Object Surfaces cannot be moved since they are assigned to a specific object and 
not a location. You cannot rename or delete predefined planes.

Plotting Properties

Using the Plot Properties tab, you can create the following types of plots:

Shaded Plot

Arrow Plot

Contour Plot

Volume plot



Electromagnetic 424

Displaying a Shaded Plot

The shaded plot allows you to plot the magnitude of the field quantity on the 
sensor surface, as shown in the following figure:

Displaying the shaded current plot is controlled by using the check box next to the 
plot name. When it is selected, the plot is visible. Within the plot there are some 
basic controls:

Log Scale: This controls whether the scaling and color representation uses a 
logarithmic scale or a linear one.

Transparency: This controls the transparency of the shaded plot.

Displaying an Arrow Plot

The arrow plot allows you to plot the quantity on the sensor surface, as shown in 
the following figure:



425 Electromagnetic

After selecting the  tab, select  to display the arrow plot. You can Arrow Enable
control the following properties of an arrow plot:

Scaling arrows: You can select the  check box to control whether the Scale
arrows are scaled, based on the relative magnitude of the current density 
through out the design. When it is selected, the arrows will be scaled, 
making the lower current density areas have smaller arrows. If it is not 
selected, all the arrows are displayed with the same size. However, their size 
can still be changed by changing the arrow size.

Using a logarithmic scale: You can select the  check box to control Log Scale
whether the scaling and color representation use a logarithmic scale or a 
linear one. If scaling is not enabled, only the color weighting is affected.

Specifying arrow size: You can specify the relative size of the arrow in Arrow 
. Remember that if the arrows are not scaled, the default size of the Size

arrows appear to be larger than when the arrows are scaled.

Displaying a Contour Plot

The contour plot allows you to plot the magnitude of the field quantity on the 
sensor surface, as shown in the following figure:
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After selecting the  tab, select  to display the contour plot. You can Contour Enable
control the following properties of a contour plot:

Using a logarithmic scale: You can select the  check box to control Log Scale
whether the scaling and color representation use a logarithmic scale or a 
linear one. If scaling is not enabled, only the color weighting is affected.

Specifying the number of divisions: You can specify the number of divisions 
in the  combo box.Divisions

Displaying a Volume Plot

The volume plot enables you to scale and specify arrow size, as shown in the 
following figure:
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Specifying Plot Options

You can modify the plots by using the options menu. The options menu displays the 
color key for the plot and can also be used to change the Minimum and Maximum 
values that are being plotted. The color used for the plot can also be specified from 
the Options dialog box.
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System Min and System Max: The system minimum and maximum values represent 
the minimum values for all the plots that are currently being drawn. However, in 
order to keep scale consistently, the maximum and minimum values are not 
changed when the Solution Setup is modified. The maximum and minimum values 
are displayed as System Max and System Min. If you want to use these values 
instead, click the Restore Max and Min button.

Similarly, you can modify the maximum and minimum values that are used for 
displaying the data by typing in new values. These will not be changed as the 
Solution Setup is modified.

X and Y Arrow Density control the density of arrows within a sensor. They have no 
effect on Object Surface Sensors.
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Plotting Boundary Conditions

Use the Boundary Conditions tab in the plotting regions to plot the boundary 
surfaces. By selecting the Boundaries Visible box, you can pick the boundary 
surfaces that are visible on the screen. The unassigned surfaces are those which 
are on the surface of objects, but do not have any boundary conditions assigned to 
them.

Plotting 3D Mesh

When a solution is loaded, a third column, Mesh, becomes available in the 
Properties tab. By selecting the Mesh column check box, the mesh inside the 
material or individual object can now be seen. In some cases, there may not be any 
mesh inside the object if the object was not assigned any tetrahedral. Flat objects, 
by definition, do not have any tetrahedral assigned to them.

Shaded Mesh

The surface mesh of the objects can be drawn by selecting the Surface Check box 
in the Mesh box at the bottom of the Properties Tab. Once selected, the volume 
mesh can also be selected.

Animating FEM Fields

You can animate the FEM fields by selecting the  box at the bottom of the Animate
Plot Properties Tab. If the Plot Magnitude button is selected, the animation option 
is not available. X and Y Arrow Density control the density of arrows within a 
sensor. They have no effect on Object Surface Sensors. You can also change the 
phase by sliding the Phase Bar, as shown in the following figure:
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You can control the following animation options of arrow, shaded, and contour 
plots:

Determine the display update time: Specify a value in the  Display Update
text box to determine the minimal time required between display updates in 
milliseconds. Since some updates may take longer than this setting, this 
value is only a minimum number and not an absolute one.

Determine the Phase Increment value: Specify a value in the Phase 
Increment text box to control the number of degrees added to the current 
phase when an update occurs.

Exporting Field Data

You can export E or H fields data by using the Advanced Visualization window. In 
addition to exporting the field data per tetrahedra, you can export the data per 
uniform grid.

To export field data:

Select  > . The Export Field Data dialog box is displayed, File Export Field Data
as shown in the following window:

Select one of the data sampling options  or . If Tetrahedra Uniform 3D Grid
you select Uniform 3D Grid, type the number of divisions required per grid.

Select the type of field you are exporting  or .E H

Select a file format option  or .xml txt

Type a file name in the  text box.File

Click  to save the file at the required location.Browse

Select the required location and click .Save

Click .Export
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The export file contains a list of tetrahedra each with 4 point values and 10 field 
values, as shown in the following sample file:

T_1
P_1="4.167964e+000 -1.415037e+000 2.636480e+001"   
P_2="6.683468e+000 3.139348e-001 2.959784e+001"   
P_3="4.260608e+000 3.055021e-001 2.803953e+001"   
P_4="6.421932e+000 2.846765e-001 2.614055e+001"   
N_1="2.379960e+007 2.757609e+007 -7.738133e+006 
-8.965870e+006 -4.548292e+005 -5.237584e+005"   
N_2="2.070606e+007 2.399198e+007 -3.023256e+006 
-3.502968e+006 -3.397782e+005 -3.917465e+005"   
N_3="2.430381e+007 2.816046e+007 -3.119658e+006 
-3.614634e+006 -2.683231e+005 -3.074952e+005"   
N_4="1.989725e+007 2.305460e+007 -3.246496e+006 
-3.761620e+006 -3.040257e+005 -3.501238e+005"   
N_5="1.745019e+007 2.021953e+007 1.869907e+006 2.166790
e+006 -1.937719e+005 -2.238154e+005"   
N_6="2.117090e+007 2.453070e+007 1.722775e+006 1.996282
e+006 -2.439926e+005 -2.807636e+005"   
N_7="1.672967e+007 1.938458e+007 1.558138e+006 1.805409
e+006 -1.685716e+005 -1.944367e+005"   
N_8="2.481198e+007 2.874945e+007 1.584858e+006 1.836456
e+006 -1.704304e+005 -1.940710e+005"   
N_9="2.035784e+007 2.358837e+007 1.409211e+006 1.632806
e+006 -2.056144e+005 -2.360936e+005"   
N_10="1.599067e+007 1.852821e+007 1.252236e+006 1.450838
e+006 -1.420236e+005 -1.634942e+005"   

In the export file, the point values (P_1 to P_4) represents the X, Y, Z coordinates of 
the four vertices of each tetrahedron. The ten field values (N_1 to N_10) represents 
the field strengths at each of the four vertices and the midpoints of the six edges of 
each tetrahedron. Each value contains the real and imaginary parts of the x, y and z 
field components.

Computing Radiation Patterns

Computing Radiation Patterns

This section describes how to calculate the radiation fields. It also provides general 
information about the antenna characteristics that can be derived based on the 
radiation fields.

In the Momentum RF mode, radiation patterns, and antenna characteristics are 
not available.
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About Radiation Patterns

After calculating currents on the circuit, you can compute the electromagnetic 
fields. They can be expressed in the spherical coordinate system attached to your 
circuit. The electric and magnetic fields contain terms that vary as 1/r, and 1/r . It 2

can be shown that the terms that vary as 1/r , and 1/r  are associated with the 2 3

energy storage around the circuit. They are called the reactive field or near-field 
components. The terms having a 1/r dependence become dominant at large 
distances and represent the power radiated by the circuit. These terms are called 
far field components (E , H ).ff ff

The  vector relates to the  vector as shown above. Z  is the free space wave H E w

impedance.

In a layout, there is a fixed coordinate system such that the monitor screen lies in 
the XY-plane. The X-axis is horizontal, the Y-axis is vertical, and the Z-axis is 
normal to the screen. The origin or phase center of this XYZ coordinate system for 
the far field computation is at the center of the bounding box around the layout.

For Momentum,

The far field is computed separately for the upper and lower open 
half space. The Z-coordinate of the phase center is the Z-
coordinate where the upper or lower half space starts.

There is a configuration variable, 
MOM3D_USE_GRAVITYCENTERTRANSFORMATIONFARFIELDS = 
FALSE, to keep the XY of the phase center at the origin of the 
layout (0,0).  provides Defining Expert Options for Momentum
information on how to specify this variable.



433 Electromagnetic

1.  

2.  

3.  

In the direction parallel to the substrate (theta = 90 degrees), parallel plate 
modes or surface wave modes, that vary as 1/sqrt(r), are also present. 
Although the modes dominate in this direction, they are not considered to be 
part of the far-fields.

The radiated power is a function of the angular position and the radial distance 
from the circuit. The variation of power density with angular position is determined 
by the type and design of the circuit. It can be graphically represented as a 
radiation pattern.

The far-fields can only be computed at those frequencies that were calculated 
during a simulation. The far-fields will be computed for a specific frequency and for 
a specific excitation state. They will be computed in all directions (theta, phi) in the 
open half space above and/or below the circuit. Besides the far-fields, derived 
radiation pattern quantities such as gain and axial ratio are computed.

It is possible to calculate far-fields for some designs that have a top or bottom 
layer that is not defined as open space.

To get the E-field strength at a specific (x,y,z) location in the far field zone, do 
following steps:

Compute r, θ and φ from x, y, and z

Get the  for the θ and φEff

E(x,y,z) = (θ, φ) * e^{-j k r} / rEff

About Antenna Characteristics

Based on the far fields, you can derive antenna characteristics such as gain, 
radiated power, polarization and other .

Electric Field and Radiation Intensity
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The radiation intensity in a certain direction, in watts per steradian, is given by:

For a certain direction, the radiation intensity will be maximal and equals:

The corresponding maximum electric field intensity is given by:

Radiated and Input Power

The total power radiated by the antenna, in Watts, is calculated from the free space 
far-field E and H components (E , H ) integrating the radiation intensity over the ff ff
open half space(s):

The power going into the surface wave is not taken into account in this 
calculation.

The input power, in Watts, is the net power (incident - reflected) delivered to the 
antenna.

Effective Angle

This parameter is the solid angle through which all power emanating from the 
antenna would flow if the maximum radiation intensity is constant for all angles 
over the beam area. It is measured in steradians and is represented by:

Directivity

Directivity calculates the radiation intensity in a certain direction versus the 
radiated power. Directivity is dimensionless and calculated by using the following 
equation:
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Directivity indicates the best you could get out of the antenna. In reality, there will 
be loss mechanisms in the antenna (see Gain) and the feed network is never 
perfectly matched. The maximum directivity is given by:

Gain

Gain is the ratio of the radiation intensity in a certain direction versus the intensity 
of a uniform radiation of the input power. The gain of the antenna is calculated as:

where P  is the real power, in watts, delivered into the circuit. The input power equals input

to the (incident - reflected) power at the port(s). Consequently, the impact of mismatch is 

not included in this definition of Gain. For a good antenna, a large part of the injected 

power is radiated, the rest will be lost. The loss is due to the presence of lossy materials 

(either the conductors or the dielectrics used) or gets trapped into the surface wave that 

propagates cylindrically along the substrate plane.

The injected power is calculated from the S-parameters and the excitation sources 
(Thevenin sources) at the ports as specified by the user. In case of a 1-port 
antenna, the excitation source specified by the user doesn't really matter since 
both Directivity and Gain are normalized values. For a multi-port antenna, the exact 
source excitation setup at each port is really important. That is where the far field 
excitation utility available from the knowledge center (search for Far Field 
Computations from AC/HB Analysis of Antennas Plus Circuitry) is very relevant.

The maximum gain is given by:

Efficiency

The efficiency is given by:

Effective Area

The effective area, in square meters, of the antenna circuit is given by:
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Polarization

The polarization of the far field describes the orientation of its vectors (usually the 
electric field component) at a given point and how it varies with time. For antennas, 
we are concerned with the polarization of the field in the plane orthogonal to the 
direction of propagation. This is the plane defined by the vectors of the far field (Eff
).

The polarization is the locus traced by the extremity of the time-varying field vector 
at a fixed observation point.

According to the shape of the trace, three types of polarization exist: linear, circular 
and elliptical. Any polarization can be represented by two orthogonal linear 
polarizations, (E , E ), whose fields are out of phase by an angle of δ .θ φ L

If δ  = 0 or nπ, then linear polarization results.L

If δ  = π/2 and |E | = |E |, then circular polarization results.L θ φ

In the most general case, elliptical polarization is defined.
Mathematically, the linear and circular polarizations are special cases of the 
elliptical polarization. In practice, the term elliptical polarization is used to 
indicate polarizations other than linear or circular.

Polarization in terms of two orthogonal linearly polarized components

The far field phasor vector can be decomposed into two orthogonal components, Eθ
and E . Both are in general complex phasors.φ

Those fields are out of phase by an angle of δ , defined asL

The field vector at a given point traces an ellipse as a function of time.
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An alternative decomposition into two orthogonal components has the field phasor 
vectors aligned with the major and minor axis of the ellipse, E  and E . Those co cross
can be derived as follows

Where  is the tilt angle of the polarization ellipse.

Polarization in terms of two circularly polarized components

Similarly, the field can be decomposed in terms of two circularly polarized 
components, one right-handed and the other left-handed. Although this 
decomposition is less easy to perceive, it is very useful in the calculation of the 
polarization ellipse parameters. The total field phasor is represented by

Again, these are in general complex phasors. The relative phase difference between 
the two, δ , is defined asC

The relation between the linear-component and the circular-component 
representations are give by
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Polarization vector, polarization ratio and axial ratio

The polarization vector is the normalized phasor of the electric field vector. It is a 
complex-valued vector of unit magnitude.

The linear polarization ratio is the ratio of the phasors of the two orthogonal 
polarization components. In general, it is a complex number.

In the case of the circular-component representation, the polarization ratio is 
defined as:

The axial ratio of the polarization ellipse can be computed from the circular 
polarization ratio.

The tilt angle of the polarization ellipse is simply

Antenna polarization

The polarization of a transmitting antenna is the polarization of its radiated wave in 
the far field zone. The polarization of a receiving antenna is the polarization of a 
plane wave, incident from a given direction, which, for a given power flux density, 
results in the maximum available power at the antenna terminals. The antenna 
polarization is defined by the polarization vector of the radiated (transmitted) wave. 
The polarization vector of a wave in the coordinate system of the transmitting 
antenna is represented by its complex conjugate in the coordinate system of the 
receiving antenna:
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The conjugation is relevant in case of circularly or elliptically polarized waves. The 

transmitting-mode polarization of an antenna is the conjugate of its receiving-mode 

polarization vector.

Polarization loss factor and polarization efficiency

In general, the polarization of the receiving antenna is not the same as the 
polarization of the incident wave. This is called polarization mismatch. The 
polarization loss factor, PLF, characterizes the loss of power because of polarization 
mismatch:

In the above, the two polarization vectors are respectively for the incident field and the 

antenna.

The PLF, also called polarization efficiency, is a value between 0 and 1. If the 
antenna is polarization matched, then PLF=1, and there is no polarization power 
loss. If PLF=0, then the antenna is incapable of receiving the signal. The PLF for an 
antenna of RH circular polarization (in transmitting mode) that receives a RH 
circularly polarized incident wave is 1. Simularly, the PLF = 0 for receiving a LH 
circularly polarized incident wave.

Calculating Far Fields

To calculate far fields, choose  >  > .EM Post-Processing Far Field

In case of an FEM simulation, far fields will be computed before opening the 3D 
Viewer. In case of a Momentum simulation, far fields will be compute when 
required by the 3D Viewer.

Viewing Far Fields

Two windows are displayed, a Geometry window and a Far Field window. The Far 
Field Window and associated properties tab is only shown if radiation results are 
available. The radiation results are for the port excitation and frequency as 
specified on the Solution Setup tab.
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Select the  type:Plot

E = sqrt(mag(E Theta)2 + mag(E Phi)2)

E Theta

E Phi

E Left

E Right

E Co

E Cross

Axial Ratio

If you want the data normalized to a value of one, enable . For Axial Ratio Normalize
choices, set the . By default, a logarithmic scale is used to display the Minimum dB
plot. If you want to use a linear scale, disable . Set the minimum Log scale
magnitude that you want to display, in dB.

Click  to view input power, radiated power and maximum Antenna Parameters
directivity, gain, radiation intensity, E-field, and angles in the direction of maximum 
radiation.
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In the Visualization window, click the  tab to view the far field in a 2D Far Field Cut
data display. Select the  flag and select to make a Theta or Phi cut. For a Phi Enable
cut, the angle phi is kept constant. The angle theta, which is relative to the z-axis, 
is swept. This produces a vertical cut that is perpendicular to the XY layout plane.
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To view the cut data in a Data Display window, click *Display Cut in Data Display.

Exporting Far Field Data

Dataset file with Antenna Characteristics

The Antenna Parameters data display file contains following variables versus 
frequency:

Variable Description

freq Frequency in Hz

Gain, Directivity Gain and Directivity values in dBi

Efficiency Antenna efficiency in percent (%)

RadiatedPower Radiated power in Watts

MaximumIntensity Maximum radiation intensity in Watss/steradian
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Variable Description

E_phi, E_theta, E_x, E_y, 
E_z

Electric far field components in Volts in the direction of maximum radiation 
intensity

EffectiveAngle Effective radiation angle in steradian

Dataset file with 2D Cut Far Field Data

Specific information about the data available in the far-field dataset is given in this 
section.

Variable Description

Frequency, InputPower, 
RadiatedPower, 
Efficiency

Quanties at the given frequency

E_max, Theta_max, 
Phi_max, Gain_max, 
Directivity_max

Quantities in the direction of maximum radiation.

Theta or Phi, CutType, 
CutAngle

The swept parameter of a cut. When the CutType is "Phi", Theta will be available. 
When the CutType is "Theta", the Phi variable will exist. The CutAngle is the angle of 
the cut.

Gain, Directivity, 
RadiationIntensity, 
EffectiveArea

Gain (dBi), Directivity (dBi), Radiation intensity (in watts/steradian), Effective area 

(in m ).2

Etheta and Ephi Absolute field strength (in volts) of the theta and phi electric far-field components.

TiltAngle Tilt angle of the polarization ellips

Htheta and Hphi Absolute field strength (in amperes) of the theta and phi magnetic far-field 
components.

Eco and Ecross Absolute field strength of co and cross polarized electric far-field components.

Elhp and Erhp Absolute field strength of respectively left-hand and right-hand circular polarized 
electric far-field component.

AxialRatio Axial ratio, derived from left-hand and right-hand circular polarized far-field 
components.
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Variables in the Standard and AFS Dataset

Variable Description

freq The independent variable frequency, which was specified during the simulation setup. The number 
of data points is based on the sweep type and frequency plans specified during simulation.

GAMMA 
n

The (modal) propagation constant of Port . It is used in de-embedding, and is calculated for n
single, differential, and coplanar ports only.

PORTZ n The impedance of Port n as defined in the Impedance fields of the Port Editor dialog box. If an 
impedance is not specified, 50Ω is assumed.

S S matrix, normalized to PORTZ .n

S( , )i j S-parameters for each pairing of ports in the circuit, normalized to PORTZ .n

S_50 S-matrix, normalized to 50 ohms.

S_50( , i j
)

S-parameters for each pairing of ports in the circuit, normalized to 50 ohms.

S_Z0 S matrix, normalized to Z0.

S_Z0( , i j
)

S-parameters for each pairing of ports in the circuit, normalized to Z0 of each port.

Z0 n Reports the characteristic impedance of the transmission line connected to Port . This is not n
calculated for internal or coupled ports, in these cases 50 ohms is substituted.

Z0 values are not computed for Single Ports, if more than 2 ports are used in 
the same reference plane. In this case, the Z0 values are set to 50 ohms. To 
obtain a scalar Z0 for each port, they must be put on different reference planes.

ASCII file with 3D Far Field Data

The 3D far field data can be written in an ASCII formatted file.

In case of an FEM simulation, launch the far field computation from the EM 
Setup window (Tools > Far Field). Search for the  file under design.fff
<workspace>/<library>/<cell>/<layout>/<emSetup>_FEM/proj.ep/...
/level<i>/...

In case of a Momentum simulation, create a  file in the <workspace>proj.vpl
/<library>/<cell>/<layout>/<emSetup>_MoM directory and run MomEngine 
from command line (see ) to generate the  file.here proj.fff
The format for the Momentum  file is:proj.vpl
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VISUALIZATIONTYPE 1; # 3D output
PARAMETER FREQUENCY, UNITS GHz,
PT <f1> [, PT <f2>]...;
PARAMETER PHI, UNITS DEG, PT 0; # Needed, but not 
used for 3D output 
VAR THETA, UNITS DEG, PT 0; # Needed, but not used 
for 3D output
PORT <portNr1>,
UNITS VOLT, UNITS DEG, AMPLITUDE <V1_ampl> PHASE 
<V1_phase>,
UNITS OHM, UNITS RAD, AMPLITUDE <Z1_ampl> PHASE 
<Z1_phase> 
[,PORT <portNr2>, 
UNITS VOLT, UNITS DEG, AMPLITUDE <V2_ampl> PHASE 
<V2_phase>, 
UNITS OHM, UNITS RAD, AMPLITUDE <Z2_ampl> PHASE 
<Z2_phase>]...;

The data is saved in the following format:

#Frequency <f> GHz           // loop over frequencies
#Excitation # <i>            // loop over excitation 
states
#----------------
#Begin cut                   // loop over phi
<theta_0> <phi_0> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>  // loop over <theta> for <phi_0>
<theta_1> <phi_0> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>
:
<theta_n> <phi_0> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>
#End cut
 
#Begin cut
<theta_0> <phi_1> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>  // loop over <theta> for <phi_1>
<theta_1> <phi_1> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>
:
<theta_n> <phi_1> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>
#End cut
:
:
#Begin cut
<theta_0> <phi_n> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>  // loop over <theta> for <phi_n>
<theta_1> <phi_n> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>
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:
<theta_n> <phi_n> <real(E_theta)> <imag(E_theta)> <real
(E_phi)> <imag(E_phi)>
#End cut

In the proj.fff file, E_theta and E_phi represent the theta and phi normalized 
components, respectively, of the far-field values of the electric field. Note that the 
fields are described in the spherical co-ordinate system (r, theta, phi) and are 
normalized. The normalization constant for the fields is E_max

with E_theta_max and E_phi_max respectively the E_theta and E_phi in the 
direction of maximum radiation intensity.

See Also
Example Printed Dipole Antenna

http://edadocs.software.keysight.com/display/ads2017/Printed+Dipole+Antenna
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EM Circuit Cosimulation

EM Circuit Cosimulation

Contents

EM Circuit Cosimulation Overview

Using the EM Cosimulation View

EM Cosimulation View

EM Cosimulation Controller Component

Performing an EM Circuit Cosimulation with an EM Cosimulation View

Using the EM Cosimulation View Tutorial

Using the EM Model View

Creating and Using an EM Model View

Performing an EM Circuit Cosimulation with an EM Model View

Using the EM Circuit Excitation AEL Addon

Reference

Automatic EM Circuit Partitioning

The EM Model View

Manual Versus Automatic EM Circuit Partitioning

EM Circuit Cosimulation Overview

EM Circuit Cosimulation Overview

You can configure a circuit simulation to use an EM-based model for a cell instance 
or parts thereof by using the following view types:

EM Cosimulation view: This view facilitates combining EM simulation of a 
layout with circuit simulation of instances that cannot be simulated by the 
EM simulator (e.g. a nonlinear device) or for which a model already exists (e.
g. a built-in primitive, a schematic, or an EM Model). You can directly 
simulate circuit components inside an EM simulated layout. For more 
information, see .Using the EM Cosimulation View

EM Model view: This view contains the S-parameter model extracted by an 
EM simulator for the entire (flattened) layout. For more information, see 

.Using the EM Model View

Using the EM Cosimulation View

http://edadocs.software.keysight.com/display/ads2017/Using+the+EM+Cosimulation+View+Tutorial
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1.  

2.  

3.  

4.  

Using the EM Cosimulation View

EM Cosimulation View

EM Cosimulation Controller Component

Performing an EM Circuit Cosimulation with an EM Cosimulation View

Using the EM Cosimulation View Tutorial

EM Cosimulation View

EM Cosimulation View

An EM Cosimulation view is used by the circuit simulator to model a layout that is 
partly circuit simulated and partly EM simulated (using an autogenerated 
traditional EM model). When netlisted, it integrates the EM model for the EM 
simulated partition with circuit models for the circuit simulated instances. The EM 
model can be precomputed or will be computed during circuit simulation. It caches 
the S-parameters to improve performance for repeated simulations.

EM Cosimulation views are compatible with , which Dynamic Model Selection
enables you to switch between different models for the same cell. For example, a 
faster, all schematic-based representation in the  view, and an schematic

accurate mixed EM/Circuit-based representation in the  view.emCosim

Creating an EM Cosimulation View

An EM Cosimulation View is created from an EM Setup by performing the following 
steps:

Open the EM Setup window.

Select  in the Setup Type panel.EM Cosimulation

Ensure that  is selected in the  drop-down list.Views Generate

Click  after finalizing the setup.Go

http://edadocs.software.keysight.com/display/ads2017/Using+the+EM+Cosimulation+View+Tutorial
http://edadocs.software.keysight.com/display/ads2017/Dynamic+Model+Selection
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4.  

Specify Automatic EM/Circuit Partitioning

The Partitioning tab of an EM Setup controls whether individual instances are EM 
simulated or circuit simulated.



Electromagnetic 450

The partitioning policy at the top of the tab and the partitioning rules defined for a 
cell allow ADS to automate this EM/circuit modeling choice, which can be 
overridden in the tab. For more information on automating the modeling choice, 
see .Automatic EM Circuit Partitioning

Besides the Partitioning setup, all other settings of the EM Setup are relevant as 
they will be used for simulating the EM partition. You need to specify the substrate, 
define ports, set up the simulation options such as mesh parameters, and specify a 
frequency plan for the EM model generation. For more information, see Setting up 

.EM Simulations

Generating the EM Cosimulation View

After finalizing the EM simulation setup, click . This does not immediately start Go
an EM simulation. Instead it generates several cellviews. For the EM simulated 
partition, the EM Setup generates a layout and traditional EM model in a new cell 
named after the original cell with an ' ' suffix. The EM Setup also _emCosim

generates a EM Cosimulation view  in the original cell, which can be used emCosim

as regular netlistable circuit model for that cell. The netlisted EM Cosimulation view 
integrates the circuit simulated instances with the EM model.

To see the names of generated views, click the  option in the left pane Cosimulation
of the EM Setup window, as shown in the following figure:

The  view is available in the ADS Main window, as shown in the following emCosim

figure:
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Double-click the  view in the ADS Main window to open the EM emCosim

cosimulation window. Selecting the  option from the  Necessary views Generate
drop-down list regenerates the emCosim view (itself) and the cell representing the 
EM simulated partition (which typically contains a layout and EM model).

In addition, a new cell with ' ' suffix is created, which represents the EM _emCosim

partition. The cell representing the EM partition consists of a layout and a 
traditional EM model. The EM model stores the EM simulation data. You can edit 
the layout, but must not change the pin ordering.
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If there are significant changes in the original layout, you must regenerate the 
EM cosimulation view, which will also regenerate the cell representing the EM 
partition.

Parameterized Layout View

The intermediate layout view is not created when the layout of the EM partition is 
parameterized (scalable). The EM simulation input files are generated on the fly 
from the partitioning information once the parameter values are known during the 
EM cosimulation.

You can control to which cell parameters the EM Model is sensitive. Select ‘Include 
all parameters except these:’ and leave the edit box blank to include all parameters. 
Each real-valued cell parameter will become an EM Model parameter. You can 
exclude one or more parameters by entering their name(s) as a space separated list 
in the edit box. The other selection ‘Include only these parameters:’ may be more 
convenient when only a few real-valued cell parameters change the layout.

How are pins and ports handled?

The layout for the EM simulated partition contains copies of the pins of the top level 
layout and the pins of circuit simulated instance layouts (rotated 180 degrees).
Pins that are no longer connected to the EM simulated partition according to the 

 are removed from the generated layout. The Physical Connectivity Engine
connectivity of mutually touching removed pins will be guaranteed by the netlist of 
the cosimulation.

Area pin shapes are always copied to the EM simulated partition layout. The new 
shapes retain their area pin function, unless the old shape is carrying the custom 

  (also editable in AEL using property eeExcludeFromEmPin=1 db_add_property()
). Alternatively, the property  can be used eeShrinkAreaPinToContactRegion

to reduce the size of the EM simulated area pin to the contact region.

A polyline edge pin in a circuit simulated instance allows a flexible connection 
without copying filled shapes as in the area pins case.
Only the effectively connected section of such a pin is copied as edge pin to the EM 
simulated partition layout.

http://edadocs.software.keysight.com/display/ads2017/Physical+Connectivity+Engine
http://edadocs.software.keysight.com/display/ads2017/Editing+Primitives+Using+the+Properties+Window#EditingPrimitivesUsingthePropertiesWindow-CustomPropertiesDialogBox
http://edadocs.software.keysight.com/display/ads2017/Editing+Primitives+Using+the+Properties+Window#EditingPrimitivesUsingthePropertiesWindow-CustomPropertiesDialogBox
http://edadocs.software.keysight.com/pages/viewpage.action?pageId=55251085
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For all pins that have been copied to the generated layout, EM port definitions for 
these pins are copied from the original toplevel and circuit simulated instance 
layouts as-is.
The port definitions of circuit simulated instances can be edited on their layout 
using  or, for artwork macros, using .EM > Port Editor db_set_port_definitions()

You can refer the shipping example , Pin_Handling_For_EmCosim_wrk.7zap

which illustrates a number of different possible pin setups inside a circuit simulated 
component. To open this example, select File > Open > Example > Momentum> 

. The  design of this example workspace provides a detailed emcktcosim README

explanation. The following images displays the pin setup of the circuit simulated 
component, a design using this component, and the resulting EM simulated 
partition.

Circuit Simulated Component

Design

http://edadocs.software.keysight.com/pages/viewpage.action?pageId=54537393
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Resulting EM Simulated Partition
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1.  

2.  

3.  

Precomputing the EM Model

The EM model of the EM simulated partition caches the S-parameters to improve 
circuit simulation performance. When it is created, all the settings specified in the 
EM setup window are copied to the EM Model. Later, during simulation, if the EM 
Model needs to run an EM simulation to generate on-demand S-parameters, this 
copy of the settings is used to launch the EM simulation. The EM Model window 
consists of four tabs: Simulation Setup, Database, Interpolation, and Options. For 
more information, see .The EM Model View

You can precompute the EM model for default parameter values:

In the Main window, double-click the EM Model present in the cell 
representing the EM partition. The EM Model window is displayed.

Click the  tab.Database

Click . A message box is Evaluate model for parameter default values
displayed.
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4.  After the evaluation is complete, a new database entry has been created:

Using an EM Cosimulation View for Circuit Simulation

After creating an EM Cosimulation view, you can perform the EM/circuit 
cosimulation. For more information, see Performing an EM Circuit Cosimulation 

.with an EM Cosimulation View

Example

Consider the cell  in following workspace:MyResistor
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In this workspace, the layout view consists of a 50 Ohm resistor component 
 in the middle with two transmission line components ads_rflib:R_Pad1

 on either side. The associated schematic view contains the ads_tlines:MLIN

 component, which defines the substrate for the circuit.ads_tlines:MSUB

In this design, the  instances can be simulated by both EM and ads_tlines:MLIN

circuit simulation. On the other hand, the  resistor ads_rflib:R_Pad1

component is not EM simulatable. The actual layout for that component is 
unknown. Only its pads to make connection with the rest of the circuit are 
specified. An EM Model generated for the layout 'as-is' would represent an open 
circuit due to the gap between the resistor pads. Since the resistor is circuit 
simulatable, an EM/Circuit cosimulation can provide a model for the cell.

In the EM Setup, the partitioning can be edited to select the 'circuit' partitioning 
rule for the resistor. If the 'em' rule has been deleted for the resistor component, 
the 'circuit' selection is performed automatically.
After clicking , the  view an a new cell with a layout and EM Model for Go emCosim

the EM partition are generated:
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The  view is a circuit simulatable cell view supported by the emCosim Dynamic 
 in ADS. Selecting this view for simulation in the  Model Selection MyTestbench

schematic will allow to compute S-parameters for the  cell whereby MyResistor

the resistor is circuit simulated and the transmission lines are EM simulated.

Performing an EM Circuit Cosimulation with an EM Cosimulation View

Performing an EM Circuit Cosimulation Using the EM Cosimulation View

The EM/Circuit Cosimulation feature facilitates combining EM simulation of a layout 
with circuit simulation of instances that cannot be simulated by the EM simulator (e.
g. a nonlinear device) or for which a model already exists (e.g. a built-in primitive, a 
schematic, or an EM Model).
A cell that has an EM Cosimulation View can be instantiated in a testbench 
schematic to run the cosimulation.

Perform the following steps:

http://edadocs.software.keysight.com/display/ads2017/Dynamic+Model+Selection
http://edadocs.software.keysight.com/display/ads2017/Dynamic+Model+Selection
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1.  

2.  

3.  

4.  

5.  

1.  

2.  

3.  

4.  

5.  

Set up a Layout

Specify Automatic EM/Circuit Partitioning.

Generate an EM Cosimulation View.

Insert a symbol in the Schematic.

Run EM Circuit Cosimulation.

Set up a Layout

There are two basic ways to create a layout. Use the one that best complements 
your own design methodology and suits your design needs:

Layout synchronized from a schematic

Directly drawn or imported layout

Configure the EM Setup

After you have set up a layout, you need to create an EM Setup and configure the 
partitioning, i.e. whether instances will be circuit simulated or EM simulated:

Select  >  to open the EM Setup window.EM Simulation Setup

Select  in Setup Type.EM Cosimulation

Select  in the left pane of the EM Setup window.Partitioning

Select an instance for which you want to specify a partitioning rule. By 
default, the available rules are  and .circuit em

Select the desired rule from the drop-down list in the  column:Partition Rule

For more information on configuring the partitioning, see Automatic EM Circuit 
.Partitioning

Also, define an EM Simulation Setup to:

Specify the substrate.
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1.  

Define ports.

Set up the simulation options, such as mesh parameters.

Specify a frequency plan for the EM model generation.

Generate the EM Cosimulation View and EM Partition

After finalizing the EM simulation setup, click the  button. This does not Go
immediately start an EM simulation. Instead, it generates several cellviews. For the 
EM simulated partition, the EM Setup generates a layout and traditional EM model 
in a new cell named after the original cell with an ' ' suffix. The EM Setup _emCosim

also generates a EM Cosimulation view  in the original cell, which can be emCosim

used as regular netlistable circuit model for that cell. The netlisted EM 
Cosimulation view integrates the circuit simulated instances with the EM model.

Optionally Precompute the EM Model

The autogenerated EM Model caches the calculated S-parameters of the EM 
simulated partition. This calculation will be automatically triggered during the 
cosimulation if the data is not yet cached.
If the testbench schematic is not yet ready, you can already precompute the EM 
model ahead of time, so you wouldn't have to wait for this during the actual 
cosimulation.

You can precompute the EM model for default parameter values:

In the Main window, double-click the autogenerated EM Model in the EM 
Cosimulation view:
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1.  

2.  

3.  

Click the  tab.Database

Click .Evaluate model for parameter default values
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1.  

2.  

3.  

4.  

Create a symbol for your design

You need a symbol for your design in order to be able to instantiate it in a 
testbench schematic.
To create a symbol:

Right-click the cell representing your design.

Choose .New Symbol

Select the required options. For more information, see .Generate a Symbol

Click .OK

http://edadocs.software.keysight.com/display/ads2017/Generate+a+Symbol
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Instantiate your design into the testbench schematic

The  view of your design can be inserted into a testbench schematic by symbol

typing the component name, or by dragging the component from the ADS Main 
window into the testbench schematic.

Configure the testbench schematic to use the Cosimulation View

There are two equivalent ways to use a Cosimulation View:

Either the  view of your design is used as  for emCosim View For Simulation
the instance in the testbench.

Or an  component is placed on the  view of EM Cosimulation schematic

your design to integrate the  view with the schematic. This emCosim

 view is used as  for the instance in the schematic View For Simulation
testbench.

The simulation results are identical in both cases. The important distinction is the 
view used to netlist circuit simulated instances:

When using the  view as , the circuit simulated emCosim View for Simulation
instances are netlisted from the partitioned  view.layout

When using an  controller, the circuit simulated instances EM Cosimulation
are netlisted from the  view.schematic

This distinction is relevant for tuning and optimization, where the view that owns 
the circuit simulated instances is used for selecting and updating parameters.
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1.  

2.  

3.  

1.  

2.  

Using the Cosimulation View as View For Simulation

This approach does not require the presence of a synchronized schematic. Even if 
one is present, it is not used by the simulation.
The circuit simulated instances are netlisted from the partitioned  view, and layout

can be tuned and optimized from there.

Select a symbol for your design instance in the testbench schematic.

Click the  button (  ).Choose View for Simulation

Select the  view in the Choose View for Simulation window.emCosim

Alternatively, you can have the Hierarchy Policy select the correct simulation view 
for you. For more information, refer to .Dynamic Model Selection

The  Hierarchy Policy will always select the placed layout view of Standard

circuit simulated layout instances as View For Simulation. To avoid this, ADS 
comes with a Hierarchy Policy  amounting to Standard_em emCosim 

. When using this Hierarchy Policy, ADS will never emModel schematic

autoselect a layout view as View For Simulation for the circuit simulator.

Using an EM Cosimulation controller

This approach requires the presence of a synchronized schematic. The circuit 
simulated instances are netlisted from the  view of your design, and schematic

can be tuned and optimized from there.

Keep using schematic as a view for simulation of your design instance in the 
testbench schematic.

In the synchronous schematic of your design, select  > Simulate Insert EM 
 to add an EM Cosimulation controller.Cosimulation Controller

http://edadocs.software.keysight.com/display/ads2017/Dynamic+Model+Selection
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2.  

The EM Cosimulation controller integrates the EM partition of the  view emCosim

into the schematic. The netlisted schematic will instantiate the EM model of the EM 
partition to replace those original schematic instances and nets that are now EM 
simulated.

Nets in the schematic can have a spatial extent in the layout, where several EM 
model pins connect to a single original net. The netlister will split and rename 
such nets to multiple different nets to avoid shorting a pin of a circuit simulated 
instance to an unrelated distant EM model pin on the same original net.

Global nets, such as the analog ground, are an exception. They are never split 
or renamed, in order to guarantee global connectivity. EM model pins on the 
same global net will always be shorted.

Run the EM Circuit Cosimulation

You can now run simulation from the schematic testbench selecting  from Simulate
the Simulate menu.
The Data Display window appears, which shows the result of the EM cosimulation:
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2.  

3.  

See Also
EM Circuit Cosimulation
Tutorial- Using the EM Cosimulation View
Manual Versus Automatic EM Circuit Partitioning

EM Cosimulation Controller Component

EM Cosimulation Controller Component

The EM Cosimulation controller component integrates the EM simulated partition 
of an  into a schematic of the same cell. The netlisted EM Cosimulation View
schematic will instantiate the EM model of the EM partition to replace the original 
schematic instances and nets that are EM simulated. For more information, refer to 

.Performing an EM Circuit Cosimulation with an EM Cosimulation View

Inserting an EM Cosimulation Controller

To insert an EM Cosimulation controller:

Open a Schematic window.

Select  > .Simulate Insert EM Cosimulation Controller

Place the EM Cosimulation component in the schematic.

http://edadocs.software.keysight.com/display/ads2017/Using+the+EM+Cosimulation+View+Tutorial
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Alternatively, you can access the EM Cosimulation component from the 
Components pallet:

Select  from the components drop-down list in a Simulation S-Param
Schematic.

Select the  component from the components pallet and EM Cosimulation
place it in the schematic.

Using the EM Cosimulation Controller Component

You can use the EM Cosimulation Controller component to switch between multiple 
EM Cosimulation Views. Double-click the instance to open the EM Cosimulation 
window. The EM Cosimulation controller window displays all the EM cosimulation 
views. You can select the required EM Cosimulation view and click  to Open View
integrate with the schematic:

Alternatively, you can click the  icon to open the EM Push into Hierarchy
Cosimulation View.

See Also
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EM Circuit Cosimulation
Tutorial- Using the EM Cosimulation View
Manual Versus Automatic EM Circuit Partitioning

Using the EM Model View

Using an EM Model View

The EM Model View

Creating and Using an EM Model View

Performing an EM Circuit Cosimulation with an EM Model View

Creating and Using an EM Model View

Creating and Using an EM Model View

An EM Model view is used by a circuit simulator to model a component by using 
the S-parameters generated by an EM simulation. The EM-based S-parameters 
can be precomputed or you can generate them while running the circuit simulation. 
An EM Model caches the S-parameters to improve performance. EM Models are 
compatible with Dynamic Model Selection, which enables you to switch between 
two different models for the same cell. For example, a faster, schematic-based 
representation, and an accurate EM-based representation.

Creating an EM Model

To create an EM model:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Model

Select  to create an EM Auto-create EM model when simulation is launched
model after the simulation process.

To generate an EM model immediately, click . The following Auto-create Now
figure displays an EM model:

http://edadocs.software.keysight.com/display/ads2017/Using+the+EM+Cosimulation+View+Tutorial
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If this button is labeled , an EM Model already exists for this Update Now
cell.

The default name for an EM Model is . It is recommended to use the emModel
default name. You can also create an EM Model by using the following methods:

In the layout window, choose  >  > EM Component Create EM Model and 
.Symbol

In the EM Setup window, select  in the left pane. If you select Model Update 
, the EM Model will be created (or EM Model when simulation is launched

updated if it already exists) whenever you run an EM simulation.
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Updating an EM Model

If you create an EM Model from an EM Setup and then change some settings in the 
EM Setup, the changes are not updated in the EM Model because it contains a 
copy of the EM setup. To copy the modified EM Setup to the EM Model:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Model/Symbol

Click in the EM Model panel.Update Now

If this button is labeled as , then the EM Model does not Create Now
exist for that cell.

When you update an EM Model and this causes the EM Model setup to change in a 
way that affects the EM simulation results, the system deletes all the cached EM 
results. See The EM Model database for more information.

You can also update an EM Model by using the following methods:

In the layout window, choose  >  > EM Component Create EM Model and 
.Symbol

In the EM Setup window, on the  page, check Model/Symbol Update EM 
. With this checked, every time you run Model when simulation is launched

an EM simulation using this EM Setup, the EM Model will be updated (or 
created if it does not exist).
Using an EM Model for circuit simulation.

Using an EM Model View for Circuit Simulation

Default View used by a Circuit Simulation

By default, the view named  is used by ADS circuit simulation before a schematic
view named . Therefore, if you insert an instance of a cell that has an EM emModel
Model view named , there are two possibilities:emModel

If the cell has no view named , then the EM Model view named schematic
 is used for circuit simulation.emModel

If the cell has a view named , the EM Model view is not used for schematic
circuit simulation. Instead, the view named  is used.schematic

You can change the default behavior by using Dynamic Model Selection. For more 
information, refer .Dynamic Model Selection

To find the view that is used for an instance during circuit simulation, open the top-
level schematic and choose  > . In the  Simulate Hierarchy Editor Hierarchy Editor
dialog box, find the instance name in the  column. Then search in the Instance View 

 column to find the view that is used for circuit simulation. If the view for Simulation
for simulation is not , you need to specify the system to use .emModel emModel

Specifying an EM Model View for Circuit Simulation

To specify the view to be used for a circuit simulation:

http://edadocs.software.keysight.com/display/ads2017/Dynamic+Model+Selection
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Select the instance on the schematic.

Click the  toolbar button, immediately to the left Choose View for Simulation
of the Simulate toolbar button. This dialog box lists all the views available for 
circuit-simulation for the cell associated with this instance.

Select the view named .emModel

Click . The circuit simulator uses the view named  for this OK emModel
instance.

The view name  is now displayed on the instance. This is a quick way to emModel
tell whether a specific view has been chosen for an instance. You can use the 
Hierarchy Editor (choose  >  in the top-level schematic) to Simulate Hierarchy Editor
verify that this change has taken effect.

If you specify  in the  dialog box, but the emModel Choose View for Simulation
Hierarchy Editor shows that  is not the view that is used for circuit emModel
simulation, the top-level schematic is using a hierarchy policy that has the Honor 

 option selected.instance specializations

In ADS 2009 Update 1 and earlier, a Layout Component is used instead of an 
EM Model. For more information, refer .Layout Components and EM Models

Performing an EM Circuit Cosimulation with an EM Model View

Performing an EM Circuit Cosimulation with an EM Model View

The Electromagnetic-Circuit cosimulation feature enables you to run a circuit 
simulation with EM Model generation. Insert a cell that has an EM Model view in a 
testbench schematic. During the circuit simulation, the circuit simulator reuses S-
parameter model data from the EM Model. In the absence of available data, the EM 
simulator is invoked to extend the EM Model with the missing data.

Setting up a Layout

There are two basic ways to create a layout. Use the one that best complements 
your own design methodology and suits your design needs:

Layout synchronized from a schematic

Directly drawn or imported layout

Defining the EM Simulation Setup

Once you have a layout, you need to create an EM Setup view that specifies the EM 
simulation setup:

Specify the substrate

Define the ports

Set up the simulation options, such as mesh parameters.

Specify a frequency plan for the EM model generation

Ports Width

http://edadocs.software.keysight.com/display/ads2017/Layout+Components+and+EM+Models
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Ports Width

Specifying correct port width is an important factor during EM cosimulation. For 
example, if you want to connect a strip line of 0.1 mm to a layout design of width 
10 mm, you need to create a small polyline of width 0.1 mm.

In this example, you can create a polyline at points where you want to connect 
another strip line and ports.(Edge ports can also be used in these scenarios).

Defining Component Parameters

You can define component parameters that paramterize the layout. For more 
information, see .Defining Component Parameters

Creating an EM Model and Symbol

A symbol is used to represent the component in a schematic. Symbols are stored in 
Symbol views and must be created before they can be used. For more information 
on symbols, see .Generate a Symbol

An EM Model is used by the circuit simulator to model a component by using the S-
parameters generated by an EM simulation. The EM-based S-parameters can be 
precomputed or you can generate them while running the circuit simulation. An EM 
Model caches the S-parameters to improve circuit simulation performance. For 
more information about how to use an EM model, see Creating and Using an EM 

.Model View

You can generate an EM model and symbol by selecting  >  > EM Component Create 
 in the layout window. You can also use the EM Setup EM Model and Symbol

window to generate an EM model and symbol. The EM Setup window provides 
options to customize the model and symbol generation. For more information, see 

.Generating an EM Model

In ADS 2009 Update 1 and earlier, a layout component was modeled using a 
schematic, EM-based S-parameters, and File-based S-parameters. From ADS 
2011 release onwards, an EM Model can be inserted into any schematic as a 
layout component. To illustrate the differences, assume that you want to 
change the mesh density from 20 cells per wavelength to 30 cells per 
wavelength. First, assume that you want to make this change globally, that is, 
you want all instances of this component to use 30 cells per wavelength. In 
ADS 2009 Update 1 and earlier, you need to find every instance of the 
component, double-click it, and change the mesh density to 30. If you miss an 

http://edadocs.software.keysight.com/display/ads2017/Generate+a+Symbol
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instance, that instance will continue to use 20 cells per wavelength while all 
the other instances use 30. From ADS 2011 onwards, you can access the EM 
Model view and change the mesh density to 30. All instances that use this EM 
Model for circuit simulation will use the new value of 30.

Using Components in a Schematic

The Symbol view of the cell can be inserted into a schematic by typing the name of 
the component in the component name entry field, or by dragging the component 
from the ADS Main window in the Schematic window.

Running an EM Circuit Cosimulation

According to the standard simulation hierachy policy, when a cell instance has an 
EM Model view named "emModel", the circuit view is used for simulation. You can 
override the view choosen for simulation by selecting the component symbol and 
click the  button. Select the view you want from the Choose View for Simulation
Choose View for Simulation window. For more information, see Creating and Using 

.an EM Model View

Example

This section provides an exercise illustrating how to set up, perform and view the 
results of EM Circuit Cosimulation.

Opening an Example Project

Start by opening an ADS Momentum example project into your local directory.

From the Main window, select File >  > .Example Momentum

Select  and select Coupled_line_filter_wrk and click .Microwave Open

Specify the workspace name and location for creating the example 
workspace.

Click . This opens the example and saves it to the new location.OK

Editing the Component

To edit a component:

Close the README window.

Select the Coupled_line_filter layout window.

From the Layout window, select  > .EM Clear Momentum Mesh

Select  >  >  to open the Design Parameters dialog EM Component Parameters
box.

In the Create/Edit Parameter section, type  as the parameter name.L1

Select  as the parameter type.Subnetwork

Set the default value and unit to 300 um.

Click .Add
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Click .OK

In the Layout window, double-click the component to select it.

Select Parameter L in the MLIN column and set Line Length L to L1 in Length
.

Click .OK

Creating an EM Model
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Creating an EM Model

To create an EM model:

Choose  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Model

Click .Create Now

Adding and Using the Component in a Schematic

To add the parameterized component in schematic:

Click  from the ADS Main window to open a new New Schematic Window
Schematic window.

Specify the cell name.

Select  from the Schematic Design Templates drop-ads_templates_s_params
down list.

Click .OK

Type the cell name and press  to place the EM model component.Enter

Click .End Command

Click  to connect the symbol with the terminals.Insert Wire

Click .End Command

Performing EM Circuit Cosimulation

To perform EM circuit cosimulation:

Select the EM Model.

Click  (  ).Choose View for Simulation
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Choose  view.EmModel

Click .OK

Click  to perform circuit Cosimulation.Simulate

You can now view the results of EM circuit cosimulation in the Data Display 
window.

Show me How to Perform EM Circuit Cosimulation

   Video: Perform EM Circuit Cosimulation

The EM Model View

The EM Model View

An EM Model view is used by the circuit simulator to model a component by using 
the S-parameters generated by an EM simulation. The EM-based S-parameters 
can be precomputed or you can generate them while running the circuit simulation. 
The EM Model caches the S-parameters to improve the circuit simulation 
performance.

An EM Model can be created from an EM Setup. All the settings specified in the EM 
setup window are copied to the EM Model. Later, during a circuit simulation, if the 
EM Model needs to run an EM simulation to generate on-demand S-parameters, 
this copy of the settings is used to launch the EM simulation.

The EM Model Editor window consists of four tabs: Simulation Setup, Database, 
Interpolation, and Options. The following sections describe the tasks that you can 
perform using these tabs.

Simulation Setup

This tab provides a summary of the EM simulation setup: the type of simulator, 
layout, substrate, ports defined for your simulation, frequency and output plans, 
simulation options and resources, and EM model and symbol information.

http://edadownload.software.keysight.com/eedl/ads/2011/video/v6/perform_circuit_cosimulation.html
http://edadownload.software.keysight.com/eedl/ads/2011/video/v6/perform_circuit_cosimulation.html
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You can view the EM setup details and modify the setup by clicking .Edit

When you change the value of a simulation option that affects the EM 
simulation results, the S-parameter data cached in the EM Model will be 
deleted.

The EM Model Database

To improve circuit simulation performance, each EM Model maintains a database of 
the EM simulation results. When a circuit simulator requests S-parameters from 
the EM Model, an EM simulation is performed only when the S-parameters are not 
available in the database. If an EM simulation is performed, the results are added to 
the database.

Any change that affects the EM simulation results causes an EM Model database to 
become out of date. Examples of this type of changes are:

EM Model simulation setup changes: For example, changing the mesh 
density.
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Changes to the cell parameter set: Adding a parameter to the cell or 
deleting a parameter from the cell.

Substrate changes: For example, changing the thickness of a metal layer in 
the substrate.

Layout changes: For example, adding shapes or components to the layout.

The EM model automatically detects changes to the EM Model and changes to the 
cell parameter set. When such a change is detected, the EM Model automatically 
deletes its database. However, other changes are not automatically detected. If you 
make such a change, you should open the EM Model, access the Database tab and 
click .Delete All

Cell Parameter Interpolation

The settings on the Interpolation tab are used by the circuit simulator to determine 
whether for a given set of cell parameter values, model data is available, can be 
constructed by interpolation, or if a new EM simulation is required. In the absence 
of a unit name, MKS units are assumed.
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The search for available model data takes into account the Resolution value for 
each cell parameter. When new data is required, the cell parameter values for the 
new model generation is rounded to the specified Resolution.

You can enable interpolation for cell parameters. This interpolation setting only 
applies to the cell parameters, not to the frequency! When enabled, a linear 
interpolation scheme is used. The circuit simulator invokes an EM simulation only if 
the requested model sample cannot be obtained by interpolation between neighbor 
model samples. Neighbor model samples must be within a normalized distance (L1 
measure) smaller than one from the requested sample. The normalization of the 
distance is with respect to the Delta values specified for each cell parameter. 
Extrapolation is never performed in the layout parameter space. An EM simulation 
is performed to calculate a new sample in such case.
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Options

Frequency Domain Simulation Options

The EM Model does not use datasets. The EM Model reads the .cti file that contains 
the simulated frequency samples and (optionally) a .rat file that contains the 
coefficients of the rational polynomial fit in case an adaptive frequency sweep was 
used. When the circuit simulator needs S-parameters at a specific frequency, the .
cti file is checked whether data is available for that frequency first. If no data is 
present and the requested sample is within the adaptive range(s), the rational 
polynomial fit is evaluated. If that is not the case, a linear interpolation is tried using 
the .cti file samples. If that is not possible, a linear extrapolation with passivity 
enforcement is done. In case of a non-adaptive sweep, the frequency domain 
interpolation is always linear using the samples that were simulated from the .cti 
file. Within an adaptive range, the rational polynomial fit is evaluated. There is no 
control over the interpolation.

You can specify the following frequency domain simulation options:

Extrapolation mode: You can specify the following values for the extrapolation 
mode:

Linear (default): A linear extrapolation scheme is used for both magnitude 
and phase. By default, passivity of the S-parameter model is enforced during 
extrapolation.

Constant: The S-parameters at the lowest or highest available frequency are 
used.

Exponential e-damping: A mixed extrapolation scheme is used. S-
parameters at kept constant during extrapolation towards low frequencies. 
Towards high frequencies, S-parameters are e-damped in magnitude and 
linearly extrapolated versus phase.

Enforce passivity: The passivity of the S-parameter model can be enforced. You can 
enable or disable passivity enforcement through the Enforce Passivity parameter. 
You can specify the following values for enforce passivity:

Only when extrapolating: S-parameter model passivity is enforced only 
during frequency domain extrapolation.

Always: S-parameter model passivity is enforced at all frequencies.

Never: S-parameter model passivity is not enforced.
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Netlist Options

The  setting is only relevant when  is selected and Multi-pins port terminal All pins
the S-parameter ports were defined having multiple layout pins connected to either 
the plus or minus terminal, or both. The selection implies that the symbol All pins 
consists of similar number of pins as present in the layout.

Use shorts in netlist: convenience setting that shorts all pins connected to 
the S-parameter port terminal in the netlist fragment for the EM Model. It is 
sufficient to connect/wire to one symbol pin only.

Use transformers in netlist: a transformer is used in the netlist fragment for 
the EM Model to extract the common mode voltage and current from the 
multiple pins. This option is required when the pins cannot be shorted 
automatically.

Tools Menu

The Tools menu in the EM Model provides following capabilities:

 Open Layout Window opens the corresponding layout cell view in a 
Layout window. For a cell with parameters, this is the 'nominal' layout view 
with default parameter values.

 Open Substrate Window opens the substrate used in the simulation in a 
Substrate Editor window.

 Create Dataset allows you to create a dataset for the selected data item 
in the EM Model database. The name of the dataset is 
"<cellName>_<emModelName>_<index>" where by <index> represents the 
index of the selected data item and the file is written in the data directory.

 Data Display opens a Data Display window after writing the dataset for 
the selected item in the EM Model database.

 Far Field allows you to compute the far field for the selected data item 
in the EM Model database.

 Visualization opens the 3D Visualization window for the selected data 
item in the EM Model database.

 Simulation Log opens the simulation log of the selected database items.

Far Field and/or Visualization driven from an EM Model is not possible when the EM 
Model was generated with the 'Include S parameter data only' flag enabled in the 
corresponding EM Setup. The following warning window is displayed:
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Disabling the flag ensures that all data required for post-processing operations are stored 

with the EM Model. Changing the flag in the EM Setup and updating the EM Model does 

not invalidate existing EM Model data. The flag will only take effect for newly generated 

data samples. If you want to do post-processing operations on existing EM Model data 

items, delete and regenerate them.

Far-field computation and 3D Visualization driven from the EM Model database 
is only possible for fixed parameter value EM Model data items, not for the 
scalable model data items that the Advanced Model Composer generates. The 
scalable model data can be recognized by the LIST or RANGE parameter 
values. Data for post-processing cannot be stored in the EM Model database 
because such EM Model data item spans a (discrete or continuous) range of 
instances of a parametric layout.

Using the EM Circuit Excitation AEL Addon

Using the EM Circuit Excitation AEL Addon

EM Circuit Excitation allows you to visualize field data such as surface currents and 
far-field of your EM Model/EM Cosim with any circuit elements contribution in your 
schematic. Key features are:

DC, AC, Harmonic Balance, Transient and Envelope simulation can be used. 
(Support of Envelope simulation is new since ADS2016.01 release)

Both Momentum and FEM EM Model/EM Cosim are supported.

EMPro Component is supported.

Parameterized EM Models/EM Cosims are supported.

By running above supported circuit simulation for a circuit which includes 
components with EM Model/EM Cosim views, EM Circuit Excitation can get and 
store actual simulated voltages at all pins of those components. Those voltages will 
be used as excitation for EM visualization. ( Note: For Transient simulation, time 
domain signals will be converted to frequency domain before used in EM 
visualization. )

Enabling the EM Circuit Excitation AEL Addon

To enable the EM Circuit Excitation AEL Addon:

Select  in the ADS Main window.Tools > App Manager
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Select the  check box for , as shown in the Enabled EM Circuit Excitation
following figure:

Click .Close

Restart ADS.

Open a Schematic window and select  > .EM Circuit Excitation

Before using this addon, ensure that you have selected either All generated 
 or  in Output Plan options:frequencies User specified frequencies
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EM Circuit Excitation Flow

To use the EM Circuit Excitation AEL Addon, you need to perform the following 
steps:

Create a EM Model or EM Cosimulation view.

Create a circuit with supported simulation controller.

Run the DC/AC/HB/Tran/Envelope simulation.

View surface currents.

View Far Field.

To use EM Circuit Excitation, perform the following steps:

Select  >  in the Schematic window. The Circuit EM Circuit Excitation
Excitation dialog box is displayed.

Click Run DC/AC/HB/Tran/Envelope Simulation to start circuit simulation 
and post processing.

The Open Visualization button is enabled .

Select the  checkbox and select 2.4GH Far Field for MomMW or FEM
frequency from the  drop-down menu.Frequency

Select the beam you want to see in visualization.

In Visualization view, set the phi and theta values and click Display Cut in 
.Data Display

The following sections describe these steps.

Creating an EM Model or EM Cosimulation view

You can create an EM Model or an EM Cosimulation view from an EM setup 
window. For more information, refer  and Generating an EM Model EM Cosimulation 

.View

Before creating the EM model or EM cosimulation view, uncheck the Include S-
 check box. Unchecking this check box includes not only the S-Parameter data only

Parameter data, but also the required data for EM visualization. If you check this 
check box, circuit excitation visualization will not be possible.



485 Electromagnetic

Only frequencies calculated by the EM simulator can be shown in the EM 
visualization. If you want to see surface currents and far field at explicit 
frequencies, add such frequencies in your EM Setup frequency plan.

Creating Circuits for DC/AC/HB/Tran

EM Circuit Excitation works for circuits with single or multiple EM Models and 
single or multiple DC/AC/Harmonic Balance/Transient/Envelope simulation 
controller. Parameter sweep is also available. The following figure displays an 
example of a circuit with AC simulation controller:

For creating circuits for DC/AC/HB/Tran/Envelope, make sure an EM Model or EM 
Cosim view is chosen for the required instances. Only such instances will be 
available for EM visualization. The excitation voltages for each instance for EM 
visualization is interpolated or extrapolated based on available frequencies of the 
AC/Harmonic Balance simulation.

Currently DC, AC, Harmonic balance, Transient and Envelope simulation are 
supported.
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Running DC/AC/HB/Transient/Envelope Simulation

Note that EM Circuit Excitation can only visualize data at frequencies where EM 
simulator calculates its solutions. If frequencies that you want to visualize are 
not calculated by EM simulators yet, make sure to setup EM frequencies to 
cover those frequencies before using EM Circuit Excitation.

Select  in the schematic window. The EM > Circuit Excitation Circuit Excitation
dialog box is displayed, as shown in the following figure:

Select  if you want to see Far Field Far Field for MomMW or FEM option
results.

Select  if you want to interpolate circuit simulated Interpolate Node Voltages
voltages to get voltages at EM frequencies. (This option is only for frequency 
domain circuit simulations)

Interpolate Node Voltages option should be avoided to use unless you 
are really sure use of interpolated or extrapolated voltages as excitation 
is OK. Instead of using this option, consider to adjust both circuit 
simulation frequencies and EM simulation frequencies to match 
frequencies you're interested in.
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Select Time domain to Frequency domain conversion method.(This option is 
only for time domain circuit simulations) 

Select  if you want to use fs() functionality to convert to Use fs()
Frequency domain. This will allow you to specify very detailed options. 
See  for more fs function details. Note that depending on optional here
settings frequencies you get will be different. It's recommended to 
check output frequencies first by clicking  button. Frequencies...
Interpolation will be performed to get excitation voltage at EM 
frequencies.

Select if you want to apply DFT algorithm at Use DFT at each EM freqs 
each of EM frequencies.(recommended)

Click  to start circuit simulation Run DC/AC/HB/Tran/Envelope Simulation
and post processing.

If you have included an optimization controller in your circuit and want 
to run optimization, select the  check box. However, if you Optimization
have selected  in the optimization Enable Optimization Cockpit
controller, optimization flow might not work properly from this tool. To 
avoid this issue, you can disable this option. In the schematic, double-
click Optimization controller, select the  tab, and remove Parameters
selection from .Enable Optimization Cockpit

A message box stating that  is displayed.Compute excitation is all finished

Viewing Results

To view surface currents:

Select an instance from the  drop-down list.Instance

Click .Open Visualization

In the EM Visualization window, select the  tab.Solution Setup

http://edadocs.software.keysight.com/pages/viewpage.action?pageId=55248685


Electromagnetic 488

4.  

5.  

1.  

2.  

3.  

Select .Extracted Excitation

It is recommended to reset the maximum amplitude for plots after 
selecting  because it has largely different maximum Extracted Excitation
amplitude than . To reset maximum amplitude for Single Mode Excitation
each plots type, click  > .Options Restore System Max/Min

Select a state and frequency for displaying the results.

If you swept parameters by parameter sweep, each of these simulation 
becomes a .State

To view far fields:

Select an instance in the  drop-down list.Instance

Select the  check box and select a frequency.Far Field (uW mode only)

Click  to view results, as shown in the following figure:Open Visualization
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See Also
Designing Smart Antenna

Manual versus Automatic EM/Circuit Partitioning

The Automatic EM/Circuit Partitioning feature facilitates combining EM simulation 
of a layout with circuit simulation of instances that cannot be simulated by the EM 
simulator (e.g. a nonlinear device) or for which a model already exists (e.g. a built-
in primitive, a schematic, or an EM Model). The automatic partitioning obsoletes 
the manual process of stripping off these instances, extracting an EM Model and 
reintegrating it with the stripped instances in a schematic.

The automatic partitioning and how it compares versus the manual approach are 
described using an example. Open the following example:

From the ADS Main Window, select File > Open > Example.

Browse to the  directory and select the Momentum/emcktcosim

 archive file.RF_Board_wrk.7zads

Click .Open

Open the  view. Make all layers visible.LNA_stage_1:layout

http://edadocs.software.keysight.com/display/ads2017/Designing+Smart+Antenna
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The manual approach in ADS 2013.06 or before

The cells names used in this section are not included in Example.

.

Consider a layout having 11 surface mounted devices (SMDs). Central to the layout, 
there is the  transistor component. The input Board_Design_Kit:HBFP-0420

and output matching and the power supply bias make use of various R, L and C 
surface mounted devices provided by the  library.Board_Design_Kit

The  contains the circuit simulation setup for an S-SP_LNA_stage_1:schematic

Parameter simulation for this first stage. First select the schematic as view for 
simulation. This schematic view uses ideal wires to interconnect the SMD devices. 
Run the circuit simulation to see the amplifier gain and its input and output match 
in the  data display.SP_LNA_stage_1

The refined analysis of the amplifier design, using an EM-based accurate model for 
the passive interconnect, traditionally required a very significant amount of manual 
steps. This is because the layout contains instances that cannot be simulated by 
the EM simulator: the nonlinear transistor device and the Rs, Ls and Cs for which a 
model is provided in the  library. Previously, you had to Board_Design_Kit

manually separate the items that must be simulated by EM from the items that 
have a circuit simulation model already.

The traditional approach was as follows.

The  cell was copied to a new  cell.LNA_stage_1 LNA_stage_1_em

In the layout view of the new cell, pins were inserted at all SMD instance pin 
locations.

The SMD devices were deleted or flattened.

When applicable, edge and/or area pins had to be reconstructed. E.g. the 
pads of the transistor are defined as area pins.
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In the EM Setup, the ports for the EM simulation had to be configured. E.g. 
the R, L and C devices have one differential port defined.

An EM Model and new (layout lookalike) Symbol view were created from the 
EM Setup.

The  cell was copied to a new LNA_stage_1

 cell.LNA_stage_1_reconnection

In the schematic view of the new cell, all wires are deleted. The (layout 
lookalike) symbol of the  cell is inserted and all SMD LNA_stage_1_em

devices are manually reconnected. Optionally, the layout view was 
synchronized with the schematic and a new layout lookalike symbol was 
created.

The  testbench cell was copied to a new SP_LNA_stage_1

 cell.SP_LNA_stage_1_em

In the schematic view of the testbench, the  instance is LNA_stage_1

deleted and replaced by an instance of LNA_stage_1_reconnection

Only after all these steps, you could run the refined analysis from the 
 to see the impact of the actual physical SP_LNA_stage_1_em:schematic

interconnect.

The automatic approach in ADS 2014.01

Starting point is the  cell. Open the  view.LNA_stage_1 LNA_stage_1:emSetup
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At the top the setup type has been set to . When clicking  this EM Cosimulation Go
EM Setup does not immediately start an EM simulation. Instead it breaks up the 
design in an EM simulated partition with circuit simulated instances.
For the EM simulated partition, the EM Setup generates a layout and traditional EM 
model in a new cell .RF_Board_lib:LNA_stage_1_emCosim

The EM Setup also generates a EM Cosimulation view RF_Board_lib:
, which can be used as regular netlistable circuit model LNA_stage_1:emCosim

for . The netlisted EM Cosimulation view RF_Board_lib:LNA_stage_1

integrates the circuit simulated instances with the EM model.

Select the  tab. You will see a table with the configuration for instances Partitioning
found in the layout hierarchy.
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The  table shows which instances will be EM simulated and which will Partitioning
be circuit simulated. Each library cell component has its own set of Partitioning 

, where each rule declares a supported way of simulating that component. Rules
Unless , each component automatically supports the following configured otherwise
two rules:

Rule 
Name

Action

circuit Do not descend into the instance. The circuit simulation hierarchy policy is used to resolve the model 
that is used for simulation. This rule requires that the component can be simulated using circuit 
simulation.

em Descend into the instance. Model all primitive layout objects (traces, polygons, etc.) by EM and re-
examine the cell instances.

In this example, all  library components have been Board_Design_Kit

preconfigured to enforce the  partitioning rule. The  rule has been circuit em

deleted, hence ADS will refuse EM-only simulation of these components. If multiple 
partitioning rules exist for a component, a  is used to autoselect a rule unless policy
you specifically select a rule in the dialog to override the automatic choice. For 
more information on partitioning rules, refer to .Automatic EM Circuit Partitioning

In this example, the first row of the table can be interpreted as follows: when 
partitioning  for EM Cosimulation, the RF_Board_lib:LNA_stage_1:layout

 partitioning rule is being applied to the  circuit Board_Design_Kit:C

instance . The layout of the instance will be replaced by EM simulated pins and C1

ports copied from , connected to a circuit model Board_Design_Kit:C:layout

for . This model is selected using the regular circuit Board_Design_Kit:C

simulation rules: either configured as primitive (applicable here), or using the view 
for simulation, or using the circuit simulation hierarchy policy.
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Besides the partitioning, the other tabs in the EM Setup window allow you to 
specify substrate, ports, frequency plan, simulation options and resources. This is 
not different from a normal 'EM only' simulation.

An EM Setup with a partitioning that contains circuit-simulated components will 
create a  view as output. You can specify the view name on the EM Cosimulation
Cosimulation tab. This view can be used as regular netlistable circuit model for 

. When netlisted, it integrates the circuit RF_Board_lib:LNA_stage_1

simulated instances with the EM model for the EM partition.

On that tab, you can also specify the mode of operation for the cell representing 
the EM partition. By default the EM partition will be represented by a dedicated 
layout cellview.

From the EM Setup Window, click  to generate the EM Cosimulation view. Go
Besides the view, the cell representing the EM partition, , LNA_stage1_emCosim

will be created as well. The EM simulation itself will not be launched by this action. 
If you prefer to run the EM model extraction upfront, you can do so from the EM 
Model view of the  cell.LNA_stage1_emCosim

An EM Cosimulation view with a proper partitioning is all that is required. You can 
run the refined analysis from the  by selecting the SP_LNA_stage_1:schematic

 view as 'View for Simulation' for the  instance. The EM emCosim LNA_Stage_1

Cosimulation view contains all information to netlist the  instances circuit

together with the EM Model view of the cell represting the EM partition.
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Alternatively, you can integrate the EM Cosimulation with the existing 
 schematic.LNA_stage_1:schematic

In this alternative approach

Keep using  as view for simulation of the  schematic LNA_stage_1

instance in .SP_LNA_stage_1:schematic

Use  to add an EM Simulate > Insert EM Cosimulation Controller...
Cosimulation controller to .LNA_stage_1:schematic

The EM Cosimulation controller integrates the EM partition of the  view emCosim

into the schematic. The netlisted schematic will instantiate the EM model of the EM 
partition to replace those original schematic instances and nets that are now EM 
simulated.
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The simulation results are identical regardless whether you directly use 
 for simulation or, alternatively, continue to simulate LNA_stage_1:emCosim

 with an EM Cosimulation controller.LNA_stage_1:schematic

The important distinction is the view used to netlist circuit simulated instances:

When directly using  for simulation, the circuit LNA_stage_1:emCosim

simulated instances are netlisted from the partitioned layout 
.LNA_stage_1:layout

When using  with an EM Cosimulation LNA_stage_1:schematic

controller, the circuit simulated instances are netlisted from the schematic 
.LNA_stage_1:schematic

This distinction is relevant for tuning and optimization, where the view that owns 
the circuit simulated instances is used for selecting and updating parameters.

See Also
Automatic EM Circuit Partitioning
EM Circuit Cosimulation
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EMPro and ADS Integration

EMPro and ADS Integration

Keysight EEsof provides a way to combine the capabilities of EMPro and ADS by 
using a common database. The following features are supported in EMPro:

Import EMPro results and design data in ADS.

Perform EM circuit co-simulation from the ADS Schematic window.

Improve usability of the existing EMPro components by adding EM ports in 
ADS.

Contents

EMPro and ADS Integration Process

Saving EMPro Designs in a Library

Adding an EMPro Library in ADS

Adding EMPro Components in ADS Layout

Using EMPro Components in ADS Schematic

Adding EMPro Components to Schematic

Exporting EMPro Simulation Results as emModel

Exporting ADS Layouts to EMPro

EMPro ADS Integration FAQs

Application- SI Analysis of Interconnects using EMPro-ADS Interoperability

Example- Using the EMPro Connector Design in ADS

Using the EMPro FEM Engine in ADS

EMPro and ADS Integration Process

EMPro and ADS Integration Process

EMPro designs are stored in a cell, which contains multiple views. You can use 
these views in ADS layout and schematic.

EMPro and ADS Integration

http://edadocs.software.keysight.com/display/ads2017/SI+Analysis+of+Interconnects+using+EMPro-ADS+Interoperability
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EMPro and ADS Integration Process
The following flowchart depicts the ADS and EMPro integration process:
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You can perform all these actions while both EMPro and ADS are open.

Creating Designs in EMPro

You can create a new design or modify an existing design in EMPro.

For more details, see .Creating Designs in EMPro
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Saving EMPro Designs in a Library

EMPro designs are saved as cells in a library. You can import this library in ADS. For 
more details, see .Saving EMPro Designs in a Library

Adding an EMPro Library in ADS

To use EMPro designs in ADS, add the EMPro design library in an ADS workspace. 
For more details, see .Adding an EMPro Library in ADS

Using EMPro Components in ADS Layout

From an EMPro library, you can use the footprint or layout view in the ADS layout. 
For more details, see

Adding EMPro Components in ADS Layout
.

Using EMPro Components in ADS Schematic

From an EMPro library, you can use the symbol or lookalike view in the ADS 
schematic. For more details, see .Using EMPro Components in ADS Schematic

Saving EMPro Designs in a Library

Saving EMPro Designs in a Library

From EMPro 2012 release onwards, your EMPro designs are saved in a library. After 
you have saved the design, a cell with multiple views is created and stored in a 
library. You can import this library in ADS.

Designs created with EMPro 2012 that are saved as cells and views in a library 
cannot be opened with older releases. However, from within EMPro 2012, you 
have the option to save the design in the legacy format (.ep). Designs created 
with previous releases can be opened in EMPro 2012 and can be saved in the 
new library cell/view format (recommended) or in the legacy format (.ep). 
When saved in the new library cell/view format, the legacy files on your system 
remain unchanged.

While saving an EMPro project, you can specify the following project types:

EMPro OpenAccess projects: Enables you to save EMPro projects in a 
library, unless you explicitly specify a project name that ends with .ep. If the 
chosen destination is not within a library, a new library is created with the 
same name as the project.

EMPro Legacy projects: Enables you to save EMPro projects in the legacy (.
ep) format.
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All OpenAccess cells: Enables you to save projects in a library, unless you 
explicitly type a new project name that ends with .ep. If the chosen 
destination is not within a library, a new library is created with the same 
name as the project.

All files: Displays all files. It enables you to save a project in a library, unless 
you explicitly type a new project name that ends with .ep. If the chosen 
destination is not a library, a new library will be created with the same name 
as the project.

Saving Designs in a Library

To save a design in a library:

Select  >  to open the Save Project As dialog box.File Save Project As

Choose the required location for saving your project.

Click  (  ). A new library is created in the Create New OpenAccess Library
Save Project As dialog box.

Specify a name for your library, as shown in the following figure:

Double-click the new library.

Type a name for your project or accept the default name.

Accept the default project type, .EMPro OpenAccess projects
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Click .Save

If new cells are added to the EMPro library, select  >  to refresh the View Refresh (F5)
library view in the ADS Main window. If a particular cell is changed from within 
EMPro, you need to insert a new instance in the ADS design to capture the 
changes. For example, if the number of ports changed, you need to add the 
updated cell in ADS.

Show me How Do I Save EMPro Designs in a Library

youtu.be

 Video: How Do I Save EMPro Projects as a Library

Saving Existing 3D Components in a Library

You can also save components that were created using older versions of EMPro in a 
library. These projects, which were created in the  format, can be easily saved in .ep
the new format. You need to open an existing project and save it as a library. While 
opening a project, you can select one of the following project types:

All EMPro Projects (OA,.ep): Displays all EMPro projects that are created in 
the OpenAccess (OA) and .ep format.

EMPro OpenAccess projects: Displays only OpenAccess cells that are EMPro 
projects.

EMPro Legacy projects: Displays only EMPro projects that are created in the 
legacy format (.ep).

All files: Displays all files.

To open an older version project:

Choose  >  to display the Open Existing Project File Open Existing Projects
dialog box.

http://youtu.be/VUN8dnFZxg0
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Select the required project type.

Select the existing project you want to open.

Click .Open

After opening the project, you can save it in the new library format. Perform the 
following steps:

Open a legacy EMPro design.

Select  >  to open the Save Project As dialog box.File Save Project As

Choose the required location for saving your project.

Type a name for your project.

Select  as the project type.EMPro OpenAccess projects

Click .Save

Creating Designs in EMPro

Creating Designs in EMPro

To create an EMPro design, perform the following tasks:

Create a Geometry.

Assign Materials to components.

Set Mesh Priority.

Define Ports.
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Specify Simulation Setup.

Step 1: Create a Geometry

To create new objects or modify existing objects, use the Create Geometry toolbar.

Example: Creating a Parametrized Geometry

To create a parametrized geometry:

Click  in the  window.Extrude Geometry

Select the object you want to create.

Click the  tab and enter the .Extrude Extrude Distance

Click . The geometry view displays the objects that you have created.Done

Click the  tab to specify the origin of the model.Specify Orientation

Click  and select the  tool.Origin

Click the  tab.Edit Cross Section

Click the  tab.Extrude

Type  in the  text box. The edit box will turn package_length Extrude Distance
red as soon as the focus is shifted away from the edit box or when you press 
Enter. This indicates that the value is interpreted as an expression containing 
an unknown parameter.

Click . The geometry view will not show the top box as the modeling Done
sequence contains the unknown parameter .package_height

Click  (  ) to open the Parameters window.Parameters

Click  to add a new parameter.
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Add the parameter  and set  to .package_height Formula 1 mm

Show Me How to Create a Parameterized Geometry

 Create Parametrized Geometry

Assign Materials to Components

After creating a parametrized component, assign materials to the component, as 
follows:

Click  and choose  > . Drag the two generated Parts Create New Assembly
objects into the Assembly.

Choose  >  to open the Materials Select from Default Material Library Material 
 window.Library

Double-click .Copper

Click .Add

Drag the material  and drop it on the geometry.Copper

Few materials are not supported by 3D components due to limitations in 
the FEM simulator.

Set Mesh Priority

To set the mesh priority of a component:

Double-click a material in the project tree to view its default priority.

Right-click  and choose .Parts View Parts List (All Parts)

Double-click the mesh priority column and type the required mesh priority.
OR

Right-click an object in the  list and choose Parts Gridding/Meshing, 
> .Gridding- Meshing\Meshing Order Set Priority

Type the mesh priority.

Click .OK

Define Ports

You can create two types of ports in EMPro internal and waveguide port.

Add an Internal Port

To create an internal port:

Right-click  from the  list and then select Circuit Components/Ports Parts New 
 > . The New Circuit Component Circuit Component with New Feed Definition

window is displayed.

Define  and .Endpoint1 Endpoint2

Click .Apply

Add a Waveguide Port

http://edadownload.software.keysight.com/eedl/empro/2011/video/v3/creating_objects.html
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Add a Waveguide Port

Right-click  >  from the  list. Circuit Components/Ports Waveguide Ports Parts
The EMPro Waveguide Port Editor is displayed.

In the  tab, click  to select an edge of the component.Location

Click the  tab.Properties

Specify the Voltage source.

Click the  tab.Impedance Line

Define  and .Endpoint1 Endpoint2

Click . The impedance line appear on the waveguide port. The Waveguide OK
port might show an invalid symbol. As per the message, waveguide port 
should lie on the faces of the geometry. Change the padding in x direction. 
Both lower and upper padding in X direction should be 0mm as waveguide 
port lie on X plane.

Click . This makes the waveguide port valid. Similarly, define other Done
waveguide ports.

Adding an EMPro Library in ADS

This page is automatically copied from the . All edits must Single Source area
be done to the original page.
Click on this link to edit the page:
Adding an EMPro Library in ADS

http://edadocs.software.keysight.com/display/source/EMPro-ADS+Single+Source+Table
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Adding an EMPro Library in ADS

When an EMPro design is saved in a library, the following types of views are 
created:

emModel:Represents a custom view type supported by ADS that allows 
cosimulation with an EM simulator by caching simulation results.

empro: Consists of a 3D design, which is managed by EMPro. In the ADS cell 
containing EMPro library, right-click  and select . The empro Open EMPro 

 window is displayed. You can view the design in EMPro by clicking View
.Open in EMPro

layout and : Represent a layout view in ADS. The layout and footprint
footprint views can be used interchangeably. These views are of the type 
layout and represent a 3D design, but as a 2D outline.

symbol: Represents a schematic view and is the schematic black box-like 
symbol.

lookalike: Represents a schematic view and is similar to the symbol view, but 
shows the outline of a 3D design in a 2D outline for use on a schematic.

The emModel, symbol, and lookalike views are created only when a 3D design 
is simulated.

The following figure describes various components of a library:

Adding an EMPro library in ADS

In ADS, a library includes multiple cells each containing a view that is used for a 
particular tool operating on the design. For example, symbol views are used in ADS 
Schematic, while a layout view can be manipulated by ADS Layout. Together, these 
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views form a cell. EMPro, similarly, allows you to manage a design stored in the 
database. For example, consider an SMA connector that is created in EMPro. After 
adding this connector in ADS, the cell can include an emModel or layout view. You 
can insert the emModel view directly in an ADS schematic and use for circuit/EM 
cosimulation. Similarly, you can insert a layout view on an ADS layout design for 
performing 3D simulations in ADS.

To add an EMPro library in ADS:

Select  >  from the ADS Main window. The Manage File Manage Libraries
Libraries window is displayed.

Click .Add Library

Click  to close the message box. The Add Library dialog box is displayed.Yes

Specify the path of your EMPro library. You can also click  to access Browse
the required library.

Select the required library mode from the  drop-down list.Mode

Click . The EMPro design is imported as a cell with multiple views in the OK
ADS Main window.

Show me How Do I Add an EMPro Library in ADS

 Video: Add an EMPro Library in ADS

http://youtu.be/eXDswK52UdU
http://youtu.be/eXDswK52UdU
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Using Libraries, Cells, and Views in ADS

After saving your EMPro designs in a library, you can import the library in an ADS 
workspace. A workspace is used to store and organize the design work in Library:

 hierarchical architecture. EMPro components are added to a cell in the Cell:View
workspace. A cell contains various types of  that represent different aspects of views
the component, such as layout, schematic, or symbol.

Library:Cell:View hierarchy

ADS Library

In ADS, a library is a subdirectory that includes cells. Libraries are used by 
specifying the subdirectory in a library definition file, such as . This file lib.defs

defines name of the library and the mode of operation (Read Only, Non-Shared, or 
Shared). Files within the library itself define the technology (layers, resolution, and 
layout units) to be used by Views created in that library. All types of designs are 
contained in libraries.

The process information such as layer definitions, units, and substrates are defined 
in the technology of a library. You can create multiple libraries within a complete 
design hierarchy. A library resides physically in the workspace directory.

Key Features of an ADS Library

The following are the key features of a library in ADS:

Each Library has a unique name and path, specified in a library definition 
file. A library itself does not specify its name. The name must be specified 
correctly in a lib.defs file.)

Two libraries with the same name cannot be open at the same 
time.

Associated with a Technology that defines physical layers, and units. The 
technology can be a native one created for a library, or it can be referenced 
to another library.

Contains zero (0) or more Cells.
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Loaded/unloaded independently or collectively loaded through a  lib.defs

file.

Defines the technology (layers, resolution, layout units). All views in a library 
use the same technology.

Can be opened in following three modes:

Read-only Mode: In this mode, you cannot modify or commit changes 
to the library cells and the cell views. You need to use the Only Save 

 option. will work.As

Shared Mode: In this mode, you can jointly modify and/or commit 
changes to the library cells and cell views with others that might have 
access to the same ADS library location.

Non-Shared Mode: In this mode, only you can commit any changes 
to the library’s cells and cell views when library is open.

Can reside physically anywhere in the system, with the following 
conventions:

All ADS components are inside Read-only ADS libraries which are 
stored with the product.

Normal end-user libraries are usually stored in a workspace. You can 
add a library from another workspace into the current workspace.

In ADS 2011, Workspaces are not included inside another 
workspace. Instead, a lib.defs file from another workspace 
can be added to the current workspace using DesignKits 

 from the ADS Main Window.> Manage Libraries...

Cell

A Cell is a container of . Each Cell:Views

Must have a unique name in the library, although cells with the same name 
may exist in another library.

Contains zero or more views.

May have multiple views of the same type.

May have a component definition, edited by choosing File > Design 
 while editing one of its views.Parameters...

View

A View is a subdirectory in a cell that stores design information such as schematic, 
symbol, or layout. Views may also store an EM simulation setup or an EM Model. 
Each view is a container that stores a file or a database object. It is a specific 
representation of a cell. All views in a given library use the same technology.

Each view:

is associated with a Cell.

must have a unique name in the Cell.
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Schematic, Layout, and Symbol Views should generally be 
named as , , and  unless you are using schematic layout symbol
polymorphism.

Has a type (schematic, layout, symbol, EM Setup, EM Model).

Adding EMPro Components in ADS Layout

Adding EMPro Components in ADS Layout

An EMPro library consists of a footprint and layout view that can be placed on an 
ADS Layout. After adding EMPro components in a layout, you can customize 
parameters and define EM ports on these components in ADS.

Perform the following steps to use EMPro components in ADS:

Save your EMPro designs in a library. For more information, see Saving 
.EMPro Designs in a Library

Import the EMPro library in ADS. For more information, see Adding an EMPro 
.Library in ADS

Place EMPro components in the ADS Layout window.

Defining EM Ports on EMPro components.

Assigning Pins to EMPro Ports.

Perform simulation using EMPro components.

This section provides information about how to add EMPro components in ADS 
layout, assign pins, and perform co-simulation with an ADS board.

Inserting EMPro Components in ADS Layout

Before using EMPro components in ADS Layout, the technology database of 
 library must be referenced by the workspace library. The empro_standard_layers

artwork (footprint) of 3D components and their port-pins are drawn on the 
 and the  layers, respectively. These layers are empro_3dc_artwork empro_3dc_pins

saved in the empro_standard_layers library. The layer on which a 3D component 
pin is drawn together with the net determines its logical connectivity.

This is needed only if you want to create ports on the EMPro components in 
layout.

Referencing the EMPro Standard Layer Library

To link the  library to your design in ADS:empro_standard_layers

Select  >  > .Options Technology Technology Setup

Click the  tab.Referenced Technology

Click .Add Referenced Library
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Add , as shown in the following figure:empro_standard_layers

Click .OK

Adding EMPro Components from the ADS Main Window

To insert an EMPro component in ADS layout:

Open a Layout window in ADS.

From the ADS Main window, select the  or  view in the cell layout footprint
imported from EMPro.

Drag and drop the selected component in the ADS layout window. The 
Properties dialog box is displayed.

Modify the component properties as per your requirements in the Properties 
dialog box.
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Click . An EMPro component is included in the ADS layout. You can now OK
rotate and position the component in your layout design.

Adding EMPro Components using the Component Library Window

Alternatively, you can also insert a component by using the Component Library 
window. Perform the following steps:

Click  in the ADS Layout window. The Component Library window is 
displayed.

Access the library imported from EMPro in .Workspace Libraries

Double-click the required component from the  column. The Component
Choose View window is displayed.

Select  or  from the Component column.footprint layout

Drag and drop the component on the Layout window.

Customizing Component Parameters in ADS

You can customize the following EMPro component parameters in ADS

Parameter Description

CustomComponentLayer Layer in the substrate corresponding to Z=0 in the 3D Component.

CustomComponentOnTop Alignment of Z=0 in the 3D Component with top/bottom of the layer.

CustomComponentRotateX Rotates the component around the X axis.

CustomComponentRotateY Rotates the component around the Y axis.

CustomComponentMirrorZ Mirrors the component about the XY plane, boolean that triggers the projection f
(z)=-z.

CustomComponentOffsetZ Adds an additional translation in Z direction to the component, z distance 
specified by user.

minFreq Minimum frequency of interest for the project.

maxFreq Maximum frequency of interest for the project.

Defining EM Ports on EMPro Components

If you have defined ports in the EMPro design, the instance pins are visible in layout 
(diamond shape) corresponding to the connection points of the ports defined in 
EMPro. You can also add pins in the top layout, connected to the instance pins.

When a pin is recognized as a 3D pin, it displays text 3D.
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To add pins:

Select  >  in the ADS Layout window.Insert Pin

Place the pins at the required location of the ports imported from EMPro, as 
shown in the following figure:

If two 3D pins map on the same 2D coordinates on footprint, the 2D projection 
of one pin is displaced with respect to other to select each pin. However, the 
3D locations are not changed.

Waveguide Port

A waveguide port definition on an EMPro component can be used to create either a 
calibrated port or non-calibrated port when using this component in ADS layout. 
By default, the waveguide port definition will lead to a calibrated port. To do this, 
reference the empro_standard_layers technology to your design (see Adding EMPro 

), add pins to the + and – instance pins of the EMPro Components in ADS Layout
component, and associate both pins to the TML port in the EM Setup window.

The location of the + and – instance pins correspond to the location of the end 
points of the impedance lines of the waveguide port. The waveguide port setup 
parameters as defined in EMPro will be used as the port parameters in the 
simulation driven from layout.

In case the calibrated port is not be located on the boundary of the simulation 
domain (e.g. because of the presence of other metal shapes), it will be 
automatically translated into a circuit component port.

You can manually force the waveguide port definition to be translated to a non-
calibrated port by marking the port to be of calibration type None in the EM Setup 
window.

Circuit Component Port

A circuit component port definition on an EMPro component can only be used to 
create a non-calibrated port definition in ADS layout. To do this,reference the 
empro_standard_layers technology to your design (see Adding EMPro Components 

), add pins to the + and – instance pins of the EMPro component and in ADS Layout
associate both pins to a non-calibrated port in the EM Setup window. The location 
of the + and – instance pins corresponds to the location of the end points of circuit 
component port.
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ADS allows a geometrical connection between ADS and EMPro 
components. You need to assign EM pins to an EMPro component only 
when you need to measure power of the component.

Assigning Pins to EMPro Ports

To assign layout pins to EMPro ports:

Select  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window.Ports

Select an EMPro pin in .Layout Pins

Drag the pin from Layout Pins and drop it on the  or  terminal of the 
required port in .S-parameter Ports

A message box is displayed if your target pin is already used by other ports.

Click in the message box.Delete Ports and Continue

You can drag and drop multiple layout pins and connect with a S-
parameter port.
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After assigning layout pins, launch FEM from layout and simulate your design. The 
EM Setup window determines simulation parameters.

For more information, see .Defining Ports

Performing 3D Visualization

You must complete the simulation process to view data for your EMPro design 
imported in ADS. If you have already simulated a design, start the Visualization 
feature directly to view the existing data. In the ADS layout, select  > EM Post-

 >  to open the  window. You can Processing Visualization Keysight FEM Visualization

also open this window by clicking  (  ) in the EM toolbar.Visualization

To visualize FEM simulations:

Choose  >  to open the  window.EM Simulation Setup EM Setup

Select  in the EM Setup window.FEM

Specify the required settings in the EM Setup window for a layout, substrate, 
port, frequency plan, output plan, options, resources and model or symbol.

Click  in the EM Setup window to simulate your design.Simulate

Select  >  >  to preview your design.EM Post-Processing Visualization

For more information, see .Viewing Simulation Results in 3D

Show Me How Do I Use EMPro Components in the ADS Layout

Video: Use EMPro Components in the ADS

Using EMPro Components in ADS Schematic

Using EMPro Components in ADS Schematic

Adding EMPro Components to Schematic

Exporting EMPro Simulation Results as emModel

Adding EMPro Components to Schematic

Adding EMPro Components to Schematic

Using EMPro designs, you can perform EM circuit cosimulation in the ADS 
Schematic window. An EMPro component is represented by a symbol or lookalike 
in ADS Schematic. You can also perform cosimulation by using the S-parameters 
generated by an EMPro simulation. For more information, see Exporting EMPro 

.Simulation Results as emModel

http://youtu.be/gNZHT_OjI0M
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Perform the following steps to use EMPro components in ADS Schematic:

Save your EMPro designs in a library. For more information, see Saving 
.EMPro Designs in a Library

Import the EMPro library in ADS. For more information, see Adding an EMPro 
.Library in ADS

Place EMPro components in the ADS Schematic window.

Perform EM circuit cosimulation using EMPro components.

This section provides information about how to add EMPro components in ADS 
Schematic and perform EM circuit cosimulation with an ADS board.

Inserting EMPro Components in Schematic

You can insert the symbol components imported from an EMPro library in ADS 
Schematic. To insert a component, type the name of the component in the 
component name field or drag the component from the ADS Main window. The 
EMPro ports become schematic pins that can be connected to other components.

Adding EMPro Components from the ADS Main Window

To add an EMPro component in the ADS Schematic window:

Open a Schematic window in ADS.

From the ADS Main window, select  or  from the cell symbol lookalike
imported from EMPro.

Drag and drop the selected component in the Schematic window, as shown 
in the following figure:

Adding EMPro Components using the Component Library Window

Alternatively, you can also insert a component by using the Component Library 
window. Perform the following steps:

Click  . The Component Library window is displayed.

Access the library imported from EMPro in .Workspace Libraries
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Double-click the required component from the  column. The Component
Choose View window is displayed.

Select  or  from the Component column.symbol lookalike

Drag and drop the selected component on the Schematic window.

Edits made to symbol views for EMPro Component

Symbol views for EMPro component are automatically created upon saving an 
EMPro design as an OpenAccess library.

It is possible to make changes to the symbol views from within ADS by opening the 
Symbol view editor, like adding additional objects or text, scaling the symbol view, 
or moving the existing objects or pin locations. These edits will be retained after 
saving the cell from within EMPro (e.g. after making a change in the simulation 
setup).
Only in case there is a change in the port definition (e.g. a new port is added to the 
design in EMPro), previous edits in the pins locations made from within the Symbol 
View editor are omitted.

Performing EM Circuit Cosimulation

After inserting a symbol or lookalike component in the ADS Schematic window, you 
can perform EM circuit cosimulation. The EM circuit cosimulation feature enables 
you to combine EM and circuit simulations from the schematic.

To perform the EM circuit cosimulation using EMPro components in ADS 
Schematic:

Start ADS and open a workspace.

Place the symbol or lookalike component in the Schematic window.

Connect the imported symbol with other components.

Select the component and click   .Choose View for Simulation

Select the  view for simulation.emModel
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Click .OK

Click   .Simulate

Show me How Do I Add EMPro Components in Schematic

 Video: Add EMPro Components to Schematic

Exporting EMPro Simulation Results as emModel

Exporting EMPro Simulation Results as emModel

You can export EMPro simulation results as an ADS-compatible cell. The export 
process creates a cell with two views, emModel and symbol. You can use these 
cells in the ADS Schematic window. In ADS, a circuit simulator uses the S-
parameters results of an EMPro simulation. If you have performed simulations from 
within EMPro, the resulting S-parameter models are available as emModels for use 
in the circuit simulation flow. The emModel names refer to the simulation id, such 
as 000001 and 000002.

Perform the following steps to export EMPro simulation results:

Create an emModel and symbol in EMPro.

Import the EMPro cell in ADS.

Place the cell in the ADS Schematic window.

Perform simulation using the imported cell.

This section describes the process of creating an emmodel and symbol, importing 
EMPro cell, and performing simulation using S-parameters results.

Creating emModel in EMPro

To create an EM model component in EMPro:

Select  >  >  in EMPro. The Export File Export Simulation Results as emModel
Simulation Results as emModel dialog box is displayed, as shown in the 
following figure:

Select the required simulation result from the  drop-down Simulation Result
list.

http://youtu.be/17II9teMWEM
http://youtu.be/17II9teMWEM
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Specify the path for saving the library file in . You can OpenAccess Library

also click  to choose a location for saving the library file. Entering 
a new library name creates a library during the export.

Specify a cell name. By default, the project name is used as cell name.

Ensure that the  option is Open Libraries window after creation of cell
selected to display the Libraries window automatically.

Click . The Libraries window is displayed, which consists of an EM Create Cell
model and symbol that is generated as result of saving the EMPro simulation 
results. The following figure displays a Libraries window:

Alternatively, drag and drop a simulation from the Simulation Window onto an 
OpenAccess library to export the results from the simulation.

Using the Exported Cell in ADS

To add an EMPro library containing emModel and symbol in the ADS workspace:

Start ADS and open or create a workspace.

From the ADS Main window, choose  to open the File > Manage Libraries
Manage Libraries window.

Click  to open the Add Library dialog box.Add Library
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Click  and select the library that you have generated in EMPro. A valid Browse
library name is displayed automatically in the  text box.Name

Select the required mode from the  drop-down list.Mode

Click . The library containing the exported cell is added to the workspace, OK
as shown in the following window:

emModel and Symbol cell

An emModel provides an S-parameter simulation model based on the EM 
simulation for use in a circuit simulator. The following figure displays the emModel 
window:
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The following figure displays an example of a symbol imported from EMPro:



523 Electromagnetic

1.  

2.  

3.  

4.  

5.  

You can place the cell in a Schematic design in several ways, such as using the 
Place Component command or by typing the cell name in the inserted component 
history field. Alternatively, drag and drop the cell from the libraries view on the 
Schematic window.

Performing a Simulation in ADS Schematic with the EMPro Exported Cell

To perform the circuit simulation and using the EMPro simulation results:

Start ADS and open or create a workspace.

Place the emModel or symbol in the Schematic window.

Connect the imported symbol with the terminals of other components.

Select the symbol and click   .Choose View for Simulation

Choose the  view for simulation.emModel
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Click .OK

Click   .Simulate

Exporting ADS Layouts to EMPro

Exporting ADS Layouts to EMPro

You can transfer an ADS layout to a new EMPro project by using the following 
options:

Using the  Option: You can use the Launch EMPro and import this design
 option in ADS 2011 to export designs Launch EMPro and import this design

from ADS and import the designs in EMPro.

Using the  Option: You can use the Create a self-contained import script
 option in ADS 2011 to specify a Create a self-contained import script

location for saving a self-contained Python script. To complete the 
conversion, import and execute this script in an empty EMPro design. You 
can use this process when ADS and EMPro are not installed on the same 
machine.

To transfer ADS layouts:

Select  >  to display the  window.EM Simulation Setup EM Setup

Select  in the EM Setup window, as shown in the following figure:FEM
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Click . You can also choose  > Launch EMPro and import this design Tools
.Launch EMPro and import this design

Select the directory where you have installed EMPro.

Click .Choose

You need to select the EMPro installation location only once, ADS 
automatically launches EMPro if you have already specified the 
directory.

If you encounter a problem while exporting ADS layouts, such as despite entering a 
positive value for the thickness of a STRIP layer of the substrate definition, the layer 
appears as a sheet in EMPro. In such cases, to obtain thick metallization layers, edit 
the substrate definition in ADS and set the STRIP layer model to Thick (Expansion 

 or  instead of .Up) Thick (Expansion Down) Sheet (No Expansion)

EMPro ADS Integration FAQs

EMPro ADS Integration FAQs

This section provides step-by-step solutions for using EMPro 3D designs in ADS.

How Do I Add an EMPro Library in ADS

To add an EMPro library:

Open a workspace in ADS.
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From the ADS Main window, select  > .Design Kits Manage Libraries

Click . ADS displays a message about selecting a lib.defs file. For Add Library
libraries that contain only 3D cells or libraries that do not have references 
cells in other libraries, there is no lib.defs required.

Click . ADS automatically provides a name to the selected library. The Yes
default name is used when cells from the selected library are put on other 
cells and be used to match the library name back to the physical location of 
the library.

Click .OK

How Do I Reuse Results from an EMPro Simulation in ADS Schematic

If a simulation is successful in EMPro, an emModel is created automatically from 
the simulation results. After simulation, the cell managed by EMPro consists of an 
additional view. The first of these views is called 000001 and subsequent 
simulations have increasing numbers. These views are fixed simulation results and 
are directly used for cosimulation on ADS Schematic. The following figure displays 
a 3D cell containing a simulation result from EMPro:

To reuse Results from an EMPro Simulation in ADS Schematic:

Start ADS and open or create a workspace.

Place the emModel or symbol in the Schematic window.

Connect the imported symbol with other components.

Select the symbol and click   .Choose View for Simulation

Select  for simulation.000001
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Click .OK

Click   .Simulate

Results from FEM and FDTD simulations are usable in an S-parameter 
simulation from ADS Schematic.

How Do I Sweep an EMPro 3D Design using FEM in ADS

A complete EMPro 3D design is encapsulated in a cell. Cosimulation is supported 
through the emModel and empro views.

To sweep an EMPro 3D Design using FEM in ADS:

Drag and drop the symbol or lookalike view on ADS Schematic. Optionally, 
verify if the emModel view is selected for simulation.

Select the symbol and click   .Choose View for Simulation

Select emModel. The default hierarchy policy is to use the emModel. The 
following figure displays parameter sweeping a 3D design using ADS 
Schematic:

How Do I Simulate an ADS Board with an EMPro 3D Design in ADS Schematic

You can simulate a board created in ADS together with a full 3D design created in 
EMPro by using ADS Schematic as driver. Perform the following steps:
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Simulate the board using ADS Layout and create an emModel from the 
simulation.

Open an ADS Schematic window and place the generated emModel on the 
schematic.

Add the library with the 3D design to your ADS workspace.

Place the  components of the 3D design on the schematic and emModel
connect all the pins to create your required schematic.

Click   . If the emModel databases are already populated with Simulate
simulation results, the circuit simulator reuses the existing results. If the 
emModel database is empty, then proper cosimulation is performed.

Cosimulation with a 3D design from ADS Schematic is supported only if the 3D 
design is set up for simulation with FEM. If another simulator is desired, 
simulate from within EMPro and reuse the existing results.

How Do I Simulate an ADS Board with an EMPro 3D Design in ADS Layout

You can simulate a board created in ADS together with a full 3D design created in 
EMPro using ADS Layout as driver. Perform the following steps:

Open the board in ADS Layout.

Add the library containing the 3D design to your ADS workspace.

From the library, drag and drop the  view of the cell containing the footprint
3D design on to your ADS Layout window containing the board.

Set the simulation options by using the EM Setup window.

Select the FEM simulator to perform the simulation.

Click Simulate  .

You can perform ADS layout simulation of EMPro 3D designs only by using the 
FEM simulator (the Momentum simulator does not support layout simulation).

How Do I Simulate a Board Created in ADS Layout together with a EMPro 3D 
Design using EMPro as Driver

To simulate an EMPro design in ADS layout:

Open the board in ADS layout.

Set up the board for EM simulation.
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Use the EM Setup window to perform the necessary setup steps. You can 
modify all simulation setup options later in EMPro. Therefore, you can use 
either the ADS EM Setup window or the tools from within EMPro to setup 
ports, simulation boundaries, sweeps, and other parameters. In general, it is 
more efficient to perform port setup from within ADS.The layout is now ready 
to be exported to EMPro.

Click . Alternatively, a stand-alone Launch EMPro and import this design
script can be generated that you can run from within EMPro to reconstruct 
the board, including any setup made, in EMPro.

How Do I Move the Height of the Instantiation of a 3D Component

The height where a 3D component is instantiated is controlled by two parameters: 
CustomComponentLayer and CustomComponentOnTop. The parameter 
CustomComponentLayer is a layer being used to determine the Z location of the 3D 
component. It implies the layer has to be mapped into the substrate. The second 
parameter CustomComponentOnTop allows for thick layers to select between the 
bottom or the top of the layer to be used for the effective Z location.

How Do I Set the Origin of a 3D Component

The effective location of a 3D design in an ADS workspace is also determined by 
the location of the original 3D design. The absolute origin (0,0,0) of the 3D designs 
corresponds to the anchor point used in simulation driven from ADS layout to 
determine the final position of the 3D design in a combined board and 3D 
connector analysis. EMPro renders the absolute origin when the bounding box 
visualization of geometry is turned on.

The following figure shows origin of a 3D cell displayed in EMPro:
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How do I add a Port on a 3D Component

To add a port on a 3D component:

Ensure that the simulator is set to FEM in the EM Setup window.

Insert the footprint of the 3D design in the layout on ADS Layout window.

Insert a pin in the top-level design in the same manner as a regular 2D pin is 
added.

Snap the pin location to the instance pin that is part of the 3D component.

When a pin is recognized as a 3D pin, it displays text , as highlighted in 3D
the following figure:

How Do I Add Text to Look-alike or Footprint from a 3D Design

To add text to lookalike or footprint view in ADS:

Open a workspace in ADS.

Add the library where the cell containing the 3D design is contained.
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Access the cell and open the lookalike view.

Open the ADS Symbol editor to add the desired text or figures, as shown in 
the following figure:

EMPro does not modify any markup created by a user when the lookalike is 
updated within EMPro. Every shape generated by EMPro on the lookalike and 
footprint view can be updated in EMPro, but not in ADS.

How Do I Flip a 3D Component

There are presently two ways to flip a 3D component when inserted on a board. 
The first one is to open the original 3D design in EMPro and flip the component 
there and then save the 3D design again. The component is immediately displayed 
as flipped when a new 3D view is inserted in ADS.

This method modifies the original 3D design. If you do not want to modify the 
existing design, you can place the existing 3D component on a layer of a nested 
technology, which is placed in a flipped way. The following figure displays a flipped 
component:

How Do I Change the Layer of the Footprint View

To change the layer of a footprint view in ADS:
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Open the footprint view in ADS.

Click  or  to select all the components present on the view.Select Select All

Select  > . The Properties dialog box is displayed.Edit Properties

Select the required layer.

If the technology of the library does not have any layers, the layer 
selection will be empty. In that case, first add a layer to the technology 
of the library.

After changing layers, if the design is updated and the footprint view needs to be 
updated, EMPro will not change the layer position, but update the footprint but not 
the layer. EMPro verifies whether all EMPro-generated layouts are moved 
consistently to another layer. If all layers are not moved, EMPro will move all layout 
to the original layer.

3D cells can be saved in any library, so it is often beneficial to save them in a 
library that already contains the technology definition that can be used in ADS. 
When EMPro creates a library, the technology does not contain any layers by 
default.

How Do I Scale or Offset a Look-alike Symbol

By default, look-alike symbols are generated using a set of rather simple heuristics 
to determine the final size. To customize the scale value of a lookalike view:

Open the view in ADS layout.

Click  or  to select all the components present on the view.Select Select All

Select  > .Edit Scale/Oversize \ Scale

Specify the required scale factor. After editing the scale factor, you still need 
to select a center of scaling.
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Similarly, you can offset by selecting  >  or .Edit Move Move Relative

If a lookalike view is scaled or offset, EMPro does not change the scaling and 
offset. Therefore, if the original lookalike is 3 inches wide on ADS Schematic, 
any update of the lookalike from within EMPro keeps the outline of the design 
within the lookalike view within 3 inches. Similarly, if the lookalike view was 
shifted 2 inches up, any updates to the lookalike view is generated with the 
same offset value.

How Do I Use a 3D Component Created in an Earlier Version of EMPro

To use a 3D component created in previous versions of EMPro:

Open the original 3D design (typically stored in an .ep directory or zep file) in 
EMPro 2012.

Click .Save As

Select the OpenAccess library where you want to store the 3D design. Now, 
you can use the 3D design as a 3D component.

Example- Using the EMPro Connector Design in ADS

Example- Using the EMPro Connector Design in ADS

This section describes how to use the EMPro connector design, SMA Johnson Edge 
Mount, in ADS. The Connector design used in this example consists of:

Parameter definition for permittivity dielectric coax, .eps_coax

Design has two component ports:

Port 1 on the side that connects to the ADS board.

Port 2 on the coax side, which is a component port.
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Perform the following tasks:

Open the SMA_Johnson_Edge_Mount Project and modify the design.

Save the Connector Design in an EMPro Library.

Import the EMPro library in ADS.

Use EMPro Connector in Schematic.

Use EMPro Connector in ADS Layout

Open the SMA Johnson Edge Mount Project in EMPro

To display SMA Johnson Edge Mount project in EMPro:

Open the Libraries window in EMPro 2012.09.

Select  in .SMA Johnson Edge Mount Basic Libraries

Drag and drop  on  in the Project tree. The SMA Johnson Edge Mount Parts
Material Assignments window is displayed.
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Accept the default materials and click . The SMA Johnson Edge Mount OK
project opens in EMPro.

Create Ports

You need to add two ports in the SMA Johnson Edge Mount design:

Port 1 on the side that connects to the ADS board.

Port 2 on the coax side, which is a component port.

Save the Connector Design in an EMPro Library

To save the EMPro connector design in a library:

Select  >  to open the Save Project As dialog box.File Save Project As

Choose the required location for saving your project.

Click  (  ). A new library is created in the Create New OpenAccess Library
Save Project As dialog box.

Double-click the new library.

Specify  as name for your library.empro_comp_lib

Accept the default name for your project, SMA_Johnson_PCB_Edge_Mount.

Accept the default project type, .EMPro OpenAccess projects

Click . This saves the EMPro design in the new format, ready for use in Save
ADS.

Import the EMPro library in ADS

To open EMPro library containing the connector design in ADS:

Select  >  from the ADS Main window. The Manage File Manage Libraries
Libraries window is displayed.

Click . A message box is displayed.Add Library

Click  to close the message box. The Add Library dialog box is displayed.Yes

Click  to access the required design.Browse

Select .empro_comp_lib

Click . The EMPro design is imported as a cell with multiple views in the OK
ADS Main window as shown in the following figure:
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Open Design in ADS

To integrate EMPro components with an ADS design, open the following 
workspace:

ADS Install $HPEESOF_DIR/examples/EM/RF_Microwave
/EMPro_ADS_handson_wrk

To open the  workspace in ADS:EMPro_ADS_handson_wrk.7zads

Select  >  > . The Select an Archive File dialog box is File Open Example
displayed.

Double-click the  folder.FEM

Select .EMPro_ADS_handson_wrk.7zads

Click . The Unarchive Wizard is displayed.Open

Provide a destination path for unarchiving your example workspace.

Click .Next

Select .EMPro_ADS_handson_wrk

Click .Finish

Use EMPro Connector in Schematic

To add an EMPro component in the ADS Schematic window:

Open the simulate_schematic window from the EMPro_ADS_handson_wrk.
 workspace.7zads

From the ADS Main window, select  from the cell, symbol
SMA_Johnson_PCB_Edge_Mount, imported from EMPro.

Drag and drop the  component in the Schematic window.symbol

Connect the imported symbol with other components by adding connectors, 
mind polarity and port numbering, as shown in the following figure:
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Select the symbol and click .Choose View for Simulation

Select the  view for simulation.emModel

Click .OK

Click . It triggers the following sequence of actions:Simulate

Retrieve existing EM model for the board.

FEM simulation for connector, eps is equal to 2.

FEM simulation for connector, eps is equal to 4.

Perform Circuit simulation.

Use EMPro Connector in ADS Layout

To use connectors in a layout:

Open the layout design from the  EMPro_ADS_handson_wrk.7zads
workspace:

From the ADS Main window, select  from the cell imported from footprint
EMPro.

Drag and drop the footprint component in the ADS layout window. The 
Properties dialog box is displayed.

Insert the first connector, and select  as the layer to match the z-location.pc2

Accept the default values and click . The EMPro connector is added to the OK
ADS layout.

Insert the second connector, rotate and position, and select  as the layer pc2
to match the z-location.

Add four pins on layer , connected to the instance pins ads_device: drawing
of the connectors

Place the pins at the required location of the ports imported from EMPro, as 
shown in the following figure:



Electromagnetic 538

8.  

9.  

10.  

11.  

12.  

13.  

14.  

15.  

16.  

17.  

18.  

Create two EM ports from the four pins using the EM Setup window.

Select  >  to open the EM Setup window.EM Simulation Setup

Select  in the left pane of the EM Setup window. The EMPro pins are Ports
displayed in Layout Pins.

Select an EMPro pin row in .Layout Pins

Drag the pin from Layout Pins and drop it on the + or - terminal of the 
required port in .S-parameter Ports

A message box is displayed if your target pin is already used by other ports.

Select  in the EM Setup window.FEM

Specify the required settings in the EM Setup window for a layout, substrate, 
port, frequency plan, output plan, options, resources and model or symbol.

Click  in the EM Setup window to simulate your design.Simulate

Select  >  >  to view your design.EM Post-Processing Visualization

Using the EMPro FEM Engine in ADS
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Using the EMPro FEM Engine in ADS

While running FEM in ADS, the internal FEM engine that comes with the ADS 
installation is used. However, you can configure ADS to use the EMPro FEM engine 
by using the  file located in the main ADS installation directory.ComponentRefs.ini

To use EMPro FEM Engine in ADS:

Close all the open sessions of ADS.

Open the file present at the following location:ComponentRefs.ini

<ADS_HOME>/ComponentRefs.ini

The  file is write protected. Therefore, you must use ComponentRefs.ini
an editor in the administrator mode.

To point ADS to FEM bits in a different location, modify the file or include an 
additional line. If you make the new line start with a higher number, this will 
be the version that is used.
Example:

[fem]
2012.09\Location=%HPEESOF_DIR%\\fem\\260
2013.09\Location=C:\\keysight\\Mosaic\\fem\\2012.09

Run ADS.
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Package Model Extraction

Package Model Extraction

The Package Model Extraction add-on allows you to create a low frequency RLCK 
model from S-parameter data representing the package interconnect. It models the 
structure as a series of RLk block followed by a GC block to ground. In between the 
RLk and GC block, the interconnect block W models the fan out from inputs to 
outputs. Mutual coupling between the different branches is considered. The 
equivalent circuit topology is illustrated below. The mutual R components are not 
shown.

Enabling the Package Model Extraction Add-on

To enable the Package Model Extraction add-on:

Select  The Manage ADS Tools > App Manager... from the ADS Main window. 
Application Features and User Addons dialog is opened.

Select the  check box for Package RLCk Model Extraction. A Enabled
confirmation message window is displayed.

Click  to enable.Yes

Restart ADS. The Package Model Extraction functionality is added in the Add-
Ons menu of the Layout and Schematic window.

Using the Package Model Extraction Tool

To extract a package model from an S-parameter file.
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From a Schematic or Layout window, select  > Add-Ons Package Model 
 > Extraction Start...

Select  >  menu to open a file browser. Browse to the S parameter File Open
file of your package in the dataset, touchstone, or citi file format. Click .Open

Configure the Port Partitioning by selection the appropriate setting for each 
port: Input, Output of Terminated.

Select the appropriate output you want: or Data Display Sub Circuit

Click the button on the toolbar.Extract 

The Package Model Extraction dialog consists of the following elements:

S-Parameter Summary

Displays a summary of the basic information about the selected s-parameter fle 
such as name and number of available frequency points.

Port Input/Output Partitioning

If port names are available, the names are picked from the S-parameter file. When 
no port names exist, P1 up to Pn is used with n the number of ports in the file.

The Port Partitioning allows you to specify whether an S-parameter port should be 
considered as an ,  or be . The die ports are usually Input Output Terminated
specified as input, package pin ports are typically outputs.

The initial value will be Terminated unless the tool is launched from a layout view 
and a port is found in the layout with a matching name, then the term type of that 
port is used to initialize the value. In that case, the settings can be pushed to

A valid setup requires at least 1 Input and 1 Output port. Normally, all ports need to 
be correctly defined. This can be done by picking up the information from a layout 

port configuration by clicking the left icon  . The right icon  allows you to 
update the layout’s configuration from the RLCK extraction UI.

The drop down on each Input/Ouput cell, or the context menu on a set of selected 
ports allows you to update the Input/Output configurations for one or more pins.
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Output

The Output section allows you to specify the output of the RLCK extraction tool. 
You can choose the following options:

Data Display with the RLCK fit for all frequencies of the original dataset.

Create a Sub Circuit for a specific extraction frequency available in the S-
parameter data.

Displaying Results in the Data Display Window

A dataset is created that is shown in a Data Display with a specific template 
matching the output data.

RLCk Dataset Naming Conventions

The RLCk dataset contains 4 blocks: data, inputs, outputs and ports.

Dataset 
Block

Content

data Contains R, L, G and C matrices versus frequency. The dimension of the R and L matrices is 
sweep_size(Inputs). The dimension of the G and C matrices is sweep_size(Outputs).

inputs Contains a string array, Inputs, and an integer array, InputPortIndex. The former contains the port 
names whose TermType is input. The latter contains the port number or index.

outputs Contains a string array, Outputs, and an integer array, OutputPortIndex. The former contains the 
port names whose TermType is output. The latter contains the port number or index.

ports
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Dataset 
Block

Content

Contains two string arrays: Ports contains the port names and TermType the term type, both with 
the port number as index.

RLCk Data Display Template

A Data Display template dedicated to the RLCk extraction is available and loaded 
when the Data Display window opens.

The first page provides the matrices with equivalent circuit data at a frequency 
determined by the marker on the slider bar. The second page is used to 
automatically export the RLCK data at the selected frequency to 4 CSV files in the 
ADS workspace directory.

 
The Data Display window consists of two tabs:

You can manually insert that template as follows:

Open a new data display window.

Select . The DDS Template Libraries browser is opened.Insert > Template

Select the  template under the Em_Product category and click RLCk OK.

Creating a Sub Circuit

You can generate a schematic at the extraction frequency by selecting the Sub 
Circuit option in the Output section. You specify the library and cell for the output 
and the schematic format that needs to be used. By default the schematic uses 
components from the ads_rflib for simulation within ADS only. When the 
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Interoperable option is selected the generation builds a schematic using 
components from Cadence Virtuoso analog and basic libraries that can be used 
immediately in the Virtuoso schematic environment.

Interoperable operation requires an RFIC Interoperable License in ADS and analog 
and basic lib must be available in your ADS workspace.

The Input ports of the schematic are placed on the left of the design. They are 
followed by the RL block consisting of the series R, L and mutual inductances and 
mutual resistances between the branches. When connections have fan out from 
input to output an W interconnect structure is place after the RL block. On the right 
side the Ouput ports are places connected with the GC block providing the 
parasitic capacitances and admittances to the ground (Ref) and parasitic 
capacitance and admittance between the Ouput ports.

When the number of ports on the design is large this densely coupled circuit with 
fully populated matrices becomes very large. This makes it slow to create. But 
much more importantly circuit simulations with this complex circuit can take up a 
lot of simulation resources. In general however most of the mutual couplings 
elements are very small and have little effect on the simulation results. They can be 
neglected without ill effects on the simulation results. The Options section allows to 
control the dropping of the smallest elements by keeping only a the largest n 
mutual couplings and/or ignoring elements below the certain absolute threshold 
values for the mutual resistance, mutual inductance, admittance and capacitance.

Options

You can specify advanced options for extraction by clicking the Options button. The 
thresholding value is only applied when enabled in the UI. The N setting is applied 
on individual R, L, G and C elements. When the absolute value threshold is also 
active the smallest number elements is kept. When the N value is set to 0 all off 
diagonal elements of the RL and GC matrices are ignored.

The series (self) R and L value of each input branch is always maintained but the G 
and C to ground (Ref) on the outputs nodes can be dropped when below the 
threshold.

Prerequisites for a sub circuit cell that is interoperable with Virtuoso

Before you can use the Package Model Extraction functionality in the RFIC 
Interoperability mode you need to ensure that Cadence Virtuoso libraries analogLib 
and basic library are available in your ADS workspace. These libraries can be found 
on any Unix installation of Cadence Virtuoso:

<Cadence Virtuoso IC tools install directory>/tools

/dfII/etc/cdslib/basic

<Cadence Virtuoso IC tools install directory>/tools

/dfII/etc/cdslib/artist/analogLib

To update the analogLib library:

Select  > . Tools Build ADS analogLib
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Click  to build analogLib.Yes

Select the analog library folder.

Click .Select Folder

After updating the library, you can add the analogLib and basic library in the Read-
only mode to your ADS workspace.

To add these two libraries to your ADS workspace:

Select  > . DesignKits Manage Libraries

Click  in the Manage Library window.Add Library

Specify the path of the required library or click Browse to select a library.

Click .OK

The interoperable operation requires an RFIC Interoperable License in 
ADS.

Example

Following example illustrates the extraction capability.

Launch ADS

Select  and browse to the Momentum/RF directory.File > Open > Example

Select the  archive file and click .Package_RLCk_Extraction_wrk.7zads Open

Unarchive the workspace.

The cell named QFN_package contains a package with two ports (Ports 1 and 2) at 
the board side and 3 ports on the DIE side (Ports 3, 4, and 5) as shown below.
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Port 3 and 4 at the die side are both connected to port 1 at the board side. This is a 
first net of interest. Port 5 at the die side is connected to port 2 at the board side. 
This is a second net of interest.
The equivalent circuit topology for this package is illustrated above.

An s-parameter model was generated by running Momentum RF. Open the 
Package Model Extraction addon, select the QFN_package.ds dataset, partition the 
ports as shown below and run the extraction.
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CoilSys

CoilSys

CoilSys is a new capability in ADS that is useful for RF/uWave IC designers. It is an 
Add-On to create a DRC clean inductors (single-ended/differential), balun, or 
transformer and transmission lines layout with layers mapped to a Momentum 
substrate. These layouts can be tuned/parameterized, and EM simulated.It can 
further create Pcells for both ADS and Virtuoso flow. CoilSys is used in automating:

generation of scalable EM model through Advanced Model Composer.

creation of required Pcells (ItemDef based and CDF based) in PDK which are 
not always available.

creation of libraries of inductors, baluns, transformers, and transmission 
lines.

generation of lookup table for synthesis and Inductor Finder for single-
ended and differential type of inductors.

Supported Platforms

CoilSys is an add-on utility that works on all ADS supported platforms. See 
.Supported Platform

Licensing

CoilSys required an ADS Advanced Layout license.

Using CoilSys

To use CoilSys, create a workspace or open an existing one, enable CoilSys, and 
then setup CoilSys components.

Creating Workspace for CoilSys

Launch ADS 2017.

Select File > New > Workspace to create a new workspace.

Specify the workspace name and browse to the desired workspace location.

Select Setup layout technology immediately after creating the library option.

Click Change Libraries.

Select Add User Favorite Library/PDK… option and browse to the lib.defs file 
of a foundry PDK.

Click OK.

Click Create Workspace and then click Finish.
If the PDK is correctly selected in step 6, the PDK technology is selected by 
default in the dialogue shown below.

http://edadocs.software.keysight.com/display/support/ADS%20Supported%20Platforms
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Enabling CoilSys

CoilSys is an ADS add-on utility and can be enabled from the ADS main window by 
selecting Tools > App Manager… > CoilSys option after creating or opening a 
workspace.
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After enabling CoilSys under App Manager, the "User_Input.ael" is copied to the 
current local workspace. Update Via Dimensions and Via Layer list as per foundry 
PDK technology specifications. This is to ensure generation of DRC clean PCells.

The variable viaLayerList must follow a specific order. It must always starts 
from the bottom of the stack, with via defined between the top metal and 
bottom metal, that is, the via close to the substrate must be defined first.

For example: For the following substrate the viaLayerList variable should be 
declared as shown below:
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decl viaLayerList =list("Metal1", "Poly","Cont",

"Metal2", "Metal1", "Via1",

"Metal3", "Metal2", "Via2",

"Metal4", "Metal3", "Via3",

"Metal5", "Metal4", "Via4",

"Metal6", "Metal5", "Via5");

The packaging of Library from CoilSys depends on the mode that was set to either 
Legacy mode or Interoperable mode. To set the mode, follow these steps:

Select Options > Preferences from the ADS main window.
The Main Preference window is displayed.

Click Interoperability tab and set the desired mode before using CoilSys.

Restart ADS.

Select Add-Ons > CoilSys option to launch CoilSys.

Setting Up CoilSys Components

Setting up CoilSys involves the following:

Create Pcells (Inductor/Transmission)

Generate Model

Package into Library
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Create Inductor Pcell

This option enables the user to create Pcells for the different type of inductors.

Select Add-Ons > CoilSys > Create Inductor Pcell option.

Select the desired Inductor from the available list: Single Ended; Differential, 
Balun, and Solenoid.

Select the desired type of Geometry from the available list: Square (with and 
without Center Tap), Octagonal (with and without Center Tap) and Circular. 

 
0

Preview button helps the user to inspect the component layout instantly.

Create Pcell button will make the component part of the library.

Create Transmission Pcell

This option enables the user to create Pcells for the different type of Transmission 
lines.

Select Add-Ons > CoilSys > Create Transmission Pcell option.

Select the desired Transmission line from the available list: MicroStrip Line, 
Strip Line, Coupled Waveguide, and Coupled Waveguide with ground.

Preview button helps the user to inspect the component layout instantly.

Create Pcell button will make the component part of the library.
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Generate Model

Once the Pcell is created, then it is available for generation of EM model through 
Advanced Model Composer. To create an EM-based model, follow these steps:

Select CoilSys > Generate Model.
The following dialog box opens up with the available PCells created through 
CoilSys.

Select the Pcell from the above CoilSys Build Model dialog box, and select 
OK.
The Advanced Model Components window is displayed with the list of 
parameters for generation of the scalable EM-based model.
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Package into Library

This enables the user to generate the add-on library. To create Library, follow these 
steps:

Select CoilSys > Package Library option and the following dialog box open 
up.
It lists all Cells (Pcells / Model) created through CoilSys.

Select all Cells or selected ones to package the library.
While creating the package, provide a package name and location details.



555 Electromagnetic

2.  

To use the packaged library, add Base PDK to the workspace before 
adding the library generated from CoilSys.

Parameters Supported for Various Topologies

Inductor Geometry Line 
Width

Solenoid 
Width

Line 
Space

Turns Primary 
Turns

Sec. 
Turns

X Y

Single-
ended

Square Yes No Yes Yes No No Yes Yes

Octagonal Yes No Yes Yes No No Yes Yes

Circular Yes No Yes Yes No No Yes Yes

Mitered
Rectangular

Yes No Yes Yes No No Yes Yes

Differential Square Yes No Yes Yes No No Yes Yes

Octagonal Yes No Yes Yes No No Yes Yes

Square_CT Yes No Yes Yes No No Yes Yes

Octagonal_CT Yes No Yes Yes No No Yes Yes

Balun Square Yes No Yes No Yes Yes Yes Yes

Octagonal Yes No Yes No Yes Yes Yes Yes

Rectangular_Vert_Coupled Yes No Yes Yes No No Yes Yes

Octagonal_Vert_Coupled Yes No Yes Yes No No Yes Yes

Octagonal_Vert_Coupled_Sym Yes No Yes Yes No No Yes Yes

Square_CT Yes No Yes No Yes Yes Yes Yes

Octagonal_CT Yes No Yes No Yes Yes Yes Yes

Solenoid Single-layer Yes Yes Yes Yes No No No No

Transmission Line Conductor 
width

Conductor 
Length

Ground 
Width

Ground 
Space

Via 
Rows

MicroStrip Yes Yes Yes No No
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Strip Line Yes Yes Yes No No

Coupled Waveguide Yes Yes Yes Yes No

Coupled Waveguide with 
Ground

Yes Yes Yes Yes Yes

CoilShunt Parameter

Via, Via Corners, Slot and Slot Broken are the supported CoilShunt types.

Via: Vias will be drawn all over the coil if there is an overlap between Mx and 
Mx-1 layers over the coil.

Via Corners: Vias will be drawn at the corners of the coil if there is an 
overlap between Mx and Mx-1 layers over the coil.

Slot: Slotted vias will be drawn all over the coil continuously if there is an 
overlap between Mx and Mx-1 layers over the coil.
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Slot Broken: Slotted vias will be drawn all over the coil discontinuously, at 
corners the slot will be broken, if there is an overlap between Mx and Mx-1 
layers over the coil.

Coil2Fab Parameter

Add_Pins and Gnd_Shield are supported. By default Add_Pins is selected. 
Gnd_Shield draws ground shield for inductors as shown below:
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Gnd_Shield will only be drawn for cases when the two bottommost metal layers 
in the selected stack-up are connected through a via.

Therefore, in few cases, you might observe no Gnd_Shield is drawn, even after 
enabling Gnd_Shield. In such cases, the symbol has to be updated manually by 
the user to remove the ports generated for Gnd_Shield.

Using Package in ADS Flow

Invoke ADS.

Create a new workspace with Base PDK added to it. See  for Using Coilsys
details.

Base PDK must be the same PDK which was used while creating the 
Package.

Add the library from the package created using CoilSys into ADS workspace.

Select DesignKits > Manage Libraries…

Click on Add Library Definition File.

Browse the lib.defs file in the package and click Close.

If the package name is abc, the lib.defs file would exist directly in the package 
if it is created in legacy mode, whereas it would exist in abc/abc_ADS if it is 
created in interoperable mode.

Now, the library created using CoilSys can be used in ADS flow.

Using Package in Virtuoso Flow

Use the cds.lib file in the PDK directory to load the Base PDK in Virtuoso. If 
the file does not exist, then create it.

Update the cds.lib file so that the library from the package created using 
CoilSys is included in Virtuoso. For example: if abc is the package created at 
XYZ location, then add the following line in the cds.lib file.
DEFINE abc XYZ/abc/abc.

Invoke Virtuoso.

Select Tools > Technology File Manager from the CIW window.

Attach the technology of the base PDK to the library created using CoilSys.
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Here, the reference PDK is gpdk180. So, the technology of gpdk180 is being added 
to the library 'abc' which is created using CoilSys.

Now, the library created using CoilSys can be used in Virtuoso flow.

Synthesis and Inductor Finder

Synthesis and Inductor Finder helps synthesizing single-ended or differential 
inductors. The inductor must have an EM model generated using CoilSys.

Select Add-Ons → CoilSys → Synthesis menu option.
The CoilSys Inductor Synthesis window is displayed.

Select an inductor from the list that has a model.
( OK button is enabled only after a 'cell name' is entered and selected 
inductor has a model )
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Specify a cell name to generate schematic template and click OK.
The CoilSys Inductor Parameters window is displayed.

Specify the parameter values except for the grayed-out parameters and click 
OK.

Specifying large values may result in longer simulation run time.



561 Electromagnetic

4.  

5.  

6.  

7.  

The schematic is displayed with information message.

Click OK to start the simulation.

The parameters like L, Q, Reff are extracted automatically and displayed in 
the DDS window. The simulation data is saved in the current workspace. 

Select Add-Ons → CoilSys → Find Inductor menu option.

The Inductor Finder window has two drop down lists : Select Library & Select 
simulation template.

When a particular library is selected, the respective simulation templates in 
that library are listed in the simulation template drop down menu; select one.

The simulation data of selected template is displayed in form of a lookup 
table.
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For additional filtering through the results, specify the parameters (along 
with tolerance) to separate out desired inductor from the total simulated 
results.

Select an inductor from the lookup table.

Click Create Inductor.

Specify a cell name to create a pcell of the synthesized inductor.

Click OK.

The desired Inductor Pcell is displayed in the Layout window.
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Preview Layouts

Preview Layouts

Before performing a simulation, you can validate your three dimensional design in 
the 3D Preview window. The representation seen in the 3D viewer consists of the 
same definition that will be used in a simulator. If a view is incorrect in the 3D 
viewer, it is essential to redesign before attempting a simulation. Using the 3D View 
window, you can now preview a layout design.

In the 3D Viewer, you can view the following components of a layout design:

View all the nets, component instances, pins and substrate objects.

View material definitions.

Customize the view of conductors and dielectrics.

Displaying the 3D Viewer Window

Select to generate a 3D EM > 3D EM Preview > Without EM Setup Preprocessing 
view of the layout without performing any pre-processing task. This is the fastest 
way to generate a 3D view. You do not need to create an EM Setup view for 
generating the 3D view from layout.

If you select  >  to generate a EM > 3D EM Preview With EM Setup Preprocessing
3D view of the selected components, pins are not displayed in the Preview 
window.

You can also click  in the layout window to display the layout preview:



565 Electromagnetic

1.  

2.  

3.  

4.  

1.  

2.  

3.  

4.  

Viewing the Components of a Layout Design

In the layout preview window, the Project panel provides a tree-structured 
representation of a design. You can view the following components of a design:

Nets

Components

Substrates

Pins

Searching and Viewing Nets

All nets in the layout view are listed in the project panel.

To find a specific net:

Click the  icon (  ) next to .Filter Nets

Type the required net name.

Click  to display a list of matching algorithms, as shown in the following 
figure:

Select the string matching algorithm: Simple, Regular Expression, or 
Hierarchical.

The Hierarchical option is relevant only for finding component instances.

Viewing Components

All component instances in the layout view are listed and grouped per component.

How to Find a Component Instance

To find a specific component instance:

Click the  icon (  ) next to  in the  tree.Filter Components Parts

Type the component instance name.

Click  to display a list of matching algorithms, as shown in the following 
figure:
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4.  Select the string matching algorithm: Simple, Regular Expression, or 
Hierarchical.

Viewing Substrate

You can view substrate objects in the layer grouped by Conductor layer, Via layer 
or Dielectric layer.

How to View the Geometry by Layer

First, switch off the Parts Visibility toggle. This toggle can be found on the 
Geometry Window’s View toolbar. Then, select the appropriate layer in the 
Substrate tree. The view displays the objects on the selected layer only.

Pins

All top level pins in the layout are listed.

Definitions

The  branch stores definitions that can be applied to or shared with other Definitions
objects within the project. You can apply a definition to other objects in the Project 
panel by clicking and dragging the definition object on the required object.

Materials

To view a material definition object, select a material from the  list.Materials

Customizing the View

Using the View panel, you can change the view of conductors and dielectrics in the 
preview window.

In the View panel:

Click  to apply make the objects shadedSolid

Click  to make the display only the edgesWireframe

Click to make all the objects invisible.Hide 
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The translucency of the objects, which are solid, are controlled by the translucency 
slide.

Layout Display Settings

The Layout Display Settings panel enables you to show, hide, shade, or unshade 
layers in the 3D Viewer window. You can also import or export the required file. To 
open this panel, select  > .Tools Layout Display Settings

Customizing the Layout View

The following table describes options available in the View menu and View Tools 
toolbar:

Option Icon Description

Toolbars   View Tools
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Option Icon Description

View 
Manipulation  

geometry_view_manipulation.

gif

Select: The Select tool is used to select 
objects as well as manipulate the view of the 
simulation space.

Orbit: The Orbit tool is selected to perform 
rotation of the simulation space through left-
clicking-and-dragging.

Pan: The Pan tool is selected to perform 
translation of the simulation space through 
right-clicking-and-dragging.

Zoom: Zoom-in or zoom-out of simulation 
space by scrolling up or down the mouse 
wheel, respectively.

Zoom to Window: Zoom into a rectangular 
shaped area of the geometry as specified by 
the user. To use, select the tool, then left-
click and drag the mouse to designate the 
rectangular zoom area.

Zoom to 
Extents  

geometry_zoomextents.png

Enable you to zoom automatically as can view the entire 
geometry in the workspace window.

Zoom to 
Selection  

geometry_zoomselection.png

Enables you to automatically zoom selected object only.

Standard 
Views  

geometry_standardviews.gif

The Standard View button function is to automatically 
change the perspective of the objects in the workspace 
window.

Front (-Y)

Back (+Y)

Top (-Z)

Bottom (+Z)

Right (-X)

Left (+X)

Isometric 
Views  

geometry_isometricviews.gif

The Isometric Views button function is to automatically 
change the perspective of the objects in the workspace 
window.

Front/Right/Top
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Option Icon Description

Front/Left/Top

Front/Right/Bottom

Front/Left/Bottom

Back/Right/Top

Back/Left/Top

Back/Right/Bottom

Back/Left/Bottom

Custom 
Views  

geometry_customviews.gif

Enable you to define any perspective than the Standard 
Views and Isometric Views, and display at that 
perspective.

Add View

Cutting 
Planes  

geometry_customplanes.gif

Cutting Planes button feature allows you to define an 
arbitrary cross-section of the object and display it.

Toggle Cutting Plane

Edit Cutting Plane

Save Cutting Plane

Connectivity 
Tool

Toggle the connectivity tool.

Toggle 
Bounding 
Box Visibility

Toggles the visibility of the bounding box of a design when 
the design is selected.

Connectivity Tool

The Connectivity Tool allows you to verify the accuracy of large designs or 
unexpected behavior after imports. The connectivity tool is multi-threaded and 
after an initial preparation phase gives the real-time electrical connectivity of 
objects inside the design.

To check the connectivity of a design:

Click the   icon present on the  toolbar.Connectivity View Tools

Position the mouse over the required part:

Wait for the connected parts to be highlighted (if highlighting on hover 
is enabled).
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2.  

b.  Click the part; you can add/remove parts using the key modifiers Ctrl
/Shft; Note that by clicking on a part the highlighting on hover is 
temporarily disabled until all parts are removed from the selection.

Settings

In the Connectivity Tool Settings tab, you can specify the Electric Conductivity 
, and , which allows you to control which materials Threshold Evaluation Frequency

are considered as electric conductors.

The check box allows you to Highlight Connected Parts while Hovering over a Part 
enable/disable the highlighting on hover.

Neighborhood

In the  tab, you can control which neighbors of Neighborhood of Connected Parts
the selected part (see 2.b) are highlighted by using the slider; Note that this can 
also be changed using the .Ctrl + Mouse Wheel

You can also change the colors of the selected parts and highlighted parts.

The incremental highlighting of the neighborhood allows you to find where 
unwanted connections, e.g, short circuits are made.



This information is subject to change 
without notice.
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